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Overview 

Welcome to ClinicOffice v5 

The purpose of this guide is to walk you through the main features of ClinicOffice v5 and explain in simple terms how 

to get the most out of the software. 

The guide assumes that you have at least a basic understanding of Microsoft Windows and are familiar with basic 

Windows concepts (e.g. double-clicking, right-clicking, drag-and-drop etc.). 

 

About the ClinicOffice v5 Manual 

This manual is designed to be as comprehensive and informative as possible. It exists in an electronic and printable 

format and is divided into three sections: - 

 

Section 1 – Getting Started 

The Getting Started section contains all the information you need to: - 

• Install ClinicOffice 

• Select/Create a database 

• Log on to ClinicOffice v5 for the first time 

 

Section 2 – User Guide 

The User Guide will be your main point of reference for ClinicOffice v5. All the program’s features and functionality are 

explained in the User Guide. 

 

Section 3 – Tutorial 

The Tutorial teaches you the fundamentals of ClinicOffice v5. We highly recommend that you run through the Tutorial 

from beginning to end, no matter what your level of experience. 

 

Printed Help Information 

The contents section at the start of this manual should help you to find information on any aspect of the program that 

you need help with.  

Please bear in mind that this manual deals with the full functionality of ClinicOffice v5. Certain features may not be 

available on your installation of ClinicOffice, depending on what edition or modules you purchased. 
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Section 1 – Getting Started 

The ‘Getting Started’ section will help you to: - 

1) Install ClinicOffice 

2) License ClinicOffice 

3) Log on to ClinicOffice v5 for the first time 
4) Create your own Database 

5) Network ClinicOffice 

 

Installing ClinicOffice v5 

To start the ClinicOffice v5 installation download the setup file from our Pioneer Software website. Before running the 

installation file you need to make sure that you have the Microsoft .Net Framework 4.5 or newer installed. If you 

are using Windows 10 this should be already be installed.  

If you have the Hosted Edition of ClinicOffice, then you will not need to install ClinicOffice locally and instead the 
instructions to connect to our Hosted system will be sent to you via email. These instructions are only pertaining to local 

installations of ClinicOffice. 

After downloading the set-up file, please run it and follow the steps below.  
 

1. If you agree to the EULA, please select “I accept the agreement” and click Next 
 

2. The second screen will allow you to select which folder to install ClinicOffice v5 to. If you are unsure, please 

leave it as it is and click Next. 
 

3. The third screen will allow you to select which folder to install the database to. Again, if you are unsure please 
leave it as it is and click Next.  

 
4. The fourth screen allows you to select the name of the ClinicOffice folder on the start menu. We would 

recommend you leave it as it is and click Next to continue. 

 
5. On the fifth screen select the shortcut you wish to display on the desktop and then click Next 

 

6. Click Install 
 

7. After the files have been installed, simply click the Finish button to exit the installation program 
 

NOTE: If you are using the Server Edition of ClinicOffice for step 5 you will need to select to create a “SERVER” 
edition shortcut for both the server machine and any client machines you install ClinicOffice. Do not select the 
Professional Edition icon for the client machines if you are using the Server Edition. 

 

Launching ClinicOffice v5 

Following the installation process, you should have noticed that a ClinicOffice v5 icon has been placed on your desktop. 
Double-clicking on the icon will launch the program. 
Alternatively, you can launch it via the Start menu in 
Windows. 

If you are running the Startup or Professional Editions of 
ClinicOffice, then the first time you open the program it 
will present a message asking to start the database 
engine (like the one to the right). Just click OK to this and 
Yes to any user control messages. 
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Licensing ClinicOffice 

Once ClinicOffice makes a connection to the database engine, 
then a Product Activation window will appear (see the example 
to the right). The built-in licensing system protects the program 
against unlicensed copies.  
 
If you have downloaded a trial of ClinicOffice then you can run 
it for up to 30 days by clicking the button “Continue my Trial”. 
After this period is up you will need to either request for a trial 
extension or purchase a license to continue to use the 

program. If you are using the Server edition the Activation 

screen will be similar, but it will be missing the free trial 
section, this is because the trial is not on the server edition.   
 
This screen will appear whenever a license cannot be 
detected. It will also appear sometimes on a machine that 
already had a license if there has been a change to the 
machines network card, either physical or software related. 
 

 

 

 

 

 

 

 

So long as you have an internet connection, click the Activate 
Online button. The Online Activation window will appear (as 
demonstrated by the windows to the left). 

The information that you should enter is the Customer Reference, 
Registered Name and Registered Company fields. These will be 
sent to you in an email after your initial purchase of ClinicOffice. 
Please save these details for future reference as you will 
require them if you wish to transfer your license. If you have 
misplaced these details, then please either email or call us and we 
will provide you with these details again. The Computer 
Description will be automatically filled in but you can choose to 
change this if you wish to. 

Press OK once all 4 fields have been filled in. ClinicOffice will now 

connect to our online server. So long as you have entered the 

correct details and have sufficient licenses then the following 

message below will appear: 

 

 

 

Press OK to this message. You can now continue 

to use ClinicOffice. 
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If when you click OK to the Online Activation window and you have more than one license available, then the next 

window below will appear: - 

Simple left-click on the license you wish to use and click OK. Again, an activation completed message will appear. 

 

Entering an Activation Code Offline 

If you do not have the internet or your site’s firewalls block 

regular HTTPS traffic, then call or email us for an offline 
computer activation code. Please make sure that you have 

your Computer ID in front of you so that we can give you an 

activation code there and then. 

Once you have received your activation code, click the “offline 

activation code” blue link. The Enter Activation Code window 

will appear. 

Enter your code into the Activation Code field and click OK, 

after which ClinicOffice will be licensed on your computer. 

 

 

NOTE: If you are using the Server Edition of ClinicOffice then you only need to license one computer, which will 
then store the license onto the server so that all computers on your network will be able to access ClinicOffice without 
the need of additional licensing. For the Professional Edition of ClinicOffice, each computer will require its own 
license. 
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Database Selection & Logging on and off 

 

The logon screen will look slightly different depending on which edition of the software you are running.  

We have provided a sample database (Willoughby Road Clinic) with a set of fictional staff, contacts and patients, which 
can be used to learn the basics of ClinicOffice v5. We recommend that if you want to enter live clinic data then you 

would be best off creating a new database instead of using the Sample Database. 

When you run ClinicOffice, the first screen you will see is the Logon screen: - 

 

Logging on to the Startup or Professional Edition 

 
Logging on to the Startup or Professional edition 

 

Click the blue link Manage Databases; the COv5 Databases window will now appear.  

COv5 Databases Window 

 

To locate your database, click the  button and select either “This Computer” or “A Network Computer”. 
If the database is on this computer, locate the folder that stores the ClinicOffice database and press OK. When you 

are finished, press OK and then press Close on the Manage Databases window. Under the section “Select which 

database to logon to” select your database, if it is not already selected, by left-clicking on the field and selecting it. 

Enter your username and password for this database; now press LOGON. 

To create your own database, please see the section “Creating a New Database”. 
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Logging on to the Server Edition 

 
Logging onto the server edition 

 

You will notice the main difference is the need to put in the name of your server computer (the computer that hosts 

the database). Once you have done this, press CONNECT. You will then have a list of databases that you can 
connect to. Select your database and enter your username and password; now press the CLICK TO LOGON button.  

   
 

 

Logging On and Off 

Let’s practice logging on and off with the Sample Database on the Startup or Professional Editions. Alternatively, you 

can use the trial of COv5 to do this. 

Make sure that the “Sample Database” is selected. The selected database is indicated in the field above the username 

field. If another database is selected, then you’ll need to change back to the sample database. 

Type ‘jsmith’ in the username box without the quotes 

Leave the password empty and click the LOGON button. 

 

A successful logon will take you to the ClinicOffice v5 Home Page from where you can access all areas of the program. 
A good way to get straight into using ClinicOffice is to work through the ClinicOffice Tutorial (please see Section 3 of 

this manual). 

To log off from a database, click the LOG OFF button ( ) which is located on the Home menu of the ClinicOffice 

screen. This takes you back to the Logon screen. 
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Creating a New Database 

To create a new database click Manage Databases. When the Manage Databases, window has opened click the 

Create New button. This will open the following screen: - 

 

New Database Window 

 

 
For step [1] we would recommend that you give the database a descriptive name, for example an abbreviated form of 
your clinic name. For step [2] enter the name of your primary clinic. For step [3] enter your name and when giving 
yourself a username in point [a] you could have the first letter of your first name with all of your last name (i.e. John 
Smith will look like ‘jsmith’), although there is no strict rule here. In points [b] and [c] enter your password. 

If you are creating a new database using the Server edition of ClinicOffice then you will not need to worry about step 
[4]. If you are using the Startup or Professional editions, then we recommend leaving it in the default folder if you are 
not too sure where you should put it.  

When you are finished click OK and your database will be created. All you need to do now is select the database as 
your current database, enter your username and password and logon. 

 

 

NOTE: Keep a safe record of your username and password, especially if you are likely to forget it! It is usually best 
using a combination of a few words that you will remember easily (a short sentence is helpful), vary the case types; 
insert numbers and add additional non-alpha-numerical characters. 

 WARNING: If you do forget your password, then you will not be able to access your database. The only way around 
this is if you have another supervisor on the system, then they can reset your password by going into your staff record’s 
access rights and clicking the Set Password button. The alternative is for you to send us your database so that we 
can decrypt your data and extract the passwords, for which we will have to charge you.  
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Networking ClinicOffice  

Both the Professional and Server editions of ClinicOffice run on a client-server database setup. With the Professional 
edition ClinicOffice will automatically install this for you. With the Server edition you will need to install this separately 
and you will be given the installation instructions upon purchasing ClinicOffice. 

 

Professional Edition 

Since the database is already network ready all you need to do from the other computer is the following: 

 

• Open ClinicOffice on the other computer 

• On the logon screen click Manage Database 

• Now click the Add Database button 

• Select A Network Computer 

• Enter the name of the host computer i.e. server 

• Click OK 

• Select a database and click OK 
 

You can now select the database on the logon screen and login. 

 

Server Edition 

After you have installed the PGSQL database engine and have created the database you can access the database from 
another machine by following the steps below: 

 

• Open ClinicOffice on the other computer 

• Type the name of the computer that hosts your database 

• Click the Connect button 

• Select your database 
 

You will now be able to enter your credentials and logon. 
 
 

Note: If ClinicOffice is unable to connect to the computer over the network, please make sure that network discovery 
is switched on both the server and client machines. If network discovery is switched on, please also check your firewalls 
allow through port 12010 for the Professional Edition and port 5432 for the Server Edition. 
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Section 2 – User Guide 

 

Your ClinicOffice v5 Home Page 

 

After logging on, the first screen you will see is the ClinicOffice v5 Home Page. From here, you can access all areas 

of ClinicOffice v5 by simply clicking on the appropriate link. If you hover the mouse pointer over each picture, text will 

appear to let you know what part of the software you will be taken to.  

The ClinicOffice v5Home Page 

 

Tip: You can return to the Home Page screen at any time by clicking the   button which permanently resides at 
the top of the screen. It is useful to get into the practice of returning to the home page frequently, in order to get used 
to the layout of the program. 

 

 

The ClinicOffice v5 Application Menu 

The application menu can be found at the top left corner of ClinicOffice and looks like this (  ). If you click this 
button a menu will pop up enabling you to access different parts of the software.   

The second column of this menu shows the recently viewed records, which is useful if you need to revisit a record of 
someone that came in an hour or so ago. 
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The ClinicOffice v5 Ribbon Bar 

In addition to the side panel, there is also a toolbar (across the top of the Home tab) this is now called the Ribbon 

Bar. If you’re familiar with using the Microsoft Office Suite, then this should be instantly recognisable. 

 

The ClinicOffice v5 Ribbon Bar 

 

We’ve already mentioned the ( ) button which returns to the home page. Additionally, you can move backwards (

) through screens that you have already visited (just like Internet Explorer). Let’s take a closer look at what all the 

buttons on our ribbon bar can do. 

First let’s look through the Home tab on the ribbon bar. This is where you will find all the main navigational controls. 

 

 

Diary 

Takes you straight to the diary page. 

Patients 

(Top Button) Takes you straight to the patient grid.  

(Lower Button) Opens a drop-down menu that stores the Consent 

Manager, Patient Contact Centre and the SMS Message Centre.  

Finances 

(Top Button) takes you to the finance centre. 

(Lower Button) Opens a dropdown menu giving you the option to go 

straight to a finance grid. 

 

Contacts 

Takes you straight to the contact grid. 

Staff Members 

Takes you to the staff grid. 

Clinical Notes  

Takes you to your clinical notes grid. 

Email Manager 

Takes you to a full featured email client.  

Reports & Templates 

Opens the Report Centre. 

 

 

Create New 

Opens a dropdown menu giving you the option to create different 

types of new records. 

Search For 

Opens a dropdown menu allowing you to search through different 

types of records. 

Recycle Bin 

Takes you straight to the deleted grid. 
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My Pins 

Opens a dropdown list of all Pinned Records. 

 

 

Messages 

(Top Button) Creates a new message. 

(Lower Button) Has the option to create a new message and to check 

for new messages. 

VOIP Calls 

Allows you to make VOIP calls, view VOIP logs and settings. 

Tasks 

Allows you to create a new task 

 

Open Support Forum 

This will take you to the main page of the ClinicOffice support forum. 

Search for help with... 

This will allow you to search on a topic in the support forum.  

 

Active Patients 

This feature allows you to track a patient’s profile. Hence newly 
created appointments, invoices or payments will be auto filled. 

 
 

Quick Search  

Is always available and allows you to search freely across different 

areas of the program. 

Now lets take a look at the View tab.  This is where you can change some of the settings. 

 

Program Settings 

Contains 4 Sections: 

Local Computer Settings: From here you change the spell checker 
and dictionary. You can also adjust the way ClinicOffice updates, 

reset the dock windows and configure your VOIP. 

Global Settings: You can set the default preferred name format, 

change the way the record codes are allocated. You can also set up 

your SMS service, Loqate accounts and enter your email account 

details, along with a handful of other options.  

Clinic Settings: Allows you to create a new clinic or edit the details 

of an existing one. 

User Settings: Here you can change the known as format of the 

newly created staff member and re-activate any messages within 

COv5 that has been turned off. 

Types and Categories 

Opens the Types and Categories Editor. 

Companies 

Takes you to the company grid. 

 

Change Password 

Let’s you change your password. 

Staff Access Groups 

Opens the Access Groups Editor. 

Staff Team Membership 

Opens the Staff Team Membership window. This will allow you to 

assign staff to different teams.  
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User Session Manager 

Enables you to check which users are actively using ClinicOffice. 

 

Visual Styles 

Let’s you change the look and feel of ClinicOffice by selecting a 

‘skins’ type. You can choose any style displayed here or if you click 

on the  button you will be able to view many more skin types. 

We will add to these as new ones become available. 

Now lets take a look at the Tools tab. You will find more advanced features and settings here. 

 

 

Form Designer 

Allows you to create, edit, delete and import/export a clinical form. 

Visual Note Manager 

Allows you to create, edit, delete and import visual notes. 

Quick Text Manager 

Allows you to create predefined notes for the clinical notes and 

general memo fields. 

Script Editor 

This allows for greater customization with the way ClinicOffice 

behaves. Requires knowledge of C# or VB.NET (Only to be used with 

our guidance). 

Raise Invoices 

Opens the Raise Invoices from Charges screen. 

Stock Manager 

Opens the Stock Manger. 

Associate Fees 

Opens the Associate Fees Manager. 

Worldpay Terminal 

This opens the Worldpay Terminal Window 

 

 

Backup / Restore 

Allows you to take a backup of your database or restore from an 

existing backup. 

Check & Repair 

This checks the database for any anomalies and repairs any it may 

find. 

Audit Trail 

Only available for the Server and Hosted editions of ClinicOffice. 

Provides an overview and search functionality on the audit history of 

the database. 

Import Data 

Allows you to import data from a CSV File (Comma Separated 

Variable format). 

Advanced DB Operation 

This will allow you to adapt the software even more to your needs 

(Only to be used with our guidance). 
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Check for Program Updates 

 If for some reason you have auto update switched off in your 

settings, you can manually check for updates here. 

 

And finally a look at the Help Tab. This is where you can get help and assistance for ClinicOffice. 

 

User Guide 

Opens this user guide in PDF format. 

Tutorial 

Opens the tutorial in PDF format. 

 

Search for Help 

Search the support forum based on a key word(s). 

 

 

Remote Support 

Downloads a small utility that allows us to connect remotely to you. If 

you already have downloaded the utility, then ClinicOffice will detect 

it and open it up. 

Support Forum 

Takes you straight to our members support forum where you can 

find answers to your questions. 

Online Help Desk 

Takes you to our online support chat. 

Email Support 

If you have not found the answers to your questions from the manual 
or the support forum the next step is to email the support team 

direct. Clicking here will allow you to do this. 

 

Pioneer Software 

Takes you straight to our website. 

License Information 

This allows you to add, upgrade or remove a license. 

About ClinicOffice v5 

Pops up with a window giving you the version number and other 

details about your ClinicOffice installation. 

 
 

At the top of the ribbon bar is the quick access toolbar  which currently has the HOME, DIARY and LOG 

OFF buttons on it. You can add any of the buttons from the ribbon bar to the quick access toolbar by simply right-

clicking on the button you would like and select Add to Quick Access Toolbar. This could enable you to add all the 

frequently used buttons to the quick access toolbar and minimise the rest of the ribbon bar by double-clicking on one 
of the tabs. This will free up space on your screen (which is important if you are using a low-resolution monitor). If 

you have done this correctly it will look something like the following below. 
 
 
 
 

Minimised Ribbon Bar  
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Now a single click on one of the tabs will pop the ribbon bar down whilst you look for a control and then it will 
disappear again once you click elsewhere on the screen. But double clicking will show the full ribbon bar as it was 

before you minimised it. 
 

 

 

The ClinicOffice v5 Quick Links Panel 

 

The ClinicOffice Side Panel (which is shown when you hover the mouse over 

the Quick Links tab on the left-hand side) is very useful in navigating around 

ClinicOffice v5. You can also keep it permanently open by clicking on the PIN 
icon (located next to the X). If you have the Quick Links pinned, you can move 

the panel around the screen and dock it another side of ClinicOffice. To reduce 

the panel back to the tab either click on the PIN icon or press the X. 

 

There are two sections on the side panel: - 

1)  Navigation 

The Navigation section allows quick access to any part of the program. (You 

can also navigate through ClinicOffice using the ( ) button at the top 

of the screen or the buttons on the Ribbon bar) 

 

2)  Common Actions 

The Common Actions section is context-sensitive, and hence the contents 
depend upon what screen you are currently looking at. For example, in the 

screen shot to the left, the user is looking at the Patient Database and so the 

common actions all relate to the patients. 

 

You can expand or collapse each of the sections by clicking the up/down arrows 

( ).  

 

The panels available on the left side are discussed at length during the part of 

the manual that relates to them (Today’s Clinic, My Messages and My Tasks)  
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The Appointment Diary 

 

The diary is probably where you will spend most of your time while using ClinicOffice, so we’ve done our best to make 

it as easy to use as possible. We’ve also made sure that the diary is tightly integrated into the rest of the program and 

that it gives you maximum flexibility in creating, editing and viewing your appointments. 

The Appointment Diary

 

Each staff member can now have a different background colour. This helps in visual recognition of each staff member. 
You can also see that the background of the diary indicates the working hours for the staff members. A brighter colour 

means they are available, whereas a more shaded colour indicates that they are not working. Once the new staff 

member is setup you can choose a colour for them. 

Over at the top right, we have the calendar. This allows us to navigate through the diary by selecting different dates. 

Multiple dates can also be selected simultaneously (Please note this can affect performance). 

Under the calendar are the different view modes for the diary, and under the view modes is the staff member selector. 

This will allow you to decide which staff diaries you want to view. We’ll now go on to look at each of these features in 

more detail. 
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Navigating the Diary 

To the top right of the diary is a calendar. The calendar can be used to select which 
dates to display in the diary. Simply click the desired day on the calendar and the 

diary will move to the selected date – simple. You can display additional months on 

the calendar by left-clicking and dragging the bottom and left-hand sides. Continue 

to drag until an additional month appears.  

 

Here are some other things you can do with the calendar: - 

Select Multiple Days 

You can select more than one day by clicking and holding the left mouse button and then dragging the mouse across 

two or more days. 

View a Different Month or Year  

Click the left or right arrows at the top of the calendar where the name of the month is, to view either last or next 

month(s) dates. You may also do the same with the year. To return to the present date just click the Today link. 

 

Changing the Day / Date 

You will notice that you can move to today by clicking on the Today link. You can 
now click the Go To which gives you the options of 1 to 6 weeks/months from now, 
allowing you to move quickly through your diary with ease. The search for free time 
is also available here by clicking Search! 

 

Diary View 

There are two different view modes that the diary can operate in, namely Staff Diary 
view and Room Diary view. These allow you to either view appointments by staff 

member, or by the room in which the appointment takes place. There is also an 

option of grouping the appointment columns by date when more than one date has 
been selected. We recommend experimenting with this feature to find which option 

suits you best. 

 

Selecting Staff Members or Rooms 

Depending upon whether you are viewing the appointment diary by Staff or by Rooms, 

you can select which staff/rooms are shown in the diary by ticking the items in the list. 

The All and None links underneath the list changes your selection as per their names. 

Also, double-clicking on a single name will select just that one name. As well as this if 

you right-click on a name, a menu will appear giving the same options. On this same 
right click menu there is an option to Invert Selection which will un-select the staff you had selected and select the 

staff you had un-selected. There is also an option to select Teams, which is explained more in the next section. 

Towards the bottom of the right click menu are 3 other useful options: Edit this Staff Member, Re-order List and 

Show Search Box. The ‘Edit this Staff Member’ will allow you to open the record for that practitioner.  

When the option ‘Re-Order List’ is selected it will open a new window that will provide you with two options: Sort staff 
alphabetically and Sort staff as shown below. By default, the first option is what the diary is sorted by. If you 

select the second option, it will give you the ability to change the order that the staff names appear in and it provides 

you with a visual aid to do it with. 

If you select the Show Search Box on the right click menu, a search field will appear just above the list of staff 
members. This search field performs searches based on letters being entered in a set order. An example is if the names 

are displayed as first name then last name, such as John Smith. To do a search for him you will have to type in “John” 

first then “Smith”. If you type in “Smith” first, the name will not be located, and the field will go red. If you have the 
name displayed as Dr John Smith, then you will enter “Dr” first then “John” and then “Smith”. To close the search field 

simply right-click on a staff member and select Show Search Box. It is the same principle with rooms as well.  

The Diary Calendar 

 

Selecting Date 

Diary View 

Selecting Staff Members 
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Diary Preset Groups 

If you have many practitioners or rooms under a clinic’s diary you 
may find that it is a laborious task swapping and changing the 
practitioners or rooms that you are currently looking at. To make 
things easier ClinicOffice has the Preset feature.  

So, if you have a group of practitioners who work on Wednesday 
you can select these and Save them under the Preset name of 
“Wednesday”. Alternatively, you can create preset groups based 
on the roles that the rooms play in the Clinic. You cannot though 
have a preset made up of both practitioners and rooms. 

 

To create a Preset group follow the steps below: 

1. Go to the Diary in the ClinicOffice  

2. Select your practitioners or rooms that share a common 
feature 

3. Right click on one of the names 

4. Click Save Preset… 
5. Enter the name of the Preset 

6. Click OK 
 

When you right click again you will notice that in the middle of the 
diary under Selection Presets is the name of your preset. When 
you select the preset your group will then be selected. This means that if you have more than one preset you can swap 
between groups quickly and easily. 

A preset group is unique to the Clinic. This means that each Clinic can have its own defined preset group. Anyone with 
enough access rights can also use the preset groups that you have created.      

There are also three default presets which are Working Staff (now), Working Staff (today) and Working Staff 
(selected date). If you select the Working Staff (now) then all staff who are scheduled to work at this time will be 
selected. If you select the Working Staff (today) then it will display all the staff who are working today, no matter what 
day you happen to be looking at. If you select Working Staff (selected date) the staff who are working on that date you 
are looking at the time will then be displayed. By selecting Auto Select Working Staff for Date, the staff you have 
selected will automatically change depending on the day you are viewing and who is working that day. 

 

 

Creating a New Appointment 

New appointments can be created in several different ways. 

To create an appointment in a diary slot, the easiest way is simply to double-click 
on the empty slot. This will bring up the Appointment Editor so that you can 

create the appointment. Note that the editor will already have filled out the time 

and date slots based on the time slot you clicked on.  

From this same screen you can select the patient that is having the appointment, 

the practitioner taking the appointment, the room it is in, the Clinic, the 
appointment type and status. In addition, you can also type in any needed 

notes. Once you have finished click the Save and Close button.  

What if you want to create an appointment which spans several slots? 

Using the left mouse button, left-click and drag until you have the desired times 

highlighted, then right-click and select New Appointment. The Appointment 

Editor will appear, and the desired times will be displayed in the Start and End 

Fields. 

For more information on the Appointment Editor please see the Appointment 

Editor section of this User Guide. 

 

 
 

The Diary right-click menu (WITHOUT an 

appointment selected) 

Right Click Menu Preset Group 
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Creating a Quick Appointment 

ClinicOffice allows you to create what we call Quick Appointments. 
When creating a Quick Appointment, you do not have to worry about 

all the details in the Appointment Editor (such as the staff member, 

room, appointment types etc.). You only need to enter the description. 

To create a quick appointment all you must do is: - 

1. Select the desired time slot(s) in the Diary 
2. Press the space bar 

3. Enter a description and click OK 

 

Quick Appointments are ideal for such things as staff meetings, bank 
holidays, staff holidays etc. 

 

 

Moving and Resizing Appointments 

Appointments can be moved simply by dragging them with the mouse. To do this: 

1. Position the mouse over the appointment you wish to move 

2. Click and hold the left mouse button 

3. Move the appointment to the desired location 
4. Release the left mouse button 

 

You will then be asked to confirm the move operation. You can turn this message off by ticking the box which says 

Don’t show me this question again, but we recommend leaving this confirmation message on because it also acts 

as a safeguard against accidentally moving appointments. 

 

Moving the mouse over the top or bottom edge of an appointment will change the mouse cursor to indicate that you 

can now resize the appointment: - 

 
Resizing an Appointment 

 

As with moving an appointment, simply click and hold the left mouse button, then move the mouse up/down to 

increase/decrease the length of an appointment. The best thing is to experiment to get the hang of it. 

 

 

Cut, Copy and Paste Appointments 

The cut, copy and paste feature allows you to either move or copy an appointment to another date and time and/or to 

another resource (e.g. another staff or room). 

To move an appointment, we can use the cut and paste facility as follows: 

1. Right-click on the appointment 

2. Click Cut Appointment 
3. Select the destination slot for appointment (i.e. the new date/time or staff/room) 

4. Right-click on the diary and then click Paste Appointment 

5. Click OK if asked to confirm the operation 
 

To copy an appointment, follow the same procedure but click Copy Appointment (rather than cut) in step 2. Copying 
an appointment is useful for creating follow-on appointments. Also, once you have copied an appointment, you can 

repeat the final 3 steps to paste to create multiple follow-on appointments. 

 

 

 

Creating a Quick Appointment 
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Block Copy Appointments 

You can make an appointment reoccur at regular intervals. This is helpful if a patient is coming in at regular intervals 

for a course of treatments. This can also be used to copy things such as lunch breaks or weekly staff meetings. 

To block copy an appointment, right click on the appointment you wish to copy and select Block Copy... The following 

window will appear: 

This Block Copy Appointment editor is broken down into the following sections: - 

Block copy appointment 

to staff 

This allows you to select which staff member the copied 

appointments are for. 

Block copy appointment 

to room(s) 

You can select which room you wish to assign the copied 

appointments to, if there is a specific room. 

Block Copy to Dates This will allow you to copy the appointment to a set 
pattern according to the options you have chosen. For 

example, you can specify that the appointment should 

take place Tuesday and Thursday each week, or on the 
1st Saturday each month. The options are quite 

comprehensive. 

Copy Options From here you can select whether you want the 

appointment status to be copied. You can also see the 

results of the copy, which will highlight any possible 

appointment conflicts. 

 

After you have selected your parameters for the block copy click OK to save complete 
the block copy. This will now create the appointments. If you ticked the option ‘Show 

the “Block Copy Results” window’ then a new panel will open on the Diary called Copy 

Results.  

If there is a clash between a copied appointment and another appointment, then the 
result will show up in the panel with red text. You can view where the clash is occurring 

by double clicking on the copied result in question and this will take you to that 

appointment on the diary. 

Block Copy Appointment Editor 
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If you are not happy with the copy results or you have made a mistake in the block copy process you can click the 
Undo Copy button. This will then remove all appointments that had been created. If you happen to close the panel 

down before you do this, then you will be unable to use the Undo Copy feature for the last copied appointments. 

 

Deleting Blocked Booked Appointments 

If you wish to delete appointments that have been blocked booked and there are too many to delete them manually 

then please follow the steps below. 

 WARNING! It is highly recommended that you back up the database before you proceed. 

 

1) Click the blue link in the diary "Switch to Grid View" (left of the Diary Options button) 

2) Click the Search button 
3) Click the Display All Records button (This is between the Search and Refresh buttons) 

4) Click Grid Options 

5) Click Toggle Grid Filtering (A new line will appear just below the column headers) 
6) Type the description of your appointment into the line just below the Description column header 

7) You can do the same on any of the other columns you may wish to filter on i.e. "Staff Name" 
8) After you have filtered out the unwanted appointments, left click on one of the appointments and press the Ctrl 

and A keys together 

9) Right click on one of the records lines and select Delete Appointment 

This will delete all of the blocked booked appointments of this type. 

 

 

Appointment Statuses 

ClinicOffice allows you to define a list of appointment statuses. 

Typically, these would include such things as Patient Arrived, Late 
Cancellation, Patient DNA (Did Not Arrive) and Completed. 

The easiest way to set the status of an appointment is to right-

click on the desired appointment, select Appointment Status 
and then click on the new status, as shown on the screen to the 

right. 

You can however edit the Appointment Status list to suit your 

own needs. 

Q. Why should I use appointment statuses? 

[1] One benefit is that whenever you update the status of an 

appointment, ClinicOffice can send a notification message to the 
appropriate Practitioner, informing them about the status 

change. 

For example, imagine that Dr Smith’s next patient telephones in 

to make a Late Cancellation. When the receptionist updates 

the appointment status, a message will appear on Dr Smith’s 
screen (along with an audible alert) informing him of this. He 

then knows that he could spend a bit longer with his current 

patient, or that he’s got a tea break coming up. 

 

[2] Another benefit is that you can assign colours to the different 
statuses. This means that from just a quick glance at the 

appointment diary, you can see how many patients DNA, how 

any were treated, how many cancelled and so on… 

As you can see, Appointment Statuses are a useful feature. For 
more information on how to configure Appointment Statuses, 

including how to send status changed messages and how to 

configure automatic patient flagging, please see the section 

“Working Types and Categories”.  

Setting the Appointment Status 
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Cancelling Appointments 

Closely allied to appointment statuses is the Cancel Appointment feature. A cancelled appointment status is basically 
like a normal appointment status but what makes it different from a normal appointment status is that it specifically 

tells ClinicOffice that an appointment has been cancelled.  

The cancelled status can be assigned to an appointment status via the View menu -> Types and Categories -> 
Appointment Statuses. It is from this screen that the Cancelled Status check box is located. By ticking this you are 

telling ClinicOffice that this appointment status is a cancellation type status. When you tick it, the status will appear 

under the Cancel Appointment section of the right click menu on an appointment in the diary.  

You can set the cancelled status up so that when assigned to an appointment the appointment disappears on the diary. 

To do this again you would go to the View menu -> Types and Categories -> Appointment Statuses. From here there 

is a check box called “Hide in Diary”, when ticked this will hide the appointment on the diary. 

An appointment that has a cancelled status is still there on the diary, it is just hidden. This means that you can book an 
appointment in its place if you wish to. You can however show a hidden cancelled appointment by clicking on the Diary 

Options on the Diary and ticking the option “Show hidden (cancelled) appointments”. The cancelled 

appointment(s) will look like the example below.  

A Cancelled Appointment 

 
 

Generally, we would recommend that you hide cancelled appointments so that your diary is clutter free. There might 
be occasions though when you would like some cancelled appointments to be hidden and others to be displayed. For 

example, you might want an appointment that has been cancelled in advance to be hidden, this way you can still book 
in appointment. However, if someone called at the last minute to cancel their appointment and the appointment is then 

hidden you might look back on the diary and wonder why that practitioner had a spare time slot and why no other 

appointment was booked. If the cancelled status such as Late Cancellation is set so that it does not hide the 
appointment, you will be able to see that the appointment was cancelled late and hence why no other appointment was 

booked. 

In brief the benefits of using the cancelled feature are: - 

• Cancelled appointments don’t clog up the diary (although you can choose to view them in the diary) 

• Cancelled appointments are stored in the database so you can see them in a patient’s appointment history 

• A cancelled status makes it easier for reporting; it is easier to distinguish the difference between an appointment 

status that is a cancelled status and a normal status 

• You can still create invoices for that cancelled appointment direct from the diary 

• If it is a mistake you can “un-cancel” an appointment easily by right-clicking on it again and simply changing the 
appointment Status 

 

 

Appointment Types 

Appointment types are used to define the form of treatment that a patient is having for a particular visit. You can assign 

an appointment type to an appointment by right clicking on the appointment in the diary and selecting the appointment 

type. Alternatively, you can assign the appointment type within the appointment itself. 

The benefits of using appointment types are listed below. 

1. It is a quick way to identify what type of appointments are being treated 
2. You can colour code the appointment making it easier to see what type of appointments are being treated 

3. You can specify a default length of time for an appointment type 
4. You can allocate a default charge amount for an appointment type 

 
When creating a new appointment if you have a default length of time specified for the appointment type, ClinicOffice 

will remind the user that the appointment should be ‘x’ number of minutes if they have created the appointment with a 

different time range. For example, if a Treatment should be 30 minutes and the appointment was created for 15 
minutes, when the user goes to save the appointment ClinicOffice will offer to change it to 30 minutes. They can 

however select 15 minutes it is meant to be 15 minutes in that instance. 
 

For more information on how to create new appointment types, assigning colour codes, default time lengths and default 

charge amounts please see the sections “Working with Types and Categories”, “The Appointment Type Editor” and 
“Creating a New Appointment Type”. 
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The Waiting List 

The Waiting List is located at the right-hand side of the Appointment Diary and it comes in the form of a tab. With the 
Waiting List you can keep a track on patients who are awaiting an appointment. 

Waiting List 

 

To add patients to the Waiting List, follow the instructions below: - 

• Right-click on the waiting list and click NEW. The following window will appear. 

Waiting List Editor 
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• In the Patient field select the patient is you wish to add to the list. 

• In the Priority field select the importance of the appointment (how soon it needs to be done). 

• Select the appointment type and duration. If you wish you can add some extra notes. 

• You can also specify the practitioner and room.  

• Now click OK 
 

You will now see the patient you have selected in the Waiting List. Once you find a free slot in the diary either by 
browsing it or doing a diary search you can then drag and drop the patient from the Waiting List into that free slot. 

If you have a long list of patients that are waiting, you can sort them according to staff member (using the Staff field). 
You can display the notes you have made by ticking Display Notes. The waiting list also gives you the option to Auto 
refresh which is handy when you have more than one user using it at a time. 

 

 

Searching the Diary for Free Time 

ClinicOffice v5 has a facility to help you automatically 

search the diary for free time slots. You may find that 

most of the time, a cursory glance at the diary is all 
that’s needed to see where there are free 

appointment slots. 
However, if your clinic is particularly busy and you’re 

finding it difficult to manually locate free time slots in 

the diary, then the Search for Free Time feature 
should be able to help.  

To access this feature, click the SEARCH button at 
the top of the diary (or under the calendar on the right 

of the screen) 
 

Search for Free Time – Search Options screen 

This is a 2-step process– the Search Options and the 

Search Results. 
Here is an explanation of the search options that you 

can specify: - 
 

Search Range 
Look up to x number of days ahead; this is where you 
choose how far in the future you would like to look. 

 

Day / Time 
Nominate which days you would like the appointment 

to be on and if necessary which time. 
Any available time – the search will look for any time 

within a day.  
Only between – Specify between two times for the 

day(s).  

 

Duration 
How long the appointment needs to be; you can either enter it manually or click Get Duration from Appt Type to 
allow the software to enter it for you.  

 

Staff / Room 
Enter the staff members or rooms that the appointment would be for. You may choose any staff member and no 

particular rooms. 
Once you have entered the desired criteria for your search, simply click the SEARCH button. 

 

 
 

 
 

Search for Free Time 
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Search for Free Time – Search Results screen 

 The screenshot to the right shows the results 
from our search. Notice that it categorises the 

results by staff members (and then by room if 

we had selected to search by room too). Clicking 
on one of the results in the list will automatically 

move the diary to the selected time slot. If you 
double-click on one of the results it will open the 

Appointment Editor with the desired information 

already entered. 
 

Q. What if there are no results? 
Then click Back to Search Options to revise 

the search options. Perhaps try searching over a 

longer period or try a different staff member 
(perhaps any staff member). Just click the 

Search button again and ClinicOffice will show 
you the revised search results. 

 
Q. I’ve found the free slot I want to use – what 
now? 
Simply create an Appointment in the usual 
fashion by either double or right-clicking on the 

time you want. Please see the topic on “The 
Appointment Editor” for more information on how 

to use this screen. 

 
 

 
 
 

 

 

Setting the Time Slot Interval 

The Time Slot Interval is the length of time in each appointment slot in the 

diary. You can change the time slot interval on any occasion.  

The easiest way to change the time intervals is by right-clicking on the 
time ruler on the left-hand side of the diary. Then simply select the chosen 

interval length. 

You may also change the time intervals from the Appointment Diary 

Options. 

 

Other Right-Click Features 

You may Zoom In and Zoom Out on the diary by right-clicking on 

the time ruler. This does not change the time interval, but it does 
stretch/shrink your view of the diary, making things either more manageable 

or easier to view.  

Using the Goto Time you can select a date to jump to. This is could be 

used instead of scrolling up and down the diary using your mouse wheel. 

When you select the Private Mode feature via this menu, it will change the 
display text on the appointments to say [Booked]. This feature can be used 

if you wish to show a patient the diary to see what available times you have 

on a day without showing them the names or details of other patients. You 

can switch off Private Mode by selecting it again from the menu.   

Time Search Results 

Setting Diary Intervals 
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View Diary as a Grid 

ClinicOffice v5 gives you the option to view the diary as a grid. This is very handy as you can see a wider range of 
appointments in a list. You can access this by clicking on the link which says Switch to Grid View; this is located in the 
top right-hand corner of the diary, next to the DIARY OPTIONS button. To change it back, click on the link Back to 
Diary View (located in the same area).  

Diary Grid View 

 

This grid works in the same manner to the other grids in ClinicOffice, with the same options available. See the section 

“Working with ClinicOffice Grids.” 

  

 

Diary Timeline 

The diary timeline sits at the bottom of your diary screen. The idea of the timeline is that it gives you a small preview of 
your calendar range, so that you can see if there are any free available time slots. 

 

 

 

If you cannot see the diary timeline, you can open it up by going into the Diary Options and ticking the box Show the 
Timeline underneath the diary. To use the timeline, you will also need your date loading mode set to Whole calendar 
range. You can do this via the Diary Options under the section Behaviour. 

As mentioned the timeline will preview the calendar range that you have selected. If you have the months of October 
and November selected on the Diary Navigator, then the timeline will preview those months. You can use the scroll bar 
to see different days. The day that you are looking at on the diary will be the day highlighted on the timeline. If you click 
on another day on the timeline, this will change the day you are looking at on the diary. White represents non-working 
hours, orange means that an appointment has already been booked and green represents that there is a free time slot.  

Diary Timeline 
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Diary Options 

The diary options are accessible by clicking on the Diary Options button which can be found at the top right of the 

diary screen. The Diary Options has two parts: General Settings and Visual Settings. 

Diary Options General Settings 

 
General Settings 

General Settings 

Time slot intervals This changes the default appointment length when viewing the diary. 

Use preferred intervals When ticked the diary’s time slot intervals will change according to the clinic’s 

Default diary interval setting (this is changed in the Clinic Settings).  

Visible time range [time] 

to [time] 

This allows you to nominate the amount of time viewable in the diary. 

Show hidden appointments When ticked appointments set with appointment status that hides them in the diary 

will be displayed instead. 
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Show appointments from 

all clinics 

This is applicable if you have more than one clinic in your database. This displays all 
the appointments that a practitioner has at other clinics as well as the clinic you are 

viewing at the present time. 

Show the Timeline 

underneath the diary 

This will display the timeline at the bottom of the diary. The timeline provides you 

with a preview of working hours and booked appointments for each day of a month. 

Show next/previous 

appointment indicators 

This toggles the buttons to the right and left side of the diary that will take you to the 

next day that has appointments booked on. 

Show an additional time 

ruler on the RIGHT side of 

the diary 

Displays the time ruler on the right-hand side of the diary in addition to the left-hand 

side. 

Use a larger font on the 

time ruler 
Increases the font size of the time ruler. 

Show the current time 

indicator 

When ticked this will display a visible line on your diary that reflects the current time 

in the day. 

Draw over the top of 

appointments 

If this is ticked along with the above option, the time indicator will appear in front of 

appointments instead of behind as it does by default. 

Use alternative colour You can select a custom colour for the time indicator to make it stand out more. You 

can also increase the line’s thickness for the same purpose. 

Behaviour 

Diary auto-refresh Here you can choose whether you would like the diary to refresh automatically* or 

manually. 

Clash check staff members 

or rooms 

When either of these options are switched on ClinicOffice will check any clashes that 
might occur when an appointment is being created or moved to an area within the 

diary. If a clash is detected, you will receive a message informing you of the conflict. 

Snap to time slots The snap to time slots toggles between making an appointment fit the time slot 
intervals and displaying the appointment to its actual length in time within the diary 

print preview. 

Show animation effects in 

the diary* 

A sliding animation is added to the diary columns when you select a different day via 

the diary navigation. 

Always do a FULL refresh 

after saving* 

If this is ticked then every time you save and close a document the diary will 

automatically refresh. 

Automatically show the 

Waiting List when an 

appointment is cancelled 

When this option is ticked if an appointment is set to a cancelled status then the 

Waiting List will automatically appear on the right hand side as a sidebar, allowing 

you to add the patient to it. 
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Visual Settings 

Header Options 

Show staff portraits (when 

available) 

This shows or hides the practitioner’s portrait which is located above the practitioner’s 

name in the diary. 

Date header format Changes the format of the date that is displayed at the top of the diary columns. An 

example of how the format will be displayed is given next to the selection field.    

When showing multiple 

dates and staff/rooms 

If you have two or more practitioners selected and you select multiple days to be 

viewed the diary by default will display the diary by staff first then display each day 
under the staff column. With this setting you can alter it so that the diary will be 

displayed by date first with each staff member appearing under each day. 

 

The maximum number of 

columns (staff/rooms) to 

be displayed 

Limits the maximum number of staff or rooms loaded and displayed on the diary. 

Background Options 

Default WORKING time 

background colour 

This will be the default background colour for a practitioner’s or room’s diary during 
their working hours. When “Use staff/room colours” is ticked, the colour that a 

staff member has assigned will be displayed instead.  

Diary Options Visual Settings 
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Default NON-WORKING 

time 

This will be the default background colour for a practitioner’s diary during non-
working hours. When “Use staff colours” is ticked, the colour that a staff member 

has assigned will be displayed instead. 

Use staff/room colours (if 

set) 

When this is ticked the colours that have been assigned to a practitioner or room will 
appear instead of the default working/non-working time colours under the Diary 

Options. 

Darken non-working time 

by 

Darkens the custom staff/room hours for the non-working hour segments of the 

diary. 

In staff view, indicate the 

room they’re working in 

(from their working hours) 

If a default room or rooms has been assigned to the practitioner, under their working 

hours, then the room name will appear on the background of the diary when this 

option is ticked. 

In staff view, use room 
colours (when the room is 

set in their working hours) 

Like the previous option if a default room or rooms has been assigned to the 
practitioner, then when this option is ticked the background colour will default to the 

room colour instead of the practitioner’s default diary colour. 

Appointment Captions 

Caption format for staff 

/room view 

This is where you choose how you want the text information on the appointment to 
appear. You can choose four different fields to show in here these are patient name 

{patient}, appointment type {type}, room {room}, clinic {clinic}, status {status}, staff 
{staff}. You can include these in any order as well as the ones we provide (e.g. 

{patient} is visiting {clinic} in {room} having a {type}). 

Show the time in 

appointments 

The option ‘auto’ will display the time. So if the appointment only fills half the time 
slot, you can then see from what exact times. You can choose between Always on 

and Never.  

Format 

 

This only applies when looking at week view and will change the viewable times on the 

appointment from Clock and Text. 

Name format used in 

captions 

Allows you to choose a different name format. This is disabled if the Use default 

name format is ticked. 

Use default Sets the patient’s name format to the default name format specified in the User 

Settings under the main Program Settings. 

Set the font used for the 

appointment captions… 

This enables you to change the font style and size that is being used within the diary. 

Show appointment notes When this is ticked, and you have data in the notes field of an appointment then the 

notes will be shown under the appointment caption. 

Indicate account balance 

with caption colouring 

When ticked the text of the appointment for the patient whose account balance is 

negative will appear in red and when the patient has a positive balance their 

appointment text will appear in green. If neither the text will appear in black. 

Indicate related alerts of 

type* 

When ticked this will display a small red-light icon on appointments that either have 

an alerted flag attached to the appointment or to the patient of the appointment. By 

default, this will display all alert types but you can select from the drop down menu to 

display either Admin/General Alert or Clinical Alert.   

Indicate related flags of 

type* 

When ticked this will display a flag icon on appointments that either have a flag 

attached to the appointment or to the patient of the appointment. The colour will 
vary depending on the colour of flag that has been assigned. If more than one flag 

type has been assigned, then these will also be displayed on the appointment. By 
default, this will display all flag types, but you can select certain flag types via the 

field box.   

Indicate whether E-Docs 

have been created* 

When ticked a small cloud paper icon appears when an E-Document has been created 

via the appointment for the patient. 

 

* This can have an impact on the performance of the diary. This will be less noticeable on a stand-alone computer 
or when running over a fast network, but if you have a slow network or if you’re running the program over a VPN, then 
turning these options off will improve performance. 
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Financial Commands 
When you right-click on an appointment you have a set of financial commands that are displayed. 

Financial Commands on Appointment Right-Click Menu 
 

 

 

Add Charge allows you to raise a charge for the patient without invoicing them. 

Quick Transaction allows you to quickly bill the patient & take payment. 

Create Invoice creates a new invoice for this appointment. 

Receive Payment takes a payment from the person associated with this appointment. 

This menu also gives us a handy link to any related invoice or payments that have already been created for this 

appointment. 

The only other item on the diary right-click menu which we have not yet mentioned is the Session Notes item. Clicking 

this allows us to create new Clinical Session Notes (or view existing notes) relating to this appointment. 

Q. What’s the benefit of using these right-click features? 

As you may have gathered, ClinicOffice has been designed so that most features are neatly linked in to the diary. For 

example, if you create an invoice from an appointment in the diary then ClinicOffice will create a link between the 
selected appointment and the invoice. Or if you create some Clinical Session Notes from an appointment, then once 

again ClinicOffice will know to link the session notes to the appointment. 

In both these cases, you could just create an invoice or session note from the Patient Editor or by going to the invoices 

section of the program and clicking New Invoice – and there’s certainly nothing wrong with that. But linking invoices or 

sessions to an appointment has two benefits: - 

 

[1] Ease of Navigation 

By right-clicking on the appointment in the future, you have an audit trail and you can follow the links to any 

invoices/session notes which were created for that appointment. 

 

[2] Automatic Field Population 

When you create an invoice or session notes from an appointment, ClinicOffice already knows who the patient is, who 
the staff member is, which room it took place in, what type of appointment it was. All of this information is then 

automatically filled in for you in the new invoice and session notes. 
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Printing the Diary 

Printing the diary is a straight forward process; all you need to do is right-click on an empty area within the diary and 

select Print Preview. The Diary Print Options will now appear. 

 

The Diary Print Options provides you with 5 print range options. 

 

 

 

Once you have selected the print range and pressed okay the diary’s Print Preview window will open:- 

Diary Print Preview 

 

 

 

Print the current 

display 

When this is selected the print range will only be 

the times that you have displayed at that exact 
time. You will notice that the Start time and End 

time fields are greyed out and the values have 

been entered in automatically. 

Morning 

appointments 

This option will print out the morning only. It will 

select the default diary Start time (governed by 

the Diary Options), but you can enter in an End 
time. This is recommended if you cannot fit the 

entire diary onto one page.  

Afternoon 

appointments 

This option will print out the afternoon only. You 
can alter the Start time, but the End time will 

default to the last time on the diary (also governed 

by the Diary Options).  

The whole day This will print off the entire day of the diary. The 

Start time and End Time will be the display times 

from the Diary Options.  

Let me choose the 

times… 

This will allow you to select the times that are to be 

displayed in the print.  
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When you are printing from the diary there are some specific options available to you. You can access these from the 

 button. Once clicked, a screen will appear that will have 3 tabs as shown below. 

 
Printer Option Format Tab 

 
 

Here you can change the start and end date/time of the diary printout, if you were not happy with your original 

range, along with the size of the text and the shading of colour you wish to have. 

 
 

Printer Options Paper Tab 

 

Here you can change the paper size and source if applicable along with margin sizes and paper orientation. 
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Printer Options Resources Tab 

 

The Resources tab allows you more control over the exact diaries you would like to print and the order that you would 
like to print them.  

 
Once you have made the necessary changes click the PRINT button for a quick print. If you wish to choose the 

printer you will print from, click OK and then press the PRINT button on the ribbon bar instead. 

 

For a detailed explanation of printing in ClinicOffice please see the section “Printing”.  
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Today’s Clinic 

At times there might be too much going on in a day to keep track of things. At such times it would be easier to summarise 
certain events within that day, so that it makes navigating ClinicOffice easier. This is where the Today’s Clinic comes in 
hand. The Today’s Clinic can be located down the left-hand side of ClinicOffice, stored as a tab. If you keep your mouse 
cursor over the tab it will open as a side panel.  

 

Today’s Clinic Side Panel 

 

Like all side panels in ClinicOffice you can pin it by pressing the PIN icon (located top right, next to the exit). The 
Today’s Clinic has different views, allowing you to see different sets of data for the day. By left clicking on the View 
field you will be presented with a drop-down menu. 

 

Today’s Clinic View Menu 

 

This is what each view does: 

Appointment by Time Categorises all appointments by the hour.  

Appointment by Status Keeps track of the appointments statuses during the day and any changes that 
occur.  



- 41 - 

Appointments by Category Categorises all appointments by their type. This only includes appointments which 
have a patient assigned to them. 

Appointments by Staff Categorises all appointments by the staff member. Like before this only includes 
appointments which have a patient assigned to them.  

Modified Records This takes note of any changes made to a patient, contact; invoice, payment; 
credit, refund; appointment, case and session record, during the day. 

Newly Created Records Keeps track of any newly created records.  

 

When you click on a record that is shown in the Today’s Clinic it will open an editor. For example, if you are looking at 
Modified records and click on a patient’s record, this will open the Patient Editor. This works the same for all Views 
apart from the Appointments. For example, if you are looking at Appointments by Staff and you click on an 
appointment, it will take you instead to its location on the diary (this is only if you are looking at the diary).    

There are additional options for the Appointment Views; these can be accessed when you right-click on an 
appointment. You are not only given the option to open the Appointment, Patient Record or Clinic Notes but you can 
also change the appointment’s status. There is also the option to print the Today’s Clinic on the right click menu.  

You also have the option to view only your records. To do this, simply tick the box which reads “Only show my records”. 
This is helpful when you have hundreds of records displayed in the Today’s Clinic and you wish to view only your 
appointments. 

Throughout the day many changes will be made to the database and hence the Today’s Clinic will need to be kept up 

to date. To do this, press the REFRESH  button (next to the View menu). Another option is to set it up to auto 
refresh by ticking the box which says Auto Refresh. Please note that the auto refresh may affect the performance of 
ClinicOffice. 

By default, the Today’s Clinic will look at records that are on today’s date, but you can change this by clicking the 

Select Date  button. A small window will appear called “Date Selector”. If you left click on the arrow inside the field, 
a calendar will appear allowing you to select the day you wish to view. 

 

Date Selector Window 

 

 

 

You can also left click on the field and enter the date manually; once selected press OK. You will now have a small 
yellow bar appearing close to the top of the Today’s Clinic informing you of the day that you are looking at. If you left 
click on the message “Click for Today”, it will take you back to today’s date.     
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Working with Editors 

Editors are used in ClinicOffice v5 to create, edit or view details for records of any type (patients, contacts, staff, invoices, 
payments, appointments etc.). All the editors share some common functionality, so it’s the purpose of this topic to cover 
the common functionality to avoid needlessly repeating ourselves. 

Each piece of information in an editor (for example “Firstname” or “Postcode” in the Patient Editor) is referred to as a 
field. ClinicOffice supports standard textboxes, memo fields; checkboxes, drop-down lists; date fields, patient/contact 
lookup fields; number and decimal fields. If the editor has a lot of fields, then it might be grouped into sections. Very 
often an editor might contain more than one page in the form of Tabs. For example, the Patient Editor has four main 
pages and four sub-groups.  

You will notice the standard minimise, maximise, and close buttons towards the top right of most editors. This allows for 
you minimise and maximise these editors when you have to. So, for example, if you are recording some information on 
a patient’s record and the telephone rings with someone wanting to book an appointment, you can minimise the patient 
editor and navigate to the diary. Later, you can bring that patient editor back up from the taskbar and continue where 
you left off from. 

ClinicOffice does contain an additional feature called Pin It! The “Pin It!” button (located towards the top right of most 
editor ribbon bars) will allow for you to temporarily bookmark an editor. Once pinned, the editor can be accessed via the 
My Pins button located on the main Home menu. The benefit of this is that if you are working on a record and perhaps 
it is the end of the day but you need to store the record so that you can pick it up for the next day, you can just Pin It! 
When you close ClinicOffice and come in the next day you can open the record from the My Pins button and continue 
to work away on it. This could also be used as a way of reducing the number of screens that you have on display. 

 

Navigating An Editor Using Keyboard Keys 

It may be useful to note the following keys which can be used to navigate between fields in the editors. These keys 

provide an alternative to using the mouse:- 

Tab Move to the next field in the editor 

Shift + Tab Move back to the previous field in the editor 

Alt Will allow you to activate one of the buttons on the current editor ribbon bar. For 

example, if you are in the Patient Editor and you press the Alt key small preview buttons 
will appear. It indicates that if you press the letter A then the menu will be presented, 

if you press R it will take you to the Record tab and if you press D it will take you to the 
design tab. From there you will be able to show the keys you can use to activate the 

other buttons. So if I press Alt and R keys and then the D and U keys, it will duplicate 

the patient record.  

 

 
The Editor Ribbon Bar 

The editors all have common functions on their ribbon bars:- 

 
The Editor Ribbon Bar 
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These buttons have the following functions: 

Record Tab 

 

Save and Close 

Saves any changes you made to the current record and then closes 
the editor. 

Cancel 

Ignores any changes made to this record and then closes the editor. 

New 

Creates a new record of this type. 

Save 

Saves any changes made (without closing the editor). 

Undo 

Undo any changes made since this record was last saved. 

Delete 

Deletes this record. 

Print 

Opens a dropdown menu allowing you to print documents relating to 
this record. Also gives you the option to print preview the details in 
this record. 

Check Spelling 

Will allow for a one-off or a constant spell check on any memo fields 
present within the Editor. You can also access the spell checker 
settings from here as well. 

 

Send a Message 

Will send a message to another user on your network with a link to 
this record. 

Tasks 

(Top Button) Creates a task linking to this record. 

(Lower Button) Opens a dropdown menu with a list of tasks for this 
record. 

Flags 

( Top) Creates a flag linking to this record. 

(Bottom) Shows a list of all current flags. 

Pin It! 

Adds this record to your list of Pinned records on the Home ribbon 
bar. 
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Design Tab 

 

 

Enter Design Mode 

This allows you to alter the layout the editor. 

Save Design 

Only available when in design mode. Saves any changes made to the 
layout of the editor. 

Edit Custom Field Lists 

Only available when in design mode. Allows you to create your own 
custom lists and values for those lists. These can then be assigned to 
a list field. 

Add Field 

Only available when in design mode. Enables you to add custom 
fields to the current editor. 

Script Editor  

This requires knowledge of C# or VB.NET to be used. With this you 
can change the way in which the editor behaves. 

 

 

The Editor Status Bar 

This is the bar which runs across the bottom of each editor. 

The Editor Status Bar 
 

 

 

In addition to providing a size grip (at the bottom right) for the editors which can be resized, the status bar also lets 
you know who created the record and the date they created it, as well as who last updated it and the date this was 

done on. 

If you have the Server or Hosted editions of ClinicOffice and the Audit Trail has been enabled then the status bar will 

also contain a blue link that says “Audit Trail”. This will allow you to see any changes made to this particular record. 

 

Application Menu and Quick Access Toolbar 

Each editor also has its own Quick Access Toolbar located towards the top left. This works in the same way as the main 

ClinicOffice Quick Access Toolbar. You can add a new button by simply 
right-clicking on an icon within the ribbon bar of the editor and choose 
to Add to Quick Access Toolbar. This allows for quick access to some 
of your main buttons. It is particularly handy when you compress the 
main ribbon bar. 

You also have the APPLICATION MENU button (example shown to 
the right) which is to the left of the Quick Access Toolbar. By clicking 

on this, two columns are displayed. The left-hand column gives you 

several different functions such as saving and closing, but also to send 
messages and create tasks. These will vary depending on what editor 

you are looking at and you will have additional options for some editors. 
The right-hand column will display all recently viewed records that are 

of a similar nature (i.e. Patient Editor Application Menu will only display 
other recently viewed patients records).   
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The Appointment Editor 

The Appointment Editor allows you to create new appointments and edit existing ones. By double-clicking on an 

appointment in the diary the program will show you the Appointment Editor. 

The Appointment Editor 

 

Appointment Editor Fields 

These are the fields featured in the appointment editor:- 

Description If the Auto Description box is ticked then ClinicOffice will automatically generate 

a description for this appointment, otherwise you can enter a brief description. 

Start Date & Time, 

Finish Date & Time 

This shows the date, start time and finish time of an appointment. If the 

appointment is an All Day appointment then the times will be disabled. 

This is an ‘All Day’ 

appointment 

Tick this box if the appointment does not occur at a specific time. All day 

appointments appear at the top of the diary directly under the day header. 

Ignore Clashes with 

other appointments 

If ticked this will ignore all clashes that may occur with other appointments. 

Patient The patient who is involved with this appointment. 

Clients Balance This is a useful feature as it will display the patient’s balance. If they are in debt it 

will appear in red and if they are in credit it will appear in green. If they are in red 
you can use this to remind a patient at the point of booking that they owe money 

for the previous times they have visited. 
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Practitioner The Staff Member who will handle this appointment. At the bottom of this pull 
down menu are two options, All Clinics and Show Deleted. If you tick the All 

Clinics this will display staff members who do not normally work at the selected 

clinic. If you tick the Show Deleted this will show all previous staff members that 

have been removed.   

Room The room the appointment is in. 

Clinic The Clinic the appointment is attached to. 

Appointment Type The “type” of appointment (see “The Appointment Type Editor” for more 

information). 

Appointment Status The status of this appointment. 

Reminder Sent Time and Date of the reminder sent to the patient for this appointment and the 

type of reminder. 

Invoice Status Displays invoice(s) that have been raised for this appointment. A right-click on this 

reveals further details.   

 

Appointment Editor - Finances 

By clicking the Quick Transaction button this will present you with the Quick Transaction screen, allowing you to create 
an invoice and payment at the same time. If you have a default charge for this type of appointment then ClinicOffice will 
automatically insert this into the screen. 

You can also raise a separate invoice by clicking the Create Invoice button. Again ClinicOffice will offer to assign the 
default charge if one exists for it. For more information on finances and raising invoice please see the main “Finances” 
section within this user guide. 

 

Appointment Editor - Recalls 

From this window you can also create a recall for the patient by clicking the Recall Patient button. This will 
immediately bring up the Patient Recall Editor screen and will fill in details such as clinic, patient; practitioner, 
appointment type and duration. You can then specify the Recall Date and fill in any needed notes. 
 
The Patient Recall auto-fills its information based on the appointment you are creating it from. What this means is if for 
example the original appointment had no appointment type then the recall appointment will not have any information 
automatically filled in for the appointment type. You can of course edit any of the auto-filled in values. 
 
Once the recall is saved it will appear within the Recalls panel and you can setup an automated rule via the Patient 
Contact Centre so that a recall message is automatically sent out once the recall date is due. For more information on 
this please see the “Patient Recall” section. 
 

Appointment Editor - Messages 

You can send an internal message via an appointment. When you click the Send Message button it will automatically 
link the patient of the appointment to the message. This is handy if you need to send a message to another staff member 
pertaining to the patient. 

 

Appointment Editor - Tasks 

The same thing happens when you create a task via an appointment; the patient is automatically allocated to that task. 
With a task you can then assign it to yourself, everyone or specific people. You can also specify the reminder and due 
dates for the task. 

 

Appointment Editor - Flags 

When you click on the Flags button to create a new flag you are given three options: “Flag this Appointment Record”, 
“Flag the Associated Patient” or “Flag BOTH this Appointment and the Associated Record”. If you select the first option 
then the flag will only appear when the appointment is opened. If you select to flag the associated patient then the flag 
will be linked with only the patient and thus will only appear when you open that patient record. If you select to flag both 
the appointment and patient then the flag will appear when you either open the patient’s record or the appointment 
record.  
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The Patient Editor 

The Patient Editor will allow you to enter, edit or view all the information about a patient. You can access the Patient 

Editor in various ways. You can double-click on the Patients name, in the patient’s grid. You can right-click on an 

appointment and select View Patient Record. You can even open their record from a name   

The Patient Editor 

 

The Patient Editor has the following pages:- 

Patient Details Important information Name etc. 

Address Full address you can use the Loqate service to automatically fill out the address! 

More Details Contains detailed patient information 

Custom Fields Customisable Fields 

Notepad To enter notes about a patient 

Appointments A list of the patients past and future appointments 

Finances The financial standing of the patients account 

Documents The document archive for this patient 

Privacy & Consent Allows consent types to be recorded and for new consent types to be added 

 

For more information on working with Editors please see the “Working with Editors” topic. 

  



- 48 - 

Patient Editor – Patient Details 

Patient Editor - Patient Record 

This page contains the patients name, address, telephone numbers etc. There is also a notes field for you to attach any 

extra notes about the patient. It is very self-explanatory; you just input the required information. The email and webpage 

will show up underlined and in blue, as these are direct links. If you would like to include a photo of the patient, then 
double-click on the portrait box. This will then open a window search box for you to locate the folder that you have 

saved the Photo in. 

Automatic Postcode Lookup 

There is also the ability of just typing in a patient post code and our Loqate lookup facility will find the address for you 

(subject to charges from Loqate). 

To use the Loqate service you will need to create an account with them. You can do this by going to the View menu -
> Program Settings -> Global Settings and click the Setup Loqate Account. From here click on the Step-by-

step Guide blue link and follow the instructions provided there. 

Once you have your account information, you can go back into the Loqate Account Setup screen, enter your Account 
Code and Loqate API Key and click the Test Loqate Setup button. This will test that your account details are setup 
correctly. If the message comes back positive, click OK and you are now ready to use the postcode lookup facility. 
 
Now imagine if a call has come through and a new patient 
would like to register. The only information we need to take 
for the address is the house number and postcode of the 
new patient. Enter the postcode into the yellow postcode 
lookup field and click on the address line that appears 
below. You will now see all the house addresses available 

for that postcode. You can select the house number or name for the patient’s address and click the Accept ( ) button 
once done. The relevant address fields below will now be filled in. You can also do a reverse search, where you would 
type in the street name, town and perform a search by that means.  
 
Q. Does Loqate work for addresses outside of the UK? 
A. Yes, Loqate covers 245 countries and territories worldwide, but the cover will vary from country to country. Please 
see Loqate’s Address Verification page for more information. 
 

https://www.loqate.com/en-gb/address-verification/
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Q. When searching in the postcode lookup field it says “An error occurred” in red text, why is this happening? 
A. The main cause for this is either your account code or API key is wrong, in which case you will need to rectify this by 
clicking the Setup link on the field. your paid subscription has ended with Loqate. 
 

Patient Editor – More Details 

Patient Editor - Patient Information Tab 

 

 

This is the page that stores the more in-depth information about each patient and it is broken down into four sections 

which are explained further below. 

Personal Information 

This area stores the patient’s date of birth and once entered their age is displayed next to the D.O.B. field. You can 
store information such as height, weight, occupation and marital status. You will note for the “Sex” field there are three 

dots just right of the drop-down menu. When you click on these three dots it will allow you to enter in additional gender 
types or edit existing ones. You can also store other record other information such as the patient’s height, weight, 

occupation and their marital status. 

Payment Information 

Under this section, you will see the patient’s current account balance. If the patient has an insurance company, you can 
enter it into this area. By doing so, the next time an invoice is raised for them, ClinicOffice will offer to allocate the 

invoice against that insurance company. Sometimes a patient might have an additional invoice recipient that is not an 

insurance company, so you could use the Invoice Recipient field instead. This will also offer to allocate the invoice 

against the linked recipient. The patient’s insurance reference can be entered under this section as well. 

Should the patient have any discount you can specify this under the Discount % field. This is the percentage discount 

for your goods and services that you offer to this patient.  

By default, the patient’s invoice due date will be the same date the invoice was created on. If the patient by default is 

permitted to pay later, i.e. 30 days later, you can alter how many days to delay the due via the Invoice Due Days 

field. 

Patient Care 

Under this section, you can tell the system who the patient’s default practitioner is within the clinic. This is only applicable 

if the patient is treated by mainly a single practitioner. The General Practitioner field is the patient’s GP. 

Other Details 

The Other Details section will allow you to record the responsible party which can be used for linking parents with their 
child’s record. You can also record how the patient was referred to you (i.e. word of mouth or Google search) and if 

they were referenced by a person link that person to the record. You can also set the patient status from here. The 
registration date will default to the date when the patient record is created, but you can manually edit this. The clinic 
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field will default to whatever clinic you have created the record under, but again you can alter this if you have more 

than one clinic. 

 

Patient Editor – Custom Fields 

You can include an extensive list of custom fields; all of these help you to include as much information about your 

patient as possible. 

Patient Editor - Custom Fields Page 

 

 

Here we have a sample custom field page, which shows that the user has included additional information that they 
would like, which isn’t already in either the patient record or the patient information. You can create fields of all types 

here. These include text, number, calendar, as well as check box fields.  

 

Patient Editor – Appointments 

Appointments History Page 
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Here we have a complete record of all Appointments that a patient has had or is going to have along with the start and 
end times, the staff member whom the appointment was with and the type of appointment it was. If you double-click 

on an appointment it will open it up inside the appointment editor. You can also view an appointment in the diary by 
right clicking on one and selecting Locate in Diary. Also, from this right click menu you have the option to “Delete” 

the appointment. 

 

Patient Editor – Finances  

Account Balance Page 

 

From here we can see the balance of the patient’s account and details of all previous transactions. If a patient queries 
how much they owe you, a quick look at this screen will tell you all you need to know. At the top of this screen we can 

see the account balance. Each line is colour coded to indicate whether it is an invoice, payment, or refund. Double-
clicking on any line will open the appropriate editor to allow you to view and/or edit the details of the financial 

transaction. 

From the Patient Editor you can also process new financial transactions by clicking on the Financial Actions button. 

This can be accessed from any part of the patient editor. The following options will be available to you. 

 

 
This creates a Quick Invoice and Payment for this patient. For more information please 

see the section “Quick Transaction”. 

 

This allows you to create an invoice for the patient. Please note that this will not be linked 
to an appointment and therefore should only really be used for invoices that are not 

specific to an appointment. 

 
This will allow you to mark a payment against the account and allocate it against any 

outstanding invoices. You can also process a physical payment from this screen. 

 
This will enable you to correct any charges made by an invoice or it will enable you to 

give a refund. 

 
Allows you to process a physical card transaction without creating a payment record within 

the finances grid. 

 

 

 



- 52 - 

The table below is displaying the options available when you right-click on the Patient Finance grid.   

 
This will open the highlighted record. 

 
This will delete the highlighted record. 

 
Print Preview the current Patient Finance grid. 

 

Export the current Patient Finance grid to one of these formats: CSV, Excel, HTML, MHT, 
RTF, PDF and Text. 

 

Patient Editor – Documents 

The document page allows you to store any files relevant to the current patient for easy access. These files are 

compressed and archived in the current database. Alternatively, you could store a shortcut to the file. 

 
Documents and Files Page 

 

 

Document Folders 

By default, documents and files will be stored in the Root Folder, however, you can create folders to help you organise 

these. There are two different types of folders: Standard folders and Personal folders. A Standard folder acts as a 
universal folder, which means that the same folder will be visible across all patients. What it does not mean is that a 

file you save to the folder will be accessible on every patient record; that file will still only be visible for that patient. A 

Personal folder is a folder that will only be visible on the patient record that you create it on.  

Like with any other folder system, you can drag and drop files or documents into any of the folders. This works whether 

you are dragging a file from the Root Folder or a file from another folder. You can also view all patient files and 

documents at once, no matter which folder they are in, by selecting the “Show All Documents”. 

 

Adding Document and Files 

To add a file to the patient’s Documents and Files, simply drag and drop the desired file from the windows explorer into 

the document area (as shown in the previous screenshot). 

When you drop the file, you are presented with a message that gives you two options, which is to copy the file to the 

database or to make a shortcut to that file. If you choose to COPY, ClinicOffice will compress the file (to save disk 
space) and save it to your database. The advantage of this is that you can access the file no matter which computer 

you are on. The downside is that it may increase the database size considerably. If you choose to create a SHORTCUT, 
then a shortcut will be created which points to the original file on your hard drive. The advantage of this is that it will 

keep your database a smaller size. The downside is that the shortcut is only relevant to the computer it has been created 
at. This means you would not be able to access that file over the network, unless it is located on a common shared 

directory.  

Another way to add a new document is to click on the  button. 
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Clicking on Add Files will open a window, which allows you to select the desired file. Alternatively, by clicking on the 

downwards arrow you can choose to merge the record with a letter and save it to the Patient’s Document area. 

 

NOTE: If you do not have the Documents module then you will only be able to add up to three documents per 
patient and contact. Purchasing the module will remove this restriction. 

 

 

 

Scanning Directly into the Documents Area 

You may also click the Acquire From button to scan a 
document from a scanner or digital camera. This feature will 

pick-up on any WIA 2.0 (Windows Image Acquisition) 
compatible devices. When you click the Acquire From 

button a menu will appear (see image to the right). 

To perform a quick scan, simply select the device you wish 
to use. This will import images from that device and you will 

have the option to compress the image size (this is 

recommended). 

If you have more than one compatible device attached then 

you will also see the additional option, “Select and 
Scan…” When you click on this, a window will appear like 

the one below. 

 

From here you can then double-click on the 

scanner you wish to use. The difference 
between this and selecting one of the 

scanners directly from the Acquire 
From… button’s drop-down menu is that 

you will be given the scanner’s options 
window. When this appears, you can select 

if you want the image scanned in colour, 

grayscale or black and white. You can also 
change the source of the scanner if it has 

more than one source.  

 

 

 

 

 

NOTE: The Acquire From feature is not available on the Hosted edition because WIA 2.0 drivers do not work by 
default over a Remote Desktop connection. 

 

Previewing Images and PDF Documents 

You may preview images and PDF documents stored in the patient’s document section by clicking the  
button. The preview window can be altered in size so that the image is displayed correctly. To do this, bring your mouse 

cursor to the edge of the window and simply drag the side across. The image will continue to expand until it has reached 

its actual size. You can zoom in by left-clicking on the image and to zoom out click the middle mouse button. Also if you 
right-click on the image, a menu appears with several options (For more information see the section “Viewing 

Scanned/Imported Images”). 

 

Acquire from Menu in the Patient’s Document Area 

Add Files Menu 
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Adding Files from Dropbox 

You can import documents from Dropbox. The steps below will demonstrate 
how to do this. 

 

1) Click on the arrow symbol on the right of the Add Files button 

2) Click the Add from Dropbox… 

3) On the next window you will be asked to login to your Dropbox 
account, enter in your details and click Sign In 

4) You will need to verify that you are not a machine by selecting the 
relevant images and clicking Verify 

The Dropbox File Selector window will now appear. 

5) From here you can navigate through your Dropbox files and locate the file you wish to attach. Select your file 
and click OK. 

 

The document will now be attached to the patient’s documents. 

 

Uploading Files to Dropbox 

You can also upload files directly to Dropbox by right-clicking on a file within the Documents area and select “Upload 
to Dropbox”. If you are already signed in, select the folder you wish to save the file to and click OK. The upload will 
commence and once finished it will confirm that the upload is complete. You can also do the same for multiple files by 
selecting several of them and performing the same actions. 

 

Editing Documents and Letters 

You can edit documents within the Patient’s Documents by right-clicking on them and selecting Open for Editing; this 
will open the file into its default program (i.e. a letter would be opened with the default word processor such as Microsoft 

Word). To save the changes made, you need to save the edited document first inside the default program. This saves 
the changes and replaces the existing document in ClinicOffice. If you are storing documents on your local hard drive 

instead of within ClinicOffice, then you can also double-click on the document to open it for editing. 

We recommend using the Documents area of ClinicOffice for storing correspondence letters and other administrative 
documents. Clinical documents (e.g. X-Ray images or postural photographs) are best stored as attachments in the 

patient’s clinical tree. It is also advisable to Copy the files to the database rather than creating them as a shortcut. 



- 55 - 

 

Q. I am trying to edit a letter I saved to the Documents area but ClinicOffice is asking me to save it as a new 
document rather than saving it to the current document? 

A. This happens when you double-click on a letter and start to edit the document. By default, a reminder message will 
appear to say that you are editing a “copy” of the selected document. If this message has not appeared it means the 
option “Don’t show me this message again” would have been ticked in the past. So, double-clicking is merely opening 
a copy of the document. If you wish to edit the document and for the changes to be saved to the same document, then 
you will need to right-click on the letter and select Open for Editing. Now when you go to save the letter it will overwrite 
the same document. 

Emailing Documents 

If you need to email any documents or files, then all you need to do is select them from the document screen, right click 
and select Send via Email. This will open a new email via your default email program and attach the document(s) to 
the email. If you have the Email Manager Module setup in ClinicOffice and it is your default email application, then 
ClinicOffice will open the new email screen; again, the document(s) will be attached. If you have Hosted edition of 
ClinicOffice then you will require the Email Manager module for this to work. If you do not have the module then you can 
always save it to your local hard drive by right-clicking on the file or document and selecting Export To. From there you 
can then select to save it to somewhere on your local C drive for example and then attach it to your email program of 
preference. 

 

Patient Editor – Duplicate Records 

There may be times when you wish to copy a patient’s details and put them into a new record. This may happen when 
you have more than one family member living at the same address but you wish to create separate records for each of 

them. To make a copy of the patient record, press the  button. You will note that your previous record will 
be saved, and the newly duplicated record will open straight away. All information stored in the Patient Details will be 
copied over. The only difference that you will note is that in front of the last name are the words “Copy of”.  

 

Patient Editor – Merging Records 

You may have more than one record for the same patient. This can cause confusion when creating a new appointment, 
invoice or payment and when searching through the Clinical reports.  

By pressing the  button you will be able to search for this matching record and then choose to merge with 
it. You can then select which record you wish to keep. The record that you decide to keep will retain their details and 
medical information. All clinical notes, documents and finances will be transferred across from the other record.  

See the section “Merging Records” for more information. 

 

Patient Editor – Assign Access 

You may have a patient whose details are 
highly confidential, and you wish to deny 
others from being able to access them. This 
setting is not to be confused with the Staff 
Member’s access rights but instead is an 
additional layer of access on top of the main 
access rights. This setting only applies to 
accessing the current patient you would be 
looking at and to the patient’s clinical notes. 
 
To assign this individual access right, click 

the  button. The window to the 
right will appear. You can specify who can 
access this patient record by selecting the 
option “Only the specified Staff 
Members/Teams have access” and then 
ticking either the individual staff or teams. 
Anyone who is not ticked will not have access 
to this patient’s record or their clinical notes.  
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NOTE: Anyone with administrator access rights will still be able to access the patient’s record and clinical notes 
regardless of this setting. 

 

 

Patient Editor – Password Protect 

Like the Assign Access option, the Password Protect is 
another way of denying others from accessing the 
patient’s record. This option is suitable for a single staff 
member for a single patient but is not suitable for a group 
of staff, although it can be used for this purpose. 

To set a password click the  button 
(located on the ribbon bar of the patient editor). The 
following window will now appear:  

 
When selecting the Type of password protection, 

you will have the two following options: 

 
 

Protect Clinical Notes This will place a password on the clinical notes only. This will mean that you 

can still access the patient’s record without needing to enter a password. 

Patient Record & Clinical Notes This will place a password on both the patient’s record and their clinical notes. 

So, when trying to access either of these, you will have to enter a password 
first. 

 

Once you have selected the type of password protection you can then enter your password and then click OK to 
confirm this. The password will now be implemented. 

 

 

Patient Editor – Assign Online Login 

This feature is only applicable if you have the 
Online Diary module. Using this you can 
manually assign a patient with their Username 
and Password for the online diary.  

To do this click the   button 
and the Patient Online Logon screen will 
appear. When you tick the “Enable online 
access” checkbox, this will allow you to 
generate the patient’s username and password 
by clicking the “Get Email” or “Generate New 
Password” blue links. 

In the lower half of the window there are two 
tabs: Send Email Notification and Send SMS 
Notification. As the titles imply you can send 
your patient their username and password from 
the respective section. A default template is 
present for both, along with the correct merge 
fields. You can however edit and customise 
either one of these messages; this includes 
adding additional merge fields via the insert 
button. Once you are happy with the 
template(s) click the relevant Send button. 

 

 

Patient Editor – Send a Message 

You can send internal messages through ClinicOffice. When you click the Send a Message button from the patient 
record there is a link attached to the message that leads back to the patient you are looking at. This can be used when 

Patient Online Logon 
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you wish to inform a staff member about a patient. For more information on messaging within the program please see 
the section “ClinicOffice Messaging”. 

 

Patient Editor – Tasks 

You can assign tasks to staff members so that they know if they have any additional duties to carry out. If you create a 
task via the patient record, this patient will be attached to the task. This means that the staff member (that the task has 
been sent to) can open the patients record via this link.   

 

Patient Editor – Flags 

Flags are very useful. Basically, they allow you to tag a patient’s record with a piece of information. Later on, you can 

then search for patients who have specific flags. Flags can also be linked to an appointment status change, i.e. when 
an appointment status changes to “patient DNA (did not arrive)” then a DNA flag can be tagged to the patient’s record. 

Please see the topic “Flagging” for more information on the use of flags. Any flag that is attached to a patient’s record 
will be displayed in this part of the Patient Editor. From this screen you can also add, delete and edit the flags for this 

patient. 

 

Patient Editor – Contact Journal 

The contact journal is designed so that you can store notes on any communication that you have had with the patient. 

So, for example you could create a new log entry for a telephone conversation you have had with a patient or information 

pertaining to an email.  

The Contact Journal tab is located to the right side of the patient editor. The journal is composed of the following: 

Show activity 
for the last 

This will allow you to select the date range of 
logs that you wish to preview on the journal. 

 

Number of lines 
to show 

This will allow you to select the numbers of note 
lines you wish to see in the preview panel for 
each log entry. 

Include SMS 
messages in 
the journal 

Will show SMS messages that have been sent 
from ClinicOffice to the patient and if enabled 
any messages received. 

If you do not have the access rights to see SMS 
messages, then even with this option ticked you 
will be unable to view SMS messages for this 
patient. 

Include emails 
in the journal 

If you have the Email Manager module and have 
this option ticked, then any emails related to the 
patient will appear here. 

This will only show emails from email folders 
that a user has access to. So what one member 
of staff can see might be different to what their 
colleague can see. 

Include Cc/Bcc 
When ticked this will display any emails where it 
contains the patient’s email addresses within 
either the Cc or Bcc field. 

Include 
archived emails 

Shows any emails that have been archived. 
Archived emails are only applicable to POP 
based email accounts. 

Search 
You can search for specific words/phrases so 
that you can locate a specific log(s) entry 
quicker. 

Preview Grid 
This is where you will see the preview of your 
log entries. 
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Adding a New Journal Log Entry 

To add a new log entry, you can click the Add Log 
button. This will open the Activity Log Editor (as 
shown to the right). Once the Activity Log Editor is 
open you can then assign what type of log the 
record is, i.e. ‘Telephone Call’ and then enter your 
notes into the notes field.  

Alternatively, if you click on the arrow symbol 
adjoining the Add Log button, you can then select 
the Log Type from the drop-down menu. The 
Activity Log Editor will then open and the Log Type 
field will already be filled in.  

You can add/change the log types via the View 
menu in ClinicOffice -> Types and Categories -> 
Journal Log Entry. From this location you can also 
change the colour of the log entries. 
 
When in the Activity Log Editor, if you right click on 
the Notes field you are presented with the following 
options: Undo, Cut; Copy, Paste; Select All, Quick 
Text; Stamp Notes [Top], Stamp Notes [Bottom] and 
Check Spelling. 
 
From this list of options, the Quick Text is very 
helpful if you have certain phrases or passages of 
text you use often. The reason is that the Quick Text 
feature allows you to insert pre-recorded text. A shortcut to open the Quick Text is by pressing the Ctrl and Space keys 
together. For more information as to how the Quick Text feature works and how you can create text templates please 
see the section “Quick Text Templates – For Clinical Notes and Memo Fields” within this User Guide. 
 
 
 

Patient Editor – Privacy & Consent 

The Privacy and Consent tab will allow for you to update a patient’s consents. From this screen you can also view the 
audit history of past consents given for the patient. 

For information on how to use this screen, please see the section “Recording Consents”.  
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The Contact Editor 

The Contact Editor lets you create/view/edit all the information about the Contact. You can access the Contact Editor 

in various ways; probably the most common is to double-click on a contact in the Contacts grid.  

Contact Editor – Contact Record 

 

For more general help on using editors in ClinicOffice, please see the topic “Working with Editors” in this manual.  

Each contact record has four pages in total:- 

• Contact Details   Contact information for the contact and any additional notes 

• Appointments   List of their past and future appointments 

• Finances    Financial standing of the contact 

• Documents    The document archive for this contact 

 

Contact Editor – Contact Details 

This tab contains the Contacts name, address, telephone numbers, email address etc. Please note that the email address 

and the Webpage are blue. This is because they are direct links. Clicking on this will either open your web browser to 

access the webpage or open your email client program with the email address inserted.  

The “Clinic” option allows you to either associate this contact to a clinic or to all clinics held within this database. The 

“contact category” allows you to label the contact; for instance, if he was a plumber or electrician, or perhaps more 

importantly an Insurance company or GP. 

 

Contact Editor – Appointments 

As with the Patient Editor, this tab shows you a list of the contact’s appointments. It’s useful to refer to this screen if a 

contact queries anything about either their past or future appointments.  
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This screen is the same as the Patient Editor. Please refer to the section “Patient Editor – Appointments” for more 

information. 

 

Contact Editor - Finances 

From this screen you can track all account transactions. You can create an invoice, receive a payment and even give 

out refunds. 

It also tells you a summary of their account balance. If a contact queries anything about their account, then a quick 

look at this screen will tell you all you need to know. 

This screen is the same as the Patient Editor. Again, please refer the section “Patient Editor – Finances” for more 

information 

 

Contact Editor – Documents 

From here you can access all documents or files that are stored within this contacts record. This screen is the same as 

the Patient Editor. Please refer to the section “Patient Editor – Documents” for more information.  

 

Contact Editor – Duplicate Records 

Like the patients you can duplicate a contact’s record. Once the  button has been clicked the original record 
is save and then a new copy will open. This will “copy of” in front of it of the last name. 

 

Contact Editor – Merging Records 

Like the patients you can have more than one record for the same contact. By pressing the  button you 
will be able to search for this matching record and then choose to merge with it. You can then select which record you 
wish to keep. The record that you decide to keep will retain their details. All documents and finances will be transferred 
across from the other record.  

See the section “Merging Records” for more information. 

 

Contact Editor – Convert to Patient 

By pressing the Convert to Patient button (located in the Contact Editor’s ribbon bar) you can turn your contact into a 
patient. Both records are the same. They both will share the same finances and documents. So, when one record has 
been invoiced the other record will display this and when one has paid the other one will have a record of this. 

Please note that once a contact has been converted into a patient you cannot reverse this. You can remove a patient 
from being a contact but not the other way around. The reason is that the patient record contains more information, such 
as the medical fields; this means that the patient record becomes the master record. 

 

Contact Editor – Send a Message 

Works identically to the patient editor’s messaging. When you click the Send a Message button from the contact record 
there is a link attached to the message that leads back to the contact you are looking at. This can be used when you 
wish to inform a staff member about a patient. For more information on ClinicOffice’s messages please see the section 
“ClinicOffice Messaging”. 

 

Contact Editor – Tasks 

Again, like the patient’s editor you can create a task via the contact’s record; this contact will be attached to the task. 
This means that the staff member (that the task has been sent to) can open the contacts record via this link. 

 

Contact Editor – Flags 

As with patients, you can flag contacts records. For more information please refer to the section “Flagging”.   
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Contact Editor – Contact Journal 

Just like the patient editor you can store any form of communication that you have had with the contact under the contact 
journal. This information is stored in the form of log entries within the Contact Journal Panel. The contact journal also 
displays linked emails (requires the Email Manager module) and SMS messages sent and received from that patient. 
For more information on this, please see the section Patient Editor – Contact Journal. 

 

Contact Editor – Privacy & Consent 

The Privacy and Consent tab will allow for you to update a contact’s consents. From this screen you can also view the 
audit history of past consents given for the patient. For information on how to use this screen, please see the section 
“Recording Consents”. 

 

 

Finances 

ClinicOffice v5 has a new way of dealing with your finances. We now have a Finance Centre for moving around the 

finances. You can locate the finance module by clicking the FINANCES button on the ribbon bar. 

 

Finance Centre Window 

 

 

As you can see there are nine sections of the finance module, these are:- 

• Finances     The finance grid (displays all invoices, payments, credit notes and refunds) 

• Invoices    The invoice grid  

• Payments    The payments grid 

• Credit Notes    The credit notes grid 

• Refunds    The refunds grid 

• Purchase Orders    The purchase order grid 

• Items & Services   The list of all of your chargeable items 

• Stock Control   The central point to monitor stock levels of items 

• Raise Invoices   This area allows you to raise an invoice from charges 
 

Notice too that you can dock this panel so that it becomes a tab at the bottom of the screen. This allows more space for 
your information. To do this simply click on the PIN icon; this is located to the top right of the Finance Centre. 

 
 
 

Quick Transaction 

What if you need to create an invoice and take a payment at the same time? To do this you will use the Quick 
Transaction. It is much quicker than creating a full invoice and then linking it up with 

a payment (2 editor windows used). The Quick Transaction instead enables you to 
create an invoice with a payment and change the appointment status (only available 

when created with an appointment) just by using a single editor. 

There are a number of ways to create a quick transaction. The best though is to right-
click on an appointment in the Appointment Diary. This is because the invoice and 

payment will then be tied to that appointment and you will see an invoice icon on that 

appointment. 

Quick Transaction via Right-Click 
Menu on Appointment  
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When you do this, the Quick Transaction editor will appear and will look similar to the image below:- 

 

Different Invoice Recipient 

If you create a Quick Transaction for a 
patient whose invoices are sent to a 
different recipient, then this message will 
appear asking if you wish to create the 
invoice for the alternative recipient or the 
patient.  

Click on the recipient you wish to send the 
invoice to. The Quick Transaction Editor 
will then generate the recipient’s name in 
the Account field. The same message 
appears also when you are creating an 
Invoice for a patient who is not the invoice 
recipient. 

Invoice Details 

To create a Quick Transaction, simply 
complete the details on the form: the 

patient, the item for which they are being 

billed, the invoice total. 

You will notice that under the Invoice 

details, ClinicOffice tells you the person’s 
account balance (in the example to the left 

it is £0.00). If they have a debt on their 
account then this will be in red and if they 

are in credit it will be green. You also have 

the option of printing the invoice after you 
have saved the invoice and changing the 

appointment status that it is linked to. If 
you wish, you can also flag the invoice 

later to say that it has been printed. 

Payment Details 

If the recipient is in credit you will be given the option to use the unallocated money against this invoice. This can be 
done ticking the check box which will mention applying the excess money (option available at the top of the Payment 

Details). 

This option is only visible if there are unallocated funds available for the patient. Otherwise, there are the standard 

three options for the quick payment:- 

[1] Do not enter a payment 

Enter no payment. This will then leave the invoice unpaid on their account. 

[2] Open the Payment Editor screen. 

This will take you to the full payment screen rather than posting a quick payment. This is useful when a patient would 

like to pay a number of invoices with this payment. You will be able to allocate this money against numerous invoices. 

Please see the topic “Entering Payments” for more details. 

[3] Enter a quick payment for this invoice as follows… 

If you are just entering a payment for the quick invoice on this screen you should choose this option. Select the payment 
method and if they are paying by cheque you might want to put the cheque number in the Reference (optional) box. 

You can also choose if you want to print a receipt for the Quick Transaction. 

After you have entered all the details for your quick invoice and/or payment, click the OK button to proceed. ClinicOffice 

will then summarise the Quick Transaction and ask for confirmation. Simply click YES to create the invoice and payment. 

  

Quick Transaction 
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The Invoice Editor 

The Invoice Editor allows you to create/view/edit invoices in ClinicOffice. You can create an invoice in many ways – by 
right-clicking an appointment in the Diary, or from the ribbon bar in the Patient Editor, or from the invoice grid under 

Finances. 

The Invoice Editor 

 

Field Name Description 
Invoice To Here we select the invoice recipient 

Invoice Number A unique number which identifies this invoice 

Date/Time This is the Date and Time that the invoice was created 

Customer Reference Any reference requested by the recipient, especially useful for insurance companies 

Patient The patient to whom this invoice relates. This may be different from the recipient – 

for example, the recipient may be an insurance company such as BUPA while the 

patient is the person who was treated. 

Invoice Status Shows the patient’s account balance 

Clinic The clinic from which the invoice is being issued 

Room You can assign a room to an invoice which is useful if you want to track revenue 

generated by different rooms at your practice 

Staff The staff member to whom this invoice is assigned 

Appointment Type This tells you what type of appointment (if any) the invoice was generated from 

Address This is the address for the recipient of the Credit Note. Clicking the Update the 

Address button will insert the recipient’s address. 
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Adding Lines to an Invoice 

Click the + Link underneath the Invoice Items list. There will now be an empty line in the invoice for you to fill in. Under 
the description column you can either select an item from the items database, or type in your own description. The 

advantage of using your predefined items is that the costs are automatically generated. 

 
Invoice Editor – Adding Lines 

 

 

It is good to note that ClinicOffice allows you to have complete control over the invoice lines; even if you choose items 
from your product database you can still override the item descriptions, unit costs and tax percentages. When adding 

an item you can select to view inactive items. Also if you use a separate item code and description you can select to 
combine these two on the drop down list by ticking the option Single Column. This will thus enable you to search on 

the description as well as the item code when typing into the drop down field. 

There is no limit to the number of lines you can add to an invoice; just keep clicking ‘+’. You can delete an invoice line 

by selecting it and then clicking ‘–’ button. 

When you have filled in all parts of the invoice and included anything necessary in the Notes field, you will see that 
there is an option to give a Discount %. As you click on the up / down arrows to increase or decrease the discount, 

you will see the Discount Amount and the Invoice Total change. 

Once you are happy with the Invoice you can save it by clicking Save and Close. 

After saving an invoice, the program will tell you that the invoice has money outstanding on it. If you would like to fill 

in a payment now click Yes and you will be taken to the payment screen. 

 

The Invoice Status 

The Invoice Status 

 

 

The invoice status (under the Patient field) indicates how much (if any) of the invoice is still outstanding. In the above 

screen, the Invoice Status is PAID IN FULL. 

When you click on the Patient Status you will see a drop down menu. 

The first menu item takes you to the Payment Editor so that you can enter a new payment against this invoice. The 

other items in the menu show you existing payments that have already been made against this invoice. Clicking on one 

of these existing payments will open the Payment Editor for the selected payment.  
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Splitting an Invoice 

Although ClinicOffice is not an accountancy package its finances are based on a double entry booking system, similar 
to many accountancy packages. This means that a financial transaction is recorded twice, once in the form of an invoice 
and once in the form of a payment. The invoice can only have one recipient who will pay it off. In effect this means that 
when an invoice is raised for a recipient it has to be paid by that recipient. An invoice cannot have two recipients. 

This can sometimes create problems when you are raising an invoice for an insurance company who is only prepared 
to pay part of the patient’s treatment. This is where the split invoice feature comes in. This works by deducting an amount 
off from the initial invoice and creating a second invoice with that amount for another recipient.  

The following example will help to explain this better and will also show you how you can use it. Insurance A is invoiced 
for £100 on behalf of the treatment performed for Patient B. Insurance A is only prepared to pay £70 of this, leaving 
£30 to be paid by Patient B. To split this Invoice of £100 you would do the following: 

 

• In the invoice click the Split Invoice button. The 

Split Invoice window will now appear. 

 

• Half way down under Split Details is the search field 
of the recipient. In this case you would search on 

Patient B. 
 

• Set the field Split this amount: to £30.00 

 

• For this example we would leave the Set the date 
to: to remain as today’s date 

 

• Under Options tick the checkbox Open the newly 

created invoice.  
 

• Click the OK button. A new invoice will open up for 

Patient B for £30.00. It will have the item 
description of Split from Invoice. 

 

• Press the Save and Close button and click No to 

creating a payment. This takes you back to the 
invoice to Insurance A. 

 

•  You will note that this invoice also has a description 
of Split Invoice to. Click the Enter Payment button.  

 

• Set the payment to £70 and fill in the other details.  
Now click Save and Close on the payment. 

 

• Press the Save and Close on the Invoice which will 

now be paid off in full.  
 

 

 

In effect what you have done is created two invoices for two different recipients. The advantage of using the Split Invoice 
is that you can track where the invoice for Patient B came from and why they are paying for it. In this case the invoice 
would indicate that it is from a split invoice from Insurance A. 

You will note that the Split Invoice window contains details such as the original invoice total, the amount already paid 
and the amount outstanding. You also have the options to split the invoice by a percentage or do a full split. There is 
also an option to use the same date of the original invoice.  

  

Split Invoice Window 
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Entering Payments 

There are many ways to access the Payment Editor. 

• It automatically pops up after creating an Invoice or a Quick Transaction 

• From the Appointment Diary right-click on the appointment and click Receive Payment 

• From the Home menu in ClinicOffice ribbon bar click New then Payment 

• From a patient or contact’s editor click Receive Payment 
 

All of these will bring you to the Payment Editor as shown below:- 

New Payment Screen 

 

The payment editor’s fields are explained below. 

Field Name Description 
Payer This is the person making the payment. 

Date / Time This is the date and time the payment was made. 

Payment Method A category choice – usually cash, cheque or credit card. These can be edited. This is 

mandatory for Payments but is irrelevant for Credits. 

At Clinic The clinic that is receiving the payment. 

Clients Balance Shows the monies either in credit or debit on the patients account. 

Payment Number The unique (automatically generated) reference number for this payment. 

Reference An optional payment reference e.g. a cheque number 

Amount The amount being paid. 

Process with Worldpay You can process card details and take a credit/debit card payment via the Worldpay 

Terminal. 
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Allocating Payments 

There are two options for allocating payments: 

• Auto Allocate  This lets ClinicOffice automatically allocate the payment. The program will  
   allocate the payment to the oldest outstanding invoice first, then any   

   subsequent unpaid invoices in date order. 

• Manual Allocation  This will then allow you to manually allocate the payment against any   

   outstanding invoices. 
 

A single payment can be allocated against multiple invoices. Notice in the example below there is numerous invoices 

outstanding for this patient:- 

 
Multiple Payment Allocation 

 

As you can see from this screen, the patient is paying £50 out of the £130 outstanding. If we use auto-allocation, 

then ClinicOffice will automatically pay off the oldest invoice, part-pay the second invoice and will leave the most 

recent invoice for £40 unpaid. 

Alternatively, you could manually allocate the payment by selecting Let me MANUALLY allocate this payment 
against outstanding invoices. Then tick or un-tick the boxes in the Pay column to select the invoices you wish to 

pay. You may also enter in the amount you wish to pay in the Allocated column. ClinicOffice will warn you if the 

amount being paid and the amount allocated does not match.  

When you have finished just click Save and Close and this will save the payment against the chosen invoices. 

Alternatively you can abandon any changes by clicking Cancel. 

It is generally best to use the auto-allocate option. Manual allocation was designed mainly to be used when receiving a 

payment from Insurance Companies, as you will most likely need to monitor precisely which invoices are being paid 
when you receive a cheque from them. Manual allocation will though allow you to edit the allocation date of the payment 

to an invoice. 
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Issuing a Credit Note 

A Credit Note is essentially the opposite of an Invoice. An Invoice is where the patient owes you money, while a Credit 
Note is where you owe the patient money. The basic purpose of a Credit Note is to affect patient's account balance 

positively (i.e. to 'credit' their account with an amount). Here are some examples when you might raise a Credit Note 

for a customer: 

 

1. As a gift voucher which can be used at a later date against an invoice 
2. A patient complains about a £30 invoice, so you only take a £20 payment from him/her and raise a Credit Note 

for remaining £10 on the invoice. 

3. A patient disputes an invoice and refuses to pay it. After a period of time, you decide to write it off as a 'bad 
debt' so you raise a Credit Note to the same value as the invoice. 

4. You need to refund a patient for some goods or a service. You first need to raise a Credit Note and then issue a 
Refund against the Credit Note. 

 

The Credit Note Editor 

 

 

Field Name Description 
Credit To Here we select the Credit Note recipient. 

Credit Number A unique number which identifies this Credit Note. 

Date/Time This is the Date and Time that the Credit Note was created. 

Clinic The clinic from which the Credit Note is being issued. 

Staff The staff member to whom the Credit Note is assigned. 
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Room You can assign a room to the Credit Note which is useful if you want to track the 

finances by different rooms at your practice. 

Status Shows the total Credit, the amount allocated and unallocated. If you right click on the 

text you can select to allocate the Credit Note to an Invoice or make a Refund. From 

this same menu you can also see the invoice(s) that it is being allocated to.    

Credit Note Items This section allows you to add/remove/edit the items that will be credited. 

Address This is the address for the recipient of the Credit Note. Clicking the Update the 

Address button will insert the recipient’s address. 

 

To create a gift voucher (or something of this nature) open the patient’s record, click the Financial button and select 
Raise Credit Note. You need to give the Credit Note a value, which you can do by adding a line to the Credit Note 
Items. This is identical to adding a line to an Invoice (see the section “Adding Lines to an Invoice”). You can then assign 
this Credit Note to an Invoice at a later date. 

 

If you have an Invoice that you wish to balance or write off, it would be best to raise the Credit Note from the Invoice. 
To do this, click the Create Credit Note button (located on the Invoice’s ribbon bar). A value will automatically be 

filled in for the Credit Note. If you are balancing an invoice you may wish to reduce the value of the Credit Note. For 

example if the invoice is for £30 and £20 has been paid off then you can reduce the amount on the Credit Note to £10. 

To do this left click on the value under the Unit Cost column. 

  

Changing Unit Cost on a Credit Note 

 

 

Once you have done this, you now need to allocate the Credit Note to the Invoice. To do this, click the Allocate To 

Invoices button (located on the Credit Note’s ribbon bar). The Credit Note to Invoice Allocation window will now 

appear. By default it will be setup to auto-allocate the Credit Note but you can choose to manually allocate it. This 
works in the same way as allocating a payment (see the section “Allocating Payments”). Once you are happy with the 

allocation click the OK button and you will be taken back to the Credit Note. You will now notice that the Credit Note’s 

status will say “Credit is Fully Allocated”. 
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Issuing a Refund 

A refund is where money is leaving the company and is going to another. There are two different scenarios when a 
refund might be issued: - 

 

1) Refund for Goods or Services (e.g. if goods are being returned or perhaps a service was unsatisfactory and a 

refund is agreed) 

2) Refund for a Pre-Payment (e.g. a patient pre-pays for 3 treatments, but only has 2 and then wants a refund for 
the third) 

 

The Refund Editor 

 

Field Name Description 
Refund To This is the person the refund is going to. 

Date/Time The date and time the refund is being given on. 

Method The method that you will be paying the refund with (i.e. Cash, Cheque, Credit Card).  

Refund Number A unique number which identifies this Refund. 

At Clinic The clinic that the refund is coming from. 

Amount The amount being refunded.  

Process with Worldpay With this button you can refund a card payment via the Worldpay card terminal so long as 

the card entered matches the card that made the original payment. 

Reason Any reasons for the refund being given. 
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1) Refund for Goods or Services 

Example: A patient has a treatment for £20 and buys an ice pack for £15. An invoice is raised for £35 and the patient 
has paid it. The ice pack splits when the patient arrives home and they want a refund. 

 

1. Go to the Patient Record, click the Finances tab and open the invoice in question (i.e. the invoice which is being 

refunded) 

2. From the Invoice Editor, click Create Credit Note 
3. A Credit Note is created which mirrors the original invoice. You now need to adjust the Credit Note so that the 

only items listed are those being returned/refunded 
4. Now click the Issue Refund button (from the Credit Note Editor) 

5. In the Refund Editor, select the Payment Method and enter the Amount being refunded 
6. Click Save and Close 

 

You can now close the Credit Note Editor and the Invoice Editor which should take you back to the Patient Editor. You'll 
notice on their Finances screen that a new Credit Note has been created and also a new Refund, which has been issued 
against the Credit Note. 

 

 

2) Refund for a Pre-Payment 

Example: a patient pre-pays for 3 appointments at £30 each (i.e. £90). He completes 2 appointments but feels there is 
no need for the third, so he requests a refund. 

 

1. Go to the Patient Record, click the Finances tab and open the Payment in question (i.e. the pre-payment which 
is being refunded) 

2. From the Payment Editor, click the Refund Payment button 

3. In the Refund Editor, select the Payment Method and enter the Amount being refunded 
4. Click Save and Close 

 

You can now close the Payment Editor which should take you back to the Patient Editor. You'll notice on their Finances 
screen that a new Refund has been created which has been applied against the pre-payment. 

 

The reason why the first scenario needed a Credit Note and the second one did not is in the first scenario, the refund 
must NOT affect the patient's account balance e.g. The patient is invoiced £20 for an item (their balance is -£20), they 
pay £20 (their balance is £0). They want a refund. A credit note is created (taking the balance to +£20) and a £20 refund 
is issued (returning their account balance to £0). 

In other words, when issuing a refund for goods or services which have already been paid for, the patient's account 
balance should not be altered at all; hence the need to raise a Credit Note and a Refund which balance each other out. 

 

In the second scenario, you are refunding a payment which has not yet been allocated against an invoice, so we DO 
want the refund to affect the account balance e.g. The patient pre-pays £90 (balance +£90), they are invoiced for £60 
(balance now +£30) then they request a refund. The £30 refund is allocated directly against the payment; hence their 
balance is now £0. 

 

The bottom line is that refunds must always be allocated either against a Credit Note (which won't affect the account 
balance) or against an unallocated Payment (which will affect the balance). 

This can be a difficult topic to get your head round, but if you simply follow the above rules then there shouldn't really 
be any problems! 
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The Charging System 

The charging system is closely linked to invoices and can be used to raise multiple charges for different appointments 
and then raised onto a single invoice. In some practices a single invoice per appointment is acceptable and hence the 
charging system is not necessary. However other practices may require that multiple appointments are covered by a 
single invoice.  

An example of where the charging system could be used is where a course of treatments would span 10 appointments. 
Each appointment date will need to be displayed to show what the invoice covers. In this situation a charge would be 
created on each appointment. Then at the end of the tenth appointment an invoice would be raised from the charges. 
Each charge will appear on that invoice as separate lines. Below will explain how this can be done.  

A charge can be raised two ways. The first is to create it via an appointment. This can be done by right clicking on an 
appointment in the diary and selecting Add Charge. 

The second option is to create the charge via a patient’s record. This can be done by opening the patient’s record, going 
to the Finances tab, clicking the blue link at the bottom of the page “Go to ‘Pending Charges’ screen”. On the Pending 
Charges screen which will open click the Add Charge button. 

With either option the following window will appear: 

 

 

The charge editor consists of the following fields: 

Field Name Description 

Account This is the account that the charge is being assigned to. 

Date/Time The date and time of when the charge has been raised. 

Clinic This is the clinic that the charge is being allocated against. 

Staff This is the staff member the charge is being allocated against. 

Patient This is the patient that the charge has been created for. This can be different to the Account. 

Quantity If the charge is for an item then you can specify the quantity of the item here. 

Item Code This is the code for either the item or service that the charge is being created for. 

Description This is the description given to the item or service. 

Unit Cost This is the cost for the item/service. 

Charge Editor 
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Net This is the quantity multiplied by the unit cost before tax. 

Tax % You can set the amount of tax percentage if tax is applicable. 

Tax This is the tax cost. 

Total This is the quantity multiplied by the unit cost and includes any tax. 

 

If you raise the charge via an appointment then the item code will automatically be filled in so long as the appointment 
has a Charge Item that has been assigned to it. Once you have created the charge in this manner it will than attach 
itself to the appointment and can be viewed in the appointment under the Pending Charges tab. 

 

 

 

The Pending Charges on the appointment is identical to the Pending Charges screen that will appear if you opened it 
via the patient’s or contact’s record. The only difference is that the appointment’s Pending Charges will only show 
charges related to that appointment rather than all charges related to the recipient’s account. 
 
On either screen you can add an additional charge by clicking the Add Charge button. Any charges which have been 
raised onto an invoice will no longer appear on this grid unless the check box “Show invoiced charges” has been 
ticked. 
 
To raise an invoice from the charges you can click the Raise Invoices button from the appointment. The following 
screen will appear.  
 

 

Pending Charges on an Appointment 

 

Raise Invoices from Charges 
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This window can also be opened via the Home tab, by clicking the drop down menu on the Finances button and 
selecting the Raise Invoices. In either case you can view all charges which are pending to be raised as an invoice.  
 
If you have opened this via an appointment or patient record the grid will by default search on only the patient’s name. 
You will see their name in the “Show charges for” field, you can however remove this. Like all search fields if you 
search on a blank value then all records will appear; in this case all charges will appear. 
 
You will note that by default the grid is grouped by “Account”, however you can choose to group the grid by “Month”, 
“Patient” or “No grouping” which removes grouping altogether. 
 

Raising Invoices from Charges 

To raise an invoice from the “Raise Invoices from Charges” screen just tick the charges you wish to add and click the 
Raise Invoice button. What will happen is that a message will appear indicating who the invoice has been raised for 
and the amount. Like the example below: 
 
 

 
If charges for more than one account have been selected then separate invoices will be raised; one invoice for each 
account. If this is the case the message above will display each invoice along with its amount and recipient. Also the 
invoice count will appear to the top right of the message. 
 
On the “Raise Invoices from Charges” screen if you have the option Print raised invoice with template ticked then 
you can select an invoice template report to merge with the newly created invoices after they have been raised. This 
will appear after you have clicked OK on the Raised Invoice message.  
 

Raise Invoices from Charges Options 

There are a number of options you can select for the Raise Invoice from Charges screen. You can view these by 
clicking on the Show Options blue link. 
 
The options are made up of two parts: the Invoice Creation Options and View Options. The Invoice Creation 
Options will effect what appears on the invoice when you raise it. The View Options will affect the grid view on the 
“Raise Invoices from Charges”. 
 

Invoice Creation Options 

Create separate invoice for 
each patient 

Invoices are usually grouped by the invoice recipient; when this option is ticked 
though a separate invoice will be raised for each patient. 

Back-date invoice to most 
recent charge. 

By default ClinicOffice will set the invoice date to today’s date. If this option is ticked, 
the date of the invoice will match that of the most recent charge it is being raised from. 

Patient Name This will add the patient’s name to the invoice’s line description. 

Staff Name This will add the practitioner’s name to the invoice’s line description. 

Appointment Details This will add the appointment date/time, appointment type and the practitioner’s name 
to the invoice’s line description. 

Patient Insurance Ref This will add the patient’s insurance reference to the invoice’s line description. 

Custom Field 1 and 2 You can specify for either one or two custom fields to be added to the invoice’s line 
description. 

View Options 

All Clinics If you have more than one clinic then when you select this you will see charges 
pertaining to all clinics. 

Only the Active Clinic This will only show charges pertaining to the current clinic you are viewing, 

Show additional notes This will show an additional line under each charge on the grid. The information that is 
displayed is the appointment date/time, appointment type and the practitioner’s name. 

Raised Invoices Message 
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The Item Editor 

As with all the other editors this screen allows you to view and/or edit the details of a product or service.  

 
The Item Editor 

 

 

Field Name Description 

Item Code The code of this Item/Product/Service as it will appear on an invoice. 

Description The full description that will appear on the invoice. 

Sale Cost The cost for one of these items/services to your customers. 

Purchase The cost to the clinic. 

Tax % Defaults to the default tax percent is for your clinic – see the Program Settings topic. 

Leave as 0% if you don’t charge tax or 17.5% for VAT for example. 

Category Allows you to categorise this item – e.g. ‘product’ or ‘service’. 

Supplier Used for products – the person/company who supplies this product to you 

Inactive Tick this if the item or service is not currently being used and you do not want to see it as 

if it was active, but you do not want to delete it as you may need it for a later occasion.  

Notes Any additional notes you wish to make about the item or service. 
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By filling in this information for every product or service, the correct information will appear in the drop down menu in 
the Invoice Editor. This will include the cost and any tax amount for the product or service. This will save you time 

looking for the cost of everything, every time you create an invoice. 

As usual, you can save this record by clicking Save and Close or cancel any changes by clicking Cancel from the 

ribbon bar on the editor. 

 

Stock Control 

If it is an item that you are creating you may wish to monitor the stock levels. At the top of the Item Editor there is a 

tab called Stock Levels. After clicking on it you may notice that the section is greyed out and unavailable. In order to 

use it you have to save the item first by pressing the SAVE button on the Item Editor’s ribbon bar; this can now be 

used. 

 

The functions of the Stock Levels section is as follows:- 

Monitor stock levels for this 

item 
Once ticked ClinicOffice will begin to monitor the stock levels for this item.  

Quantity in Stock The current quantity in stock. 

Re-Order reminder at The minimum amount you would like to keep in stock (The amount at which you would 
like to re-order Reminder). 

Quantity to re-order The quantity of the product that you would like to re-order. 

 

You can monitor the stock levels for each clinic separately. An additional clinic will be represented by an extra tab. Make 

sure that the Monitor stock levels for this item is ticked for the clinic you wish to monitor. 

Stock Levels with Multiple Clinics 

 

Once this is all set up and you have saved it, ClinicOffice will begin to detect the item’s quantity every time it is used in 

an invoice or charge. Just after saving an invoice or charge which has a monitored item included, the following message 

will appear:- 

Stock Level Adjustment Message 

 

As can be seen the message indicates the number of items deducted. You can stop this message from appearing by 

ticking the Don’t show me this message again. 
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Stock Manager 

The Stock Manager is designed to monitor and change the stock levels of all your items within the database. This means 
that if you have a large delivery that has just come in and you need to change several quantities, this can all be done 
from this editor.  

You can access the Stock Manager by either going to the Tools menu, then clicking the Stock Manager button or go 
to the Home menu, click on the Finances menu and then select Stock Control Manager. You can also access it from 
the Finance Centre.  

Stock Manager Editor 

  

To make an adjustment to the stock levels enter a value into the Adjustment column. You will notice that when you enter 
a positive value the text turns a bold green (you are increasing the stock) and a negative value produces a bold red (you 
are deducting from the stock). If the text has not changed colour press the REFRESH button. To make the desired 
alterations click the MAKE ADJUSTMENTS button; all stock levels will change accordingly.  If you wish to clear the 
values from the Adjustments column press the CLEAR button. 

If the In Stock column is smaller than the Reorder Level column then the product’s row will be highlighted in red. This 
indicates that you have to reorder new stock for that product.  

Within the Stock Manager Editor you can only edit the stock levels, but if you need to edit any further details (i.e. the 
Item Code) you can double-click on one of the products to open the Item editor.  

You may notice that a particular product is not displayed in the Stock Manager; this means it is not being monitored. 
You can display this by ticking the box which says Show non-stock items this will display all items/services; you can 
now open up the product and select to monitor it (make sure that the correct clinic is being monitored for that product). 
All non-monitored products will be displayed in grey. 

Down the left hand side are the Clinical tabs. By clicking on one of them you will see the stock and products for that 
clinic. Along the top you will see the View menu; this allows you to group the products by a group (i.e. Supplier). You 
can print the grid by pressing the PRINT button. Once you are finished press the CLOSE button. 
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Purchase Order Editor 

A purchase order is a commercial document which is issued by a buyer to the seller. It indicates the types, quantities, 
and agreed prices for products or services the seller will provide to the buyer. Sending a Purchase Order to a supplier 
constitutes a legal offer to buy products or services. Acceptance of a Purchase Order by a seller usually forms a one-
off contract between the buyer and seller, so no contract exists until the Purchase Order is accepted. A purchase order 
will very often be issued when the stock levels for an item become low. 

Purchase Order Editor 

 

Field Name Description 

Supplier This would be the seller’s contact record 

PO Number This is the unique number that identifies the Purchase Order 

Date/Time This is the date and time that the Purchase Order was created 

Reference This would be the reference between you and the seller 

Clinic This is the Clinic that the Purchase Order is being sent from 

Address This is the seller’s address 

Purchase Order Items These would be the items that you are purchasing from the seller 

Click to Mark as Delivered Marks the order as being delivered and will add the item(s) quantity to stock 

 

To create a new purchase order, click on the lower half of the Finances button, located on the Home tab and select 
Purchase Order. This will take you to the purchase order grid. Right-click anywhere on the grid and select New 
Purchase Order. Fill in your details and press Save and Close when you have finished.  
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Associate Fees 

In some clinics it is common practice to pay a practitioner either a percentage or set amount of money which is based 
on the number of treatments they perform or the items they may have sold. The Associate Fees is designed to help 
clinics calculate how much they owe their practitioners. 

You can access the Associate Fees either via the Finances button on the Home tab or via the Tools tab. 

 

 

The Associate Fees Manager screen will allow you to view the rules in different ways. How this works is that the rules 
would be grouped by two active categories. The categories that you can select between are “Rule”, “Item Service” and 
“Staff Member”.  So you could group the rules by “Staff Member” and then by “Item/Service”. This displays each staff 
member’s name that has a rule assigned to them. You can then expand each name and see which items/services are 
being assigned to them and then the rule(s) pertaining to that staff member with that item/service. You can alter these 
settings to see what best suits you. 

Before you can calculate how much you owe a practitioner you need to first of all create a rule or rules depending on 
your requirements. Below is an example of how you would create a new rule and then use the rule to calculate the 
amount you owe your practitioners. In this example we will want to pay all practitioners within the clinic 75% of the 
value of the treatments they have performed.  

 

1) Click the New button.  
 

2) On the Associate Fees Rule Editor window that appears type in the name of the rule on the Rule Name field. 
 

3) Just below the Rule Name field are two options to pay staff by based on either “a percentage” or “a fixed 
amount”. In this situation we will select “a percentage” and set this to 75%. This means that 75% of any 
item/service we select later will be assigned to the practitioners. 
 

4) You can decide whether the staff member is paid based on the invoice being raised or when you received a 
payment for the invoice by selecting either “an invoice is raised” or “payment is actually received”. In this 
example we will select “an invoice is raised”. 
 
With the invoice option you can also select to “Process credit notes as negative fees”. When ticked, this will 
factor in invoices that have been raised in conjunction with refunds and will appear as a negative figure. 
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5) Under the section “This rule applies to” select “only these selected items & services”. 
 

6) We can now selected individual items/services that this rule is applicable for. In this example we will click None 
(blue link at the bottom of screen), to unselect everything and then tick only the Treatment item. 
 

7) Just to the right of this select “only these selected staff members”. 
 

8) In this example we would select all active practitioners from the list of staff members. 

 
9) When you are finished click the OK button 

 

 
The Associate Fees Rule Editor will look something like the window below. 
 

 

If you no longer require this rule then you can click the Delete button, towards the bottom left of the screen. If you wish 
to keep the rule but do not wish to delete it then you can choose to disable it by ticking the “Disable this rule”. This 
way you can access the rule later but at least it will not be calculated. 

Once the rule(s) has been created you can then select to calculate how much you owe your practitioners based on it. 
To do this, please follow the following steps: 
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1) Click the Calculate button on the Associate Fees Manager window. 
 

2) The Associate Fees Calculator window will appear. Select the Date Range you wish to calculate. 
 

3) Click on the Calculate button. 
 
 
The associate fees will now be calculated and the results displayed in a grid format. The grid will be grouped by the 
practitioner’s name. You can expand on each staff member’s name and see the breakdown of the amount owed to 
each staff member. 
 

Associate Fees Calculator 

 
You can choose to hide the additional transaction details by un-ticking the checkbox in the bottom right hand corner 
“Show transaction details”. If you have many rules and you wish to calculate only one or a select few, you can do so 
by clicking on the Run Rules field and ticking the relevant rules you wish to run on this occasion. 
 
You can print this grid off by clicking on the Print button. When you are finished, click the Close button. 
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Processing Credit/Debit Cards 

ClinicOffice will allow you to enter and process credit or debit cards. The program integrates with three different services: 
Paymentsense Connect, Paymentsense ECOM/MOTO and Worldpay. You may have noted that on the Quick 
Transaction, Payment and Refund windows there is a “Process Payment” button. When you click on this it will open a 
terminal window for whichever service you are using.  

Before you can process card payments through ClinicOffice you will first need to sign up for either a Paymentsense or  
a Worldpay Online account. You can do this by going to the View menu, clicking on the Program Settings button, going 
to the Global Settings tab and click the blue link “Setup Payment Provider”. The screen below will now appear. 

 

Should you wish to learn more about either provider just click on the prospective links “Learn more about…”. You will 
note on this screen a fourth option called “Cardsave”. This option is only relevant for customers that have a Cardsave 
account because Cardsave was bought over by Worldpay and so new customers would apply only for a Worldpay 
Online account. 

 

Q. Which payment provider should I choose? 

A. It is dependent on how you wish to process card payments. If you require a physical card machine, then you will need 
to sign up for a Paymentsense Connect account as we can directly integrate with their card machines. If you prefer the 
ability to enter the card details directly into ClinicOffice and to even perform recurring payments, then you would be 
better off using a Worldpay Online account or Paymentsense ECOM/MOTO. Should you wish you can always have any 
of these accounts running side by side with each other. 

 

For information on setting up a Payment senses account please see the article “Setting up a Paymentsense Account”. 
To setup a Worldpay Online account please see the article “Setting up a Worldpay Online Account”. 

https://pioneersoftware.co.uk/co-paymentsense
https://pioneersoftware.co.uk/co-paymentsenseecom
https://pioneersoftware.co.uk/co-worldpay
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Setting up a Paymentsense Connect Account 

From the Select Payment Provider screen click the Go to the Paymentsense setup screen button. The window 
below will appear. 

From the Paymentsense Setup screen, click the Setup Guide button. This will take you to our website which will provide 
you with instructions on how to begin the process of setting up an account. Once you have created your account you 
will be sent the physical card machine along with its Host Address and API Key. Once you have these details go back 
to the Paymentsense Setup screen and double-click on the blue link [Dbl-Click to Edit]. You can enter those details 
into the window below. 

 
You may have noticed that you can have a 
different account for each clinic. So, you can 
have a different card machine for each clinic. 
All you need to do is enter in the Host 
Address and API Key for each clinic. If all 
clinics share the same account, you can 
simply enter your details into the “Default 
Paymentsense Account” line. You can test to 
make sure your details are correct by clicking 
on the button Test Card Machine 
Credentials (same window you would enter 
the API Key). 
 

 

Journal Logging 

A little lower down on the Paymentsense Setup window is the section Journal Logging. From this section you will be 
able to select if you do not want to log Paymentsense transactions in the patient’s journal, only log successful 
Paymentsense transactions or log all Paymentsense transactions in the patient’s journal. If you select to log the 
transactions, you can select the log type. What this will do is then create a log entry into the patient/contact’s record 
whenever a card has been processed with that log type. 

 

Card Type -> Payment Method Mapping & Transaction Currency 

From this same window, you can also select what payment method each card type should be saved as on the payment 
or refund. By default, all cards will be saved as the payment method of “Credit/Debit Card”. You can also set the 
Transaction Currency, which by default will match your computer’s local regional settings, but you can always alter 
this should you need to you. When you are happy with these settings, click the OK button. 
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END OF DAY Reporting 

When using a card terminal machine, you must perform an end of day report or end of day banking. The reason this is 
essential is that any pending settlements will be triggered, and this means information stored on the machine will be 
sent from there to the acquirer (card issuer). It will also give you a figure for the day’s taking as well, which is printed 
directly from the card machine. 

From this section of the setup screen you can specify what is termed as the end of day. You can specify what is the end 
of day i.e. 17:30. You can set it so that it reminds anyone who logs out after this end of day time or to remind the last 
person who logs out after the end of day time. You can also specify to only show the reminder for certain users. 
Alternatively, if you prefer not to be reminded you can select the option ”Don’t remind me – I’ll do it manually”.  

 

Processing a Card Using Paymentsense Connect 

You can process a card using Paymentsense in multiple areas of ClinicOffice. For example, via the Quick Transaction 
screen, Payment editor or Refund screen. The below example will walk you through processing a card payment via a 
patient’s appointment. 

 

1) Right-click on an appointment and click Quick Transaction 

2) Click the Process Payment button 

3) Check to make sure the amount is okay and click the Sale button 

4) This sends the amount through to your card terminal machine and from here the patient can use their either 
through contactless or chip and pin 

5) Once payment has been made successfully the Paymentsense Terminal will report "Successful" (like the 
example below. 

 

 

 
6) Click OK and the payment and invoice records will automatically be created 

 

Issuing a refund is the same in the sense of opening a refund screen, clicking Process Payment button but instead you 
would click the Refund button. The person will need to be present for you to be able to issue the refund to the card they 
originally paid with. 
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Setting up a Paymentsense MOTO/ECOM Account 

A MOTO or ECOM account is different to a Paymentsense Connect account in that a Connect account will connect to 
a card terminal machine but a MOTO or ECOM account do two different things which are stated below: 

1) MOTO stands for mail order, telephone order and this will allow you to process cards directly through 
ClinicOffice without the need of a card machine. The card details are entered into but not stored in the 

software. This allows for the payment to be processed but card information is not retained. Instead a token of 

the transaction from Paymentsense is recorded in the software. 

2) ECOM stands for E-Commerce and will allow for payments to be taken online. This can be used with the Online 

Diary addon so that patients can prepay for their appointments. 

 

Technically the ECOM and MOTO are two separate accounts, so you can apply for the one without the other or you 
could apply for both and use them for the different purposes. Below we will look at the steps for setting up both. 

 

MOTO Account Setup 

1) Please visit the following https://pioneersoftware.co.uk/co-paymentsenseecom and fill in the online form to sign 

up for an account 

2) Once you have been sent through your MMS and Merchant Account Details you can login to the Paymentsense 

MMS Gateway 

3) From the gateway you will need to enable the option for 3rd party applications to process payments 

4) From this same gateway, please also set a password for the 3rd party applications (this can take up to 15 

minutes before it can be used) 

5) Go to the View menu in ClinicOffice and click the Program Settings button 

6) Go to the Global Settings tab and click the “Setup Payment Provider” blue link 

7) Click the Paymentsense ECOM/MOTO Setup and for the “Default Account” double click on the link Dbl-

Click to Edit 

8) From here please enter your Merchant ID and your MOTO password and click Test MOTO to make sure that 

ClinicOffice can connect to your Paymentsense MOTO Account 

 

Q. What are the MOTO CA Credentials for? 

A. MOTO CA is a different Paymentsense account to your MOTO account. You will require this if you wish to perform 
repeat transactions based on the same card. You will need to contact Paymentsense to enable this additional account.  

 

ECOM Account Setup 

The first four steps are the same as the MOTO Account Setup. The latter steps are different for the most part. 

1) Please visit the following https://pioneersoftware.co.uk/co-paymentsenseecom and fill in the online form to sign 

up for an account 

2) Once you have been sent through your MMS and Merchant Account Details you can login to the Paymentsense 

MMS Gateway 

3) From the gateway you will need to enable the option for 3rd party applications to process payments 

4) From this same gateway, please also set a password for the 3rd party applications (this can take up to 15 
minutes before it can be used) 

5) Please now email “connect-e.support@paymentsense.com” along with your ECOM gateway username to 
request your unique ECOM JWT Key 

6) Once you have this go to the View menu in ClinicOffice and click the Program Settings button 

7) Click the Paymentsense ECOM/MOTO Setup and for the “Default Account” double click on the link Dbl-
Click to Edit 

8) Go to the ECOM Credentials tab and enter your ECOM Merchant ID, Password and your JWT Key (this is 
different from the API Key) 

9) Click the Test ECOM button to make sure that your account works 

https://pioneersoftware.co.uk/co-online-diary
https://pioneersoftware.co.uk/co-online-diary
https://pioneersoftware.co.uk/co-paymentsenseecom
https://mms.paymentsensegateway.com/Login.aspx
https://mms.paymentsensegateway.com/Login.aspx
https://pioneersoftware.co.uk/co-paymentsenseecom
https://mms.paymentsensegateway.com/Login.aspx
https://mms.paymentsensegateway.com/Login.aspx
mailto:connect-e.support@paymentsense.com
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Once the ECOM account is setup you may need to give it a further 15 minutes for the JWT Key to register and then you 
should be able to enable this within the Online Diary’s Admin Setting area. This will then allow for patients to pre-pay or 
pay a deposit towards their appointment before they come into the clinic.  

 

 

Processing a Card Using Paymentsense MOTO 

Like the other integrated payment methods in ClinicOffice, you can use the Paymentsense MOTO on any screen that 
you are recording money being taken or refunded. This includes the Quick Transaction screen, the Payment editor and 
Refund editor. The below example will look at using the MOTO Paymentsense account with the more commonly used 
Quick Transaction screen from an appointment. 

 

1) Right-click on an appointment and click Quick Transaction 

2) Click the Process Payment button 

 

A window like the one below will appear. Fields such as “Process a transaction for”, “Amount” and the address fields 
will be auto-filled in. 

 

3) Enter in the card details for the customer and click the Sale button 

4) If the card details are accepted, then a Transaction Successful message will appear, click OK 

5) You will be asked if you want to email the customer a receipt of their payments, you can either select the pre-
recorded email you have or enter a new one 

6) Once done the Quick Transaction screen will close and an invoice and payment record will be saved against 
the customer’s record 
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Issuing a refund is a similar process to the above except you will need to get into the Refund editor and from there click 
Process Payment. Once you get to this screen a similar looking terminal will appear and from there you can click the 
Refund button. For more information on how to issue refunds, please see the “Issuing a Refund” section. 

 

Q. Card is being declined, what do I do? 

A. There are two main reasons why a card is declined. The first is that the customer’s bank has blocked the card. The 
second is that the customer does not have enough funds available in their account. For both situations, the customer 
should contact their bank. There are of course numerous other reasons why the payment might have failed. To find out 
what exactly this is, you can click the “Show Terminal” link and this will present a specific message with the reason the 
payment has failed. 

 

Setting up a Worldpay Online Account 

 

From the Worldpay Setup screen, click the Worldpay Setup Guide button. This will take you to our website which will 
provide you with step by step instructions on how to set up an account. Once you have created your account you can 
enter in your Service Key and Client Key into the Worldpay Setup window. 

You may have noticed that you can have a different account for each clinic. So, you can enter in a separate Service 
Key and Client Key for each account. If all clinics share the same account, you can simply enter your details into the 
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“Default Worldpay Account” line. You can test to make sure your details are correct by double-clicking on the blue link 
[Dbl-Click to Test]. 

A little lower down on the Worldpay Setup window is the section Journal Logging. From this section you will be able 
to select if you don’t want to log Worldpay transactions in the patient’s journal, only log successful Worldpay transactions 
or log all Worldpay transactions in the patient’s journal. If you select to log the transactions, you can select the log type. 
What this will do is then create a log entry into the patient/contact’s record whenever a card has been processed with 
that log type.  

From this same window, you can also select what payment method each card type should be saved as on the payment 
or refund. By default, all cards will be saved as the payment method of “Credit/Debit Card”. You can also set the 
Transaction Currency, which by default will match your computer’s local regional settings, but you can always alter 
this should you need to you. When you are happy with these settings, click the OK button. 

 

Processing a Card Using Worldpay 

Once you have your Worldpay account setup in ClinicOffice, you can start to process card payments via the Worldpay 
Terminal screen. You can access this screen from various windows. As mentioned, a littler earlier, you access the 
Worldpay Terminal via the Finances button, the Quick Transaction screen, or the Payment screen then you will be 
allowed to accept a sale or to pre-authorise a card. If you access the Worldpay Terminal via the refund screen, then you 
will only be allowed to refund the payment. For now, we will just look at accessing the Worldpay Terminal via the 
Finances button which is on the Home menu at the top of ClinicOffice. When you access it from there, the following 
window will appear. 

 
 
From this window you can select to either process a “ONE-OFF transaction” or to link the transactions to either a patient 
or contact record. There is an option to “Re-use the card details from a previous transaction” which can be used 
when linking the transaction to a record. To use this, you will need first the persons consent to do this. If they do give 
you consent, then you can click the blue link “Consent has NOT been Given” and indicate how the person gave 
consent. Once the consent has been given and recorded, you can then use this same card for future transactions for 
this person. 
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Q. Does ClinicOffice store card details? 

A. The card details are NOT stored in ClinicOffice and are only handled by Worldpay’s secure servers which are fully 
PCI DDS compliant. This means that you as the end user do not have access to the person’s card information. In the 
situation of someone giving you the company permission to use their card for future occasions, ClinicOffice merely 
stores a token of the transaction and communicates directly with Worldpay to re-use the same card.  

 
The second half of the Worldpay Terminal window under the heading “Transaction Details” is where you enter the card 
details, along with the amount being paid. If you access this window via a quick transaction, payment, or refund, then 
the amount will automatically be filled in. On the other half of this window are the details of the person paying: such as 
their name and address. These details are again automatically filled in if you access this window via the quick 
transaction, payment or refund windows. 

Once you have entered the card details along with the person’s name you can then proceed to pre-authorise the card 
or process a sale with the card. With any of these options a message will pop up asking you to confirm the transaction 
details and it will ask you if you wish to proceed. If you click the Yes button a second message will appear confirming 
the transaction as being successful. If one or more of the details are incorrect, however, or the pre-authorisation has 
failed, then a message will appear in the Worldpay Terminal stating why it has failed, just like the image below. 

 
Decline Worldpay Message 

 

You can find out more information about why the card was declined by clicking on the small blue link in the bottom left 
hand corner named “Show Terminal”. This will open a Terminal Screen just to the right of the main window which will 
provide you with a breakdown of what failed. 

You will note that just next to the link “Terminal Screen” are three other links. The first is the “Worldpay Setup” which 
will take you to the window that stores your account details and Worldpay configuration detail. The second link is 
“Transaction Log” which will open a window, like the one below, that stores the results of past card transactions.     

 
Worldpay Log Window 

 

The last link “Worldpay MMS” will take you to the Worldpay Online Payments webpage.   
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Creating Online Payment Links 

You might be in a situation with your business where it is advantageous to send out a link to allow your patient or client 
to make a payment online. One way this can be achieved is by embedding a live payment link into either your invoice 
template or into an email. Please note the requirements below needed before you can do this. 

 

Requirements:-  

1) ClinicOffice Server Edition + Support Plan or ClinicOffice Hosted Edition 

2) A compatible payment provider with ClinicOffice  

 

So long as you meet the criteria above then you can enable the payment link by following the steps below. 

 

1) Go to the View menu and click on the Program Settings button 

2) Go to the Global Settings tab and click the “Setup Payment Provider” link 

3) Click on the “Configure Online Payments” link (bottom left of the window) 

4) Tick the payment providers you wish to make available for online payments. You can only enable Worldpay Online 

or Paymentsense ECOM if you have your account details for the relevant payment provider entered in. 

If you wish to use PayPal, please insert the email address your PayPal Business account is registered to and your 
preferred currency. 

Once this is done our live payment links will now be able to function. To insert a payment link into an invoice template, 
please follow the steps below. 

 

1) Go to the Reports and Templates section in ClinicOffice 

2) Right-click on an Invoice based layout report like the report just called “Invoice” and select Report Source 

3) Copy and paste in the text below and put it just above the text that says "from inv" then click OK 

 

,cast('' as varchar(250)) as _invpaylinkurl 

 

4) Right-click on the report and select Design Template 

5) On the left-hand side is a label field (see image below), drag and drop this onto the invoice and resize 

accordingly 

 

https://pioneersoftware.co.uk/co-payments
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6) Double-click on this label and type in your text to indicate you want to receive a payment for example, "Click 

here to pay online" 

7) While you still have this field selected, on the Properties panel to the right-hand side of the designer, click on 

the Data button 

8) Expand open the (Data Bindings) and from there expand the (Navigation) 

9) Click on the Bindings drop down and expand the "ReportData" 

10) Select the text _invpaylinkurl 
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11) When you have the payment link label selected you can change the font size, font colour, boldness and 

whether it is underline via the “Font” controls within the editor. Usually for a web link you would set the font 

colour to a deep vibrant blue and underline the text. Making the font bold can also help it to stand out further. 

 

 

 

12) Click the Save Design button 

 

This will now work as an active payment link for current invoice being displayed within the screen. This will also work 
when the report is emailed out as a PDF to the patient or client. 

 

Sending Payment Links 

1) Open an invoice or create a new invoice 

2) Click on the Send via Email button 

3) Select your invoice template 

4) Edit the text that appears in the email template to suit your needs and provide room for the payment link 

5) Click the Insert button and select InvPayLinkURL 

 

This will insert the <InvPayLinkURL> text into the document that will act as a merge field. Like the example below. 
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6) If you are happy with everything else, including the email address this is going to, click OK to send it out 
 

What happens next? 

When the patient visits the payment link either within the 
email sent or from the link within the PDF copy of the invoice, 
they will see the screen to the side appear in their web 
browser. What payment options appear will depend on what 
payment providers you are currently signed up with. The 
example here offers all 3 payment providers. 

From this screen the client can click on the preferred 
payment provider if you have more than one and enter their 
card details. Once the payment has been made successfully, 
the client will receive a message on the screen thanking 
them for the payment and an email receipt is automatically 
sent out. In addition to this a new payment record will be 
created within ClinicOffice and allocated against the invoice. 
The invoice in turn will be marked as paid. 

 

What if the patient tries to pay a second time for the 
same invoice? 

As soon as the first successful payment is made, the system 
automatically notes that the invoice has been paid for. So, 
when the same payment link is visited a second time the web 
page will merely display a message saying, “There are no 
payments to be made on this invoice.” Hence, there is little 
possibility of a patient paying twice for the same invoice.    
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Companies 

Although the Companies section is not linked to the finances in the conventional sense, it still has great relevance to it. 
A patient may work for a company that wishes to pay for their treatments. Hence you would assign this company to the 
patient’s record. When you go to raise an invoice, it will offer to assign the invoice to the company. In this sense it works 
in the same manner as assigning an insurance company or an alternative recipient. 
 

You can create a company record in two ways. The first is to open a patient record click on the Search button ( ) 
within the Company field under the address section of the patient’s record. A search window will appear, and you can 
click the New Company button. 
 
The second option is to go to the View tab, click the Companies button. This will take you to the company grid and it is 
from here you can click on the New button. Either way the following window will appear. 
 

Company Editor 

 

From this screen you will enter the name of the company and can also add any further information into the notes field. 
You can assign employees to the company by right clicking within the Employees/ Related Records field and selecting 
Add Patient(s)/Contact(s). You can then perform a search on the relevant patient/contact record and add them on. 
You can also remove an employee in a similar fashion by right clicking on their name and selecting Remove 
Patient(s)/Contact(s). 
 
On the lower left half of the screen you will note the Employee Details. These fields will be filled by the company’s 
primary contact. To assign a primary contact right-click on one of the employees under the Employees/ Related Records 
field and select Set as Primary Contact. Once you have done this the Employee Detail fields will be automatically filled 
in. 
 
Once you clicked OK the company record will be saved. You can then add this company to a patient’s record by opening 
the employee’s record and assigning it to the company field. Alternatively, this can be done by opening the Company 
record and adding the employee there (discussed earlier on). From here the company can be billed in behalf of the 
patient.  
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Working with ClinicOffice Grids 

ClinicOffice v5 uses data grids to display database records in rows and columns. These grids are very flexible and can 

be customised to suit your needs. Here’s an example of the patient grid:- 

 
Patient Database Grid 

 

 

Navigating through a Database Grid 

You can navigate through the database in a few different ways: - 

• Use the vertical and horizontal scrollbars 

• Use the mouse wheel to scroll up and down (if your mouse has one) 

• Press the up, down, left, and right keys or the Page Up, Page Down, Home and End keys 

• In-line search (see next subheading) 
 

 

In-line Searching 

To use the in-line search facility, simply select the column you wish to search on (by clicking on it) and then type in 

what you want to find. ClinicOffice v5 will try to find the record as you type. 

For example, if you are looking at the patient database grid and you click in the Lastname column, then type the letters 

“smi” (the case doesn’t matter) ClinicOffice will locate the closest match it can find – probably someone with the name 

“Smith” in this case.  
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Column Resizing 

If you wish to resize (i.e. widen or narrow) the grid columns, then move 
the mouse cursor over the boundary between two columns. You will notice 

that the mouse cursor will change as shown to the right. 

Click and hold the left mouse button and drag the column to the size you 
require. Alternatively, if you double-click at this point, then the column to 

the left will automatically be resized to fit the data. 

If you right-click on a column header, you will also notice the Best Fit and Best Fit (all columns) commands which 

can also be used to automatically adjust the column widths. 

 

Column Moving 

If you wish to change the position of the columns in the grid, simply drag 

the column header to the new location. While dragging the header, you will 

see a black outline appear which indicates where the column will be moved 

to when you release the button. 

 

 

Hiding Columns 

If you wish to hide a column, you can do so by right-clicking on a column 

header and selecting Hide this Column (see example to the right). If you 
wish to have the column redisplayed, click on the Grid Options button, 

click the blue link “Show Column Customizer” and a Customization window 

will appear with the hidden fields in it. From here you can drag and drop 

the hidden field back onto the grid with the other columns. 

 

 

 

 

 

 

Grouping Records 

The grids allow you to group records together based on common field 
values. Firstly, you need to make sure that the Group by Box is visible. 

This is a grey area which appears above the grid and says, “Drag a 
column header here to group by that column”, as shown to the right. 

To toggle the Group by Box, right-click on any column header and click 

Show Group by Box. 

Now you can simply drag and drop a column header into the Group by 

Box and ClinicOffice will automatically group all records together, based on the column that you chose. 

You can group by multiple columns, simply by dragging and dropping more column headers into the Group by Box. To 

remove the grouping, simply drag the column header out of the Group by Box and drop it back among the other column 

headers in the position of your choice. 

The best thing is to simply experiment for yourself and see how this feature can be of use. 

 

Q. What if I make a real mess of the grid and don’t know what to do?! 

A. You can always reload the default grid layout by clicking on the GRID OPTIONS button (in the top right-hand corner) 

and then selecting <Default> which is under Layouts. 

 

 

Column Sizing 

 

Moving a Column 

 

The “Group by Box” 

Hiding a Column via Right-Click Menu  
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Sorting the Grid 

 
Any column in the grid can be sorted alphabetically (or numerically) in 

ascending or descending order. To sort a column in ascending order, 

simply click the column header as shown in the example to the right. 

As you can see, a blue triangle pointing downwards appears to indicate 

that this column is now sorted into a descending order (i.e. “Z..A” or 
“9..1”). To sort the column in ascending order, simply click the column header again and the blue triangle will point 

upwards indicating an ascending order. 

The same can be achieved by right-clicking on the column header and selecting Sort Ascending or Sort Descending 

from the menu. 

You can sort on multiple columns by selecting the first sort column (as described above) and then holding the SHIFT 
key (on the keyboard) whilst clicking on another column header. This will add a secondary sort on the second column 

you have chosen. You can then add a third sort as well by clicking on a third column while still holding the SHIFT key. 

You may sort by as many column headers as you like by using this method.  

 

 

Filtering Records 

The filter facility allows you to filter the information shown in the grid. Bear in mind 

that the filter only applies to whatever data is currently being shown, so you may 
want to click on the arrow on the Search button and select Show All Records 

before using this feature. Filters can work in conjunction with searches or can be 

used as in a more permanent way when you save the grid layout (please see the 

section “Saving a Grid Layout” for more information). 

To put a filter on a column, you must first make sure that grid filtering is enabled. 
You can do this by clicking on the Grid Options button and click on the blue link 

“Toggle Grid Filtering”. Once column filtering is enabled, you’ll notice that each 

column has an empty field just underneath the column header. Start typing in the empty field and the grid will be 
filtered in ‘real time’. As you type in the first letter it will select only the records with that fist letter and so on. To the 

right is an example where the “Town/City” filter button has been clicked and ‘Co’ has been entered. 

You will note that to the left of the filter is an ABC label, which stands for “Contains”. This means what you type will 

filter on values that ‘contain’ the text or numerical value you have inserted. If you click on this label you will be presented 

with an assortment of options. By selecting a different option, it will affect how the filtering works on the grid. Each 

option and what they do is listed below. 

 

Option Purpose 

Clear Filter Clears any text or value inserted in this field’s filtering. 

= Equals Will filter on values that are an exact match to what has been inserted into the filter. 

≠ Does not equal Will filter out values that are an exact match to what has been inserted into the filter. 

ABC Contains Filters on values that contain what has been inserted into the filter. It doesn’t matter 

if the value is present at the beginning, somewhere in the middle or at the end. 

ACB Does not contain Filters out values that contain what has been inserted into the filter. It doesn’t matter 

if the value is present at the beginning, somewhere in the middle or at the end. 

A%C Is like Will filter on values that are a match to what has been inserted into the filter but unlike 

the “Equals” operation, this is not case sensitive. 

A%C Is not like Will filter out values that are a match to what has been inserted into the filter but 

unlike the “Does not equal” operation, this is not case sensitive. 

ABC Begins with Filters on values that only begins with the value inserted into the filter. 

ABC Ends with Filters on values that only ends with the value inserted into the filter. 

> Is greater than This will only work with numerical values. It filters on values that are higher than the 

one specified. 

Example of Filtering 

 

Column Sorting 
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≥ Is greater than or equal to This will only work with numerical values. It filters on values that are higher or equal 

to the one specified. 

< Is less than This will only work with numerical values. It filters on values that are lower than the 

one specified. 

≤ Is less than or equal to This will only work with numerical values. It filters on values that are lower or equal 

to the one specified. 

 

 

How to Use More Than One Filter on a Single Field/Column 

By typing into the filter area just below a column header, you will only be able to filter on a 

single value at a time for a field. One way to place additional filters is by hovering your 
mouse over a column header, clicking on the small arrow that will appear (see the example, 

to the right) and from there click “Custom”. The Custom AutoFilter window below will now 

appear. 

 

This screen will allow for you to specify two 
conditional filters for this field. On the fields to the 

left is the filter type options. These are like the ones 

mentioned in the grid above, with the addition of “Is 
Null” and “Is Not Null” which will factor in or out 

blank values on a row. On the right is where you 

would insert the criteria. 

You will note the options “AND” and “OR”. These 
are known as Boolean Operators that will change 

how your filter works with the combined criteria. If 

you select “AND” it will tell the grid to show only 
rows for this field that match the criteria specified in 

the first and second filter. If you select “OR”, then 
you are telling the grid to filter on rows that match 

either the first or second filter. Once you have set 

your criteria, click OK for it to take effect. 

If you need to specify more than two filters for a field 

then there is another way, you can right-click on a 
column header (i.e. Town/City) and select Filter Editor. 

If you do not have this option, please make sure that the 
Toggle Grid filtering is enabled first. The filter editor is a 

little more complex to use than the methods mentioned 

above, but it will offer the greatest flexibility and control. 
The filter editor will not only show a filter on a single 

field/column, but it will show all filters present on the 
current grid. The Filter Editor will also support a wider 

range of operators and will allow you to specify more 

than one. In the example to the right, the criteria are 
that the Town/City field match either Spalding or Boston 

and they must have a number in the Mobile field. 

Clicking on an operator such as the “AND” or the “OR” 

will allow you to either change the operator, add a new 

condition to the current operator or add a new group, 
which will add a new operator. You also have the option 

to remove an operator from the same menu. You can 
remove a current filter condition by clicking on the small 

close symbol. Once you are finished, click the OK button or the Apply button to preview what changes the filters make 

to the current grid display.  

 

 
 

 

Enabling More than One Filter 
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Column and Group Summaries 

At the bottom of the grid is the grid footer where summary values are displayed. There 

are also group footers which are visible when you are grouping by columns.  

Summaries allow mathematical calculations to be displayed within the grid footer or a 
group summary footer. Simply right-click on the footer immediately beneath the column 

you want to summarise, and you will see a menu like the one to the right. 

These functions are self-explanatory. The Count function is available for any column, 
but the other functions will only be available when numerical data is present within a 

column. 

To remove a summary from a footer, simply right-click on it again and click None. 

 

 

Saving a Grid Layout 

You might find that you have formatted the grid in a way that you feel it will be useful to have it for future use. Maybe 
you want to use it for printing or use it to export information. This is where the saving the grid layout comes in hand. The 
steps below will talk you through how to save a grid layout for future use and this applies to both standard grids (i.e. 
Finances grid) and grid reports. 

 

1. Assuming you are already looking at the grid, click the Grid Options button 

2. At the very bottom of the panel, under the Layouts, click the Save Layout button 
3. Enter in a name and click OK 

 

When you now visit this grid, you can select the layout from the Grid Options. Layouts are specific to each grid but will 
be visible to other users who also have access to that grid or report. 

 

Q. What is being saved when I am saving a grid layout? 

A. The following are saved within the grid layout: any filters, column positions; hidden fields, grid grouping of records; 
grid sort order and preview fields. Anything that you search on is not saved. Searches are fluid and are not intended to 
be saved. 

 

  

Footer Summary menu 
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Grid Options 

At the top right of the grid is the GRID OPTIONS button, clicking on this label 

will bring up the grid options panel on the right-hand side of the screen. 

It is from here that you will have greater control over how your grid appears and 

operates. The functionality of the grid is listed out in the table below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Data Source Some grids e.g. the patient grid (above) have more than one source, If you would like to 
view more of the data stored you can select either Additional Lookups or Next/Prev 
Appointments. Each grid has its own sources and you can add your own if you know 
SQL. 

 

Toggle Grid Filtering Clicking on this option either adds or removes the filtering fields from the grid and the 
filter menu. 

Filter Field 

 

If you type into the filter field it will find all records that match it. For example, type in 
“15/03/1987” in the filter field under D.O.B; this will find all dates of births that are born 
on 15th March 1987. 

If you hold your mouse over the top right-hand 
corner of the column header then a small arrow 
will appear. Click on this and it brings down a 
small menu. The options will vary depending on 
the column you have chosen and how many 
records contain this information. At the top of the 
menu there will always be the three choices: 
Custom, Blanks and Non-blanks. Just below 
this you have a list of values that are present 
within the grid. If you select (Blanks) for Patient 
Category, then all the records which have no 
Patient Category will be displayed and if you 
select Non-blanks the opposite happens. If you choose the (Custom) filter option, the 
window to the right will appear. 

Filter Menu 
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Custom Filter Window

 

This custom filter enables you to choose from a selection of rules and enables you to run 
two rules simultaneously. It will also detect which set of values is required and give you 
the necessary options. 

 

Show records at startup When ticked this will automatically display all records within a given Clinic or Database, 
when you go to view the grid for the first time in this session. 

Search all clinics By default, this is not ticked and so when you perform a search on the grid you will only 
see data for your currently selected clinic. When ticked, data from all clinics will be 

displayed when you perform a search. 
Use patient status 
colours 

You can assign colours to the patient’s status under the Types and Categories. When this 
option is ticked the colours for the patient’s status will be displayed. 

Hide inactive records Any patient’s which have their status set to inactive will be hidden from the grid. 

Toggle Group By Box Clicking on this option either adds or removes the grid grouping box at the top of the 
columns. 

Toggle Group Footers This inserts/removes the footer which is present at the base of each group (this is if the 
grid has been grouped). The footer is most helpful if you need to count the number of 
records present or add up a monetary value for a group. 

Show Column 
Customizer 

Clicking here brings up the column 
Customization window. This works by 
left-clicking on the field you would like on 
the grid and dragging and dropping it 
there. A very useful feature of this is the 
ability to drag and drop existing columns 
into the column Customization window 
and remove them from the grid. 

 

 

 

 

 

 

 

 

 

 

 

 

Column Chooser 
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Preview Field When a preview field is selected from the drop-down menu an additional row will 
appear below a given record that has data for your chosen field. So, for example if you 
are in the Patient Grid and you select Email, in the Preview Field on the Grid Options all 
patients  

Who have an email address will display an additional column below. This will display 
their email. 

Patient Grid with Email Preview 

 

 

You can preview any field that your grid currently contains. If you change the data source 
of the grid, then the Preview Fields will also change. You will also note that there is the 
option Max number of lines. This will allow you to choose how many lines you wish to 
be previewed under the record. This is helpful if you are previewing a memo field such 
as appointment notes, you can limit the number or increase the maximum number of lines 
that can appear. 

 

Show all records at 
startup 

When ticked this will display all records within a given Clinic or Database, when you go 
to view the grid for the first time in this session.  

 

Layouts This is where you can save any grid layout you may need. You will then be able to return 

to it for future occasions. To do this, setup the grid the way you want it and then at the 
bottom of the Grid options click SAVE. Enter a name for the layout and click OK. Your 

new layout will now appear in the list for you to select. You can click the DELETE label to 
remove the current layout if you need to. 
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Charting 

ClinicOffice v5 can produce charts based on the information within a grid; this means that they reflect the current 
data on display. As a quick example please take a look at the Finances screen; click the arrow on the Search button 

and select Show All Records then click the Charts button which can be found in the title bar above the main grid. 
 

Finance Bar (top of the Finance Grid) 
 

 
 
This will open a drop-down menu that allows you to either open an existing chart using the data available in the grid 

or to create a new one.  

 
On the finances grid there is a chart called “Transactions by Week”. If we click on this the following screen will 

appear. 
 

Transactions by Month Chart 

 
 

This shows the total value of all Invoices, Payments and Credit within the month of December. To enable the different 
features of the charting module right-click on the graph; this menu now appears:- 

 

 
 

 

Chart Designer Opens the full designer window so that you can change any of 
the variables of the chart. 

Show Legend Toggles the description of what the colours on the graph relate 
to. 

Save Chart Saves the chart so that it appears on the dropdown menu when 
you click on the CHARTS button. 

Delete Chart Deletes this chart from the dropdown menu. 

Print Chart This will print preview the chart. From there you can print it off. 

Show at Startup Opens the chart in its current position and with the current 
settings, next time you load the finance screen. 

Export Chart Allows you to export the chart (Please see Exporting Data for 
more information).   

Charting Rick-Click Menu 
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Chart Designer 

Transactions by Month – Chart Designer 

 
Chart Data 
 
Header Title This is the title you would like for your chart. This appears at the top of the chart. 

Plot this value This is the field where the first set of values will be plotted along the Y-axis. 

With an operation If the “Plot this Value” is for a numerical field, then you will need to select an additional 
operation. By default, this will be a Sum operation. So, you would sum up the total 
numerical value. You can alternatively select Avg; Min and Max operation instead of the 
Sum if this suited your purposes better. 

Against this field This is where the second set of values will be plotted along the X axis. 

Group date/time by If the “Against this field” is a date value, you will have the additional option to group the 
date either by day, week, month or year. 

Create Series for Allows you to plot a chart in series with another field. In effect this is the third value and so 
acts like the Z axis. 

 

Chart Type and Properties 
  

You have a “Chart Type” section where you can select the chart type you wish to display your data with. You may 

wish to play around with the different types and decide which is best. You can click the Recommended Settings 
button and then Apply to see how this looks. 

  
On the right-hand side there is the Chart Properties, which will allow you to delve further into the chart settings 

such as label positions or the format of the labels. Generally, this is designed for more advance users, although you 

are more than welcome to have a play around with this regardless of user experience. 
 

If you are happy with the chart you have designed and wish to save it, close down the designer window, right on the 
chart and select Save Chart. The chart will now be accessible via the Charts button on the grid you created it from. 
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Searching the Database 

ClinicOffice employs a simple but powerful search facility. There are two search modes you can use, namely a Quick 

Search and Full Search mode.  

Patients Bar (Top of Patient Grid) 

 

 

Quick Search 

The quick search facility is available from all screens as it is now located on the 

quick access toolbar at the top of the window.  

The quick search lends itself to searching quickly for a record. The way it works 
is that ClinicOffice will search the most commonly used fields for the screen you’re 

currently looking at. 

For example, on the patient database (as shown above), the quick search will 

usually search the most commonly used fields for example when searching the 

patient database (as above) it will look in the Lastname, Firstname, Patient Code, DOB and post code fields. Simply 

type what you’re looking for into the search box and then click on the magnifying glass (or press Enter).  

The quick search also changes according to the area you are looking at; for example, if you are looking at the contacts 
grid then it will change to search on contacts. Alternatively, you can choose the area to search, by left clicking on the 

icon to the far right and selecting from the drop down menu.     

 

Full Search 

The full search enables you to be more specific 

about what you’re looking for. You can enter 

search values against specific fields. Click the 
Search button (located at the top of each grid) 

to open the full search. 

Notice that you can mark some fields as your 

Favourite Search Fields ( ) while the rest will 

remain in your Other Search Fields  ( ). For 
example, in the Patient Search if you wished to 

add the field Company to your favourites, just 
right-click on it and then click Add To 

Favourites. You may move this back to the 

Other Search Fields by again right-clicking on 

the field then click Remove From Favourites.     

The only significance of assigning favourites is 
so that you can adapt the user-interface more 

specifically to the way you work. 

After entering the values that you wish to search 
for, click the OK button to start the search. Bear 

in mind that you can enter partial searches on 
text fields and the searches are not case 

sensitive (for example “sm” on “Lastname” will 

find anyone called “Smith” or “Smart” or 

Smithe”). 

The CLEAR SEARCH VALUES button will clear 
the search so that you can start again and 

clicking OK without inputting any data will show all the records. 

  

Quick Search on the Patient Database 

Full Search on the Patient Database 
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Exporting Grid Data 

Another feature of the ClinicOffice grids is the powerful export functions. To export a grid, please follow the steps below. 

1. Either click the Show All ( ) button or perform a search on the grid (see previous article) 
2. Right-click anywhere on the grid 

3. Select Export Grid 
4. Then select the format you wish to export it to i.e. Export to Excel 

5. Navigate to the folder you wish to save your file to 

6. Enter a file name and click the Save button 
 

Bear in mind that ClinicOffice v5 will export the grid data exactly as it is currently shown on screen. This means that 

only the records currently displayed will be exported, including the sort order, filters and grouping. This is the case on 
almost all grids and grid-based reports. The only things that are not exported are fields being previewed under the main 

lines or secondary grid source information on grid-based reports. 

 

 
 

Batch Updating Information 

There might be times when you need to update a value on multiple records and ideally, you would only need to do it 

once, this is where the Batch Update feature comes into play. The Batch Update feature is available on the following 
grids: - 

 

• Appointments (accessible via the Diary) 

• Patients 

• Contacts 

• Invoices 

• Items and Services 
 

The fields that you will be able to perform the batch update on will vary depending on the grid you are looking at. For 
example, the patient’s grid will let you update fields such as the patient status or postcode, whereas the invoice grid will 
allow you to update the invoice due date. Regardless of the field, the process is similar. The example below will provide 
a generalised way of performing the batch update, but it will vary slightly from the field to field. 

 

WARNING! It is very hard to reverse a batch update, so please make sure that you are updating the correct 
records before proceeding. We STRONGLY recommend that you perform a full backup of your database before 
you proceed. 

 

1. Go to one of the grids capable of batch updating i.e. the Patients grid 
2. Perform your search for the relevant records (see “Searching the Database”) 

3. Left-click on one of the records and press the Ctrl and A keys both together 
4. Right-click on one of the highlighted records 

5. Go to Batch Update and select the field you wish to update 

6. If you are sure you are updating the correct record, click Yes to the next message 
7. Enter in the new value and click OK 

8. Again, if you are certain about this batch update click Yes 
9. Type YES if you are sure you wish to proceed and click OK 

 

It may take several minutes to perform the batch update, depending on the number of records you have selected. Once 
finished ClinicOffice will tell you how many records have been successfully updated. Please click OK once finished and 
you will find that the selected records are now updated with the new value you specified.   
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Program Settings 

The Program Settings has four different sections: Computer Settings, User Settings, Clinic Settings and Database 

Settings. To access these go to the View menu (located above the ribbon bar) and press the Program Settings 

button, the following window appears:- 

 

Local Computer Settings 

The Local Computer Settings area is for settings directly pertaining to the machine you are running ClinicOffice from. 
This means that these settings can vary depending on which computer you are using ClinicOffice on. Each setting is 
explained below. 

 

Spell Checker From here you can alter the spell checker settings and add new dictionaries for different 
languages. For more information on this please see the section “Spell Checker”. 

Auto Update Settings By default ClinicOffice is set to auto check for updates every 7 days. From here you can 
change how often it auto checks for update. Alternatively you can stop ClinicOffice auto 
checking completely. 

Other Settings for this Computer 

Reset Dock Panel 
Positions 

If you have altered the positions of the dock panels and wish for them to return to their 
default layout press the Reset Dock Panels (resets the side panel positions). You will 
have to close ClinicOffice and reopen it for this to take effect. ClinicOffice asks for your 
confirmation on quitting the program abruptly, you can choose to un-tick this reminder from 
here. 

Configure VOIP 
Settings 

You can configure or setup ClinicOffice with a VOIP service by clicking on Configure VOIP 
Settings. You can select to use either Birchills VOIP or Skype. 
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Ask for Confirmation 
before Closing 
ClinicOffice 

The option Always ask for confirmation before exiting ClinicOffice when ticked will 
mean that when you try to close ClincOffice a message will appear asking if you are sure 
you want to close it. This is helpful if you have a habit of closing ClinicOffice rather than 
minimizing it. 

Use Internal PDF 
Viewer for viewing 
PDF documents 

If this option is ticked, when you go to open a PDF document from within ClinicOffice it will 
open the file using internally using its own PDF Viewer. If unticked then when you go to open 
a PDF document within ClinicOffice it will use the default PDF viewer you have installed on 
your computer instead. 

How should 
ClinicOffice handle 
email links? 

There are three options you can select from for this: “Use MAPI”, “Use MAILTO” and “Use 
ClinicOffice”. If you have an email program outside of ClinicOffice and it uses the MAPI 
protocol, then select “Use MAPI”. If you have an email program that uses MAILTO instead, 
then select “Use MAILTO”. If you are not too sure if your email program uses MAPI or 
MAILTO just try either option and see which one works. If neither of them works then you 
need to make sure your email program is set as default for one of those protocols. If you are 
only using ClinicOffice to send out emails then select “Use ClinicOffice”. 

 

 

 

Global Settings 

The Global Settings are settings that apply across the entire database you are currently logged into. This means changes 

made here will apply to all machines and user accounts. An explanation of what each setting does is listed below.  
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Backup 

By default, ClinicOffice will remind the user to back up every 3 days if no backup has been made since. From here 
you can choose to change how often you are reminded and even turn off the backup reminders. If you have the 
Server Edition of the ClinicOffice then the backup will have to be performed on the server machine. If you have the 
Hosted Edition, then this option will not take effect as the backups are automatically handled for you.  

Patient/Contact Details 

Allocating Patient 
Codes 

By default, when you create a new Patient, ClinicOffice will prompt you to assign a code. From 

here you can change this so that patient codes are auto allocated. The other option is to set 

it up so that ClinicOffice will not prompt you or try to auto allocate a code.  

You can also choose whether you want to allocate unique codes to the Patient records. The 
difference between the two options is that Allocate Unique numbers per Clinic will allow the 
same code number for a patient/financial record on the database, so long as it is assigned to 
another clinic. For example, if you have Clinic A and Clinic B both clinics may have a patient 
with the code of 100. Allocate globally unique number will not allow this and hence every 
code no matter what clinic, will be unique. This option combines the code for all clinics. 
Normally the Allocate unique number per Clinic is fine and that is why it is the default 
setting. 

Default Status for 
New Patients 

Another option is set the patient with a default status. This is helpful when you are creating 

a new record and wish to assign the patient as ‘Active’ by default. 

Default Name 
Format 

Whenever you are entering a name for a new staff member, the Known As field (inside the 

Staff Member Editor) will also generate a name. This name will be displayed in areas such as 
the Diary Navigator and drop-down menus. It is here that you can change the way in which 

the name is generated in the Known As field. When you change the Default Name Format, 

it will only affect newly created staff members after that point in time. 

Setup Address 
Format 

You can do a similar thing with the way that the address format appears on letters. You can 

edit the layout via the blue Setup Address Format link. 

Financial Defaults 

Allocating Financial 
Codes 

Just as you can choose to allocate unique codes either per clinic or globally to each patient 
you can also have the same options for the finances. Please see the “Patient Defaults” for an 
explanation of the difference. 

Invoices are due 
NET 

ClinicOffice will allow you to specify when an invoice is due to be paid. By default, the Invoices 
are due NET is set to 0 days. 

Default Tax Percent If your clinic charges include tax, then you can specify a Default Tax Percent from here. 
When you do set a default amount any items that you create will have this percentage auto 
allocated against the new items. 

Other Global Settings 

Allow editing of 
Clinical Notes 

By default, users of ClinicOffice can edit Clinical Notes freely and this includes past notes as 
well. For legality reason this may not be acceptable for certain professions. By un-ticking the 
option Allowing editing of Clinical Notes this will prevent any user from editing past notes, 
but they can continue to enter new notes. The notes will be automatically time stamped. 

Allow multiple 
logons for the same 
user 

ClinicOffice by default will allow for the same user to login multiple times from different 
locations. This option is controlled by the Allow multiple logons for the same user setting. 
When un-ticked a single user cannot login using the same username from multiple locations. 
For example, if you decide to login at the reception desk and you are using the username 
‘jsmith’ and then you decide to login with ‘jsmith’ on a second computer. What happens is that 
on the second computer you are logging into you will be given the option to forcibly log yourself 
off from the reception computer. If you press Yes, a message will appear on the reception 
computer informing you that your login has been overridden and you will be returned to the 
logon screen; you are given 10 seconds before this happens.  

Log users off if idle 
for 

With the setting Log users off if idle for you can choose to have idle ClinicOffice users logged 
off after so many minutes. With this setting ticked it will only ever log off users who have not 
been using ClinicOffice for the specified number of minutes. If a user is still using ClinicOffice 
it will not log them off. 
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Password prompt 
on RDS 
disconnection 

This option is applicable only for people connecting into ClinicOffice via a remote desktop 
connection for example ClinicOffice Hosted edition. When enabled, if you lose your remote 
connection and connect back in, ClinicOffice will require you to re-enter your password.  

Security Settings From here you can set the password complexity required for both staff members and if you 
have the Online Diary for patients as well. Two-step authentication can also be enabled here 
for either ClinicOffice or for the Online Diary. This supports both SMS and third-party 
authenticator apps such as Google Authenticator, Authy or Microsoft Authenticator. 

Audit Trail Settings If you have the Server or Hosted Edition of ClinicOffice then you will have a basic audit 
enabled. This will log any changes made on the appointment, case, invoice, payment, session, 
and staff. You can back this more comprehensive or do a custom audit and tell which parts of 
the software you wish to monitor.  

With the audit you will note that at the bottom of each editor is a small Audit History link. 
Please note that any changes made before this option is ticked would not have been recorded 
under the audit history. 

Image Compression 
Defaults 

By default, ClinicOffice will offer to compress attached images that you import into the 
database. The reason for this is that images can exponentially increase the size of your 
database. By clicking the Image Compression Defaults… you can set the size an image has 
to be before ClinicOffice offers to compress the image. You can also adjust the minimum 
quality that the image should be after compression i.e. “Don’t allow the quality of the JPEGs 
to fall below 50%”. 

PDF Conversion 
Defaults 

As another method to save space ClinicOffice will offer to convert an imported PDF to an 
image; this way allowing it to compress the image once converted. By clicking on the PDF 
Conversion Defaults... link, you can set the minimum size a PDF has to be before 
ClinicOffice offers to convert it. From the same screen you can set the criteria of how many 
pages a PDF needs before ClinicOffice offers to convert it and also set to convert the PDF if 
you are saving so much space for example converts if saving 5% or more. 

Override User 
Settings 

Also under the Advanced Settings is the Override User Settings…, which can be used only 
by an administrator of ClinicOffice. Each user of ClinicOffice will have settings which are 
unique to them, but there may be certain settings that you wish to be the same for all users 
and this is what the Override User Settings is. It allows for an administrator to create a default 
setting within ClinicOffice which will override all users’ settings. An example is if you wish for 
all staff members to have certain load mode settings within the diary. Rather than getting all 
users to adjust it, you can use the options within the Override User Settings panel to set a 
default value for them. 

Doc Storage Setup ClinicOffice allows for you to attach files to the patient’s record or to their notes. This setting 
allows for you to select where these files should be saved to. By default, the documents will 
be saved directly in the database. The benefit of this is that the documents will be included 
when you run a backup of the database, but your database will become exceptionally larger 
with time.  

The second option is that you can select to save the files to a network drive or network location. 
The advantage to this is that it helps to keep the size of your database down, but the 
disadvantage is that you need a network location everyone can access and you will need to 
back up your documents separately. 

From this screen, you can also select to copy all your documents stored within the database 
and save it to the network location you have specified. You can also do the reverse and import 
documents from the specified file location into the database. You can also delete all files from 
the database, but we heavily recommend that you do this after careful planning. 

Additional Services 

Setup Email 
Accounts 

By clicking on the Setup Email Accounts link, it will bring up a window which will allow you 
to enter your email account server settings. The window will also allow you to specify your 
default email account, how often ClinicOffice should check for emails, the outgoing email 
account, your SMTP details, and your proxy server settings. Please note that you require the 
Email Module to have full access to these settings.  This window is still accessible even if you 
do not have the Email Module. For more information, please see the “Emailing” section. 

SMTP Servers If you click on the SMTP Servers link a new window will open which will allow you to enter 
your email SMTP server details into. 
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Clinic Settings 

The Clinic Settings is where the settings directly apply to the individual clinics. From this screen you can also create 
additional clinics or archive older ones.  

 

Setup SMS Account When you click on the Setup SMS Account the next window that appears will allow you to 
enable the SMS service. You can also buy additional credits via this screen. 

Setup Loqate 
Account 

The link Setup Loqate Account will open a window that will allow you to enter your Loqate 
account details. If you do not have an account, you can visit their website clicking the link “Go 
Straight to Sign-Up Form” or click the “Step-by-step Guide” link for a setup guide if you 
need any help with this. 

Setup Worldpay 
Account 

The link Setup Worldpay Account will open the Worldpay Setup window which will allow you 
to register for a Worldpay account, enter your account details in and configure any settings 
relating to the Worldpay service. 

Setup Healthcode 
Billing 

The last link Setup Healthcode Billing will open the Healthcode Setup window that will allow 
you to enter in your Healthcode account details and enter in your provider numbers. From the 
same window you can also map the “Industry Standard Codes” to your item/services as well.  
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Note: If you decide to edit the Start numbering Patient/Financial Codes, ClinicOffice will not backdate. All records 
created before this alteration will not be changed and their codes will stay the same. Only records created after the 
alteration will be affected. 

 

 

Creating a New Clinic 

The steps below will help you to add a new clinic to your database. 

1) Go to the View menu (above the ribbon bar) 

2) Click the Program Settings button 

3) Go to the Clinic Settings tab 
4) Click the Create a New Clinic blue link 

5) Enter in a name and click OK 
6) You can now enter in the clinic code, primary practitioner, and opening hours 

7) You can also enter the clinic address by clicking the Edit the Clinic Address button 

8) Once you are happy with the settings click OK at the bottom of the Clinic Settings screen 
 

  

Create a New Clinic Allow for you to create a new Clinic within the database. Each clinic will have its own settings 
on this screen. 

Delete Clinic Remove the selected clinic. If the clinic has anything assigned to it for example staff, patients, 
appointment then the clinic will not be removed but will in effect be archived instead. 

Clinic Code The three-letter code will be placed at the beginning of the clinic’s patient codes or financial 
codes. This helps to identify the difference between where each record belongs to. 

Primary Practitioner Tells ClinicOffice if the clinic has a primary practitioner. When assigned new patients created 
for the clinic will automatically be allocated to this practitioner. 

First Patient Code This is to be used in conjunction with the Global Settings -> Patient Defaults -> “Allocate unique 
numbers per clinic”. The first patient created for this clinic will be assigned with this number as 
their code. Thereafter each patient will be assigned with the current highest code number plus 
one. 

First Financial Code This is to be used in conjunction with the Global Settings -> Financial Defaults -> “Allocate 
unique numbers per clinic”. The first financial record created, such as an invoice, payment, 
credit note or refund for this clinic will be assigned with this number as their code. The numbering 
works independently for each form of financial record. 

Default Diary Interval If your diary is set to “Use preferred intervals” then the value that you set here will be what the 
diary will default to when you are viewing it in room view or when you are viewing more than 
one staff member when viewing the diary by staff. 

Allow online booking 
at this clinic 

This is applicable if you have our Online Diary add-on module. By default, all clinics will be 
bookable online. By unticking this setting, a patient could not book an appointment at that clinic. 

Clinic Opening Hours This assigns the opening hours of the clinic and will change the bookable hours available on 
the room view of the diary. This does not affect the diary when viewed by staff but that is because 
this view references the staff working hours instead. 

Edit the Clinic 
Address 

Allows you to edit the default address. This is used as a reference by some reports that will 
merge through the clinic address. 
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User Settings 

The User Settings is unique to the user logging into ClinicOffice. Each setting on this screen is explained below. 

 

Preferred Name 
Format 

From here you can change the way in which your name appears in COv5. By clicking on the 

field, you are presented with several different formats which are: Lookup, Code Lookup, 

First/Last, Title/First/Last, Formal, Informal, and Complete. The default setting is set to Lookup. 

This overrules the Default Preferred Name Format present under the Database Settings. 

Auto-Capitalise 
Names/Addresses 

You can stop the auto-capitalising of names and addresses simply by un-ticking either the 
Auto-Capitalise Names or Auto-Capitalise Addresses. 

Use clinic prefixes 
in drop-downs 

This will display the clinic prefix when selecting the clinic in any drop-downs such as the ‘Active 

Clinic’. 

Always Compress 
Images 

When the option Always Compress Images is ticked all images that are scanned or imported 

into ClinicOffice will be automatically compressed so that they take up less room, hence saving 

space. 

Show Flag Alerts 
screen-centre 

This will make any flags that are attached to a record appear centre screen like an alert.  

Optimize PDFs ClinicOffice gives you the option to keep your database size to a minimum by offering a PDF 
compression when importing a PDF document. You can select from here whether it should just 

prompt you, to always do it by default or to have this feature switched off entirely. 

Optional Messages Some tasks you may need to carry out multiple times (i.e. moving appointments around); 
depending on the task a message may appear each time you carry this task out. This may 

become irritating, so ClinicOffice has the option to turn these messages off simply by un-ticking 
the box next to the message type. Alternatively, if you want a message to reappear simply re-

tick the box. 
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Two-Factor Authentication (2FA) 

ClinicOffice has the two-factor authentication feature for both the main core program and the Online Diary addon. This 
can be enabled for both staff and for patients. 

 

Q) What is two-factor authentication? 
A) Two-factor authentication (2FA), sometimes referred to as two-step verification, is a security process in which 

users provide two different authentication factors to verify themselves. In the first step a username or password 

is required. In the second step a security token is required to verify that you are who you say you are. 
 

Q) What methods of two-factor authentication does ClinicOffice use? 

A) ClinicOffice and in turn the Online Diary can utilise any authenticator application such as Google Authenticator, 
Authy or Microsoft Authenticator. Both services can also use SMS messages as the two-factor authentication 

method. In addition to this as a fall-back service the Online Diary can utilise email as well. 
 

To enable the two-step authentication in ClinicOffice, please follow the steps below.  

 

1) Go to the View menu 

2) Click Program Settings  

3) Go to the Global Settings 

4) Click Security Settings 

5) Under the ‘Two-Factor Authentication (2FA) 

for Staff Logins’ section, select either ‘Enable 

Two-Factor Authentication via SMS 
(with email fallback’ or ‘Enable Two-

Factor Authentication via Authenticator 

App or SMS’ 

6) Select what you want to use the two-factor 
authentication for, whether you want this to 

apply to the Desktop (ClinicOffice) or Online 

Logins (Online Diary) or both options. 

7) Select when you wish for the authentication 

to expire. By default, the authentication 
expires after 12 hours, so in effect the next 

working day you will need to authenticate 

again. If you prefer staff to do this every 
time, then you can set this to 0 or you can 

extend the hours up to 168 which would 
mean a staff member would only need to use 

the second authentication once every week. 

8) When finished click the OK button 

 

Q) What is the “Enforce strict two-factor 
authentication” option? 

A) When this option is not ticked, it will allow for 
people who do not have an authenticator app or a 
mobile number recorded against their staff record, to 
bypass the two-step authenticator (2FA). To bypass 
the 2FA, the user must select ‘authenticate via SMS 
instead’ and then on the next screen select ‘Click 
here to bypass’. 

This feature exists to help with a gradual transition to 2FA so at least those users who have no mobile number recorded 
can still use the software. It is also useful if your local clinic has no internet as 2FA depends on an internet connection to 
verify the security code. 
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If security is a prime concern, then we personally recommend that this option is ALWAYS ticked and just make sure that 
everyone has a mobile number recorded against their record. 

 

9) If you have selected to use SMS as either the primary or secondary means of two-factor authentication, then on 

the first time clicking OK you will be presented with the message below, which will only appear if some staff do 
not have a mobile number. You can select the option ‘Yes, Show me the affected users’ to view who falls 

into this category. 

10) If you now log out of ClinicOffice and go to log back in, when you click the Login button the two-factor 
authentication screen will appear. If you do not already have an authenticator app, click the link, ‘Click here to 

download one’. 

11) Once you are into your authenticator app, click to add a new account and either select the option to scan a QR 

code or to add another account. Point your phone’s camera at the screen with ClinicOffice to scan the current 

QR Code. 

12) Once ClinicOffice has been added go into this account and find the security code. Enter it into the ClinicOffice’s 

two-factor authentication screen and click OK.  

 

If you prefer to just send yourself the security code via SMS, click the Send Via SMS button. If your staff record has a 
mobile number recorded, you will be sent a security code to your phone that in turn you can enter into the authentication 
screen on ClinicOffice. 
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The Patient/Contact Selector 

Some fields in ClinicOffice refer to another person (contact or patient) in your database. For example, take a look at the 

patient/contact field in the following screenshot: - 

 
A Patient/Contact Field 

 

 

Notice that there is a magnifying glass button ( ) and a new button ( ) to the right of the field. 

Clicking the new button allows you to enter a new person – giving you the choice as to whether it’s a new contact or 

patient where appropriate. Clicking the search button will bring up the patient/contact selector screen as shown below:- 

The Patient/Contact Selector 

 

Performing a Quick Search is usually the easiest way to find a person. For example, you can enter a patient’s last name, 
first name or their code and click SEARCH. If you wish you can search on both the last and first names by entering it 

in the 'Lastname, Firstname' format. Please note that when you search in the first name and last name order then no 
contact or patient records will be displayed. When you leave the search field blank, click SEARCH it will show all the 

contacts and patients in your database. 

You can also filter this screen by using the Everyone, Patients or Contacts options at the bottom of the window. 

Under the Options you can select to show a patient’s status colour if you have assigned colours to the patient’s status. 

You can also hide inactive patient records. If you have more than one clinic you can select to either search on 

patient/contacts from your current selected clinic or from all clinics. 

The SELECT NOBODY button closes this screen and allows you to remove a reference to a patient/contact. 

Once you have selected the person you were looking for, click OK.  
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ClinicOffice Messaging 

ClinicOffice features its very own internal messaging system – very much like an email system but integrated into 

ClinicOffice. This feature allows you to send messages to other staff members who also use the system. New to 

ClinicOffice is the Message Centre. Here you can view the Inbox, all your messages are now stored like real emails. 

If you are running ClinicOffice over a network and you send a message to another user who is currently logged on, 

then the message will automatically appear on their screen along with an audible notification. If the user is not currently 

logged on, then he/she will receive the message as soon as they next logon. 

 
The Message Centre 
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Sending a Message 

To send a message, click the  button which is on the ClinicOffice Home ribbon bar (across the top of the screen). 

The following window will then appear:- 

 
Sending a Message 

 

 

Here’s how to send a message:- 

• Left-click on the To field, and then select the staff member(s) by ticking the boxes next to their names. You 

will know if a staff member is logged onto ClinicOffice because their name will appear in green. 

• Type in your message in the Message box. 

• If you want a receipt to be sent back to you when each recipient reads the message, then tick the Request 

Acknowledgement box. 

• If this is an urgent message, then tick the Message is URGENT box. 

• If this message is about a specific patient or contact, then you can include a link to the patient (see “The 

Patient/Contact Selector” for more information on how to do this). 

• Decide when the message should be sent. Normally, you would just send the message immediately but you 

can select a future date if you wish. 

 

Click the Send button to send the message or CANCEL to abandon it. 
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Receiving Messages 

When you receive a message, a window will pop up in the bottom right hand corner of your screen. If the message is 

marked as URGENT, it will appear in red and next to the Unread Messages it will state how many of those are urgent. 

You will also hear an audible alert to let you know that you’ve received a new message. 

 

 

Take a look at the above messages. The total number of unread messages is mentioned at the top of the window along 
with the number of urgent messages. You will also note that the messages stack up on the window. This window can 

preview up to 4 messages, however you can view all messages by right clicking on this window and selecting your 

message which you wish to read in full.  

Towards the bottom left of the unread message screen are two buttons. The first is the Snooze All ( ) button which 

allow you to hide all messages currently previewed for a specified period of time. The second button is the Mark All 

as Read ( ) button which will mark all messages present as being read. 

If you decide to snooze a message it will reappear at the specified time and will look like the message below.  

 

 

Again this window can preview up to 4 messages. You will note that on the snoozed message you can either choose 

to snooze the message for a further period of time, alternatively you can Remove All Snoozed Message Reminders     

( ). 

If the sender asked for an acknowledgement, then you will have to acknowledge the message.  You can do this by 
opening the message and then clicking the Acknowledge button.  

 

This message will appear in the bottom right hand corner of the screen (same area as a non-urgent message).  You 

can remove the message in the same manner you would a normal message. 

 
To delete a message right-click on it, in the message centre and select Delete Message. Alternatively you can open 

a message and click the Delete button. You can view all deleted messages in the Recycle Bin by selecting

. 
 

You may remove all deleted messages permanently by again right-clicking, then selecting Empty Recycle Bin. You 
can also empty the recycle bin through the OPTIONS button.   

 
The right-click menu also gives you the option to Purge Old Messages…; this enables you to remove all messages 

that are older than a certain period of time (i.e. older than 2 months). This option permanently deletes all messages 

within the Inbox, Sent Messages and Recycle Bin.       

Snoozed Message 

Received Messages 
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Sending SMS Messages  

To be able to send an SMS message you will need to first enable the SMS Messaging service. This will register an 
account for you with us. To enable this, please follow the steps below. 

 

1. Go to the View menu 

2. Click the Program Settings button 

3. Go to the Global Settings tab 

4. Click the blue link “Setup SMS Account” [the screen below will appear] 

5. Tick the option “Tick to Enable SMS Messaging in ClinicOffice”. 

 

You can test that your ClinicOffice is communicating 
with our SMS service by clicking the button Test 
Connection to SMS Server. If the connection fails, 
please alter your firewall or antivirus ClinicOffice 
through. 

In order to buy more credits, you will need to login to 
your Client Portal. You can do this by clicking the 
blue link below the text that provides the credit count. 
If it is the first time, you will need your ClinicOffice 
account details in order to log in. If you do not have 
these, then please feel free to send Pioneer Software 
an email requesting for this information. After logging 
on for the first time you will be able to assign your 
own username and password for future access. 

 

Account Configuration 

The My Country should default to your country of 
residence, but if it does not you can change it by 
clicking the blue link next to the field. 

If you do not wish for people to be able to reply to the 
SMS messages, then select the option “Show SMS 
Sender as”. This will usually have something filled in 
from your clinic name, but you can alter it. Please 
bear in mind that it can only be 11 characters long 
due to SMS limitations. 

If you prefer for people to be able to reply to your 
SMS messages, then you can facilitate this by 
selecting “Allow replies to ClinicOffice”. The number 
they reply to, is a virtual number provided through our 
SMS service.  

Once finished, click OK. 

 

There are several ways you can send an SMS 
message within ClinicOffice. A few of these examples are listed below. 

Example 1: 

1. Go to the Diary in ClinicOffice 
2. Right click on an appointment 
3. Select Patient Record 
4. Click Send Text Message 

 

Example 2: 

1. Go to the Patients section in ClinicOffice 
2. Double click on a patient’s name to open their record 

3. Click the mobile icon located in the mobile field. 
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Example 3: 

1. Go to the Patients section in ClinicOffice 
2. Left click on one record  
3. Press CTRL+A on your keyboard 
4. Right click on one of the highlighted records 
5. Select Patient/Contact 
6. Click Send Text Message 

 

Any of the examples above will present the window below:- 

 

 

You will see the name of the recipient and their mobile number. If you followed the steps in Example 3 you will have 

multiple recipients. You can add or remove a patient/contact by clicking the add button  or remove button . 
Within this same window you are given three options to either send the message to a mobile first, to send it to a 
landline first or to send it to a mobile only. The first option means it will try to send a message to a mobile first but if no 
mobile number is present it will try the landline number instead. The second option is a reverse to this in that it will try 
the landline number first but if no landline is present it will try the mobile number. 

You are free to type whatever message you want to appear. You can customise it by clicking the Insert button, which 
will offer a selection of merge fields. If you follow Example 1 the merge fields are a choice of name formats and 
information pertaining to that appointment. If you follow Example 2 or 3, you still have the different name formats but 
you also have the appointment information for both the patient’s next and their previous appointment. In all three 
examples the account balance is available.  

When you select a merge field from the Insert button, the text will be inserted wherever the text cursor is positioned in 
the Message window. If you were to select the merge field “FullName” for example the text would be inserted as 
<FullName>. It will only merge the information for the recipient once you click the Send button. 

If it’s a message that you will use regular, then you should save it to your templates by clicking on the SAVE button 
and save it with a recognizable name. You can use this message in the future by clicking on the TEMPLATES button 



- 122 - 

and selecting it. Also, by clicking on the INSERT button you can place in an auto generated field which will change 
according to the individual’s details.  

Once you are satisfied with the message and the selection of recipients you are sending it to, click the  
button. ClinicOffice will give you a little report afterward to let you know how many SMS messages were successfully 
sent. It will also change the Status under Recipients in the SMS Message window. If the message was not successful 
then it will say FAILED, it will highlight in red and give it a small description of why it failed (underneath the patient).    

An SMS can be sent automatically as an appointment reminder or appointment confirmation for example. To see how 
to do this, please see the section “The Patient Contact Centre”. 

 

Note: ClinicOffice can only send SMS messages to patients who have a mobile phone number or who have a BT 
landline. Also, SMS messages are 160 characters in length, so if this character limit is exceeded you will be 
charged for two messages rather than one. 

 
 
 

SMS Message Centre 

The SMS Message Centre allows for you to see a record of all SMS messages that have been sent from the system 
and equally, if enabled, all messages received in one place. 

 

The centre is broken up into two tabs: SMS Inbox and SMS Outbox. The options for the centre are listed on the next 
page. 
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Date Range You can specify the date range of SMS messages you wish to view 

Search Panel 
When enabled an additional search field will appear. This allows for you to search on 
the sender/recipient name and their number. 

Show sms content in grid When ticked the contents of the SMS message will appear within the grid. 

Most recent 

On the right hand side of the SMS Message Centre is a small preview window of the 
conversation you have had with the current contact you have selected. The “Most 
recent” field allows for you to select the order that you wish to see the message in. 

Show conversation 
Enable for a preview of messages sent to the current contact selected. This will 
include both current and past messages sent and received. 

Show SMS notification 
popups 

When a new SMS message is received a small pop-up window will appear.  

  

 

There is the option to “Show SMS notification popups”. When 
this is ticked a small message will appear every time a new 
SMS is sent back. These messages can also stack in the 
preview as well if you have more than one message. 

If you wish to review these messages later you can click on the 

Snooze button ( ) and set it not to reappear again for up to 
8 hours. If you wish to read them and tell the system that you 
have read them you need to click the Open SMS Centre 

button ( ). As shown above, from the SMS Centre you can 
see the contents of the messages that have come in. If you tick 
the “Read” checkbox it will prevent the popup notification for 
this SMS message from appearing again and you. 

 

Q. How do I stop these SMS popups from appearing? 

A. Go into the SMS Message Centre and untick the option “Show SMS notification popups”. This will no longer appear 
for any user within ClinicOffice. 

 

Q. How do I prevent some of my staff from viewing the SMS Message Centre and these SMS popups? 

A. You can prevent some users from viewing either of these by going to their access rights or access groups and 
unticking the option “SMS Message Centre”, which sits under the “Other Options” area of the access rights screen. For 
more information on how to do this, please see the section “Staff Member Access Rights”. 

 

Q. Can SMS messages be viewed on the patient’s or contact’s record?  

A. Yes, they can. Any SMS messages pertaining to the patient or contact can be seen on their record via the Contact 
Journal tab.   
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Emailing 

In ClinicOffice there are two different emailing systems. The first is a Text Only Email system that comes with the 
ClinicOffice by default. This will allow you to send a basic email and is perfect for sending reminders to patients about 
a future appointment. One of the downsides to this is that ClinicOffice does not store the details of the email that has 
been sent and you cannot receive emails within ClinicOffice either. 

The second system is the Email Manager module which will allow for you to send/receive emails in an html format. This 
works like a full email client. 

 

Text Only Emailing 

To send a text only email you will need to first enter your SMTP email server details. To register your email account, go 
to the View tab, click on the Program Settings button, click on the Global Settings tab, and then click the Setup Email 
Accounts blue link. The following window will appear: - 

 

SMTP Server Manager Window 

 

With the standard Text Only Email system you can store only one Email Account with its SMTP server details. The table 
below explains what each part of the SMTP Server window is there for. 
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Basic Settings 

Outgoing Server (SMTP) 

Server Type Allows you to select between regular SMTP, Office365 Business and Gmail. When you 
select SMTP you will need to manually enter in your email server SMTP settings. If you 
select either Office365 Business or Gmail you can just click to sign into either service and 
ClinicOffice will automatically link up to either account. 

Server Name This is your outgoing mail server. This will be provided to you by your email provider. It 
will very often be in a format like this: smtp.example.com  

Security You can select either “None”, “StartTLS” or “TLS or SSL” for your security protocol. Either 
TLS or SSL allows for a secure encrypted connection between your email client 
(ClinicOffice in this case) and your email server. “StartTLS” means it will take an existing 
insecure connection and make it secure. Not all email providers will provide this 
functionality so you will need to check. 

Port (Default 25) Some email servers require a specified port to work through. Again your email provider 
will specify if a unique port is required for the SMTP Server. If you tick “Use default port” 
it will use port 25 for “None” and “StartTLS” or port 465 for “TLS or SSL”. 

Authentication Required Your Email Provider will specify if authentication is required. If it is then tick this checkbox. 

Username This is the main username that you would use to access your email server. So in many 
cases this will be your main email address. If your email server is on a local machine then 
this will probably be different. 

Password This is the password you use to access your emails on the email server. 

Sender Details 

Sender Name This is the default name that will appear when the recipient receives an email. 

Sender Email This is the default email address that the recipient of an email will see. For example if you 
email an appointment reminder this is the email address that will be seen. 

Send Test Email After you have entered your details it would be wise to click this button. If a successful 
connection has been made a message will appear saying ‘A test email has been sent 
successfully’. If the email fails to send it will provide you with an error code, which comes 
from your email server and explains why it has failed. 

Configure your proxy 
server 

If you have a proxy server on your system then you can configure your proxy by clicking 
on the blue link.  

Advanced Settings 

Authentication Method 

SMTP supports different authentication and security mechanisms. By default, this setting 
is set to “Auto” which means ClinicOffice will automatically select the most appropriate 
“Simple Authentication and Security Layer” (SASL) for you. You can, however, change 
the type SASL used. Please note that not all email servers work with all forms of SASL 
mechanisms. 

Authentication Options  
Allows you to select an option for the authentication. By default, this is set to “None”. This 
does NOT mean there is NO authentication enabled, but it means that there are no 
additional authentication "Options" enabled such as "Use Local Domain As Default". 

Security Protocol  
This allows you to select the security protocol your server uses i.e. TLS 1.1 or TLS 1.2. If 
you leave it to TLSAuto, the highest TLS certificate that your email server uses will be 
selected. 

Mail server timeout after 

Like any local email client, ClinicOffice will attempt to connect to your email server. If it 
fails, it will inform you that it cannot connect and why it cannot connect. By default, it will 
try for 30 seconds with each send and receive attempt. Using this setting you can increase 
the length of time before ClinicOffice will timeout. 
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Sending Text Only Emails 

There are multiple areas where you can send an email. These areas include any editor where there is a built-in email 
field (i.e. patient, contact, staff editors). You can also send an email via the right click menu in the appointment diary, on 
the appointment, patient and contact grids and a number of the grid reports as well. There is an option to send an email 
via the Patient Contact Centre (see the section “The Patient Contact Centre” for more information). You can also email 
reports and attach them to an email. Below are a couple of examples of sending a text email. The first example will 
show you how to email a single patient via an appointment. The second example will show you how to email an invoice 
report as a PDF attachment. 

 

Example 1: 

• Go to the Appointment Diary 

• Right click on an appointment 

• On the menu go down to Patient Record 

• Select Send Email 

• The “Send Email” window will appear 
 

 

Example 2: 

• Open an existing invoice 

• Click the Print button 

• Select one of the invoice reports 

• Click the Email As button and select PDF File 

• Click OK 
 

 

You will note that on both occasions the same window will appear. In example 2 you will also see the name of the 
attached file. 

 

 

Send Email window 
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You will note the recipient(s) of the email will appear in the window at the top. You can put the subject of the email into 
the Subject field and enter the contents of the email into the Message field below. Once all is acceptable click the OK 
button and your email will send through to them. 

 

Problem: When trying to send an email a message saying “MAPI Email Client Problem” appears, what 
do I do? 

This message will appear because ClinicOffice will initially try to use a MAPI compliant email program such as Microsoft 
Outlook. To fix this however you can tell ClinicOffice to use itself when sending emails from within the program. The 
steps below will help you with this. 

 

1. Go to the View menu in ClinicOffice 

2. Click the Program Settings button 

3. Under the Local Computer Settings tab please select “Use ClinicOffice (use ClinicOffice to send emails)” 

4. Click OK 

 

After following the above steps you will now find that any emails from ClinicOffice will be sent from within the program. 

 

Note: You can store up to 3 email addresses for one patient. This means that when you click to send an email, 
whether this is using ClinicOffice or your external email client you can send the email to all 3 addresses. 
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Email Manager 

The email manager is an additional module in ClinicOffice v5 and works in a similar manner to many other desktop 
email clients. You can access it via the Email Manager button on the Home ribbon bar at the top of the program. 

 
The Email Manager 

 
 

Email Account Setup 

To use your email account through ClinicOffice you will need to set it up within the program. To do this, please follow 
the steps below. 

 

1. Go to the Email Manager 
 

2. Click the Email Settings button (top right) 
 

3. Midway down on the Email Settings panel is the option “Email Account Manager”, click on this 
 

The following window on the next page will appear. 
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4. On the screen above click the 

New button (bottom left) 
 

An email account wizard will appear. The 
first time this window is opened, it will 
take a little while to retrieve the settings 
from some of the major email providers. 

 

5. From this window you can select 

Gmail, Outlook.com; Office 365 
Business, Yahoo; AOL or iCloud. 

Once selected, click the Next 

button.  
 

6. You will now be asked to enter a 
name for your new email 

account. This is just a name that 
helps you identify the email 

account. We recommend 

choosing a short name. Click 
Next button once you have 

entered a name. If you selected 
Gmail or Office365 Business 

you will need to click on the button to 
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sign in to those services and from you will be redirected to a webpage to login to your email account. From there 
you can proceed to step 9 on these instructions. If you selected one of the other services then proceed to step 

7. 
 

7. Enter the Username and Password for your email account 

 
8. You will also be asked for the Sender Name and Sender Email. These will be what the patient sees when you 

send them an email. Note if you are using an iCloud account then please follow the additional instructions given 

within the yellow box on this setup screen. 
 

9. Once you are finished click 
the Finish button 

 
A new window will appear named 

“Manage IMAP Folders”. From here 

you can select the folders you wish 
to synchronise and manage the 

users that can manage IMAP folders. 

 

10. Select the folders you wish 

to synchronise by ticking the 
first checkbox on the left 

 
11. You can tick the “Include in 

Send/Receive” for the 
folder so that it will 

automatically check this 

folder for new emails when 
ClinicOffice connects to the 

email server. 
 

12. For each folder select who 

can access that folder by 
clicking the Setup Access… 

button and then allotting the staff or team that can have access to it. 
 

13. You can copy the same access from one folder to another by clicking the Copy Access To… button and 

selecting the folders and clicking OK. 
 

14. Once you have finished click OK on the “Manage IMAP Folders” window and OK to the next message 

 

 

Setting up an Email Account Manually 

If you are using a non-predefined email service, then you can set this up manually following the steps below. Note, that 
if you are using Gmail or Office365 Business service then we strongly recommend that you follow the above previous 
steps instead. 

 

1. Go to the Email Manager 

 
2. Click the Email Settings button (top right) 

 
3. Midway down on the Email Settings panel is the option “Email Account Manager”, click on this 

 

4. On the screen above click the New button (bottom left) 
 

5. Select “Other (Manual Configuration)” and click Next 
 

6. Enter the name you wish to identify this email account by and click Finish 
 

This will take you back to the Email Account Manager screen and will now allow you to enter your details manually. 
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7. Under the Incoming Server tab, select either IMAP or POP 

 
8. Enter in your server name, security, port, username, and password 

 

9. Click the Test IMAP Server or Test POP Server button, to see if the connection has been established to the 
server 

 
10. If you are using IMAP click Manage IMAP Folders 

 
11. Select the folders you wish to synchronise by ticking the first checkbox on the left 

 

12. You can tick the “Include in Send/Receive” for the folder so that it will automatically check this folder for 
new emails when ClinicOffice connects to the email server. 

 
13. For each folder select who can access that folder by clicking the Setup Access… button and then allotting the 

staff or team that can have access to it. 

 
14. You can copy the same access from one folder to another by clicking the Copy Access To… button and 

selecting the folders and clicking OK. 
 

15. Once you have finished click OK on the “Manage IMAP Folders” window and OK to the next message 
 

16. Go to the Outgoing Server tab 

 
17. Enter in the server name, security and port for the SMTP 

 
18. You can copy the username and password from the “Incoming Server” section by clicking the blue link “Copy 

from ‘Incoming Server’” 

 
19. For peace of mind click the Test SMTP and if a successful connection has been made to the server it will say 

that a test email has been sent 
 

20. Enter your Sender Name and Sender Email and if you already have an email signature set up you can select to 

use this 
 

21. You can mark this as your default email by clicking the Set as My Default Email Account button 
 

22. Click the Save and then Close buttons once done 
 

 
For a better understanding of what each field does within the Email Account Manager setup screen, please see the 
tables below. 

 

Email Account Manager 

Email Accounts 

Incoming Server 

IMAP/POP Server Settings 

Server Type 

You can select to use either IMAP or POP protocols or the Office365 Business or Gmail 
service for the incoming server. The difference between them is that IMAP will synchronize 
all the email contents between ClinicOffice, your email server and any other devices that you 
check your emails on. So, for example, if you mark a newly downloaded email as read, this 
will be synchronised to the other devices that use this email. If you send an email, this will 
also be visible in the sent folder on the other devices. 

POP or technically POP3 downloads emails from the server to a single computer. Generally, 
with POP3, once an email is downloaded, it will delete it off from the email server. With 
ClinicOffice this is not the case unless you set it to. Still, unlike IMAP if you mark an email as 
read it will not be synchronised across other devices. This is the same when sending emails. 
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For Office365 Business or Gmail you can just click to sign into either service and ClinicOffice 
will automatically link up to either account or will automatically sync. Signing to either of these 
services will also autofill the outgoing server details as well. 

Generally, we recommend that you use IMAP, unless you have a Gmail or Office365 Business 
account. 

Server Name 
This is your incoming mail server. This will be provided to you by your email provider. It will 
very often be in a format like this: pop.example.com or imap.example.com 

Security 
Define the security protocol that your email server uses. You can select: “None”, “StartTLS” 
or “TLS or SSL”. Your email provider will be able to give you this information. 

Port 

Each security protocol has a port number that it will use to communicate through. If you have 
the option “Use default port” ticked, then it will select the default port number of the security 
protocol you have selected. Please note that your email server may use a different port to the 
default port number. 

Username 
This is the main username that you would use to access your email server. So in many cases, 
this will be your main email address. If your email server is on a local machine, then this will 
probably be different. 

Password This is the password you use to access your emails on the email server. 

Test IMAP/POP 
Server 

Tests the connection with the IMAP or POP server. If successful ClinicOffice will indicate that 
the “Connection was Successful”. If it fails a message will indicate why it has. Please 
remember that failure messages are generated from your email server and then presented in 
ClinicOffice. 

Manage IMAP 
Folders 

Allows you to manage the email folders you wish to synchronise with and who can access 
these folders. 

Email Checking 

Check every This allows you to specify how often ClinicOffice checks and downloads new messages. 

Only check when 
logged on as 

From here you can specify which user accounts will check for your new emails. If you leave it 
blank ClinicOffice will download your emails, no matter who is logged on. This does not mean 
that they can check your emails if you have denied them access from viewing your email 
folders, it just means that when they login ClinicOffice will check for new emails for you. 

Only check from this 
computer 

You can specify only one computer that can download your emails. Again, if you do not specify 
then all computers will check for your emails. 

POP Delivery 

This section will only appear if you have selected the POP server type under the Incoming Server section. 

Deliver to Global 
Inbox 

This will put all downloaded messages into the Public Folders’ inbox. 

Deliver to Staff 
Member 

This is an alternative to the “Deliver to Global Inbox” option. You can specify which staff 
member should receive the emails instead. 

Leave messages on 
the server 

When you select this option, all messages that you download from your email server will 
remain on the server.  

Delete messages 
from the server once 
downloaded 

When you select this option, messages that you download from the server are then removed 
from the email server. 

Delete messages 
from the server after 

When you select this option, you can specify to have messages removed from your email 
server after a set number of days.  

Outgoing Server 

Outgoing Server (SMTP) 

Server Name 
This is the address of your outgoing server. This will be provided by your email provider. The 
format of this tends to be smtp.example.com. 

Security 
Define the security protocol that your email server uses. You can select: “None”, “StartTLS” 
or “TLS or SSL”. Your email provider will be able to give you this information. 

Port Each security protocol has a port number that it will use to communicate through. If you have 
the option “Use default port” ticked, then it will select the default port number of the security 
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protocol you have selected. Please note that your email server may use a different port to the 
default port number. 

Authentication 
Required 

Enables you to enter your email account’s username and password. If you have an internal 
exchange server on the same network as your ClinicOffice, then you may not need to tick 
this. If you do not, you will need to. 

Copy from ‘Incoming 
Server’ 

For most email accounts the username and password are the same for the outgoing server 
as it is for the incoming server, so you can click this link to copy the username and password 
from the “Incoming Server”.  

Sender Name This is the name that will appear when the recipient receives an email. 

Sender Email This is the email address that the recipient of an email will see. 

Default Signature 
Allows you to allocate a default signature to the email account, which will appear when 
sending a new email, replying to an email, or forwarding an email. 

Advanced (IMAP)/(POP) 

This section will only appear if you have selected the IMAP server type under the Incoming Server section. 

Authentication 
Method 

IMAP supports different authentication and security mechanisms. By default, this setting is 
set to “Auto” which means ClinicOffice will automatically select the most appropriate “Simple 
Authentication and Security Layer” (SASL) for you. You can, however, change the type SASL 
used. Please note that not all email servers work with all forms of SASL mechanisms. 

Authentication 
Options  

Allows you to select an option for the authentication. By default, this is set to “None”. This 
does NOT mean there is NO authentication enabled, but it means that there is no additional 
authentication "Options" enabled such as "Use Local Domain As Default". 

Security Protocol 
This allows you to select the security protocol your server uses i.e. TLS 1.1 or TLS 1.2. If you 
leave it to TLSAuto, the highest TLS certificate that your email server uses will be selected. 

Mail server timeout 
after 

Like any local email client, ClinicOffice will attempt to connect to your email server. If it fails, 
it will inform you that it cannot connect and why it cannot connect. By default, it will try for 30 
seconds with each send and receive attempt. Using this setting you can increase the length 
of time before ClinicOffice will timeout. 

Sync past emails 
(IMAP ONLY) 

This is only for IMAP. With this setting, you can specify how far back in time you wish to store 
and synchronise emails locally. By default, it is set to store and synchronise emails from 1 
month ago. 

Suppress upload 
sent emails to “Sent” 
folder (IMAP ONLY) 

By default, IMAP will synchronise not only incoming emails across all devices accessing the 
same email server, but it will also synchronise emails sent from ClinicOffice across all devices. 
By ticking this option, it will prevent sent emails from synchronised. 

Reset Downloaded 
Emails… 

This blue link will allow you to re-download emails from the server despite them already having 
been downloaded in the past by ClinicOffice. This is on the provision that those emails still 
exist on the email server. 

Advanced (SMTP) 

Authentication 
Method 

SMTP, POP or IMAP support different authentication and security mechanisms. By default, 
this setting is set to “Auto” which means ClinicOffice will automatically select the most 
appropriate “Simple Authentication and Security Layer” (SASL) for you. You can, however, 
change the type SASL used. Please note that not all email servers work with all forms of SASL 
mechanisms. 

Authentication 
Options  

Allows you to select an option for the authentication. By default, this is set to “None”. Th is 
does NOT mean there is NO authentication enabled, but it means that there are no additional 
authentication "Options" enabled such as "Use Local Domain As Default". 

Security Protocol  
This allows you to select the security protocol your server uses i.e. TLS 1.1 or TLS 1.2. If you 
leave it to TLSAuto, the highest TLS certificate that your email server uses will be selected. 

Mail server timeout 
after 

Like any local email client, ClinicOffice will attempt to connect to your email server. If it fails, 
it will inform you that it cannot connect and why it cannot connect. By default, it will try for 30 
seconds with each send and receive attempt. Using this setting you can increase the length 
of time before ClinicOffice will timeout. 

Default Outgoing Accounts 

The default email 
account is 

This is the default account for the entire ClinicOffice program and is what is used for clinics 
and staff members as their default unless they have their own specified default email. 
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Clinic Defaults 
This allows you to define a specific email that a clinic would use. This overrides the main 
default email account for the purpose of contact rules such as appointment reminders.  

Staff Defaults 
When set, a staff member will have their own custom default email. This overrides the main 
default email account when the staff member is sending out emails from the system, such as 
emailing a patient. 

Other Email Settings 

New Allows you to add an email account to the system. 

Delete Deletes an email account off from the system. 

Set as My Default 
Email Account 

To use this, select an email account and click this button. This will set your personal staff 
email to use this email account as your default. 

Disable this account 
This will disable the current email account within ClinicOffice, preventing you from 
receiving/sending any emails. 

Save Saves changes you have made to the email account setting page. 

Show progress 
when send/receiving 
emails 

When you do a send/receive for emails a small progress bar will appear in the bottom right of 
ClinicOffice. If you un-tick this option then this progress bar no longer appears.  

Configure proxy 
server 

This is only to be used if have a proxy server on your local network.  

 

On the left-hand side of the Email Manager are the email folders, this is broken down into sections. The main categories 
are Online Accounts and Offline Folders. Online accounts are for IMAP accounts and Offline Folders are for POP 
accounts are kept. The only Online folders you will see will be the ones you have been granted access to. 

Under the offline folders you will see your user folders and the public folders. Each section has a Drafts folder, Deleted 
folder, Inbox folder, Junk folder, Outbox folder and Sent folder. You will also see any offline folders that have been 
shared with you. Offline folders are always present even if you do not have a POP account. You can however minimise 
these within the folder tree so that they are not a nuisance or in the way. 

You can select to add new subfolders to both online and offline folders by right-clicking on any of the folders and selecting 
New Folder. If you do create a new subfolder for an online account, then this folder will become present on the email 
server as well. You can equally rename and delete subfolders by again right-clicking on them. 

 

At the top of the Email Manager there a several buttons. These carry out the following functionality: 

 
This will send and receive all emails for all email accounts present in 
ClinicOffice. Left clicking on the right-hand section of the button (arrow pointing 
down) will give you the options: Check My Accounts, Check All Accounts and 
Send Pending Emails.   

 
This will create a new email. 

 
This will reply to the sender of the current email that you have selected. 

 
This will reply to all email present on the current email, i.e. sender and other 
recipients of the same email. 

 
This will forward the current email you have selected. 

 
Marks the email(s) you have selected as read. 

 
Marks the selected email(s) as spam and send them straight to the spam 
folder. 

 
Deletes the selected email(s) 

 
This will allow for you to perform a search on the emails.  

 
This will take you to the email settings. See “Email Settings” for more 
information.  
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Email Settings 

The email settings are accessible via the Email Settings button or the Email Settings tab. The Email Settings is broken 
down into 5 major sections: Email Grid Options, Preview Options, Setup & Configuration, Email Archiving and 
Other Options. 
 

Email Grid Options 

 

See the section “Working with ClinicOffice Grids” for more information on the Grid 
Options functionality.  

Preview Options 

This allows you to change the way the Email Manager displays the emails. This is 
broken into two settings: Preview pane location and Block preview images. 

The preview panel will allow you to preview an email without the need to physically 
open it. Just select the email by a single left click and it will appear in the preview 
panel.  

With the Preview pane location you can select where you wish the preview panel 
to be present. By default the preview panel is set to appear to “Show on the right 
hand side” of the email grid. You set to “Show underneath emails” or “Don’t Show” 

The preview panel should not be confused with the “Show preview lines” on the Email Grid Options. The “Show preview 
lines” will show a text only preview of the email and this is displayed on the grid and not in the preview panel. The 
preview panel is capable of displaying emails that are in html format. 

By default images will be displayed when viewing an email in the preview panel. You can however choose to have this 
blocked by using the Block preview images. You could select to block “On All emails” or “On Junk email only”. 

 

Setup and Configuration 

This area consists of 4 buttons: Email Account Manager, Spam Email Settings, Sorting Rules and Run Rules. 
These 3 sections are considered on the preceding and following pages. 

 

Email Archiving 

This area will allow you to set up an automatic archiving process. You can specify under the Options how often you 
want the archiving process to run and how old the emails need to be before they are archived, Archived emails will still 
be present in ClinicOffice but will be hidden, unless the setting “Show Archived Emails” is ticked. There is also an 
option to delete emails after a period of time although this is unselected by default as it will permanently remove the 
emails from the ClinicOffice database, rather than just hiding them.  

Toggle Grid Filtering This will enable you to place a filter on the email grid. 

Toggle Group by Box Allows for an additional row to appear above the grid, 
allowing you to drag a column header into this area 
and to group the grid by these columns values. 

Toggle Group Footers This will display/hide the group footer. In order to use 
this it will require that the grid is being grouped. 

Show Column Customizer This displays a new window which holds any hidden 
fields for the grid. You can remove columns off from 
the grid and place them into the Customization 
window. You can also take columns out of the hidden 
section and add them to the grid. 

Reset the Grid Layout This resets the email grid layout back to its original 
format. 

Show status colours If you have assigned colours to the patient/contact’s 
statuses these will show when this option is ticked. 

Show preview lines Gives a preview of the first few lines of an email. The 
previewed is displayed on the grid. You can change 
the maximum number of preview lines. 

Email Settings 
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Spam Email Settings 

 

 

ClinicOffice has an inbuilt spam filter which over time learns which emails are spam and which emails can be trusted. 
This is achieved when you mark an email as spam. The system detects, makes note of the format and context of the 
email and after a few similar emails being marked as spam, all future emails of this nature will be instantly marked as 
spam.  

Spam Detection 

Your ClinicOffice will give you a spam rating on each email that it downloads based on your spam filter. From here 
you can mark at which value an email should be considered to be spam. So for example if you set it to 75 then 
emails that come in and have a spam score of 75 or higher will be sent to the Junk folder. 

Spam filter Training 

Reset the spam filter This undoes all of the previous training that your spam filter has received. 

Train SPAM messages 
from a folder 

You can train your spam filter by selecting a folder with saved spam emails. Be 
careful because if you selected a folder with genuine emails then it will register such 
emails as spam on future occasions. 

Train GOOD messages 
from a folder 

By clicking on this option and selecting a folder full of genuine emails you will add 
these types of emails to your trusted list. 

Re-train filter from current 
emails 

If you wish to reset all of the rule on your spam filter then you will click this option.. 

Black / White Email Lists 

Spam Email Options 
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Edit the BLACK list of 
email addresses 

When you click on this link a new window will appear displaying a list of emails and 
domains that have been blacklisted. You can also add to this list via this window by 
clicking the Add button.  

Edit the WHITE list of 
email addresses 

This works like the BLACK list but instead provides you with a list of emails that have 
been marked as trusted.  

Other Settings 

Automatically mark spam 
emails as ‘read’ 

Any emails that have been identified as being spam will be marked as read if you 
have this option ticked. 

Move black-listed emails 
straight in the ‘Deleted’ 
folder 

When this option is ticked any emails that are on the black list will bypass the spam 
folder and go straight into the deleted folder.  

Permanently delete black-
listed. 

If this option is ticked all black listed emails will be permanently deleted straight away 
rather than going to the Junk or Deleted folders. Please use with discretion. 

Show the ‘Spam-Score’ for 
each email 

This will display an extra column in the Email Manager. This is the Spam Score 
Column and it will display each email’s spam rating. 

 

 

Email Sorting Rules 

 

There is System Rules and Personal Rules. The system rule will allow you to create a rule affecting all email accounts 
and a personal rule will only create a rule for your own user email account. 

Email Rules 

This is where your list of rules will be displayed. From here you can select a rule to edit it, create a new rule or 
choose to delete a rule. 

Rule Settings 

Apply this rule when an 
email is Received/Sent 

This allows you to create a rule either to be run on emails that are being received 
(incoming emails) or you can select it to run on emails being sent (outgoing emails). 
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This rule applies to the 
following email accounts 

This only applies for system rules. This allows you to select which emails accounts 
you wish the rule to apply to. 

Rule Conditions 

Condition 1- 3 You can specify up to 3 conditions for your email sorting rule. You can specify to filter 
on text that is present in the “From”, “To”, “Cc”, “Bcc”, ”Subject” fields or the main 
body of text in an email. Other types of conditions that can be set are: to specify the 
size of an email, if the email has an attachment or if an email has been marked as 
important. 

All conditions must be met/ 
ANY one of the conditions 
must be met. 

By selecting “All conditions must be met” every email will have to match up to all 
conditions before the rule is applied to it. By selecting “ANY one of the conditions 
must be met” will mean that if any one of the conditions are met by the email the rule 
will be applied to it. 

Rule Actions 

Action 1-3 This is where you can select up to 3 actions for this rule.   

Other Options 

If this rule applies, don’t 
process any other rules  

If you have this option ticked then once this rule has been applied to an email then no 
other rule will affect it.   

Apply this rule to SPAM 
messages 

Usually a rule will not be applied to an email marked as spam however if this option is 
ticked it will. 

Disable this rule If this option is ticked then the rule will not run unless you un-tick it. 

 

Email Editor 

When you go to reply to an email or to create a new email the email editor window will open.   
 

Email Editor  

The Email Editor works in a very similar fashion to the document template editor (For more information please see the 
section “Document Templates”). The features that are different are shown on the next page. 



- 139 - 

 Home Tab 

 

Your email will be sent to your specified recipients when you click on this 
button. 

 
This will save the email to your Draft folder. You can then access your draft 
later on in a similar fashion to other emails. 

 

Signature 

From here you can select your email signature to be used on the email. 
You can also manage and create new signatures by selecting Manage 
Signatures... at the bottom of the drop down menu. 

Attachment 

This will allow you to locate a file from your local machine in order to attach 
it to an email. 

Attachment Options 

Provides the compression options for images or PDF documents that are 
attached to an email. 

Insert Tab 

 

Signature 

This works in an identical manner to the Signature button on the Home tab. 

Snippet 

This will allow you to insert pre-defined text. You can also manage and 
create your snippets by selecting Manage Snippets... at the bottom of the 
drop down menu. 

Template 

From here you can select to use an template. You can also manage and 
create your email templates by selecting Manage Templates... at the 
bottom of the drop down menu. 

View Tab 

 

When clicked on the ‘BCC’ (Blind Carbon Copy) field will appear below the ‘CC’ 
field. This field will allow you to insert multiple recipient’s email addresses like 
the ‘To’ and ‘CC’ field. Unlike the ‘To’ and ‘CC’ field though the recipient will 
not be able to see the other recipient’s email addresses that have been placed 
in the ‘BCC’ field. 
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Assigning Default Signatures 

Like other email client programs the Email Manager within ClinicOffice will enable you to assign a default signature to 
each email account being used on the system. The steps below will explain how to do this. 
 

• Go to the Email Manager within ClinicOffice 

• Click the New Email button 

• Click the Signature button and on the drop down menu select Manage Signatures 

• Click the New button 

• Enter a name and click OK 

• On the right hand side is a large text field where you can type in your signature 

• You can insert an image by clicking the Inline Picture button ( ), locate your local image and click Open 

• You can also insert a link to your website by clicking the Hyperlink button ( ) 
 

The signature may look something like the example below. 

 

• If you want the signature to automatically appear when you click to create a new email or are replying to an 
email, tick the bottom two checkboxes  

• Click the Save button once finished 
 

All that remains is to assign this signature to an email account. These next set of steps outline how to do this. 

• While still in the Email Manager click the Email Settings button 

• Click the blue link Email Account Manager 

• Select your email account and go to the Outgoing Server tab 

• Select your signature from the drop down menu on the Default Signature field 

• Click Save and Close 

 
Now when you go to send out an email via this email account your signature will appear at the bottom of the email. 
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Creating Emails Snippets 

A snippet is not the same as an email template. A snippet will allow for you to insert predefined text within the body of 
your email without replacing the entire contents of what you currently have in the email. For example, maybe it is a set 
of step by step instructions, such as how to locate the clinic or get into the building. Snippets are particularly useful if 
you need to reply to someone but want to keep the contents of their email still present. The steps below explain how 
you can create a snippet. 

 

• Go to the Email Manager in ClinicOffice 

• Click the New Email button 

• Go to the Insert menu (tab) at the top of the email screen 

• Click on the Snippet button and select Manage Snippets 

• On the next screen click the New button 

• Enter in a name and click OK 

• On the right hand side is large text field where you can type in your text 

• You can insert an image by clicking the Inline Picture button ( ), locate your local image and click Open 

• You can select one of the three buttons to insert bullet points into the text 
 

An example of what an email snippet could look like is show below. 

 

• When you are finished with creating your snippet, click the Save and then Close button  
 

You can now insert the snippet into the line of the email by clicking on the location you wish to insert the text or images, 
go to the Insert menu, click Snippets and select the name of your newly created snippet. 
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Creating Email Templates 

You would use an email template when you wish to modify everything within an email. So for example a newsletter 
could be a template. As the template replaces the email subject, the email’s text and any attachments it is best to use 
an email template for new emails as oppose to replying to an email or forwarding an email everything. If you prefer to 
insert predefined text or images within the current email, please see the topic “Creating Email Snippets”. The steps 
below explain how you can create a new template. 

 

• Go to the Email Manager in ClinicOffice 

• Click the New Email button 

• Go to the Insert menu (tab) at the top of the email screen 

• Click on the Template button and select Manage Template [the screen below will appear] 

 

• On the next screen click the New button 

• Enter in a name and click OK 

• On the right-hand side at the top of the screen you can enter the Email Subject 

• Below the tools is the main email body where you can enter the contents of the email 

• Like the snippets you can select to add images, hyperlinks, tables and adjust the size and fonts of the text 

• To add an attachment, right-click somewhere in the bottom File Attachments field and select Add 

• Locate the file you wish to attach and click Open 

• Once finished click the Save and then Close buttons 
 

You can now use the template by opening a new email, go to the Insert menu, click Template and select the name of 
your newly created template. 
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Sending Encrypted Emails 

With the advent of the General Data Protection Regulation (GDPR), it has become paramount that emails containing 
personal and sensitive data are encrypted and secured so that unwanted individuals do not gain access to such 
information. ClinicOffice supports two methods to keep your emails secure. 

 

Method 1 

The first method is by making sure that both your Incoming Server and Outgoing Server use either StartTLS or TLS/SSL 
as their security protocol. Your email service provider should support at least one of these options. There are slight 
differences between the two and how your emails are encoded, but the net result is that both will secure and encrypt 
the contents of the email being sent from ClinicOffice to your intended recipient. This will prevent anyone who is 
monitoring your network/internet traffic from reading the contents of the email. 

 

Method 2 

The first method is essential but will not cover you if you accidentally send the confidential email to the wrong person. 
This is where this second method comes into play by encrypting the email’s contents and its attachments in an additional 
manor. The steps below will explain how to do this. 

 

• Open up a new email 

• Insert in the recipient’s email address, email subject, the email’s contents and any attachments 

• Just right of the ‘From’ field tick the option Send as Encrypted Email 

• Click the Send button and the following window will appear 
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You can select to either generate a password by clicking the “Generate” blue link or enter in a password yourself. Please 
bear in mind that the original contents of the email will not be displayed to the recipient because it is now encrypted, so 
you will have to enter in the purpose of the email and explain that the contents of the original email have been encrypted. 
By default, there already will be something filled in for this but you can edit the text to suit your needs. 
 
When sending an encrypted email the recipient will need to know the password in order to access the encrypted 
contents. It is strongly recommended that you do this by another means such as calling the recipient or sending an SMS 
or even to email the recipient on another email address with the password. The reason is that it defeats the objective of 
encrypting the email and then sending the password in the same email because if the email was received by the wrong 
person then they will be able to unlock the sensitive information inside. So by doing this, it will be only the correct 
recipient that will be able to unlock the encrypted contents. The Encrypt Email screen already has an option to send an 
SMS to the recipient but you will need an SMS account with us in order to do this. The default SMS message already 
includes the merge field for the password that is merged in once the message is sent. 
 
Once you are happy with everything on the Encrypt Email screen click OK and the email will be sent, along with the 
SMS if you have selected to send this as well. 
 

Email Archiving 

If you are using a POP3 server for your emails then you will find that with time the number of emails increases the load 
time for the email. To improve performance you can archive old emails. To do this you can set up the auto archiving by 
clicking on the link “Auto Archiving Options” under the Email Settings. From the options window you can specify how 
often the auto archiving should be run, how old an email should be before it is archived and also an option to permanently 
delete emails after a set number of months if you want to delete them permanently from the database.  

Once an email has been archived you can still view it by ticking the option “Show archived emails” (also under the 
Email Settings). 

 

Other Options 

The Email Manager screen can be displayed in its own window, separate from the rest of ClinicOffice. To open the Email 
Manager in a separate window you need to tick the option “Show in separate window” which is towards the bottom 

of the Email Settings, log off and back on again and the next time you click on the Email Manager button it will open in 

its own window allowing you to view other screens such as the Diary at the same time. 

From the other options you can also view the Email Log by clicking on the Show the Email Log link. This will open a 

new window which will provide you with details of emails sent and received, along with any issues that were encountered 

when trying to send an email.    
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Voice Over IP Setup 

ClinicOffice can be setup to integrate itself with 

a VOIP service. The two services that it can 
integrate with are either Birchills VOIP or 

Skype. To use the Birchills VOIP service you 

need to setup an account with them and enter 
those details into ClinicOffice. If you have Skype 

already installed then ClinicOffice can use this 

to make outgoing calls with. 

You can access the VOIP settings by clicking on 

the lower half of the VOIP Calls button on the 
Home menu and selecting Configure VOIP 

Settings. The window to the right will now 

appear. 

You can either setup your Birchills Account or 
enter your Birchill account details by clicking the 

Configure my Birchills Account blue link. 

When you do, it will take you to the Birchills 
VOIP Account Setup screen. If you have not got 

a Birchills account you can click the More 
Information button, which will take you to a 

page on our website which will contain 

information on how to setup an account. If you 
already have an account you can enter your 

username and password in the perspective 
fields. You can click the Test Connection 

button when you have done that to see if your 

account details work. You can click the Go 
Back (VOIP Setup) link to go back to the 

main VOIP Setup page. 

A bit further down on the VOIP Setup screen 

are three options. Once you have configured 
your Birchills VOIP account you can select “Use 

my Birchills VOIP account”. This means any calls received through to your Birchills VOIP service will be displayed in 

a small pop-up window in ClinicOffice. If the number that is coming through matches one of your patient or contact 
records then their name will also appear on the pop-up window. You can also make outgoing calls, which will be 

mentioned later on and view a full history of your calls you have made through the service. 

If you do not wish to setup a Birchills account you can use Skype instead by selecting “Use Skype (if available)”. In 

order to use this option you require Skype to be installed on your computer and 1-click dialling enabled. Please note 

that Skype does not support incoming call notifications, however you still can make outgoing calls via ClinicOffice. 

If you do not wish to use either service, then you can select Disable VOIP and hide it from the user interface. 

Please note that these settings are on a per computer basis and will need to be entered on each machine you wish to 

use the VOIP service on. 

 

Receiving Incoming Calls 

If you have ClinicOffice setup with a Birchills VOIP account, then 
whenever you receive a call ClinicOffice will display a small popup 

towards the bottom right of your screen; just like the image to 

the right. 

Once the phone call has been answered the popup will remain on 

your screen for several more seconds and then will fade out. If 
you wish for the popup to remain on your screen then you can 

click the pin icon towards the top right. This will remain on the 

screen until you close the popup. 

As mentioned earlier on, if the telephone number that is calling is stored within a patient’s or contact’s record then their 

name will appear on the popup message. If you right click on the popup you can select their name from the menu and 
this will open their record. If the telephone number does not match any records then you can add it to a record by right 

VOIP Setup 

Incoming Call Popup 
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clicking on the popup and selecting Add to Record. When you do this you will be offered to add the number to either 
the person’s telephone or mobile number. Alternatively you can copy the number to a clipboard by selecting Copy to 

Clipboard. 

 

Making Outgoing Calls 

With both Birchills VOIP and Skype you can make outgoing calls. There are a couple of ways to do this. The first way 

is by clicking on the lower half of the main VOIP Calls button and selecting Make a Call; a small Call Number window 
will appear. Just enter in the number you wish to call and click the OK button. If you are using Birchills VOIP your 

phone will begin to ring, simply pick your phone up and it will dial out to that number. If you are using Sykpe this will 

then launch the Skype program and will begin to dial your number. 

The second way to make an outgoing call is to open either the patient’s or contact’s record and to click on the green 

phone icon ( ) which is present on the Telephone, Work Tel or Mobile fields. This will then dial the number present 

in that field. 

If you’re using Birchills VOIP you need to make sure that you have the correct extension number selected for your 
phone. If your phone is extension 105 then you need to set this in ClinicOffice. You can do this by either selecting your 

extension when you login to ClinicOffice (requires Birchills VOIP to be setup) or you can do so by clicking on the lower 
half of the main VOIP Calls button and selecting Select your Extension. From here you will be able to select your 

phone extension and click OK. If you do not select the correct extension when you go to make an outgoing call the 

number will dial through to the wrong phone. 

 

VOIP Call logs 

With the Birchills VOIP ClinicOffice can connect to the service and display a list of your incoming and outgoing calls that 
you have taken or made within a particular day. You can access this screen by clicking on the lower half of the VOIP 
Calls button on the Home menu and selecting Show Call Log. The screen below will appear. 

 

By default the grid will show you the calls that have been processed for today and it sorts the calls by time order. You 
can change this by clicking on the “Show call log for” field and select another date. Alternatively you can select a date 

by clicking on the calendar icon ( ) or the next/previous ( ) day icons. Under the column “Lookup Results” a 
patient’s or contact’s name will appear if the number for the telephone call is stored in their record. You can open their 
record by right clicking on the row and selecting their name. If the number is not recognised you can instead right click 
and select Add to Record if you know that the number belongs to a patient or contact. On the far right hand side is a 
Play column. By clicking on a play icon you can listen to the relevant telephone conversation.  
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Working with Types and Categories 

ClinicOffice allows you to define types and categories for records. 

To see a list of all the available types and categories in ClinicOffice v5, go to the View menu and click the Types and 
Categories button. You should see the following:- 

Types and Categories Menu 

 
 

As you click on one of the tabs on the left hand side of the window all the available options will appear on the right side 
of the screen. Most of the types/categories simply contain a list of values. Take a look at the Occupation List for example. 
 

To edit an entry in the list, simply double-click on it, alter the text and press Enter to save the change. You can 
obviously create a New entry or Delete an existing one by right-clicking and clicking New Record or Delete Record. 

Alternatively you can click the  or  buttons. 
 
You probably have also noticed that the field edit boxes which required you to select an entry from a type or category 

list always has a little button  at the bottom which is the edit category list icon. 
Take the bottom part of the Appointment Editor for example:- 

 
Type/Category Editor Button Example 

 

 

The idea is that clicking on this button will take you straight to the appropriate type/category editor so that you can 
change the list if you so wish. 
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By and large, all the Type/Category editors are the same with the notable exception of the Appointment Type editor and 
the Appointment Status editor which have some extra fields. Let’s take a look:- 

 

The Appointment Status Editor 

The Appointment Status Editor 

 

 

The first difference you will notice is that you can assign a colour to each Appointment Status. These colours appear 
down the side of the appointments in the diary, giving a visual indication of the status for each appointment. 

The third column is “Send Message?”, which allows you to select whether a “status change” message will be sent to 
the staff member when the appointment has changed to this status. 

For example, imagine that Mrs Whiting has an appointment to see Dr Smith. By default the Appointment Status in the 
diary will be set to None (the colour down the side will be grey). When Mrs Whiting arrives, the receptionist changes the 
appointment status to “Arrived”. If there is a tick in the Send Message column for Arrived (which there is in the above 
example) then ClinicOffice will automatically send a message to Dr Smith saying that Mrs Whiting has now arrived (this 
will change the colour down the side to yellow). 

The fourth column “Cancelled Status?” allows you to specify if you want to register the appointment status as a 
cancellation type status; this will mark the appointment on the diary as being cancelled. Also the status will appear under 
the “Cancel Appointment” section of the right click menu in the diary. 

The fifth column, “Hide in Diary?” will mean that when the appointment status has been selected it will hide the 
appointment from the diary, unless specified otherwise in the Diary Options. This is particularly useful when used in 
conjunction with the “Cancelled Status” as it will hide the cancelled appointment from the diary while it still exists on the 
database. 

Lastly the sixth column, “Deleted?”, when ticked will make the appointment status inactive so that you can no longer 
select it on the diary or in an appointment. The value however will remain present in appointments that have already 
had the status assigned. You can hide the appointment statuses marked as “Deleted” on the Appointment Status editor 
by un-ticking the Show Deleted Items checkbox.  



- 149 - 

The Appointment Type Editor 

Like the Appointment Statuses you can assign each Appointment Type a unique colour. Simply double-click on the 
colour field to select one from the pre-defined list or from the provided colour-selector. This serves as a visual aid to 
identifying each appointment type. Since the colour changes the background of the appointment on the diary it’s good 
to use lighter pastel colours which won’t obscure the text. 

The second thing you will notice is that you can choose the Default duration of that appointment. ClinicOffice will now 
notify the user if they have assigned the incorrect time to an appointment of that type and offer to auto adjust it. 

You can also mark an appointment type as being “Bookable Online?” which will allow patients to select that type when 
booking online. This will only work if you have our Online Diary module. 

You can assign a default charge amount to an appointment type via the Charge Item column; this is a drop-down menu 
which pulls its information from Items/Services section of ClinicOffice. For more information about how this works please 
see the next section “Creating a New Appointment Type”. 

 

Appointment Type Groups 

Depending on the services your clinic offers you may require dozens or even hundreds of different appointment types. 
This can be confusing for the staff when trying to locate the correct appointment type for an appointment. This is where 
groups can help to organise your appointment types. 

You can create an appointment type group by clicking on the blue link Edit Groups…, which sits above the appointment 

type grid. The Appointment Type Groups window will open, click on the small plus  button at the bottom and type in 
the name of your new group. You can add as many groups as you like to this section. Once finished, click the Close 
button. 

By default, the Group column will not be displayed within the Appointment Types editor; to display it, tick the Show 
Appointment Type Groups checkbox (next to the Edit Groups blue link). The Group column will appear, and you can 
now assign your appointment type group to the appointment types. 

 

Assigning Appointment Types to Practitioners 

Another helpful feature is the ability to assign specific appointment types to certain practitioners. This is useful if 
appointment types can be handled only by certain practitioners. This also helps to eliminate the possibility of an 
appointment type being assigned to the wrong practitioner.  

 

You can access the above screen by clicking the Assign Appt Types -> Practitioners button. To assign a staff member 
to an appointment type simply select the appointment type on the left hand side, then select your practitioner you wish 
to assign and click the top arrow pointing to the right. This will move that practitioner into the Assigned column. If there 
is an appointment type that all practitioners can perform then it is best that you leave everyone in the Unassigned 
column; this way you can assign the appointment type to all practitioners when in the diary. 
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Creating a New Appointment Type 

 
Creating a new appointment type is a twofold process. The first part is where you must create a new Item /Service. The 
second is where you must create a new Appointment Type inside the Types and Categories and then link up the 
Item/Service with it. This is so that when an invoice is raised for this appointment type a value will be automatically 
generated for it. If you do not wish to have a default charge for an appointment type, you can skip the first stage. 

 

First Stage 

• Go to the Items & Services grid. To do this either click on the drop-down menu on the FINANCES button and 
select Items/Services or go to the Finance section and click on the ITEMS & SERVICES button in the Finance 
Centre. 
 

• Right-click on the grid 
 

• Select New Item/Service, the Item/Service editor will open 
 

• Enter a name into the Description field i.e. “Domiciliary” 
 

• Enter a value into the Item Code field. Most of the time this would be the same as the description.  
 

• Enter a value into the Sale Cost field 
 

• For an appointment type you can leave the Purchase Cost and Tax Percent fields empty 
 

• For the Category field select Service, you may use another category type if you wish 
 

• You can leave the Supplier and Notes field empty 
 

• Once you have finished entering in all details click SAVE AND CLOSE 
 

Second Stage 

• Go to the View menu 
 

• Click on TYPES AND CATEGORIES 
 

• Inside the Types and Categories window, click on the Appointment Types tab (down left-hand side) 
 

• Now create a new item by clicking on the  button (located near the bottom) 
 

• Enter the Appointment Type’s name (usually the same as the Description of the Item/Service) 
 

• You can assign it a colour if you wish 
 

• Give the appointment a duration time  
 

• For the Charge Item column select you’re Item/Service; the Item/Service will be displayed in the list as it’s Item 
Code rather than it description. 
 

• Once you are done click CLOSE 
 

Now when you go into your diary to create a new appointment you can select your new appointment type. Also when 
you raise a new invoice a default charge will be raised. 

You will note that at the top of the Appointment Types screen is a button called Assign Appt Types -> Practitioners. 
If you click on this a new window will open. From here you can assign appointment types so that only certain members 
of staff can perform them. 

To do this simply select an appointment type and highlight the desired staff from the Unassigned column, then click the 
Add Selected button to add them to the Assigned column. If you want everyone to be able to perform that appointment 
type you can leave them all in the Unassigned column.  
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Patient Recall 

The Recall System allows you to remind patient’s that they are due another appointment and that they need to rebook 
it. The way in which it works is like the Waiting List, but the Waiting List is something definite i.e. the patient already has 
confirmed the appointment but is waiting for the correct time to be available. On the other hand, the Recall is not 
something definite; it serves more as a reminder that the patient should rebook for another appointment. 

 

The recalls are stored in a panel which is located to the right-hand side of the Appointment Diary and it comes in the 
form of a tab. 

 

The Recalls Panel can be broken down into the following options: 

 

 

Show This allows you to select the range of Recalls 
you wish to display. Such options are all 
patient recalls, due today, due next week or 
overdue recalls. 

Patient This allows you to search on an individual 
patient’s recalls.  

Use Active Patient This inserts the active patient’s name 
automatically into the patient search field. 

Staff Filter When a staff is selected here only the recalls 
assigned to them will appear. 

Display tel nums This displays the telephone numbers on the 
recalls if one exists for the patient. 

Display notes This displays any notes that have been 
added to the recall. 

Only show if no 
reminder sent 

This will hide all recalls where a reminder has 
already been sent.  

  

When the recall is due for today the text will turn a bold blue, but when it is overdue the text turns red. If no reminder 
has been sent and the recall is overdue as well, then an exclamation mark will appear at the top. As soon as a reminder 
has been sent the exclamation will turn into a bell icon, indicating that the reminder has been sent.  

You can change the recalls that are on display by changing the value in the Show field. For example, if you set it to 
next week then only recalls that are due up for next week will be displayed. On the other hand, if you select Overdue 
Recalls, only recalls that have not been dealt with for their given date will be displayed. 

When the patient has confirmed an appointment time you can drag and drop the recall onto the diary. This will 
automatically create the appointment for you.  

Recalls Panel 
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Creating New Recalls 

There are multiple ways to create a new recall. Follow the steps below to see how to create a recall using one of the 
methods: 

• Go to the Recalls Panel 

• Right click on the section where the appointment recalls are stored and select New Recall; the following 

window will appear: 
Patient Recall Editor 

 

• Enter the name of the patient you are creating the recall for 

• You can choose to enter the name of the practitioner and the App Type if you wish to 

• You will need to enter the duration of the appointment. You can select one of the values given or enter your 
own. 

• You now need to enter the Recall Date. If you click the  icon it will give you a list of preselected values.  

• Click OK when you have finished 
 

The new recall will be added to the Recalls Panel.  

 

Another way to create a new recall is to right click on an appointment in the diary and to select the Recall Patient. The 
Patient Recall Editor will open up and you will note that some of the field values have automatically been filled in. You 
can do the same by opening the appointment record up and clicking the Recall Patient button. You can also drag and 
drop the appointment straight onto the Recalls Panel and this will again open the Patient Recall Editor. Inside the Patient 
Editor on the ribbon bar there is the button Recall Patient, which also opens up the Patient Recall Editor in the same 
manner. 

 

 

Sending Out Recall Reminders 

There are two ways of sending out a recall reminder. You can either send out an individual reminder for a single recall 
or send out multiple reminders to a group of patients who match a certain criteria at a specific time.  

To send out a single reminder please follow the steps below: 

• Open a reminder via the Recalls Panel 

• Click on the blue link which says Recall reminder has not yet been sent 

• Select Send Reminder 
 

To send off multiple reminders please see the section “Creating a New Rule” under “The Patient Contact Centre”. 
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As soon as a reminder has been sent out the blue text will change at the base of the Patient Recall editor to show the 
method of contacting the patient and the date and time it was sent out. It might look something like the example 
below: 
 
Recall Reminder [Letter] sent on 24/08/2009 at 15:39 
 

 

Deleting Recalls 

You can delete either a single recall or a set of recalls which are older than a specified time. To delete a single recall 
simply go to the Recalls Panel right click on a recall and select Delete Recall. Alternatively go into a recall and click the 
Delete button. 

To delete multiple recalls right click on the section where the appointment recalls are stored and select Delete Expired 
Recalls. You can choose to delete either 1 Month, 2 Months, 3 Months, 6 Months or 1 Year. Press OK after you have 
selected. This will only affect overdue reminders. 

 

 

Patient Information 

The Patient Information is a helpful utility that is in the Appointment Diary. At a quick glance it can tell you the essential 

details about a patient. You can access the Patient Information window by clicking on the Patient Info button  
(next to the diary’s Search button). The following window will appear: 

 

 

Once the window is open, all you need to 
do is left-click on an appointment and open 
the window. The details of the patient who 
is attending this appointment will be 
displayed. 

By default the window will display patient 
information such as the home telephone 
number, work telephone and date of birth 
to name a few. It will also show 3 display 
cards of the account balance, total 
appointments booked and number of 
cancelled appointments. A bit further down 
it will display the most recent 
appointments. At the bottom it will show 
past appointment statuses on a pie chart 
i.e. completed or cancelled. To the left of 
this is an image of the patient if you have 
one for them. 

You can change the view of the Patient 
Information window by clicking on the drop 
down menu in the bottom left hand corner 
and selecting “Compact”. When the 
compact view is selected the Patient Info 
screen changes so as only to display the 
patient’s image and their basic information. 

You can resize the Patient Info window 
like many other windows in ClinicOffice 
and then save this size by clicking the 
“Set Size” blue link at the bottom of the 
window.  

The Patient Info Window 
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Editing the Patient Information Window 

At the bottom of the Patient Information window you will note there is a “Design” link. This will take you to a new 
window that will allow you to customise the appearance of the Patient Information window. You will have to edit each 
view separately. So, for example if you want to edit the Default view you would select “Default” and then click 
“Design”. If you wish to edit the Compact view you would select “Compact” and then click “Design”. The Dashboard 
Designer Window will appear. 
 
 

 
At the top of the screen are the buttons to save the edited dashboard, to undo and redo any changes, to edit the 
dashboard’s SQL sources and also buttons to insert new components into the dashboard. The last 3 buttons on the 
ribbon bar will allow you to duplicate the current dashboard, to delete it and alter the currency. You will note that there 
are some additional tabs on the ribbon bar and these will change according to the component you have selected on 
the dashboard designer. For example if you have a grid selected then these tables will change to the Grid Tools.  
 
The way the dashboard works is that each component will have its own SQL source. When you click on a component 
such as Patient Info the drop down menu field will change to Patient Info. In turn just below that you will see the 
values: “name”, “value” and “id” appear. You will note that under Data Items the items “name” and “value” will be 
inserted. In this particular instance the grid is being grouped and summed up based on the patient’s id. You can see 
this because the item “id” is inserted under the Measure section. 
 
When adding a new component into the dashboard, from the insert section of the ribbon bar, you need to select a 
SQL source first, form the drop down menu field. Once you have selected this you need to add items from that source 
into the Data Items columns so that information can be displayed. You can choose to hide some items by dragging the 
items to the Hidden Data Items section. You would do this if you wish to sort by that item’s value but not display it. You 
can measure or summarise data by dragging another item under the Measures section. Any changes made you can 
select to save them by clicking on the Save Dashboard button.   
 
The Dashboard Designer has many advance components and because of this it is recommended that you seek the 
direction from our technical support team (support plan required) before it is used. Alternatively you can post on our 
support forum (www.clinicofficeforum.com) for advice and aid in using this feature.  

Patient Info Dashboard 
DesignerWindow 

http://www.clinicofficeforum.com/
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Patient Contact Centre 

The Patient Contact Centre is where you choose the ways in which you wish to contact your patients. For example, you 
could tell ClinicOffice that you would like an SMS message to be sent the day before each appointment. Once the rule 
is setup and told to run, then ClinicOffice will automatically process the rule for you. 
 
You can access the Patient Contact Centre by clicking on the lower half of the Patient button (within the Home menu) 
and clicking the Patient Contact Centre. 
 

 
 
The Patient Contact Centre will appear in a separate window and will look like the window below. From here you can 
create new rules, edit existing ones, preview and run the rule. 

 
 

Creating a New Rule 

To create a new rule click on the NEW RULE button, (or right-click and then select New Rule) the following message 
will appear. 
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You are presented with 5 different options: Appointment Reminder, Appointment Booking; Recall Reminder, 
Appointment Based Rule or a Patient Based Rule. The difference between the 5 will be shown soon. 

 

Appointment Reminder   

If you select Appointment Reminder the following window will open:- 
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The Rule Editor will allow you to:- 

• Name the rule and add a description. 

• Specify that a consent type is required before a patient can receive a message 

• Schedule the rule so that it will run either manually, send a reminder to run it or run it automatically. 

• Select the day you wish to run the rule and when it is next scheduled to run. 

• Select which member of staff you wish to run the rule and on which computer 

• Set the conditions that the rule is to run on. 

• Delete the rule. 

• Run the rule. 
 

To understand how this editor works follow the example below:- 

• In the Contact Rule Editor [Appointment Reminder] window enter a name in the Rule Name field. 
 

• Select Reminder which is under Rule Scheduling near the top. 
 

• Select Run every: 1 day(s) at 12:00. 
 

• In the field Next Run is scheduled for select yesterday’s date so that a reminder message will appear today. 
 

• Click the three little dots which are in the Only run for these users field. A list of staff members will appear. 
Select the staff you wish to receive the reminder about running the rule and press OK. 

 

• Click the three little dots which are in the Only run on this computer field. Your computer name will appear 
indicating that the rule will run only from this computer. 

 

What you have done so far is set the rule so that it will send a reminder message to you every day at 12 o’clock. As the 
next scheduled run was yesterday you will receive a reminder shortly after you have created the rule. 

 

Now to set the rules conditions:- 

• Where it says Send a reminder 1 day(s) before the appointment, left-click on the 1 day(s) and set it to 2 
day(s). 
  

• Where it says Only for appointments with the following staff left-click on the [set value] and choose one of 
the staff members. 
 

• Select [Yes] for the Exclude cancelled appointments from this rule. 
 

• Now set the value to Active for Only for patients with the following status. 
 

• Left-click on the blue text which says [Click here to setup reminder], the Appointment Reminder window will 
open. 
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If you haven’t already done so, you will need to enable the SMS service in order to send SMS messages. Likewise you 
will need to setup your email account details so that you can email patients.   

You can send a reminder to patients by either sending an SMS message, an email or a letter. In the Text/Email 
preference field you can choose to either send an SMS first then try an email, send an email first then try an SMS or 
do both at the same time. You can choose to use all 3 options or just one of them. To select one of the methods simply 
tick the box that is found at the top of each section. 

You enter information into the SMS Message and Email fields the same way you would when entering information into 
either the SMS Message or Email windows (See the section Sending SMS Messages and Emails).  

 

• For this example select Create a Letter and press OK. 
 

• You can either wait for the Scheduled Rule message to appear and then run the rule from the message or go to 
the Patient Contact Centre select this rule and click RUN RULE. The Patient Contact Centre Rule Processor will 
appear:- 
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• If you are happy with the patients selected click Process Actions. 
 

• The Rule Processor will now work through each patient informing you if the process was successful. 
 

•  Since these are letters that have to be printed out COv5 will store them in order to do this. 
 

• To view these, click on the VIEW CREATED LETTERS in the Patient Contact Centre Rule Processor, then click 
on the Appointment Reminder Letter. You can also view them by going to the Patient Contact Centre and left-
clicking on the blue text which says There are some documents which need to be printed – click here, then 
select Appointment Reminder Letter.  
 

• The ClinicOffice Word Processor will now open with the new merged letters being displayed. If everything 
appears to be okay press the PREVIEW button located in the ribbon bar.  
 

• To print the letters click the PRINT button.  
 
 

After the letters have been printed, COv5 will clear those newly printed letters from its memory. In the Appointment 

Diary you will notice a small letter icon ( ) appear on appointments when a reminder has been sent. 
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Appointment Booking Rule  

When you select Appointment Booking the following window will appear:- 

 

The Appointment Booking rule although based on appointments, works on a different basis to the Appointment 
Reminder. The Appointment Reminder works on the basis of the date of the appointment; however the Appointment 
Booking is based on the “Created On” date of the appointment instead. 

So the purpose of the Appointment Booking rule is to send an email or text message to the patient, to confirm that their 
appointment has been booked. What this means is that if a new appointment is created for next week or it is booked for 
next year, in both situations that appointment would receive a booking confirmation message when the rule runs. This 
is because the created on date would be today for example. 

If you wish to run the rule automatically each day this is fine, but given the nature that the rule will send out messages 
based on when the appointment has been created it is usually recommended to set the rule to run towards the end of 
the day. Doing it this way, people will more likely receive their confirmation on the day the appointment has been created. 

What if an appointment is created after the rule has already run for the day?  

This is not a problem as the Appointment Booking rule does have a tolerance setting (7 days by default). What this 
means is that it will factor in the created on date for appointments from the past 7 days for example. So if an appointment 
was created yesterday but did not receive a booking confirmation message, then the rule will still pick up on it and send 
out a message for it. 

Is there a risk that a patient might receive more than one appointment confirmation? 

The short answer to this is NO. Once a confirmation message has been sent out for an appointment, another one will 
not be sent. The only way they might receive more than one booking confirmation at the same time is if they have had 
more than one appointment booked for them at the same time, but this will still only be one message per appointment. 
If they happen to have two appointments on the same date but they are different appointment types you can always 
specify that only certain appointment types receive a booking confirmation.  
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Appointment Based Rule  

If you select Appointment Based Rule the following window will open:- 

 

The Appointment Rule works in the same manner to the Appointment Reminder. There are just a few things that are 
different.  

One of them is the Appointment Based Rule has a tolerance rule in addition to the trigger rule. If you have the trigger 
rule set to 3 Day(s) After an appointment, all appointments 3 days ago will be selected. If you have the tolerance rule 
set to 2 Day(s), all appointments from 3 days ago to yesterdays will be selected. What this rule does is extend the 
number of days covered. 

The problem with the tolerance rule is it will carry out the function (i.e. sending a letter to a patient) on the same 
appointment every time the rule is run, so long as the appointment falls into the range of the tolerance rule. This can 
mean that patients could receive a dozen letters. So to get around this the Appointment Based Rule has the rule Only 
run the rule ONCE for each appointment, which is located towards the bottom of the editor. You are given the options 
of [Yes] and [No]. 

One of the usages of the Appointment Based Rule is to send a letter reminding the patient that they need to book 
another appointment. To assist you there is a rule which states Only if the patient has no appointments after this 
one. If you select [Yes] to this then only patients who have no future appointments after this one will be sent a letter. 
As a patient might be seeing the clinic for more than one treatment type there is an option Only look at appointments 
of the same types which will help up narrow down on the patients who should receive a message. 

You will also notice that at the bottom of the Contact the Patient window (accessed by clicking the link Contact the 
patient: [Click here to setup]) there is a greater variety of merged letters to send compared with the Appointment 
Reminder Rule.  

Apart from these differences the Appointment Based Rule is the same in every other way to the Appointment Reminder.    
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Recall Reminder 

If you select Recall Reminder the following window will open:- 

 

The Recall Reminder is like the appointment reminder except for the fact that it is based on recalls instead of 
appointments. The recall reminder is one the simplest reminders to set up. 

You have the option to send out the recall reminders either for the ones that are due today, this week or this month. 
There is the option to include overdue reminders as well. If you do leave it as No then any overdue recalls will not 
receive a reminder. 

The Recall Reminder only requires 3 additional filters. They cover the clinics, the types of recalls and the staff member 
that the patient’s recall is assigned to. You can also choose to send this reminder out more than once for the same 
group of recalls if you wish.    

You will also notice that at the bottom of the Contact the Patient window (accessed by clicking the link Contact the 
patient: [Click here to setup]) there is by default a small selection of letters to choose from. 
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Patient Based Rule 

If you select Patient Based Rule the following window will open:- 

 

The Patient Based Rule is unlike the other three in that it is purely based on the patient’s record. It is identical though 
in the way it works. The patient rules that are used here, are in the same format as the other three rule editors. One of 
the most noticeable features about the Patient Based Rule editor is that you can perform three actions unlike the other 
three rule editors (these can only perform one).  

 

The three actions that can be performed are:- 
 

• Contact the patient This allows you to send an SMS message, email or letter to the patient. 
 

• Flag the patient By using this action you can choose to flag a patient’s record. 

 

• Remove patient flags This action will remove a particular flag from the patient’s record. 
 

The Patient Based Rule runs on the same principles as the other three rule editors. This means that to create a rule for 
this is similar to creating a rule using either three of the other editors.  

 

The best way to use the Contact Rule Editors is to break them down into parts. Each section makes sense when you 
read through it. Before using the rule editors on a regular basis it might be an idea to do one or two test runs. To delete 
a rule simply right-click on it in the Patient Contact Centre and select Delete.  
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Task List 

Another feature of ClinicOffice v5 is the Task List. You can view your tasks by clicking on the My Tasks tab on the left 

hand side of ClinicOffice. 

 

As shown just above, the task list displays all the tasks that you are permitted to look at. The list shows each task’s 

priority, description and any notes for the task. 

There are also two task groups, My Tasks and Global Tasks. Global Tasks appear in everyone’s task list, which is useful 
when a task needs to be done but it doesn’t matter who does it. But Personal Tasks belong to you, these appear in 

your list, but no-one else can see them.  

 

New Task Create a new task (see “The Task 

Editor” topic). 

Refresh Refreshes the task list. 

Settings This either hides or shows a number 

of options related to the Task Panel. 

Show future tasks This will display future tasks. 

Show global tasks This will display tasks that are global. 

Show flagged email This will show flagged emails. 

Show completed tasks This will show completed tasks that 

have not been deleted yet. 

Display task notes Displays the notes for each task. 

 

You can also right click on the tasks in the list. You will be presented with the options: New Task, Edit Task, Delete 

Task, Mark as Completed, Refresh and Print Tasks. 

To create a new task click the New Task  button. Alternatively click the Tasks button which is on the Home menu of 

ClinicOffice. 

To edit a task, simply double-click on the task via the task list. This brings up the Task Editor, which we’ll take a look 

at now.  

  

The Task List 
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The Task Editor 

The Task Editor lets you create, view and edit the task items in your task list. 

The Task Editor  

 

This screen is fairly self-explanatory. The Task Description is obviously a description of the task. You can add extra 

notes in the Notes field if you need more space. 

You can link a patient or contact to the task. You can also assign a Task Priority level to the task. Higher priority tasks 

appear further up the task list which is useful. The Due date is the date and time the task needs completing by, to 

help with this you can set a Reminder. If you have multiple clinics, then a task can be assigned to a specific Clinic. 

Lastly there are three settings for the Task Assignment:- 

• This is a PERSONAL task for me   This task only appears in your list.  

• This is a GLOBAL task for this clinic  Global tasks appear in everyone’s task list. All users have full 
access to public tasks. 

• This task is assigned to the following staff... 
       This will allow you to attach the task to a staff member. 

 
If the task has been completed tick the box Task has been completed (above the notes field). This will put a 

strikethrough the task to indicate its completion. Click the Save button to save the task. 

 

Task Reminders 

When the task reminder is due, you will get a popup window 

appear like the one to the right. 

Task Reminders are very similar to the Message windows (see 

“ClinicOffice v5 Messaging”). Up to 4 task reminders will stack 
within the same window. You can view all tasks by right 

clicking on the window. From this window you can Snooze All  

( ) tasks or Mark All As Completed ( ). 

Task Reminder 
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Clinical Notes 

Clinical Terminology 

ClinicOffice uses a structured method to record a patient’s clinical history. Here’s an overview of the terminology used 

in ClinicOffice to describe the different elements of a clinical history. 

 

• Cases 

A patient who is being treated at your clinic will have one or more open cases. In most instances you will first 

create a new case record for a patient when they first visit your clinic for an initial consultation. The case record 

will remain open until you discharge the patient or are no longer treating them for whatever reason, at which point 

the case is closed. 

A patient may have more than one case open at a time. For example, if a patient is being treated by two separate 
practitioners for two different conditions, then he/she will have two open case records – one for each condition / 

treatment plan. 

A case record has the following fields:- 

a. A unique Case Reference number (generated by ClinicOffice) 

b. The Case Type (user-definable e.g. a specific diagnosis, complaint or condition) 
c. The Primary Staff (the member of staff who is primarily responsible for this case) 

d. Case Opened (i.e. when the case was started) 
e. Case Closed (i.e. when the case was closed) 

f. The Outcome (user-definable list e.g. “patient better” or “patient discharged self”) 

g. A Case Notes field 

h. Additional Custom Fields of your choice 

 

• Sessions 

Session records are usually linked to appointments – i.e. one session record is created for each appointment 

that a patient has. A session record contains your clinical notes for each patient visit. 

In most cases a session record will simply contain treatment notes from a patient visit, but we chose the generic 

term ‘session’ for ClinicOffice, because session notes are also used to record initial consultations, diagnostic 

sessions, x-ray appointments etc. 

Every session record must belong to a case (see above). For example, let’s say a patient presents with a specific 

complaint. He receives a course of 10 treatments over the next few months, after which he is better and is 

discharged. 

Presuming that the patient had no prior history with your clinic then his Clinical History would consist of one 

case record which contains ten session records. 

A session record contains the following fields:- 

i. The Date & Time that the session took place (usually linked to an appointment) 
j. The Appt Type (appointment type, user-definable e.g. consultation, treatment, x-ray etc.) 

k. The Staff Member who handled the session 

l. The Room where the session took place 
m. The Outcome (user-definable list e.g. “patient better” or “patient discharged self”) 

n. The Clinic Name of where the session took place (used if managing multiple clinics) 
o. Four customisable notes fields (Subjective, Objective, Assessment, Plan) 

p. Additional Custom Fields of your choice 

 

This Case/Session paradigm forms the backbone of a patient’s clinical history in ClinicOffice. There are however 

additional elements of the clinical history which augment the cases and sessions. These are Forms, Visual Notes, 
Images and Documents/Files. Collectively, they are referred to as ‘attachments’ because you can attach them to 

case records or session records or the overall patient record. 
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1) Clinical Forms 

This basically lets you design a form template much like you would design a paper questionnaire form. You can 

add questions of different types to the form (e.g. yes/no questions, questions which require answers to be selected 

from a pre-defined list, numerical questions, free-form text questions etc.). 

You can design any number of form templates (e.g. you may have one for ‘Case History’, another for ‘Diagnostic 

Findings’ etc.) which can then be attached to a clinical history. 

(Please see the topic “Designing Forms” for more information.) 

2) Visual Notes 

The Visual Notes area is an optional add-on module for ClinicOffice v5. We have included a library of pre-defined 

Clinical charts and diagrams for you to use (although you can also import your own). The idea of Visual Notes is 
that you can draw on an image to give a visual representation of a patient’s complaint/condition/symptoms etc. 

etc. There is also a small notepad (can be opened by pressing the Notes button) so that you can add any additional 

notes to the image. 

3) Images 

ClinicOffice allows you to attach images (in a JPG or BITMAP format) to a clinical history. This could include such 
things as a scanned image of a patient x-ray, a postural picture of the patient taken with a digital camera or even 

scanned paper documents detailing the patient’s history. 

4) Documents and Files 

ClinicOffice also allows you to attach any other type of computer document or file to a clinical history. This could 

include word documents, excel spreadsheets, text files – any file type at all. 

 

By way of summary then, a patient’s clinical history is composed of one or more case records, each of which can 
contain any number of session records. Additionally, you can attach forms, visual notes, images and 

documents/files to any part of the clinical history. 
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The Clinical Summary 

A patient’s clinical history can be represented by the Clinical Summary window as shown below. 

 

The Clinical Summary displays all Cases, Sessions, 

Attachments, and the Patient’s Details in one window. The 
purpose of this is to give an overview of a patient and a 

quick way to send out patient information to 3rd party 
medical providers such as a patient’s GP. A few of the 

clinical summary components are explained below and are 

based on the numbering in the image to the left. 

 

1) This drop-down menu works like an index, it allows 
you to select a section of the patient’s clinical notes and will 

take you straight to that section. 

2) This Print button will take you to the print preview 
screen for these notes and from there you can print them off 

or save them as a PDF document. 

3) This button is the “Send via Email” and when clicked it 

will offer to either email the patient or to email the patient’s 
general practitioner. If the patient does not have a GP 

assigned, then the email will be addressed straight to the 

patient. When your email window appears, it will insert the 
relevant email address and attach a copy of this clinical 

information all zipped up. 

4) This “Send to Word Processor” button will send this 

clinical summary to your local word processor program (for 

example Microsoft Word or LibreOffice Writer). This is for the 
purpose that you can perhaps remove or format information 

before sending it on. 

5) Allows you to specify to load six or twelve months, one 

or two years, or to load everything. This is useful when a 
patient has notes dating back over many years and to 

reduce loading times. 

 

The Clinical Summary will arrange and display the details the same way the Clinical Note Navigator is arranged. 

Clinical Notes Navigator 

 

If you want, move an attachment such as a visual note and assign it to another session or case, simply left click on it in 
the Clinical Notes Navigator, then drag and drop it onto the desired session or case. You can assign a session to a case 
or note by using this method. By doing this you will affect the layout of the Clinical Summary for that patient. 
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Creating Cases and Session Notes 

The most common way to create session notes is from the Appointment Diary. To create a session for an appointment, 

simply right-click on it then click View Session Notes as shown below:- 

 
Creating Session Notes from an Appointment 

 

 
When you create a Session Note for an appointment, ClinicOffice firstly needs to know which Case the session belongs 

to (please see the previous topic for more information), so a message will appear giving you the option to assign the 

Session Note to a Case or the option to create a new Case.  

Case Selector 

 

If the patient already has more than one Case, then select the appropriate one and click OK. If there are no Cases, 

then ClinicOffice will automatically create a new one.  

By using this method to create a new Session Note, details such as Date & Time, Appointment Type, Staff Member, 

Room and Clinic Name will be automatically filled in. Also if you create a Case this way, then the Case Opened and 

Primary Staff fields will be filled in automatically for you as well.   

You can also create a Session Note or a new Case when you are inside the Clinical Notes window.  
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Clinical Note Ribbon Bar 

By clicking the NEW button on the ribbon bar, a small menu will appear allowing you to select either a new Case 

Record or Session Record. If you create a new record using this method, then certain fields do not generate any 

information that would have done using the previous method.  

After selecting (or creating) the case you will then be presented with the Session Editor to enter the session details, this 

leads us on to our next topic.   

 

The Session Editor 

The Session Editor allows you to create, edit or modify session records. 

The Session Editor 

 

The session editor has two pages: 

1. Session Details 

This page contains the main fields used to record session information. It contains the basic fields like the 

session’s date and time, the session type, the patient and staff involved etc. 
 

There are also four notes you can use for clinical notes. By default ClinicOffice uses SOAP notes (Subjective, 
Objective, Assessment, Plan). You can stamp any of the 4 notes field with your name (whoever you are logged 

on as) the date and time simply by right-clicking and selecting Stamp Notes. Also via the right click menu you 

can select Show Previous Notes (shortcut is CTRL-H keys), which will open up a screen and will show you 
the previous notes for the field you have selected. From there you can select to copy those previous notes into 

the current note field if these are applicable for the current note. 

2. Custom Fields 

This page allows you to define additional custom fields that you would like to store for each session record. For 

more information on how to use custom fields, please see the Designing Forms topic.  
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The Case Editor 

The case editor allows you to create, edit or modify a case record. 

The Case Editor 

 

The case editor has two pages:- 

1) Case Details 

This page contains the main fields used to record case information. The Case Ref is a unique reference which 

is auto-generated by ClinicOffice. You can use the Case Type to define what the case is for. For example, you 

could assign each case type as a body part; so, each case pertains to a different section of the body you are 

treating. The case type description will also show when assigning a session note to a case.  

You can also use this screen to close a case, set the case outcome or enter case notes. Just like the session 

notes you can also stamp the case notes with your name, date and time.  

2) Custom Fields 

This page allows you to define additional custom fields that you would like to store for each case record. For 

more information on how to use custom fields, please see the Designing Forms topic. 

 

Attaching Additional Records 

As mentioned previously you can attach a Clinical Form, 
Document/Image or a Visual Note to any Session or Case 
Note. To create one of these additional records, go to the 
ribbon bar (in the Clinical Notes) and click on the Attach 
button. Select one of the options i.e. Clinical Form.  

This new record will attach itself to the Session or Case that 
you have selected at the time. You can move this, by left-
clicking on the record in the Navigator and then dragging and 
dropping it on the desired Case or Session. If you do not want 
it to be assigned to any other record, then drag and drop it 
onto the patient’s name which is at the top of the Navigator. 

 If you wish to delete a record, then left-click on that record 
once and press the DELETE button which is in the ribbon 
bar. You can also delete a Case or Session using the same 
method. 
 

Attached Record to Session Note in Navigator 
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With Visual Notes you can import images, which can be edited in the same manner. You would do this by clicking on 
the IMPORT FROM FILE button which is in the bottom left of the Visual Note Templates window. For further information 
please see the “Visual Notes” section.   

 

Printing the Clinical Summary 

There are times when you need to print off a patient’s clinical notes. Located in the top right-hand corner of the Clinical 

Summary window there are two buttons, the Print Preview ( ) and the Send To Word Processor ( ). These 
enable you to print off the clinical notes. 
 
When you click the Print Preview button, this opens the ClinicOffice Print Preview window. From here you can 
choose to alter the size of the margins, the orientation and scale. You cannot alter the layout of the content from here. 
Once you are happy with things click the Print button (located top left on ribbon bar).  
 
If you click the Send To Word Processor button, this will export the clinical summary to Word. With Word you have 
greater freedom to edit the content layout. This is recommended if the standard Print Preview is not displayed the way 
you want it. You can then print the summary from here.  
 
 
  

Attaching/Viewing Other Document Types 

ClinicOffice can store any type of external document. If it is not an image or PDF file, then ClinicOffice will open it with 
your default program. For example, if you store a “.doc” file inside the Clinic Notes and go to open it, ClinicOffice will 
open it using your default word processor.  

 

To attach a document that is not an image, follow the steps below: 

• Go to a patient’s Clinical Notes 

• Click the Attach button on the ribbon bar and select Document/Image; the Attach Documents/Images 

window will appear 

• By default, the file type will be set to search for image files only. Change this to All Files (*.*) 

• Locate the document you wish to attach and open it 
 

The document will be added to the patient’s Clinical Notes. You may wish to move this to a Case or Session if it is not 
attached to the correct one (see “Attaching Additional Records”).  

 

Viewing Documents on the Clinical Notes 
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When you left click on the document ClinicOffice will state that it is unable to automatically preview the file (as it does in 
the image above). You will instead be provided with two options: 

 

1) Open a COPY of this file with the associated program 

This will open a copy of the document into its default program. This means that it is not the original from ClinicOffice 
and hence any changes made will not be saved to the same location. Instead you would have to save it to your computer 
hard drive and re-import it if you wished for the latest changes to be present in the patient’s Clinical Notes.  

 

2) Open this file FOR EDITING with the associated program 

This will open the original document that is contained in ClinicOffice. Any changes made to it can be saved straight back 
into ClinicOffice. This can be done by pressing the Save Changes button in ClinicOffice once any changes have been 
made to the document.   

 

 

Viewing Scanned/Imported Images 

When you scan or import an image into the Clinical Notes, such as a letter, 

you might find that the image is too small to read or that it is displayed 

landscape (instead of portrait). This can be annoying when you are going 
through the patients details and you must read the details on the image. 

ClinicOffice has some features to aid you with this problem. 

Assuming you are looking at an imported image inside the Clinical Notes 

Editor, right-click on that image and the menu to the right will appear. 

At the top of the menu you have two options to Fit Whole Image and 
Fit Image Width. If you select Fit Whole Image, this will fit the image 

to the Image Area of the Clinical Notes. So, no matter how small you 
make this area, the entire image will fit in. If the image is smaller than the 

Image Area, it will stay at its original size. If you selected the second 
option Fit Image Width, this would only make the width of the image fit 

to the Image Area. If you alter the Image Area’s height the image will not 

shrink.  

The middle of the menu contains the zoom options. These range from 

25% of the original image size to 300%. You can also zoom in if you left-
click on the image and to zoom out press (don’t scroll) the middle mouse 

button again on the image. You will notice that if the image does not fit 

within the Image Viewer then small window will appear.       

 

 

You will notice that part of the image in 

the navigator window is clear while another 
is tinted. The clear part is what you are looking at in the image viewer now. If you 

place your cursor on the clear section, you will notice it change ( ). Simply hold 

down the left mouse button when the cursor is like this and move it around. The focus 

of the image (in the Image Viewer) changes to whatever part you have highlighted.  

You will also notice in the right-click menu a Rotate Clockwise and Rotate Anti-
Clockwise.  This enables you to change the orientation of the image to your liking. 

You can save the image as an external file by selecting the Save Image As…. If you wish just to copy and paste the 

image into another document, then you can select Copy to Clipboard. 

  

Right-click on Image Menu 

 

Navigator Window 
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Visual Notes 

As mentioned previously Visual Notes is an additional module, which enhances your note taking. To attach a Visual 
Note, click the Attach button and select Visual Note. The following window will appear: 

 

Visual Note Template Window 

 

On your left hand side is your available templates. When you left click on one it will be previewed in the preview 
window on the right. You can rename or delete a template simply by right clicking on the templates and then selecting 
either Rename or Delete.  

To import a new template simply click the Import From File button. Windows Explorer will appear allowing you open 
an image file (following formats are compatible: bmp, gif, jpg, jpeg, png or wmf). When you have found the image you 
wish to use click Open.  

If the image is large ClinicOffice will notify you of about it and ask if you wish to reduce the size. You will be provided 
with four options: 

 

Yes – Reduce the image size This will reduce the size of the image this time ONLY. 

No – do not change the image at all This will not reduce the size of the image on this occasion. 

ALWAYS reduce large images Once selected ClinicOffice will always reduce the size of an image. 

NEVER reduce large images Once selected ClinicOffice will not check again the size of an image. 

 

Once you have selected one of the options click OK. The image will now be imported and will be added to the 
available templates. 

To insert the Visual Note into the Clinical Notes, select one from the left hand side and click OK. The Visual Note will 
be attached to the Patient Summary, Session Notes or Clinical Notes depending on what you had selected at the time. 
You can choose to reassign this if you wish; see the section “Attaching Additional Records” for more information. 

When you select the Visual Note it will be displayed in the window on the right hand side of the Clinical Notes. 
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Visual Note inside the Clinical Note editor 

 

You will note that at the top of the image you have a small toolbar. The toolbar is broken down into the following 
sections: 

 

Tool Provides you with the Freehand, Rectangle, Ellipse, Line, Symbol-Circle, Symbol-Filled Circle, Symbol-
Filled Square, Symbol-Cross and Symbol-Circle and Cross tool styles. 

Colour This allows you to select the colour that you wish your tool style to be in.  

Size This sets the size that the tool style will appear in. 

Undo This will undo the last change that has been made. Note that once you have saved the Visual Note you 
cannot undue any changes that had been made before. 

Notes Opens a separate Notes window so that you can store any additional information. This window does not 
appear automatically on opening the Visual Note.   

 

There is also a Tool Preset feature within the notes. What this will do is allow you to save a tool along with its 
settings. So for example example if you like to mark regions of pain in the body with a red symbol-circle which has a 
size 3, then you can select the tool, size and colour and then click the Add Preset button. You can assign a name to 
the preset and click OK. So for future occasions if you need this particular tool with its settings, rather than selecting 
the tool, size and colour you can just click the preset and your settings will be automatically filled in. 

Remember to save any changes made to the Visual Note by clicking the Save button on the Ribbon Bar.  
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Quick Text Templates – For Clinical Notes and Memo Fields 

Writing down comprehensive clinical notes or even general notes can take precious amounts of time and if you are 
running a busy clinic you do not always have time to spare. To aid you with writing out notes ClinicOffice has a Quick 
Text feature. The Quick Text will allow you to create templates that can be used in either the patient’s clinical notes or 
within any other memo field such as in a journal log on the patient’s record. 

You can access the Quick Text Manager screen by going to the Tools menu and clicking the Quick Text Manager 
button. You can also access the same screen by clicking the Manage Clinical Templates button, on the Design tab, 
within the patient’s clinical notes.  
 

 

The Quick Text Manager is broken down into two sections: General Templates and Clinical Templates. The General 
Templates, as the screen above suggests, are for notes in any memo field except for the clinical notes memo fields. 
The Clinical Templates are for notes within the memo fields of the clinical notes only. 

Towards the bottom left of the screen are three buttons: New Template, Delete Template and Edit Template (in that 
order). These options are also available when you right click on the main grid section. There is also a fourth option on 
the right click menu which is New Sub-Template. A sub template is the same as a normal template but it can be grouped 
under an existing template. A sub-template will also require another template to be assigned to. This is one way you 
can organise your notes by placing them into groups and sub groups. 

When you click to create a new template the Quick Text Editor will appear. This window has two fields: Template Name 
and Expanded Text. The template name is merely a title for the given note. The expanded text is what will appear on 
the memo field when you select to add the text template. 

To add a quick text template to any memo field, for example the Subjective field within a session note, right click on the 
field and select Quick Text. Alternatively you can left click on the memo field and press the Ctrl and Space keys 
together. A new menu will appear allowing you to select anyone of the respective templates and sub-templates. You 
can search on the template name by typing into the search field which will be at the top of the menu. Once you have 
located the template you wish to insert, just double click on it. The template text will be inserted wherever your cursor 
happens to be on the memo field.  

There are two additional buttons just right of the search field which will allow you collapse the list of templates so that 
you can only see the top level templates or to expand the list of templates. At the bottom of the menu is also the link 
Quick Text Manager which will take you back into the main Quick Text Manager window.  

Quick Text Manager 
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Designing Forms 

ClinicOffice implements a versatile system for designing forms. To create a new form or edit an existing form, click the 

DESIGN CLINICAL FORMS button located on the ribbon bar under the Tool menu.  This brings up the Clinical Form 

Manager.  

Clinical Form Manager 

 

1) Click the NEW button, to create a new form.   

2) Enter the name of the form and click OK.  

New Clinical Form Name 

 

 

3) The form will now appear in the Clinical Form Manager. To edit this form, double-click on the form name and 
this will bring up the form designer. 

 

The next few pages will now go through some of the components of the form designer and what each part does. Then 
it will look at adding new fields, organising them and then grouping them. 
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Clinical Form Designer 

 

The ribbon bar on the form designer lets you add/edit fields on the form. Below is information about the components on 
the ribbon bar.  

 

Preview Form This allows you to preview the form as you would see it in the Clinical Notes, and 

you can test it by entering information in (information that you enter here will NOT 

be saved). Clicking on this again will allow you to return to the design mode.  

Preview Online This option is only available if the Online option is ticked within the Form Manager. 
This will preview how a form would be displayed via the E-Docs service in a web 

browser. For more information, please see the section “Online Forms and E-Docs”. 

Save Design This will save any changes that have been made to the form. 

Edit Custom Field Lists You can create/edit/delete the custom field lists from here.  

Add Field  This gives you the option to add Text, Memo, List, Checkbox, Date, Number and 

Decimal fields to the form. 

Close Form Designer This will close the form designer. If you have not saved the changes you have 

made, then it will ask you if you want to save the changes made.   
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Customization Window 

The Clinical Form Designer also has another part to it that enables you to edit the form further. This is the Customization 

window.  

 

      Customization Hidden Items     Customization Layout Tree 

 

 

The Customization Window is broken down into two sections:- 

 

Hidden Items  

The Hidden Items of the Customization window stores the new fields that you have created (if you have selected an 
area in the form designer the new field will be added there instead). From here you can left click and drag the field into 
the desired location on the form designer.  

This area also allows you to insert an Empty Space Item, Label, Separator and Splitter field into the form designer. 
These fields are always present in the Hidden Items list, as additional attachments. Each of these fields has a purpose 
and they are as follows:- 

 

Empty Space Item This creates a space between fields. When additional fields are added to the form, this space 
reduces in size (when the form is full the Empty Space Item will have a minimum set size). 
This can be useful when align fields. 

Label This allows you to create a custom label, this behaves like a data field but does not have any 
of its own functionality. 

Separator This is a thin line that separates the fields and will be displayed on the form in the clinical 
notes. 

Splitter This is like a separator but is more prominent in its appearance. 

 

Layout Tree View 

The Layout Tree View of the Customization window displays the full contents of the form, including the hidden items in 
a tree layout. The tree is first organised by the Layout Control Group, this is broken down into groups and tabbed groups. 
Each group will have field(s) assigned to them.  
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The layout tree has virtually the same functionality as the Clinical Form Designer, minus the visual display. For example, 
if you were to right-click on a field, you will have the exact same options presented to you as you would in the Form 
Designer.   

The Customization window also lets you Undo  and Redo  any changes you have made to the position of the 
fields. It does not undo/redo the addition of a field or any changes made to the field name. Once the design of the form 
has been saved the changes made before the save cannot be undone using the UNDO and REDO buttons, only 
changes made thereafter will be affected.    

 

 

Adding a New Field  

To add new fields, click on the ADD FIELD button. You will be presented with a 

drop-down menu with the following list: Text Field, Memo Field, List Field, 

Checkbox Field, Date Field, Number Field and Decimal Field.  

 

 

 

 

 

 

 

 

Once you have selected one of the fields, i.e. the Text Field, a small 
window will open up allowing you to enter the Field Name (this is the 
unique name of the database field) and the Display Name (this is 
shown in the form). This is so that you could have four fields for 
example, all called Description on the form (Display Name is called 
"Description") while the underlying Field Names would have to all be 
different (i.e. "Description1", "Description2" etc.). Once you have 
entered the two names press OK. This is the same for all fields 
except one, which is the List Field.  

If you choose the List Field, you will be presented with a window like 
the one to the left. 

With this you will enter the Field Name and Display Name in the usual 
manner. You will then select the custom list you wish to have. Each 
list will have items; once the custom list field has been created the 
items will be displayed in that list. To edit or create a custom list, click 

on the Edit the Custom Lists link from this window. You can also click EDIT CUSTOM FIELD LISTS button, on the 
ribbon bar in the Clinical Form Designer window, to do the same. The following window will appear: - 

 

 

 

Text Field A text field allows you to enter an alpha-numeric value as 

a form. 

Memo Field While a simple text field only gives you one line of text, a 

memo field lets you enter several lines of text. 

List Field This type of field lets you define a list of answers and then 

select an answer from that field list. 

Checkbox Field Checkbox fields are represented by a tick box on the form. 

The tick box gives you the choice of a 2 or 3 state tick box. 
The 2 state has the options of ticked and un-ticked. The 3 

state includes an unspecified option (represented by a 

square). 

Date Field A date field lets you select a date for the field’s value. 

Number Field A number field takes a numeric value which must be a 

whole number. 

Decimal Field A decimal field takes a numeric value which can include a 

decimalised figure. 

Patient/Contact 
Lookup 

This is the standard search field, which is present in the 
appointment editor, which searches through your database 

for the desired Patient/Contact.   

Add Field Menu 

Creating a Custom List Field 
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The left-hand column contains the custom list’s name; the right-hand column contains the items or contents of that list. 

To add or remove a list or item press the  or  buttons in the respective columns, then enter the necessary 
details into the field. Once you are satisfied with the changes made, click the CLOSE button. You can use a newly 
created list, in the Custom List Field window and then press OK, to insert the field into the Form Designer.  

 

 

Form Designer Right-Click Features 

Quite a few of the Form Designer’s powerful features are contained within the right-click options. If you right-click on a 
field the following menu appears: - 

 

 

 

Edit Field This allows you to rename and edit any of the field’s 
properties. 

Required Field Use for Online Forms and makes this field mandatory and 
must be filled in by the patient. 

Delete Field Deletes the field completely. NOTE: past data entered in this 
field will be erased. 

Size Constraints Gives you the option to lock the size of a field, meaning you 
cannot alter the size. Also, the option for free sizing (removes 
the lock on size).  

Hide/Show Label Hides or shows the field name in the Form Designer.  

Label Position To select this option, the field that you have selected must be 
showing the field name. This gives you the option to place 
the field name at the top, bottom, left and right of the field. 

Hide Field This removes the field from the Form Designer and places it 
into the Customization window, Hidden Items menu. 

Create Group/Tabbed 
Group 

This groups a field under a heading. Additional fields can be 
added to a group. 

Add Item Allows you to add a label, separator, or splitter item. 

Add Empty Space Item Adds a blank space item. 

Right-Click Field Menu 

 

Custom Field List Editor 
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Grouping and Tabbing 

To organize and structure your form you can group fields. These groups can be made into tabbed groups. This also 
helps to structure the display in the Layout Tree View on the Customization window.  

To make a group, right-click on a field in the Clinical Form Designer, then select Group. This puts the field into a blue 
box, with the group name being displayed just above the field, just like the following example: - 

 

Grouped Field

 

The default group name will be something like ‘item1’. You can rename the group, by right-clicking on the group name 
and selecting Rename.  

To add an additional field, left-click on a field (outside the group) and drag it underneath the field that is already 
grouped. Move it until you have a small black outlined rectangle box appear, you can now drop it there. 

Adding an Additional Field to Group 

 

 

You can add as many additional fields to the group as you like using this method. An alternative method to this, is to 
select several ungrouped fields by pressing the Shift button and left-clicking on each field you wish to add. Right-click 
on one of the fields and select Group. This will group all selected fields. This method will only work if all selected fields 
are connected to each other. 

 

To turn a group into a Tabbed Group, right-click on the group name and select Create Tabbed Group. It should look 
something like this:- 

Tabbed Group 

  

You can rename the new tabbed group the same way you would a group. You can also add another tabbed group to 
this, by selecting a new group then dragging the group name until a small black outlined box appears. Then dropping 
this next to the present tabbed group. 

Adding an Additional Tabbed Group 

 

 

One group can have several sub groups, just as one tabbed group can also have several groups attached. This is how 
the form is organised into categories and sub-categories. To do this, just drag the desired group and like a field place 
it into another group and drop it there. 
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Flagging 
ClinicOffice employs a powerful flagging system. You can create as many flag types as you want, and then attach them 

to virtually any record to act as reminders, alerts or to identify a group of patients for any purpose you wish. 

 

Tip: To edit the Flag Types, click the View menu from the main ClinicOffice window, then click Types & Categories 
then click Flag Types. This shows you a list of all the current flag types. You can add, edit, or delete flag types using 
this screen. (See “Working with Types and Categories” topic for more information.) 

 

To flag a patient’s record please follow the example below:  

        

• Open a patient’s record; click FLAGS on the ribbon bar. This 

brings up the Flag Editor window. 

 

• Select the Flag Type you want to attach to the patient’s 
record. (You can add a new flag type by clicking the category 

button  which is at the bottom of the menu.) Select the Flag 

Colour. 

 

• By default, the box Alert me about this Flag will be ticked 
which will make this flag into an alert. When a flag is put on 

alert it will pop up whenever a patient record is accessed. If 
you do not want this just un-tick the box. 

 

• Enter any Notes if you wish.  

 

• Click OK to attach the flag. 
 

ClinicOffice will now create and attach the flag to the patient’s 
record. You can see the flag by going into the patient’s record and 

clicking on the lower part of the FLAGS button. Then click on the 

flag you wish to see. 

Alternatively, you can flag a patient’s record by right-clicking on the record, selecting Patient Record and then clicking 

Flag Record(s). This opens the same Flag Editor window (as seen in the previous picture).  

You can also attach flags to any of the editors in ClinicOffice. When you go to add a flag to an appointment, invoice, 

payment, credit note or refund you will be presented with the following three options:  

1. Flag this Record  

2. Flag the patient/contact Record 

3. Flag both this record and the associated patient/contact’s record 
 

Within the Diary Options there are two options: Show related alerts and Show related flags. If an appointment 
or patient has been flagged and you tick the Show related flags, you will be able to see a small flag icon on the 

related appointment. You can also specify the flag types that you wish to be displayed.  
 

If the flag that is assigned to an appointment or patient has an alert on it then this can also be displayed by ticking 

the Show related alerts. This will display a small red light on the related appointment. Again with this you can 
specify the type of alert to display from the Diary Options. 

  

Flag Editor Window 
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Flag Search 

Except for the reports, all grids have the Flag Search feature. If you assign a flag to a record and you wish to locate that 
record in the future, this will help you search for it in a matter of seconds. Follow the example below: - 

 

• Go to a grid i.e. The Patient Grid. 

• Click the arrow on the Search button and select Flag Search. This brings up the following window. 

• Select and tick the flag type(s) you wish to see. 

• Press OK. 
 

If nothing appears, then that means there are no records with that flag type assigned to it. If you have assigned a flag 
to a record and do a search upon this flag type, then the record will show. This applies for all types of flag searches. 

 

 

Removing Flags 

After a certain time, the flag that you have assigned to a record would have served its purpose and will be no longer 
needed. To remove a flag, go to the record which has the flag attached to it. Click on the arrow pointing down on the 

FLAGS button and then click on the flag you wish to remove. The flag editor will appear; now click on the  
button. This will permanently delete the individual flag.  

 

If you have multiple flags assigned to one record and you want to remove them all, click on the downwards arrow on 
the FLAGS button and then at the bottom of the menu click on Remove all Flags. This will delete all flags permanently. 
Of course, you can always use this method to remove a single flag as well.  

 
 
 
 
 
 

Reports and Document Templates 

 

The reports and document templates part of the program allows you to generate, preview and print out 
reports/documents about your clinic.  You can access this from your home page (the bottom middle button) or by 

clicking on the button in the ribbon Bar.  
 

 
 

This will bring you to the Reports and Document Templates centre. Unlike previous versions of ClinicOffice we now 

use 4 different types of reports. 
 

• Charts   Our charting module can add virtually any type of chart to virtually any grid 
within ClinicOffice, which enables eye pleasing instant reports.(For more information 
see the ‘Charting’ section of this manual’) 

• Document Templates This is where you design all your mail merge letters and insert all your  
headers etc. 

• Grid Reports  These are very much like Excel style reports which use the ClinicOffice grids  

to allow extra functionality.  
 

• Layout Reports  These are the reports that you will use if you want complete control of the  

look and feel of the whole report. For instance, the Invoice Report. You can now add 
your own headers in with relative ease. 
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Reports & Documents Templates 

 
You can see in the left column, the different report categories. These can be changed in the Types and Categories 
Editor. In this screenshot we have used the <All Reports> option so we can take a look through all of them. 

 
 

Running a Report 

To run a report, simply double-click on the chosen report and the following screen appears. 
 

 

You will recognise the search criteria box as it 
is the same as all other full search boxes within 

ClinicOffice. And it lets you set the criteria for 
which records you want to include in the report. 

You will also notice that you are able to 
nominate the fields that you use the most as 

favourite.  

Clicking the Other Search Fields allows you 
to use more fields if it is needed (as shown 

above). If you wish to add a field to the list of 
favourites simply right-click and select Add to 

Favourites. 

Once you have selected the criteria for the 
report, you will notice at the bottom of the 

window there are a few other options:- 

 

 

 

Clear Search 
Values 

Clears all the data from all 
search fields on this screen 

OK Creates the report using the 
criteria you have chosen 

Cancel Closes the screen 
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From here each report type works slightly differently to each other. We will start with how to create a new report, 
then go onto the components of each report or template and from there how to edit each report. 

 
 

Creating a Report or Document Template 

Please note that we do not actually recommend creating new templates from scratch as this requires a bit of knowledge 
of SQL (Structured Query Language). Instead, we recommend copying an existing template (preferably one that is close 
to the report that you would like to design) and then renaming it and editing the copy.  
To do this, please follow these three steps below: - 

1. Select your chosen report and right-click on it   

2. Click Copy and you will notice that a new template called ‘(Copy 1)’ has appeared 

3. Right-click on this copied report, click Rename, enter your chosen name, and then click OK 

 
 

Layout Reports 

To edit a layout report, right-click on your report and select Design Report. You will then have the window below appear. 
If you wish to create a new document, please follow the steps in “Creating a Report or Document Template” and then 
carry on following this section. 

Invoice Report Designer 

 

This is the main screen of the layout report designer. As you can see it looks quite complex so we will go through the 
basics. If you prefer to get straight into editing the layout report, please feel free to skip to the section “Adding New 
Components to a Layout Report”. 

First, we will look at the ribbon bar and all the controls that it offers. 
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HOME 

 

New Report: Starts a brand-new report either from scratch or using a 
wizard [not generally recommended]. 

Open Report: Allows you to open other layout-based reports. 

Save: Saves the template (If you click on the arrow it will allow you to save 
the document under a different name using the Save As option). 

Preview Report: This will open the Search Criteria window that will allow 
you to perform a search on the report. From here you can see if your report 
is appearing how you want it to. 

 

 

Edit Data Source: Allows you to change the SQL source code that the 
report uses [advanced users only].  

 

Paste / Cut / Copy: These work the same as any other windows program. 
Allowing you to move or replicate highlighted text. 

 

Font: Click here to change the font type. If you are using a local install of 
ClinicOffice then this will display all font types that Windows installation has 
available. 

Font Size: Displays current font size and allows you to adjust it 

Bold / Italic / Underline / Strikethrough 

Background Colour: Adjust the colour behind the text 

Foreground Colour: Adjust the colour of the text 

 

 

Alignment: Align text to the top, middle or top on the vertical line and to 
the left, centre, right or justified within the horizontal line. 

 

Borders: Add or remove borders on the selected controls such as labels 
or calls within a table. 

Border Colour: Set the colour of the border of the selected control 

Border Width: Set the border width of the selected control 

Border Style: Set the style of border such as line, double line, or dashes 

LAYOUT 

 

Alignment: This can be used when multiple controllers are selected, such 
as multiple labels. You can align them to the left, centre, or right on the 
horizontal line and top, middle, or bottom on within the vertical line. 

 

Align to Grid: When selected  

Fit Bounds to Grid: Aligns the current control such as a label to the 
report’s background grid. 
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The below features only work when you have more than one control, such 
as a label or rich text field, selected. 

• Make horizontal space equal 

• Increase horizontal spacing 

• Decrease horizontal spacing 

• Remove horizontal spacing 

• Make same width 

• Make same height 

• Make same size (this applies to height and width) 

• Make vertical spacing equal 

• Increase vertical spacing 

• Decrease vertical spacing 

• Remove vertical spacing 
 

The next two features can work on multiple or singular controls. 

• Centre the selected controls horizontally 

• Centre the selected controls vertically 

 

 

These can be used when you have multiple controls stacked on top of each 
other.  

Bring to Front: This will bring your selected label or other control forward 
by one place. 

Send to Back: This will bring push your selected label one place behind 
another label. 

 

Snap to Grid: When ticked label controls are automatically snapped to 
report’s background grid when moving them. 

Snap Lines: Provides guidelines based on the position of other controls 
such as labels. Helps to provide uniformity and is recommended that you 
have this ticked. 
 

Page 

 

Margins: You can define the size of the page margins here. You can 
select from some predefined values or set your own custom values.  

Orientation: Change the orientation of the page to either Landscape or 
Portrait. 

Size: Define the page size of the report. You can select from predefined 
values such as A4 or A5 or custom define one. 

 

Page Colour: Change the background colour of the page. 

Watermark: Add an image or text to the background of the page. 

View 

 

Printing Warnings: When enabled this warns the user if any controls on 
the page cross over the right-hand margin. If they do, it generates an 
additional page to fit the control in.  

Export Warnings: This highlights in red any controls that are intersecting 
or overlapping. 

Watermark: If the report has a watermark present this can hide it on the 
design if you temporarily need to. 

Grid Lines: Toggles on or off the background page grid. 
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Expand All: Expands all bands on the report. For example, it will expand 
the GroupHeader or Detail band.  

Collapse All: Collapses all groups on the report. 

 

Language: Specifies the language associated with the localizable 
property values within the report. For example, certain font types will only 
support certain languages. 

Show Localizable Properties: When ticked only properties effected or 
changed by language localization will appear on the Properties panel. 

 

Zoom Out: Zooms out so that you can see more detail on the screen 

Zoom: Allows you to select a certain zoom level 

Zoom In: Zooms in on the screen by one level 

 

• Windows – This menu allows you to toggle on or off the seven toolbox 

windows at the edges of the screen. These are: Report Explorer, Field 
List; Properties, Report Gallery; Group and Sort, Scripts Errors and 

Toolbox.  

 
 
Now we will look at some of the standard control tools and how to insert them into a report. We will focus on the main 
ones that we recommend using within these layout reports. 

 

Label: This will be the more commonly 
used control. You would use this for 
titles, headers, and merge fields.  

Panel: Serves as an umbrella to house 
multiple controls such as labels and keeps 
them formatted within an area. 

 

Check Box: Used to display Boolean 
fields, which is to say True or False 
values from the database.  

Table: Allows multiple merge fields to be 
inserted into a table like structure. Useful 
to use it within the Details area of the 
report. 

 

Rich Text: Works like a label field but 
allows for individual parts of the text to 
be formatted differently. This is good to 
use for extensive information. 

 

Line: This is just a line shape that can be 
inserted into a report for aesthetic reasons. 

 

Picture Box: Allows the importing of an 
image onto the layout report. 

 
 

 

 

Adding New Components to a Layout Report 

 

1. Go to the Reports and Template area of the 

software, right click on a layout report, and 
select Design Template. 

 
2. From there left-click on a control like the 

Label and drag and drop this onto the 

report. 

 

 

 

 

 

Adding a New Control 
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3. To resize it, left click on the edge of the label and drag 

to expand it. 

 
4. You change the text within the label field by double 

clicking onto it and this will allow you to change the text 
present. 
 

 

 

5. If this field should pull or merge 

information from the database, 

then you can do this by 
selecting the label and clicking 

on the small arrow that sits 
towards the top right of this 

label. 

 
6. Click on the drop-down menu of 

the Data Binding field 
 

7. Expand the ReportData header 
and select the data you wish to 

appear within this field 

 
8. If you have selected data that is 

date/time or currency based or 
maybe you wish to format a 

number, then you can format 

this from the same Label Tasks 
area by clicking on the three 

dots on the Format String field. 
 

9. Within the Format String Editor screen, you can select your category on the left-hand side, such as DateTime or 
Currency. When you select the category, you will be presented with a list of predefined options that you can 

select from. If you go to the Custom tab, you can specify your own format. For example, if you have selected 

DateTime and go to Custom you could enter just “d” (without quote marks). This will format your date to use 
the local regional date format from your machine. Click OK once you are finished. 

 
From the Label Tasks (as shown above) you can also set things such as “Auto Width”, “Can Grow”; “Can Shrink”, 
“Multiline” and “Word Wrap”. These additional options just aid for the formatting. For example, if you are merging in 
something like the clinic address which is multiline by nature then you would want to make sure to have that option 
ticked. 

The above instructions are in no way exhaustive and it merely scratches the service of what the Layout Reports are 
capable of. At the very least though it should hopefully give you an idea of how to add fields and how to find the options 
associated with this control. 

 

Q. What is the easiest way to add an image to such a report? 

A. The easiest way is to just copy and paste in the image. When you do this, it will automatically put the image into a 
Picture Box control. One thing you will probably want to do though is either resize the field afterwards or change how 
the image scales. You can change the scaling by clicking on the Picture Box and then clicking on the small arrow 
towards the top right of it. From this Label Task area click on the Sizing field drop-down and generally we recommend 
you select “Squeeze”. This will always maintain the aspect ratio of the image. 

 

 

 

 

 

Resizing a Control 

Assigning Data to Merge into a Control 
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Grid Reports 

The grid reports are much the same as the other grids that you see within ClinicOffice, but with slightly more search 
functionality and grid layouts already setup. Unlike the layout reports and document templates which are designed to 
generate information to present to your client or patient, the grid reports are very much for the purpose of internal 
reporting. 

By default, ClinicOffice has an array of different types of grid reports which will inform you on things such as invoice 
totals, appointments performed, staff login history and much more. You can run anyone of these reports by going to the 
Reports and Templates area of the program and double clicking on one of these reports, the Payment List for example. 
When you run a report, you will be presented with a Search Criteria window, that will allow you to specify things such 
as date period. It might be worth viewing the “Other Search Fields” as this could have additional criteria that will be 
helpful for your reporting. 

Once the report is open, you can move the data around, order the fields differently or even place filters on the grid. 
Editing a grid report is very much the same as editing a grid layout. You will notice that there are several Grid Layouts 
available in the Grid Options box on the right of the page. You can add to these by clicking SAVE once you have a 
design that you are happy with and inputting a name. Once you press OK your saved layout will appear there too. 

For more information on how to do any of the above please see the “Working with ClinicOffice Grids” section of the User 
Guide. Each grid report will also support charts that can be used to visualise your data. For more information on how to 
run and create charts please see the sections “Charting” and “Chart Designer” of the User Guide. 

 

 

Search Criteria: This brings up the criteria box, so you can change 
the data that is on the screen 

Edit Data Source: This is where you can change the SQL source that 
draws the data from the database (recommended for advanced users 
only) 

Print Preview: Will show you a preview of how the grid will be printed 
off. 

Close: Grid Report Closes the report prompting you to save if 
necessary 

 

Charts: Enables you to generate chart such as a pie chart or bar 
graph based on your grid data. It will update automatically depending 
on your search criteria and what is being displayed at that moment on 
time on the grid. Please see the sections “Charting” and “Chart 
Designer” 

 

Toggle Grid Filtering: Display an additional row below each of the 
column headers that allows you to filter on a column with a value. 

Toggle Group By Box: This will show the group by box at the top of 
the grid and you can drag on of the column headers into this to group 
the grid by that header. 

Toggle Group Footers: This will show footers for your groups if the 
grid is grouped by a header. 

Toggle Column Customizer: Displays the Customization window 
that may can contain any hidden column headers. 

Preview Field: Can be used for fields with more extensive information 
such as note type fields. When enabled this will appear as a preview 
window row below each existing row. 

Max number of lines: Effects the maximum number of lines displayed 
in the Preview field when that option is enabled. 

Layouts: Any adjustments to the grids grouping, filtering, or 
positioning of column headers can be saved a as a layout for future 
use. 

 

For a more detailed explanation of what each part of the Grid Options 
does, please see the section “Grid Options” in this User Guide. 
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Document Templates 

This is the ClinicOffice Word Processor. It can be viewed as a light version of Microsoft Word or LibreOffice. You would 
use a Document Template to write letters to a patient or to the patient’s GP for example. 

 

 

How to Create a New Document Template 

If you need wish to create a new letter, then we recommend that you copy an existing one based on what information 
you need. For more information on how to do this, please see “Creating a Report or Document Template”. 

 

How to Edit a Document Template 

1. Go to the Reports and Templates section of ClinicOffice 

2. Scroll down to the Letters section and right-click on an existing letter 

3. Select Edit Template 

 

From here you can modify the document like you would in a standard word processor. You can also copy and paste in 
text and images from other words documents. The next set of steps below will look at how to add the current date and 
time to the report. 

 

1. Within the template click on the area within the document that you wish for the date to appear 

2. Go to the Insert tab 

3. Click the Date/Time button 

4. Select the format that you want the date or time to appear in and click OK 

 
The date and time will update whenever you go to run the letter or open the template. From the Insert menu you can 
also select  to insert things like tables, images, hyperlinks, and text boxes. 

ClinicOffice Word Processor 
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If you want to insert merge fields that will pull through information such as the patient’s name, their address or other 
information, please follow the steps below. 

 

1. Within the template screen, click on the area you wish to insert the merge field 

2. Go to the Data Merge tab 

3. Click on the lower half of the Insert Merge Field button and select the field you wish to merge 

 

Remember to click Save Template from the Home tab once you have finished inserting the desired merge fields and 
modifying the letter. 

 

Formatting Merge Fields 

If you insert a date-based merge field it will default to a United States of America format. If you need to change this or 
wish to display the time as well as the date, please follow the steps below. 

 

1. Within the template editor screen, go to the Data Merge tab 

2. Click the Show Field Codes button 

3. If the date-based field is <<dob>> for example, then it will now display as { MERGEFIELD dob }. After the 

merge field name “dob” insert: \@ “dd/MM/yyyy”. Once you are finished it should look like { MERGEFIELD 

dob \@ “dd/MM/yyyy”}. 

4. Click the Show Field Names, go back to the Home tab, and click Save Template 

 

In step three you will note we use a \@ and this tells the system that this is a date. After this we place a space and enter 
within double quotes the format. The above example uses the UK and Ireland date format but you can change it to 
however you need it to appear for example “dd-MM-yy” or “yyyy.MM.dd” or “dd/MM/yyyy HH:mm”. Below is date/time 
reference grid. 

 

Format Code Represents Display Example Format Code Represents Display Example 

dd Day of Month 01 HH 24 Hours Format 14 

dddd Day of Month Monday hh 12 Hours Format 02 

MM Month of Year 05 mm Minutes 52 

MMMM Month of Year May ss Seconds 33 

yy Year 21    

yyyy Year 2021    

 

 

Document Template Components 

Below is a more detailed look at the ribbon bar and see what options we have available. 

 

Home Tab 

 

Save Template: This saves any changes made to the template. 

Save As...: Allows you to save the template as an RTF file 
outside of ClinicOffice. 

Print Document: This will allow you to print the document.  

Print Preview: Shows a print preview of the document. 
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Cut: Cuts the selected text and stores it to the clipboard. 

Copy: Copies the selected text and stores it to the clipboard. 

Paste: Allows you to paste the contents of the clipboard. 

 

 

Font: Allows you to change the font type of the text. 

Shrink Font: This shrinks the font size by 1 font size. 

Grow Font: This increases the font size by 1 font size. 

Font Size: Allows you to change the size of the text. 

Bold: Makes the selected text bold. 

Italic: Makes the selected text italic. 

Font Colour: Changes the colour of the selected text. 

Text Highlight Colour: This highlights the background of the text 
in a colour. 

Font 2: Allows you to adjust all font settings. 

Change Case: Changes the case of the text. 

Underline: Underlines the selected text. 

Double Underline: This underlines the text twice. 

Strike Through: This put a line straight through the selected text. 

Double Strike Through: Puts two lines through the selected 
text. 

Subscript: This makes the text small and places it at the text 
baseline. 

Subscript 2: This makes the text small and places it above the 
line of text. 

 

Bullets: Puts the text into bullet points. 

Numbering: Puts the text into numbered bullet points. 

Multilevel List: Allows you to create a staggered numbered 
bullet point system. Works with the numbering button. 

Decrease Indent: Decreases the indent level of a paragraph. 

Increase Indent: Increases the indent level of a paragraph. 

Line Spacing: Change the width of space between the text’s 
lines. 

Align Text Left:  This aligns the text to the left of the page. 

Align Text Centre: This aligns the text to the centre of the page. 

Align Text Right: This aligns the text to the right of the page. 

Justify: Adjust the text so that there is equal spacing between 
the left and right. 

 

Find: Enables you to locate a specific word in the body of text. 

Replace: Allows you to replace a specific word. 

Check Spelling: Automatically spell checks the document. 

Spelling: This will perform a one-off spell check on the  entire 
document. 

Perform Merge: This merges the document template with your 
specified data in ClinicOffice. 
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Insert Tab 

 

Page Break: Any text or images on this line will be placed on a 
new page. 

Table: This creates a table in the document. 

Picture: This allows you to insert an image into ClinicOffice. 

Date/Time: Inserts today’s date and or time into the document. In 
addition, provides an option to update that date/time whenever 
the document is opened. 

 

Bookmark: Allows you to insert bookmarks into the document. 

Hyperlink: Allows you to insert an active link to a web page or 
document. 

 

Header: This allows you to edit the header. 

Footer: This allows you to edit the footer. 

Page Number: This inserts the number of pages the document 
makes up. 

Page Count: This inserts the number page number. 

 

Symbols: Allows you to insert different symbols into ClinicOffice.  

Signature Point: Inserts a signature point for the letter to be 
signed via the E-Documents system. 

Page Layout Tab 

 

 

 

Margins: From here you can alter the width of the margins on 

the document. 

Orientation: This allows you to select either portrait or 

landscape. 

Paper Size: Allows you to select the page size of the document. 

Columns: Allows you to select to have either one, two or three 
columns on a single page. 

Breaks: Insert a page break either on the current page, next 
page or on an odd or even page. 

Line Numbers: Inserts a line number, presenting a line count, 

down the left-hand side margin. 

Page Colour: Sets the background colour of the page 

 

 

View Tab 

 

Simple View: This will display the document as a simple memo. 
It ignores the page layout. 

Draft View: In this view elements such as the header and 

footer will not be visible. 

Print Layout: This will view the document as it would appear 

when printed. 
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Horizontal/Vertical Ruler: When the Horizontal Ruler is 
selected a ruler will appear at the top of the page and when 

Vertical Ruler is selected a ruler will appear to the left of the 

document.  

You will note that when you select Print Layout both options will 

be selected by default. When you select Draft View only the 
Horizontal Ruler will be. When you select Simple View neither of 

them will be. 

 

Zoom Out: This will decrease the zoom factor on the 
document by 10%. This will have the effect of making very 

thing look smaller, but it will not affect the physical size of the 

document. 

Zoom In: This will increase the zoom factor on the document 

by 10%. This will have the effect of making everything look 
larger but again it will not affect the physical size of the 

document. 

Data Merge Tab 

 

 

Template Source: This is the documents source code. This 

requires knowledge of the SQL language. 

Insert Merge Field: This allows you to insert merge fields 

such as names and addresses into the document template. 

Show Field Codes: This shows you the formatting of a merge 

field, such as the structure of a date. 

Show Field Names: This takes you back to the normal view 

and shows you the name of the merge fields. 

Perform Merge: This merges the document template with 

your specified data in ClinicOffice. 

Header & Footer Tools - Design Tab This Design Tab is only useable when you have clicked on either 

the Header or Footer from the Insert Tab 

 

Go to Header: This takes you to the header of the current page. 

Go to Footer: This takes you to the footer of the current page. 

Show Next: This takes to the next header or footer. 

Show Previous: This takes to the previous page’s header or 

footer. 

Link to Previous: This links the current header and footer you 

have selected with the previous page’s header and footer. 

 

Different First Page: This allows you to specify a unique 

header and footer for the first page. 

Different Odd & Even Pages: This allows you to specify unique 

headers and footers for the Even and Odd pages. 

Close Header and Footer: This takes you back to the main 

body of text and closes the header and footer. 

Table Tools - Design Tab This Design Tab is only useable when you have created and have 

selected a table on the document.  

 

Shading: Allows you to select the background colour of a cell. 

Borders: Allows you to change the borders of a selected cell.  
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Line Style: Allows you to change the style of the borders of the 

cell. 

Line Weight: Allows you to change the thickness of the borders 

on the cell. 

Pen Colour: This changes the cell border’s colour. 

Table Tools - Layout Tab The Layout Tab is only useable when you have created and have 

selected a table on the document. 

 

Select: Gives you the options to select a cell, select a whole 

column/row or to select the entire table.  

View Gridlines: By selecting this option, it will display any 

grids that have their cell borders hidden on the document. 

Properties: This takes you to the table properties and allows 

you to view and edit the settings for a cell or table. 

 

Delete: Give you the option to either delete cells, delete 

columns, delete rows or to delete whole tables. 

Insert Rows Above: This inserts a row above the current 

selected cells. 

Insert Rows Below: This inserts a row below the current 

selected cells. 

Insert Columns to the Left: This inserts a column left of the 

current selected cells. 

Insert Columns to the Right: This inserts a column right of 

the current selected cells. 

 

Merge Cells: You can merge selected cells using this. 

Split Cells: You can split selected cells.  

Split Tables: This will split the whole table into two. 

 

AutoFit: Allows you to autofit the table to the cell contents, to 

the Window or you can lock the column widths. 

Align Top Left: Positions the text top left of the cell. 

Align Top Center: Positions the text top centre of the cell. 

Align Top Right: Positions the text top right of the cell. 

Align Center Left: Positions the text centre left of the cell. 

Align Center: Positions the text centre of the cell. 

Align Center Right: Positions the text centre right of the cell. 

Align Bottom Left: Positions the text bottom left of the cell. 

Align Bottom Center: Positions the text bottom centre of the 

cell. 

Align Bottom Right: Positions the text bottom right of the 

cell. 

Cell Margins: Specify the margin sizes of a cell. You can also 
set the spacing between cells and select to automatically resize 

cells based on the contents. 
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Printing 

Any page that is displaying information regarding a patient, contact or staff member can be printed out. Most software 
would provide you with a print preview of what you are about to print out and ClinicOffice is no exception. 

Patient Grid Print Preview

 

Using the print preview in COv5 is a great way to see exactly what your print out will look like. You can also from here 

export the printout to a PDF or even an Excel file. 

 

 

Print Preview Ribbon Bar 

 

The print preview ribbon bar is broken up into the following sections:- 

 

 

• Print  

Brings up the standard windows print dialogue. 

• Options 
This is sometimes called, ‘Page Setup’. This brings up a 
range of options to alter the appearance of the print 
preview. For example, paper size, colour settings and 
many more. 
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• Header/Footer 
Allows you to put a custom header and footer in. It also 
has options to generate name, date and time. If you are 
printing off a Grid Report, then you can enter [Criteria]; 
this displays your Search Criteria. 
 

• Scale 
Enables you to shrink or expand the size of the printout 
and allows you to select how many pages you wish to 
save the document onto. 

• Margins 
Gives you 4 different margin sizes to choose from.    

• Orientation 
Allows you to choose between Portrait and Landscape.  

• Size 
Selects the size of paper you wish to print upon. 

 

 

• Find 
Allows you to search for a name or word. 

• Bookmarks 
This allows you to navigate through the document in a 
structural view.  

• First/Previous/Next/Last Page 
Enables you to browse through multiple pages quickly. 

 

• Many Pages 
With this you can select the number of pages you wish 
to display upon on screen.  

• Zoom Out/In 
You can zoom in and out in a progressive manner. 

• Zoom 
Allows you to zoom in or out by a set percentage. 

 

• Page Colour 
Allows you to set a background colour for the page. 

• Watermark 
Allows you to insert a background image and text. 

 

• Export To 
Allows you to export the print preview into the following 
formats: PDF, HTML, MHT, RTF, Excel, CSV, Text, 
Image. 

 

• E-Mail As 
This is like Export To, but after you have saved the file 
it will then open your default mailing program with the file 
attached to it.  

• Close Print Preview 
This closes the Print Preview window down. 

 

At times you will have to adjust the settings so that you have the document presented in the way you need it. This is 

particularly the case with printing off Grids and the Appointment Diary. Remember that the more information you have 
the less likely it will fit onto one page. For example, you will struggle to fit several practitioners, each with a full diary 

onto one page displaying all appointments. 
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Online Forms and E-Docs 

One of the biggest time consumers for Clinics can be the long wait while patients fill in and sign a medical history form 
or something similar. ClinicOffice assists with this by allowing you to create your own forms, and then email them out to 
patients. Once completed, ClinicOffice can store the forms or save them as PDF documents within the patient record 
that they relate to. 

 

This feature also allows for the collection of electronic signatures, and therefore replaces the current E-Sign feature. 

To use our ClinicOffice E-Docs service, you need the following :- 

• ClinicOffice v5 (Startup, Professional, Server or Hosted editions) 

• The Documents Module add-on 

• The Forms Module add-on (Only if you want to create fillable custom forms as well as collect signatures) 

• Either a Hosted account, or the ClinicOffice Support Plan 

• A touchscreen device such as a tablet, preferably with at least a 10” screen (Only needed if you plan to use this 
within the Clinic.) 

 

Please click the link below to find out more about the benefits of E-Docs and the required specifications of your tablet 
device: https://pioneersoftware.co.uk/co-edocs 

 

 
 

 
 

Signature Capture 

 

[1] Preparing a Document for Signature Capture 

 

This feature directly replaces the ‘E-Sign’ feature and so much of it works in exactly the same way. To create your 
document, please follow the steps below. 

1. In ClinicOffice go to the Reports and Templates section 

a. Right-click on a Letter Template (e.g. “Letter to Patient”) that you wish to use as a basis for the new 
E-Sign document and click Copy 

b. This creates a copy e.g. “Letter to Patient (copy 1)”. Right-click on that copied template and click Rename 
to give it a new name (e.g. “Patient Consent”) 

c. Now right-click your new Letter Template and click Edit Template 

2. In the document itself, left click to place the cursor on the spot where you wish the signature to be inserted 

https://pioneersoftware.co.uk/co-edocs
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3. Go to the INSERT tab (at the top) and click the Signature Point button 

 
You will now see the text [SIGN HERE] inserted into your document. You can insert more than one signature point into 
the document if required. 

Once you’ve finished, click the Save Template button and close the document editor. 

 

[2] Capturing a Client’s Signature 

1. To create the E-Docs document, simply merge  your Letter Template with a patient record. The recommended 
way to do this is :- 

a. Open a patient record and click the Print button (at the top) 

b. Select the document template (e.g. “Patient Consent”) created in section [1] 

c. This will open the document and merge in the patient’s details 

2. You will now see a button to the top left of your screen that says “Send to E-Docs” [clicking this opens the E-
Docs Manager, which is covered more fully in Using the E-Docs Manager] 

3. For now, just click “Generate E-Docs” and select “Use a Tablet” 

[Using a tablet (or another device) allows you to open the document with the patient present, and you can hand them a tablet 
for them to review and sign. Sending an email link allows the patient to fill it out in their own time.] 

 

A message will now appear providing you with your Customer Reference and the Document ID, and a link to the document 
(see below). 

 

 

NOTE: Letter Templates can be merged with multiple patient records, however when creating an E-Sign document 
which is to be signed by ONE person, you obviously only want ONE patient record. Using the PRINT button in the 
patient record (as described above) ensures that only one patient record is merged into the template. 
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1. On your tablet or other device, enter in the Customer Reference and Document ID into the E-Sign website and 
click the Load E-Document button 

2. The document should now appear, and you can hand the device over to the client 

3. If they are happy to sign it, then they should :- 

a. Make sure their name appears correctly in the box at the bottom of the screen (if it is incorrect, they can 
tap on it to correct it) 

b. Use their finger (or stylus of the device has one) to sign their name in the box. If they make a mistake or 
the signature is inadequate, they can click the Clear button to start again 

c. Click the SIGN button to insert their signature into the document 

d. (If there are multiple signatures required, step (c) will need to repeat) 

4. Finally, they can click the FINISH button and hand back the device 

 

NOTE: If the document has multiple signature points, then the patient will need to click the SIGN button more 
than once to reflect each signature. For example, if it is a 2-page document with signature points at the bottom 
of each page, the patient will to press SIGN twice before being able to press the FINISH button. 

 

  

Once the document has been signed, a popup notification message 
will appear in ClinicOffice (at the bottom right). 

You can click the Open E-Docs Manager ( ) button on the popup 
notification to view the signed document. 

 

 

The final step is to then import the signed document. Clicking on the notification will open the E-Docs Manager, or 
alternatively, you can find it on the drop-down arrow under the patients button. We will cover how to operate the E-Docs 
Manager in Using the E-Docs Manager. 

 
 
Q. I accidently clicked OK to the “Document Uploaded to E-Sign” message before making note of the Document 
ID. Where can I find this number again? 
 
A. You can retrieve the Document ID from the E-Sign Manager, by clicking the lower-half of the Patients button on the 
Home menu in ClinicOffice and selecting E-Sign Manager from there you will see the document and it will state “In 
Progress” and will provide the Document ID in the first column on the left.   
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Making a Form E-Docs Compatible 

 

This feature allows you to create and send a form to a patient via email for them to complete and return. For example, 
a Medical History form, or COVID-19 Symptoms form. 

 

1. Firstly, you need to create your form within ClinicOffice. As mentioned at the outset, if you haven’t already, you 

will need the Forms add-on module and potentially the Documents module to use this feature. 
 

2. To access the Form Manager, head to the ‘Tools’ tab in ClinicOffice, and then click ‘Forms Manager’. Double 

click to edit any form, and from there, click the Preview Online button. This will generate the form on the E-
Docs service and will open your internet browser with a preview (like the example below). 

 

 

This will at least give you an idea of how it will look online and this will also be what the patient sees.  

 

NOTE: The online form will not be able to mimic some formats. For example, a form might have two or more 
fields on the same line but when the form appears online, these fields will appear in a linear style. Another 
thing to note is that checkboxes will appear as Yes/No drop-down menu in the case of a two-state checkbox, 
and in the case of a three-state it will appear with a blank value or Yes/No. 

 

For more information on how to design a form, please refer to the Designing Forms section. This can be accessed via 
ClinicOffice’s Help menu. 
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3. Once you have your form, you will then need to select whether it is to be “Clinical”, “Admin”, OR both (see 
below). 

 

 

 

An Admin form would only allow the form to be saved in the patients documents area. This would be useful for things 
like “Information Sharing Consent” for example or any forms that only need to be completed once.  

A Clinical form would be a form that gets attached to a patients clinical notes and has direct relation to treaments. This 
would be useful for “Consent to Treatment” type forms. 

A form can also be both. This might be useful for any type form where you want to have both a copy on the patients 
documents section and on their Clinical Notes. 

Once you are happy with the form, you just need to make sure that the Online box is checked, and the form is then 
ready to be sent out via E-Docs to a patient. To do this, you will need to access the E-Docs Manager. 

 

Q. Can a form be setup to request the patient for a signature? 

A form can be configured to accept a signature. This can be done by going into the form designer and going to the 
Online Form tab. From there make sure that the “Show Signature Box” is ticked. You can customise the text that is 
presented to the patient before they complete their signature by clicking the Signature Paragraph button (see example 
below). 
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Q. Can a field be made mandatory? 

Yes, you can make a field mandatory. To do this, while in the form 

designer, you can right-click on a field and select Required Field. 
Alternatively, when you are adding a new field there will be a “Required 

field” checkbox that you can select.  

You will know if a field is required because its text will be in red. This is 
equally true when the form appears online as well. If the patient does 

not fill the field in they will be prompted to once they click to finalise their 

form submission. 

 

 

Using the E-Docs Manager 

[1] E-Docs Manager Basics 

 

To access the E-Docs Manager, click on the drop-down arrow under the 
main Patients button in ClinicOffice, and select ‘E-Docs Manager’. You 
will now see the window below open up. 

 

 

 

This screen gives you an overview of all pending documents. The status of the document will be shown here. It will be 
either waiting to be filled in by the patient or waiting to imported back into ClinicOffice.  

Right-clicking on any document from this screen will reveal a list of options, such as re-sending via email, cancelling 
or showing further document information. 

This drop-down allows you to select 
whether you want to show/hide  

pop-ups (mentioned in section A/2) 
when a new completed document is 

detected. 
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This screen will also show who initiated a document, the name of the patient and the name of the document that has 
been issued. 

Clicking on ‘New’ will take you to the E-Docs generator screen. 

 

[2] Generating E-Documents 

There are multiple ways that you can access this screen.  

1. One way is as above, through the E-Docs Manager 

2. You can also access it via the E-Docs menu from any patient or appointment record if you want to run a letter 
with a signature point 

3. Right-clicking on any appointment in the diary 
 

The latter 2 options simply bypass the need to select the document or patient. 

 

 

 

Any forms that have been selected for online use from the Form Manager or letters with signature points will appear in 
either of the drop-downs above. 
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Load Template allows you to create a template for a form or group of forms and documents. This is useful if you 
frequently have to send a specific set of documents to your patients. For example, maybe you need to send out a 
welcome pack. To create your own document group, simply add your list of forms/letters to the generator, and then click 
the ‘Save’ icon. Give your template group a name, and then in  future, simply click ‘Load Template’, select your template 
group, and your document pack will be loaded in ready to be sent to the patient. The nice thing is that the template 
group can also store information such as whether a signature is required, the save location and whether a patient 
consent is granted once this document group has been completed. 

 

Document Ordering allows you to choose/re-order the documents as they will be presented to the patient. When you 
add more than 1 document to the list, you will notice the arrows to the right side of the screen turn green (see image 
below). Use these arrows to change the order. 

 

 

 

Save Location allows you to choose where the completed document will be saved. With forms, depending on whether 
you have selected an ‘Admin’ or a ‘Clinical’ form will depend on what is avaliable here. An ‘Admin’ form can only be 
saved to the “Patients Documents” and a ‘Clinical’ form can only be saved to a “Clinical Notes” location. Letters can be 
saved in any of the mentioned locations. 

 

Form Signature Required allows you to capture a signature relating to the form that the patient has just filled out. If 
ticked, ClinicOffice will then create an additional PDF version of the file with the signature of the patient. This is so that 
the document cannot be tampered with subsequently. You can also choose to save the PDF version in a different 
location from the form itself. 

 

Update Patients Consent will allow you to specify that once this form, letter or document template group has been 
completed then automatically mark a consent or consents as being given by the patient. These options are given to you 
when you tick the “On receipt of this E-Document, update the patient’s record to Consent Given for these consent 
types..” option. From there your required consents will be displayed and you can select which one is applicable for this 
form, document or templated group. 
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Once you are happy with everything, you can click ‘Generate E-Docs’. You will then be asked if you want to send the 
document via an email link, hand the patient a tablet there and then or just save it for later (see image below).  

 

 

 

 

Once the patient has returned the document, you will see the completed status pop-up as mentioned in Section A of 
this guide, or you can go straight back to the E-Docs Manager window, and you will see it there (as below). You can 
then press the ‘Import Completed E-Docs’ button, and the documents will save to the location that you specified when 
you generated the E-Docs. (This cannot be changed once you have submitted a document to the patient. If you make 
a mistake, you must cancel it, and recreate the E-Document.) 

 

 

 

 

Once the document has been imported, you can view these records by right-clicking on the log, going to Imported 
Records and selecting the relevant form or PDF document (as shown above). 
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Healthcode Insurance Billing 

We have integrated within ClinicOffice Healthcode. This enables you to submit invoices securely to an insurance 
company electronically via the Healthcode system. For the leading healthcare insurers, this has now become the 
preferred method of billing. It reduces the number of returned invoices compared with sending them yourself directly to 
the insurer and leads to greater efficiency for your clinic. There are no additional charges for signing up to Healthcode. 
 
To use Healthcode, you will need the following: - 

• Healthcode account with Site ID 

• The relevant insurer provider number 

• Industry Standard Codes 
 

Setting up Healthcode 

If you already have a Healthcode account, you can enter these details into ClinicOffice by following the steps below. 

1) Go to the View menu (tab) within ClinicOffice 
 

2) Click the Program Settings button 

 

3) Click the Global Settings tab 
 

4) Towards the bottom left click the blue link “Setup Healthcode Billing” 
 

The main “Account Settings & Defaults” screen will now appear. 

 
5) Please enter in your account’s Site ID, Username and Password 

 

6) Test that your account details are correct by clicking the “Test connection to Healthcode” button 
 

 

NOTE: If you do not already have a Healthcode account, then you can always click the “Contact Healthcode” 
blue link to get in contact with them to setup a new account. 
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You will note that at the bottom of the Account Settings screen is a 
section called “Default Claim Properties”. Within this section are 
different links to the relevant insurance company’s properties. For 
example, when you click on BUPA the screen to the right will 
appear.   
 
The settings within this screen will always override your other claim 
settings for the insurer you are looking at. Generally, you will not 
need to touch this screen unless you are instructed by Healthcode 
to change a value within your claims. For example, an insurance 
company might require an Authorisation Code so you would insert 
such a value into this screen.  

 
 

7) Click on the Provider Numbers tab and enter in your relevant provider numbers 

If you do not know what your provider number is then Healthcode will be able to provide you with this.  
 
You will note that each insurance company is represented by a three-symbol code; however, these abbreviations are 
not always obvious in what they represent. A key chart for this is displayed below. 
 

Insurer Code Insurer Name  Insurer Code Insurer Name 

BUP Bupa  BCW Simplyhealth 

BUI Bupa International  SLH VitalityHealth 

NUH Aviva  HHS Healix Health Services Ltd. 

PPP AXA PPP  WPA Western Provident Association 

EFS Exeter Friendly Society  AWC Allianz Worldwide Care 

CIG Cigna Healthcare    
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8) Next click on the Item/Service Code Mapping tab 
 

You will note that you have three columns; the first two are pulled from your items and services grid and are stored within 
ClinicOffice. The third column is where you would put the industry standard codes. The reason for this is that Healthcode 

will not know what your individual items or services represent when you are submitting an invoice. 
 

9) From here enter in the industry codes for the services that can be claimed for and click OK once finished 
 

 

NOTE: The Industry Standard Codes can be obtained from Healthcode if you do not already have them. To assist 
you with this you can click the Export Mapping File, save the CSV file locally and email it through to them. Once this 
has been filled in click the Import Mapping File, locate your CSV file, select it and click open. The relevant codes 
will then be filled in. 

 

By following the above steps, you will unlock the Healthcode Manager within ClinicOffice. The next phase of the setup 
is to help ClinicOffice identify which contact is an insurance company. 

 

10)  Go back to the Home menu within ClinicOffice 
 

11)  Click on the Contacts button to go to the 

contacts grid 

 

12)  Locate your insurance contacts, such as Bupa, 

AXA PPP etc. by using the Search button 

 

13)  Open the Insurance company’s record and 
click the Healthcode button 

 

14)  Tick the checkbox present on the screen and 
select the Healthcode insurer code via the 

drop-down menu 
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15)  Click OK 

 

16)  Repeat steps 12 to 15 for each insurance company you have on record  

 
If you do not have an insurer on record but you will be billing them in the future you can create a new contact by clicking 
the New button within the Contact grid and from there enter in their details. Once done you can again follow steps 12 to 
15. By doing this, when you now raise an invoice for an insurance company the option to submit to Healthcode will be 
available. 

The last part of the setup phase is making sure the patient has the insurer marked as their insurance company and that 
they have an insurance reference entered. The next set of steps will go through this. 

 

17)  Within the main Home menu click the upper-half of the Patients button to go to the Patients grid 
 

18)  Open a patient’s record by double clicking on it 

 

19)  Unless customised, expand the “More Details” group  
 

20)  Under the Payment Information fill in both the Insurance Company and Insurance Ref fields 

 
 

 

21)  Click Save and Close 
 

22)  Repeat steps 18 to 21 for each patient that is paying via their insurer 
 

The above steps are the main prerequisites that will enable you and your company to submit invoices to your insurer 
via Healthcode. There may, however, be times when the invoice will still fail. We will now consider this part way through 
the next subsection. 
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Submitting Invoices via Healthcode 

In this section we will consider how you would raise an invoice and then submit it to Healthcode. If you have not already 
setup your Healthcode account within ClinicOffice then it is advised that you follow the previous section “Setting up 
Healthcode”. 
 
The scenario we will consider is that an appointment has been completed for a patient that has insurance and now an 
invoice needs to be raised and then submitted to Healthcode. 
 

1) Go to the patient’s appointment within the Diary 

 

2) Right-click on the appointment and select Create Invoice 
 

3) Select to “Invoice the patient’s Insurance Company” (i.e. Invoice: BUPA) 

 

4) If you have a default charge item that you wish to use click Yes to the next message 
 

If you do not have a default charge item for this appointment type then you can add a service to the invoice by pressing 

the small + symbol at the bottom of the “Invoice Items” and then selecting the item via the Item Code column. For more 

information on how to add a new invoice line please see the section “Adding Lines to an Invoice”. If you wish to know 
how to create a default charge amount for an appointment type please see the section “Creating a New Appointment 
Type”. 

 

5) Once the correct charge amount has been inserted click the Healthcode Claim button 

 

6) This should bring up the Healthcode Claim window, click Submit to Healthcode 
 

So long as your setup is correct the claim will automatically be submitted. If, however, something is missing from your 
setup then an error message will appear under the “Claim History” section, this is usually self-explanatory. If you do 
need assistance, please contact either Healthcode or Pioneer Software (customers on our support plan can call or email 
our support team, non-supported customers can post for free on our support forum forum.clinicoffice.co.uk).  

https://forum.clinicoffice.co.uk/
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Healthcode Claim Manager 

Using the Claim Manager, ClinicOffice provides you with a way to overview your submitted claims, claims that are 
pending and invoices that are without any claims. You can access the claims manager by clicking on the lower-half of 
the Finances button and selecting Healthcode Claims. Alternatively, you can access it by going to the Tools menu 
and clicking the Healthcode Claims button there. This will bring up the window below. 

 

Healthcode Claim Manager – Without Claims

 

The first screen that you will see when opening the Healthcode Claims Manager are the invoices that are without a 
claim. So, these are invoices that qualify to have a claim because they are invoiced to an insurer registered with 
Healthcode but as of yet, a claim has not been raised. If you always submit a claim to Healthcode whenever raising an 
invoice then this screen will be empty, however, this screen does provide you with an alternative way to create claims 
on bulk. You can do this by clicking the “Select All” link if you wish to create a claim for all the invoices or tick the 
checkbox under the “Select” column for individual invoices and click the Create Healthcode Claims button. This screen 
is also useful because it allows you to check that the invoices that need claims have been created.  
 
The Claim Manager will allow you to select a date range for your claims. By default, the grid is grouped by the “Insurer” 
but you can change this so that the claims are grouped by “Month” or remove the grouping a ltogether. You can also 
right-click on an invoice and select to open it. In the next two screens we will consider the right-click menu will also allow 
you to open the individual claims as well. You can also access the main Healthcode Setup screen from the blue link 
towards the bottom left. 
 
If you are in the process of a claim and have not had time to complete but decide to save it or the claim has failed for a 
reason, then these claims will show on the “Show Pending Claims” section of the Claim Manager. The next screenshot 
demonstrates this. 
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By looking at the screen above the status of the claims become evident. A “Failed” status is highlighted in red and a 
message of why the claim failed will be visible below the claim line. In the example above the reason for the failure is 
that the invoiced item has no industry code assigned to it. A “Pending” status is highlighted in blue and will display when 
the claim was initially created. You can correct or complete a claim by right-clicking on the claim, select Open Claim, 
make the needed adjustments/corrections and click Submit to Healthcode. All being well your claim should go through. 
  

 
The last section of the Claim Manager is the “Submitted Claims” and these are claims that have been successfully 
submitted to Healthcode. Now, all that you need is to wait for the insurer to either pay the submitted claim or indicate 
why they are unable to. Once this has been received the Claim Status will change to “Collected by Insurer”. 
  

Healthcode Claim Manager – Pending Claims 
 

Healthcode Claim Manager – Submitted Claims 
 



- 216 - 

Audit Trail 

In all editions of ClinicOffice, whenever a record is created or updated a note is made within the database of who created 
it and who updated the record. It will also tell you the date and times of this. Such information will be visible at the bottom 
of the relative records. If you wish to see a more thorough breakdown of what was updated, then this is where the Audit 
Trail comes into play.  

As the audit trail feature records any changes and keeps a record of past information as well, it does mean that more 
reads and writes to the database are made. As this is the case, the audit trail is available only for the Server and Hosted 
Editions of the software. 

 

How to Turn on the Audit Trail 

The Audit Trail is set to a basic audit by default. This records changes made to the appointments, clinical notes, invoices, 
payments, patient and staff records. If you want a more system wide audit trail, then you can do this by following the 
steps below. 

 

• Go to the View menu in ClinicOffice 

• Click the Program Settings button 

• Go to the Global Settings tab 

• Click the link Audit Trail Settings… 

• Select the option “Comprehensive Audit” checkbox 

• Click OK and OK 
 

From this point on, any changes made within ClinicOffice will be recorded. This also includes any text removed or any 
record deleted.  

 

Audit Trail on an Editor 

There are two ways you can view the audit history. The first way is via the individual record. If you open up nearly any 
editor within ClinicOffice, at the bottom of that editor there will now be an Audit Trail blue link present (see example 
below).  

Audit Trail Link Location 

 
 
When you click on this link, a window such as the one below will appear. 
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In the example given above, this is an Audit Trail window for the Invoice Editor, but the Audit Trail window for any editor 
will be pretty much the same. You will note that there are three columns the Date/Time, Description and Staff Name. 
The Date/Time will tell you when the creation or update took place for this record. The Description is a brief statement 
of what has occurred, for example the record was ‘Updated’ or the record was ’Created’. The Staff Name displays the 
member of staff that has performed the action of either updating or creating the record. This screen also shows any 
linked information to the record such as the custom fields. 

You will note that each line has a small arrow present to its left. By double-clicking on a line, it will present you with 
further information, like the example below where all three audit lines of the invoice audit history have been expanded. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Within the expanded information there will be each field that has been either added to or modified. This displays all 
changes made to the current record. If no information has been entered or changed within a field on the editor, then no 
information is recorded into the audit history, because there is nothing to record for that field. 

You will note that to the right of the field name are little symbols present. There are three different symbols altogether 
and these are explained in the table below. 

 

Audit Symbol Description 

[+] 
The ‘plus’ symbol means that a new value has been added to the 
current field. 

[─] 
The ‘minus’ symbol means that a value has been deleted from the field 
and the field is now empty. 

[−>] 

The ‘change to’ symbol means that the value has been replaced. Old 
previous values are displayed in red text and new values are displayed 
in green text. If we take the Total field within the image above, it has 
the old red value of “35” and it is being changed to “40” which 
presented in green text and the “[−>]” symbolises the transition. 
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Audit Trail Manager 

If you need to see the audit history for the entire database, rather than for a single record, you can do so by going to the 
Tools menu and clicking the Audit Trail button. The window below will appear. 
 

 
The Audit Trail Manager screen allows you to either view a larger range of auditing information or a more specific area. 
The fields and their functionalities are explained more in the table below. 

 

Field Name Functionality 

Date Range Allows you to search on the audit history for either a specific date or a range of dates. 

Database Table 

You can search on either all tables or look at a specific table within the database. This is useful 
if you are looking to see changes made to an area of the database such as changes made to 
appointments or to the patients. 

You will also notice three additional options: Inserts, Updates and Deletes. By default, all 
three are ticked. You can untick any one of them to refine your search. So, for example, if you 
only want to see records that have been deleted you will untick the other two options and leave 
the “Deletes” checkbox ticked. 

Staff Member(s) 

This allows for you to search on the staff member that has performed the changes. This field 
can be used if you wish to monitor changes a staff member has been making to the system 
throughout the day. 

Value Search 

This will search on records that are linked to a patient or contact record. So this could be either 
used directly for searching on the patient or contact’s record or any linked records such as 
appointments or invoices for that individual. Once you have selected the person you will note a 
long number is inserted into the Value Search field this is the internal ID the database will use 
to find the associated records. 

 
Once you have entered in your search criteria, click the Search Audit Trail button. As indicated, the wider the search 
range, the longer the search will take to complete. Should you wish, you can also click on the Print button to print this 
screen or to export it to PDF, CSV or some other format.  

You will note that the grid is colour coded. Anything highlighted in a GREEN colour indicates that a record has been 
created; any lines in BLUE indicate that a record has been updated and any lines highlighted in RED indicate a record 
has been deleted.  
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Managing and Recording Consents 

With the advent of the GDPR (General Data Protection Regulation) seeking a patient’s or contact’s permission to store 
their data or the right to contact them is ever more paramount. To help you with this we have added a consent 
management system. This consent system will allow you to mark and keep a track record of consent for each patient 
and contact. You can add your own consent types and even allocate consents for specific appointment types. Should 
you wish ClinicOffice will also bring up a reminder when you open a patient’s record or create a new appointment that 
certain consents have not been agreed to as of yet. 
 

Consent Manager 

To understand what consent types are already available you will first need to visit the Consent Manager. The Consent 
Manager can be accessed by going to the Home menu, clicking on the lower half of the Patients button and clicking 
Patient Consent Manager. 
 
 

 
 
 
The consent manager screen will now appear. 

 
 

Opening Consent Manager 
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From this screen you can add new consents, edit existing consents and delete unwanted consents. You can view the 
notes made about the purpose of the consents by ticking the “Show notes” checkbox. You can see disused consent 
types by ticking the “Show deleted” checkbox. You can also manage the appointment types a consent is assigned to by 
clicking the blue link “Consent -> Appt Types” (toward top right). 
 
You will note that on the first time opening the consent manager there are already default consent types present. Their 
purposes are listed below.  
 

Consent Name Applies To Show Warning Purpose 

Can Re-Use Worldpay 
Tokens 

Patients & 
Contacts 

No Warnings You will need to gain a patient’s or contact’s 
permission in order to be able to re-use their 
card details for future transactions. Without this 
permission you would need to retake their card 
details each time they come to make a 
payment. 

Record Personal Data Patients & 
Contacts 

Always Show 
Warnings 

With this enabled you have permission to store 
and record information on the patient or 
contact. A warning message will appear 
whenever you open their record or create an 
appointment for them until you have recorded 
that permission has been given.  

Information Sharing Patients & 
Contacts 

No Warnings Used for when permission has been granted by 
the patient or contact to share their information 
with third parties. 

Marketing 
Communications 

Patients & 
Contacts 

No Warnings Used for when permission has been granted by 
the patient or contact to send them things such 
as newsletters or special offers. 

Treatment Consent 
Given 

Patients Warn on Clinical 
Action 
+ Appointment 
Type Warnings 

To be used when consent has been given to 
allow you to perform treatment on the patient. 
A warning will only appear when creating and 
saving a new appointment for a patient without 
consent. 

  
 

Q. I do not need all of these consent types can I just delete them? 

A. If you do not require a consent type then yes you can delete it by right-clicking on the consent and selecting Delete 
Consent Type. A Consent Type is never truly removed because the audit links created within the database but it will 
be hidden from view and no longer used once marked as deleted. The only two consents that you cannot delete are the 
“Can Re-Use Worldpay Token” and “Record Personal Data”. 

 

Q. I do not wish to delete the consent types but is there a way to stop the consent warning messages from 
appearing? 

A. To prevent consent warning messages from appearing right-click on the consent type and select Edit Consent Type. 
Set the “Warnings” field to “No Warnings”. Also click on the Set Appt Types button within the Consent Type editor and 
make sure that no appointment types are ticked. Repeat this for each consent type. 

 

Q. Is there a way of disabling the consent system? 

A. Yes there is. To do this, go into the Consent Manager and tick the option “Disable Consent System”. You will no 
longer have any consent warnings, regardless of the individual consent settings. 

 

Creating New Consent Types 

 

1) Click on the lower half of the Patient button and click Consent Manager 
 

2) Click the New Consent 
 
3) Give the new consent a name 
 
4) Select who this applies to (Patients, Contacts or Patient and Contacts) 
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5) Set whether you want a warning message to appear and where you wish it to appear 

 

 

Q. What do you mean by warnings? 

A. A consent warning is where a message will 
appear within ClinicOffice warning you that a patient 
or contact has not granted consent for a particular 
purpose. Within the Consent Type Editor, there are 
4 different Warnings, and these are: No Warnings, 
On Admin Actions, On Clinical Actions and Always 
show Warnings. These will affect where the consent 
warning will appear. 

If the consent is set to “On Admin Actions” then a 
consent warning will appear for the patient whenever 
a new appointment is created, closing their record or 
linking them to another record. If the consent is set 
to “On Clinical Actions” then the warning will 
appear whenever you go into the patient’s clinical 
notes. If you set the consent to “Always Show 
Warnings”, then the warning message will appear 
whenever an admin or clinical action is performed for 
the patient. 

If the consent has been set with a warning to appear then by default the warning will activate when the consent has not 
been recorded, when the consent was declined and when the consent has expired. The warning will stop once the consent 
has been recorded. 

 

6) If the consent given is only valid under law for so long, then you can set for the consent to expire after a period 

via the Expires After field 

 

Q. I cannot set my own custom expiry period for the consent?  

You will note that by default the “Expires After” field only has the values 6 months, 1 year; 2 years, 3 years; 5 years 
and 7 years. You can type your own custom expiry period though. For example, if the consent is only valid on the day 
of treatment, then you can type into the field “1 day” (without the quotes). If the consent expired after two weeks, you 
can type “2 weeks” (again without the quotes). The system will recognise this text. All you need to do is enter in the 
number and then the period i.e. days, weeks, months or years. 

 

7) Enter in any notes to explain what the consent is for [this is not required] 

 

8) If you require for the consent warning to appear only for certain appointment types, then click the Set Appt 

Types button 
 

9) Tick the appointment types you want the warning to appear for and click OK 

 

10) If you are happy with everything click OK again 
 

Your new consent type will be created and will take effect immediately. 
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Recording Consents 

Once the patient or contact has given you consent for one of the consent types you can record this within ClinicOffice 
on their record. The steps below will assist you with this. 

 

1) You can do this by either clicking on the “Go to their Consent Record” when the consent warning message 
appears or directly open their record and go to the Privacy & Consent tab 
 

2) Click the Update button to the relevant consent i.e. if it was Marketing Communication you would like Update 

on that 
 

3) If consent is given, select Consent Given and if they have declined then select Consent Declined 

 

4) To the right of this is a text field, either type in how the consent was given or select from the drop-down list of 
predefined note values [see image below] 

 

Recording Consent within Patient’s Record 

 

 
 
 

5) Click the Save button 
 
The consent will now be updated and saved to this record. 
 
Q. How do I change or add new predefined notes for the consents? 
A. To edit or add new consent note templates you can click the blue link “Edit Note Templates” which is at the top of 
the Privacy & Consent tab for both patients and contacts. From that screen you can add, remove and add new 
consent notes. 
 

Consent Audit Trail 

You may have noted in the previous section that when you record a consent being given or declined, that there is 
“Previous Notes” field section. This is a preview of notes recorded in the last consent for this consent type on the 
patient or contact you are looking at. These previous notes are a part of the Consent Manager’s Audit Trail. Each 
consent type for each record stored on the database has its own audit trail. To view the full audit history, click the 
Audit Trail blue link on the consent (location varies, see examples below). 
 

Audit Trail Example 1 

 
 

Audit Trail Example 2 
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The Consent Audit Trail that appears will look like the window below. By default it will show the notes of current and 
past consent recordings. You will note that the current or latest consent note is marked with the grey label “Current 
Audit Record”.  
 

 
Should you wish to you can also print this screen by clicking the Print button. Past consent notes cannot be edited or 
altered in anyway. 
 
 
 

Searching on Patient’s and Contact’s Consents 

There are a three ways you can search on the consents for patients and contacts. These are listed below. 

 

Option 1 

You can search on the patient’s or contact’s consents via the Consent Manager. Doing it this way will search on each 
consent type separately. The steps below will show you how to do this:- 

 

1) Click on the lower-half of the Patients button and click Consent Manager 

2) Right-click on one of the consent types i.e. Record Personal Data 
3) Go to Reports and select from there “Consent Report –Detailed (Contacts)” or “Consent Report – Detailed 

(Patient)”, depending on what you want to search on 
 

This will generate a list of ALL consents given, declined, expired and not recorded for this consent type and this will be 
throughout all history. You can click the Search button to refine the search further. 

 

Option 2 

An alternative method is to search on the consents directly via the patient’s or contact’s grid. The benefit to this is that 
you can specify the consent value i.e. “Consent GIVEN”. The steps below will talk you through this. 

 

1) Go to the Patients or Contacts grid by clicking on either the Patients or Contacts button 
2) On the Search button, click on the arrow that is pointing down 

3) Click Consent Search 
4) Select the Consent Type, i.e. Marketing Communications 

5) Select the Consent Value, i.e. Not Recorded 
6) Click OK 
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Option 3 

This third option is a variation on the first option, but you would instead access the reports directly from the Reports and 
Templates section of ClinicOffice. This overall provides you with the greatest flexibility for reporting on consents. The 
steps below explain how to do this. 

 

1) Click on the Reports and Templates button on the Home menu 

2) Scroll to Patient group of the Reports and Templates 
3) Double click on one of the consent reports, i.e. “Consent Report – Detailed (Patients)” 

4) If you want to specify the status or value of the consent type, put it into the Consent Status field, i.e. consent 

given 
5) Type in the name of the Consent Type you want to search on, i.e. Information Sharing 

6) If you wish to a date range, double click on the Other Search Fields to expand it open 
7) You can specify the date within the Consent Date/Time field 

8) You can also specify a number of other search criteria from here 

9) Once happy, click the OK button 
 

 

Updating Consents on Bulk 

Generally, you should not need to update people’s consent on bulk and it is sounder that you should do this on an 
individual basis instead. However, there are times, maybe for historical reasons or on the point of introducing a new 
consent type that you will need to update patient’s consents on bulk. In this section, we will discuss two options on how 
you can bulk update people’s consents using the Batch Update feature. 
 

Option 1 

The first option we will discuss is a way to bulk update consents across the entire database. This might be useful if you 
need to reset everyone’s consent on marketing for example. The steps below explain how to do this. 
 

 WARNING! It is highly recommended that you backup your database before you proceed, as this 

cannot be easily undone. 

1) Click on the lower-half of the Patients button and click on the Consent Manager 

2) Right-click on the consent you wish to perform the bulk update on, i.e. Marketing Communications 
3) Select Batch Update…. 

4) Click OK to the next message that appears 
5) Set the consent status i.e. Not Record or Consent Given 

6) Put a note on how consent was given or is not for that matter 
7) Click OK, click Yes if you are certain of bulk updating these consent 

8) Type in Yes and then OK, again only if you are 100% certain 
 

Note: When performing the batch update using Option 1, you will be updating either all patients, contacts or both 
depending on who the rule is to apply to. The Consent Manager will indicate this. 

 

Option 2 

The second option will allow for you to search on a group of patients instead and to then perform the batch update on 
their consents. The steps below can be replicated for contacts via the Contacts grid as well. 

Step1 – Searching on the Records 

You will need to go to the Patients grid by clicking the Patients button. Once in there you can perform your search on 
the patients by clicking the Search button. If you wish to search for their current consent status, please follow Option 2 
in the article “Searching on Patient’s and Contact’s Consents”. 

Step 2 – Updating the Consents 

If you wish to update the consent for everyone currently on the grid, left-click on any record and press the CTRL and A 
keys together, this highlights everyone. Now right-click on any of the highlighted records, go to Batch Update -> Patient 
Consent and select the consent you wish to update for everyone selected. Like in steps 5 to 8 of Option 1, you can set 
the consent status and put a note for it. Click OK, type YES and then click OK again. All records that you have selected 
will now have their consent updated. 
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Destroy Personally Identifiable Information 

Under article 17 of the General Data Protection Act (GDPR) it introduced the “Right to erasure”. This allows for the 
individual whom personal data is stored on to request for their data to be erased. Article 17 does, however, make clear 
that although the person has a right to request for erasure that only applies if there is no compelling reason for its 
continued processing. If you are of a medical profession then there likely is a very good reason for you to continue 
processing their personal data for the purpose of providing medical care. So in summary, your right to retain the data 
overrides their request for their data to be removed so long as you have a valid reason to keep it.  
 
The body that governs your particular profession will likely have guidelines of how long you have to keep data. For 
some, this might be 7 years after a person has finished their last treatment or after they have sadly passed away. 
Other professions will be different. After the end of this period, some feel that they no longer have a valid reason to 
retain this information. This is where our “Destroy PII” (destroy personally identifiable information) feature comes into 
play, as it offers a way to remove all references to that individual, meaning in NO WAY can they be identified from 
what remains within ClinicOffice. 
 
In this section, we will consider two examples of how to use the “Destroy PII” feature. The first example will look at 
how to destroy PII on for a single individual. The second example will consider how to do this on a group of records 
that have no longer been seen for a period of time.  
 

 WARNING! Before you proceed with either example, please make sure that you have the correct 

records selected before destroying their PII as this CANNOT be reversed. 

 

Example 1 

1) Go to the Patients or Contacts grid 
 

2) Locate or search the individual you wish to 
remove the personal identifiable information 
for and open their record 

 
3) Click the Delete button and click Yes to the 

next message 
 
4) Click the Recycle Bin button (located on the 

Home menu) 
 
5) Locate the record you have just deleted and 

open it again 
 
6) Click the Destroy PII button (the window to 

the right will appear) 
 

You will note that there are 5 different options you can 
select when running the Destroy PII. It is down to you 
to assess what is required in order to comply with the 
“Right to erasure”. Each option explains what it does 
on the screen. If you tick all 5 options, then not only 
will the identifiable information on the individual record 
be removed but also all other linked records to that 
person has will also be wiped as well. 

 

7) Click OK at the bottom of this screen 

 

8) Type YES if you are certain you want to 
proceed and click OK 

 

The personal identifiable information for this individual will now be wiped and destroyed. 
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Example 2 

1) Go to the Patients grid by clicking the Patients button 
 

2) Click on the Grid Options button (towards top right of the grid) 
 
3) Select “Next/Prev Appointments” from the drop down menu below 

the Data Source text at the top of the panel (see example on right) 
 
4) A little further down on the Grid Options panel, click the blue link 

that says Toggle Grid Filtering 
 

5) Scroll to the far right-hand side of the patient grid until you can see 
the Nextapp and Prevapp columns 

 
6) Hover your mouse over the Nextapp column header until there is a small arrow that appears and click on this 

arrow (see example below) 
 

7) Tick the option Show Empty 
 

8) Now click on the Search button 
 
9) Locate the Prevapp field (located under 

Other Search Fields by default) and search 
for “On or before” a date from 7 years ago 
for example (adjust this to whatever you are 
required to) 

 
10) Click OK and OK again 
 
11) Make note of the number of records present 

by scrolling to the far left hand side and in 
the bottom left will be a count present there 

 
12) Select all records, by left-clicking on one 

record, pressing CTRL and A together 
 
13) Right-click on one of the highlighted 

records and select Delete Patient 
 

14) Click on the Recycle Bin button (in the 
Home menu) 

 
15) On the Recycle Bin grid, click the Search button 
 
16) Search on the Deletedon field of when you deleted the record i.e. Today (also specify a time to narrow the search 

range) and click OK 
 
17) Select all records, by left-clicking on one record, pressing CTRL and A together 
 
18) Right-click on one of the highlighted records and select Destroy PII 
 
19) Make sure that the record selected count, match what you had registered on the patient screen 

 
20) Select carefully the PII Removal Options and click OK 

 
21) Type in YES and click OK 

  

Note: Information such as general dates (except for the date of birth), invoiced or payment amounts will not be 
removed when you destroy a person’s PII. The reason is that this information is not deemed personally identifiable 
information. The only information that could possibly be linked back to the individual is removed.  
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Merging Records 

You may find that you have more than one record for a patient or contact. This can occur when someone else enters a 
new record for the same person. This can also easily happen with an appointment type; you can have two different 
descriptions applying to the same appointment type. This can cause confusion and complications.    

The merging contacts or patients work in a similar way to merging Types and Categories, but there are slight differences. 
These will be discussed in turn. 

 

Merging Patient/Contact Records 

To merge a patient or contact record the same process is involved. You can only merge two records at a time.  

 

To do this, follow the instructions below:- 

• Go to the Patient/Contact grid  

• Right-click on the record you wish to merge 

• Select Merge Records. A search box will appear.  

• Enter the name of the record you wish to merge, then select it 

• Press OK  

• A message will appear, select the record you wish to keep as the original  

• Another message will appear informing you that the merge was successful, press OK 
 

You will find that the record that you choose to keep will remain, but the other record will be deleted. Any appointments, 
financial records, documents or Clinical Notes will be transferred over. Details that are entered into the standard fields 
of the Patient Editor, such as medical information, are not transferred over.  

You can also merge two records by selecting both of them in the grid, right-clicking on one of them and then select 
Merge Records. The message will appear asking you which one to keep. Select it and then press OK to the following 
message. This is a slightly quicker way of doing it. 

 

Merging Types & Categories  

To merge in the Types and Categories is an identical process, with just a slight difference. Please follow the instructions 
below:- 

 

• Go to the Types and Categories 

• Select which type of category you wish to edit (i.e. Appointment Type,  Contact Category) 

• Within the grid choose field name (i.e. Reassessment in the Appointment Type) and right-click 

• Go to Merge with…, select the other field you wish to merge with from the menu 

• A message will appear, select the field that you wish to keep 

• You will be informed that it was successful, press OK 
 

All references to the field within Clinic Office will now be changed to the field that has been kept. An example is if you 
merge the appointment type Foot Massage with Treatment and you decided to keep Treatment, all references to Foot 
Massage will be changed to Treatment.   

 

 

 

 

 

 

 

 

Note: Once a merge has been successfully completed it CANNOT be undone. 
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Recycle Bin 

ClinicOffice has its own Recycle Bin. All patient, contact and staff member records, when deleted end up here.  

These records can never be deleted permanently. The advantage of this is that if you were to do a financial summary 
report for the year, those deleted records will be taken into consideration. If a Patient/Contact record was to be removed 
completely, then this could mean an incorrect financial report being generated. This also stops anyone accidently 
deleting someone’s record permanently. 

 

To access the Recycle Bin, go to the Home menu on the ribbon bar and click the RECYCLE BIN button.        

Recycle Bin Button 

 

The following grid will be displayed:- 

ClinicOffice Recycle Bin Grid 

 

This grid acts like any other grid in ClinicOffice. If you double-click on a record, an editor will open. You will notice that 
it would say [DELETED] next to the record name. You will also notice that the editor is greyed out, meaning that you 
cannot alter any details while the record remains deleted. The only exception is the Patient/Contact records, where the 
Finances section is usable. This is so that any financial report generated in the future will be accurate. 

 

Q. Due to GDPR I want to be able to destroy a person’s information, but how can I do this if I can never 
permanently remove a person’s record? 

A. You can remove a person’s identifiable information by using the “Destroy PII” feature via the right-click menu. For 
more information on how this works, please see the section “Destroy Personally Identifiable Information”. 
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Restoring a Deleted Record 

Deleted Contact Record 

 

 

To restore a deleted record, open it up and click the Undelete button located at the top of editor on the ribbon bar (like 
the image above). Alternatively, you can right-click on the record in the Recycle Bin grid and select Undelete Record. 
This then removes that record from the Recycle Bin and moves it back to its original place (i.e. if it was a patient 
record it will move to the patient grid). 

 

 

 

 

 

 

 

Note: Any financial or appointment records that are deleted will NOT go to the recycle bin. Instead they are deleted 
permanently and hence cannot be retrieved once deleted.    
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Zoom Integration Guide 

 

Prerequisites 

Zoom integration is offered as a standard feature of ClinicOffice, so there are no additional modules or add-ons that 
need to be purchased. 

However, Zoom requires you to have a paid-for account for third party applications (like ClinicOffice) to integrate via 
their API. For more information, please see their price plans here: 
https://zoom.us/pricing 

 

Step 1 – Configuring Zoom Integration 

Click [1] View -> [2] Program Settings -> [3] Global Settings -> [4] Setup Zoom Integration (as shown below). 

 

 

 

Click the Add Account [5] button and then login to your Zoom account. You will also need to agree to any prompts 
allowing ClinicOffice to access your Zoom account. 

Once your account has been added, map the account to a Staff Member in your ClinicOffice database as shown below 
[6]. If you have any sub-users in your Zoom account, these too can be mapped to Staff Members. 

 

https://zoom.us/pricing
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Once you have finished adding your Zoom account(s) to ClinicOffice click the Close button. 

 

Step 2 – Creating Zoom Meetings 

Now that you have a Staff Member linked to a Zoom account, whenever you create an appointment in the diary for that 
Staff Member, you will see the option (at the bottom of the screen) of Create Zoom Meeting. 
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Click Create Zoom Meeting to create a new Zoom meeting in your Zoom account and link this appointment to it. This 
will invoke the screen shown below. Set any options you require for the Zoom meeting and click OK to create it. 

 

 

 

 

Step 3 – Appointment Reminders for Zoom Meetings 

The Patient Contact Centre in ClinicOffice allows you to configure rules for sending out Appointment Reminders. (You 
can find the Patient Contact Centre under the main Patients button in the ribbon bar.) 

When you create an Appointment-based rule there is a setting called “For Zoom appointments” (shown below). 

This gives you the option to make the rule ONLY apply to appointments which are linked to Zoom or appointments  
which are NOT linked to Zoom. 
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When configuring the reminder itself, there are two Zoom-related merge fields that can be inserted into the message 
text: 

AppZoomURL  This embeds the URL (webpage link) for the recipient to tap on to join the meeting 

AppZoomPassword This embeds the password (if there is one) that they will require to join the meeting 

 

 

 

For more information on creating and configuring Appointment Reminders and other automated rules, please refer to 
the section “Patient Contact Centre”. 

 

 

Uninstalling/Removing Zoom Integration from ClinicOffice 

If you no longer wish to use Zoom with ClinicOffice, simply remove all the accounts from the Zoom Accounts screen, as 
follows: 

• Click View -> Program Settings -> Global Settings -> Setup Zoom Integration  

• For each Zoom account, click the REMOVE ACCOUNT button 

 
As a second step you can remove the integration from your Zoom account as follows: 

• Login to your Zoom Account and navigate to the Zoom App Marketplace 

• Click Manage -> Installed Apps or search for the “ClinicOffice” app 

• Click the “ClinicOffice” app 

• Click Uninstall 

 
The above steps will remove all Zoom integration from ClinicOffice. 
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Staff Member Access Rights 

With ClinicOffice v5 you can set each staff member up so that they have certain access rights. This is an important 
feature, because you might not want certain members of staff to have access to certain records that you store on the 
database (i.e. financial records). 

To set the Access Rights of a staff member, go to the Staff Members grid. Double-click on the staff member you wish 
to change. Once in the Staff Editor click on the Access Rights tab. It should look like the following screen:-     

 

Staff Editor Access Rights 

 

The Access Rights can be broken down into two sections Assign to Access Group and Use Custom Access Rights.  
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Assign to Access Group 

This area has three default groups: Supervisor, Full Access, and No Access. If you set the staff member to Supervisor, 
they will have full access to all parts of COv5 and will be able to alter other staff member’s access rights. If you set the 
staff member to Full Access then they have full access rights, but they ‘cannot’ alter other staff members access rights. 
If the staff member is set to No Access, then they have no rights on COv5 and will not be able to logon. 

You can create or alter an Access Group by clicking on the blue text which says Manage the Access Groups…; the 
Access Group Editor opens. 

Access Group Editor 

 

To create a new Access Group, press the NEW button. To remove a group, press the DELETE button. To rename a 
group right-click on it, in the Access Groups list and select Rename. To make a copy of an Access Group right click on 
the group and select Copy. You cannot edit or change any of the original three Access Groups. To edit one of your own 
Access Groups, see the next part on “Use Custom Access Rights”. Press the SAVE button to save any changes made. 

 

 

Use Custom Access Rights 

This section is used if you want to edit a staff member’s access rights, but you wish to define a unique set of rules. This 
works in the same manner as the Access Group Editor.  

You have four parts: Main Sections, Record Editors, Other Options and Reports. The Main Sections are whole 
parts of ClinicOffice for example the Patients grid. If this was un-ticked the staff member could not view the Patient Grid 
but could still view the Patient record by other means.  

The Record Editors covers all editors in COv5. Rather than being tick boxes (like the Main Sections), you have four 
choices: Full Access, Full (No Delete), Read Only and No Access. So, if you set Patient Editor to No Access the staff 
member could view the Patient Grid but would not be able to look at the Patient Editor. So, if you combine the two 
sections, by un-ticking the Patients (Main Sections) and set the Patient Editor to No Access, then the staff member 
could not view the Patient Grid or Editor. 
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The Other Options are all the additional areas of ClinicOffice v5 that are not classified as a Main Section or Record 
Editor. This area is particularly useful if you wish a staff member to have access to a certain area of ClinicOffice, but 
you wish to restrict the functions that they can carry out. An example is if you wish to allow the member of staff to have 
access to all grids (i.e. patient) but not to be able to export the data to something like an Excel spreadsheet. To do this 
un-tick the box next to Export Grids (located under Other Options). 

The Reports section rounds off the Access rights nicely. This area is helpful if you wish for a member of staff to have 
access to a report such as a ‘Letter to a Patient’, but not to the financial reports. The other sections have rules on the 
access rights for reports, but they affect all reports. This section though allows you to specify which report they may or 
may not have access to. Simply un-tick the box next to the report you do not wish them to use. 

You also have the Default Access column and the clinic’s column. By default, the clinic’s column will appear in yellow. 
This means that any changes made in the Default Access column will also affect the clinic’s column. The advantage is 
that if you have several clinic columns (all in yellow), you can set a general rule for all clinics. To remove the yellow 
shade, simply tick the Customised Access box (located below each clinic name). Once removed any changes made 
in the Default Access column will no longer affect the clinic’s column. 

The following example will show you how to customise a staff member’s Access Rights:- 

 

• Go to the Staff Grid 

• Double-click on the staff member you wish to edit. 

• Click the Access Rights tab. 

• Select the Use Custom Access Rights (located towards the bottom left hand corner). 
 

We need to set the staff member’s access rights so that they cannot create/view any financial information. To do this 
read on:- 

• Under the Default Access column in the top half (Main Sections) un-tick: Credits, Finances, Invoices, Items, 

Payments, POs and Refunds 

• Again under the Default Access column but this time the lower half (Record Editors) set the Charge, Credit, 
Invoice, Item, Payment, PO and Refund Editors to No Access 

• Further down in the Default Access under Other Options column un-tick the Quick Transactions and Stock 

Control 

• Also un-tick all financial reports (under the Reports section) 
 

You will notice that the clinic’s column has also changed (so long as Use Customised Access box was un-ticked). Now 
the member of staff will not be able to access any financial records. Their Access Rights should look something like the 
following:- 

Modified Access Rights Main Sections 
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Modified Access Rights Record Editors 

 

Modified Access Rights Other Options and Reports 

 
 

 

You might have noticed that not all the fields within the access rights have a separate tick box for each clinic. The 
reason for this is that certain fields are not defined by a single clinic. For example, Reports (which is under Main 
Sections) are not categorised by clinics. The reports can draw information from any clinic; hence if the member of 
staff is not allowed to access information about their own clinic then neither can they access other clinic’s information. 

 

Note: Whenever an additional report is created a new rule is automatically created for it. Make sure that you 
change the Access Rights for staff members whom you do not wish to access it. Also, any changes made to the 
Access Rights will not take effect until that member of staff is logged off from ClinicOffice.  
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Managing Users Logged In 

The User Session Manager allows you to monitor all users accessing the same database. Go to the Tools menu and 
click the User Session Manager button. 

User Session Manager 

 

You will use this screen if you suspect that someone is not actively using ClinicOffice. One scenario could be that one of 
the users terminated their connection abruptly with ClinicOffice so that it was forcefully closed (i.e. they switched the 
computer off at the mains). In this case ClinicOffice will still register that user as being logged on. To check if this is the 
case click the Send Query button. ClinicOffice will now check for 60 seconds to see if the user is Inactive. If the user logs 
back onto ClinicOffice during this time this will be detected and the query will finish. If the user has not logged back on, 
then the Session Manager will declare them as being inactive. When a user is inactive click the Remove Inactive button, 
this then removes their entry. All users that are logged on will be shown as active; hence the Remove Inactive button will 
not affect them. 

 

Another scenario is if a user is logged onto ClinicOffice and forgot to log off before they left. If this is the case and you 
know for a certainty that they will not be back, you can forcibly remove them by clicking on the Force Remove button. A 
log off warning message will appear on their screen, like the one below. 

Log Off Warning Message 

 

Once the message appears it will run for 10 seconds, after which they will be logged off from ClinicOffice. Only staff 
members with the access rights of a Supervisor can perform this task.   

 

 

Note: that any data that is being entered into an editor, which has not been saved, will be lost when the user is 
forcefully removed. 
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Active Patient 

When you start to use ClinicOffice you will notice a field situated in the top right hand corner of the program, just left of 
the search field. This is the Active Patient field.  

Active Patient Field 

 

 

When you open a patient’s record or Clinical notes, that patient will then become the Active Patient. You can also set 
the active patient by going into the diary, left clicking on an appointment and selecting Set as Active Patient. You will 
notice that the Active Patient Field flashes a golden orange colour when the active patient has changed. What 
happens next is when you go to create a new appointment, invoice, payment or credit note; you will be asked if you 
wish to use their name. If you click Yes then the Patient’s field will be automatically filled by the active patient’s name. 
This is so long as you are not creating it via another record, in which case it would assign that individual’s name 
instead. 

 

The Active Patient field can store up to 10 patients in its history. To select another patient from the history left click on 
the field and select one of the other patients. You can clear the current active patient by selecting Clear Active 
Patient. Note that this does not clear the list of patients in the history. In order to clear this you need to you log off and 
log on and then the history will be wiped. 

 

The Active Patient is handy when you want to create multiple appointments for a specific patient. So for example if 
you wanted to book five appointments for “Joe Bloggs” in the future, then you will set him as your active patient. You 
will then go to the relevant date and time, create a new appointment and click Yes to use the active patient; his name 
will be automatically filled in. This means you do not need to continuously reinsert his name, because it is 
automatically done for you.  

 

If you wish to disable the Active Patient field you can right click on it and select Disable this Feature. By doing this, 
the field will become grayed out. 

Disabled Active Patient Field 

 

 

When in this state ClinicOffice will stop tracking the patients. To restore the field right click on it and select Enable this 
Feature. 
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Spellchecking 

ClinicOffice has an inbuilt spell checker. This can be used on any memo field 
present in any of the editors. You can switch on the spell checker by clicking 
on the Check Spelling button (at the top of any editor i.e. session notes) and 
select “Check as you type”. Once this option is ticked any memo fields will 
have their spellings auto checked. You would do this for any editors and once 
enabled for that editor the setting will be saved for future use when you log in. 

When you start typing, any words that are spelt incorrectly or that are not 
recognised in the built-in dictionary will be highlighted in red. You would correct 
any misspellings by right-clicking on the text and selecting the correct spelling 
of the word. If you know for a certainty that the word is correctly spelt but ClinicOffice is incorrectly showing it has having 
been misspelt, then you can right-click on the word and select Add to Dictionary. The word will now be recognised for 
future use. 

Some of the more basic editors, such as the Activity Log Editor, do not have the auto spellchecking feature. You can 

still perform a spellcheck by right-clicking on the memo field and selecting Check Spelling. After selecting the Check 

Spelling, ClinicOffice will find any misspelt words within that memo field. Any words that were not spelt correctly will 

then be highlighted in a Spelling window (see image below). 

 

 
From this window, you can select the correct word in the Suggestions field. If you are purposefully misspelling the 

word then you can click Ignore. If the word is correctly spelt then you can click the Add button in order to add the 
word to the program’s dictionary. Whenever you select one of the suggestions, click to ignore or to add to the 

dictionary, then the spelling window will move to the next word. Once all words have been checked, a message will 

appear to say that the spelling check is complete.   
 

For a more detailed explanation of the functionality of the above window, please see the table below. 
 

Not in Dictionary This window shows a preview of the text in the memo field. It highlights in blue the word 
that is being queried. Once the word has been dealt with i.e. ignored or added to the 
dictionary then the next incorrect word is highlighted. 

Ignore Once This will ignore the highlighted word. If another misspelt word is entered into the memo 
field then this word that has been ignored will be brought into question again. 

Ignore All This will ignore the highlighted word permanently. No matter what else happens the word 
will remain ignored. 

Add to Dictionary This will add the highlighted word into your dictionary. 

Suggestions This provides you with a list of suggestion of what to correct the highlighted word with. 

Change By clicking this button it will change the current highlighted word with the word that you 
selected under the Suggestions section.  

Change All By clicking this button it will auto correct all words that have the same mistakes with the 
word selected under the Suggestions section. 

Options This will take you into the Spell Checker Options window 

Undo Last This will undo the last correction made. 

 

The auto-spellchecker is also available in the Email Manager’s Email editor window by clicking the button Check 
Spelling. You can enable this feature in the Document Template editor as well by clicking the same button. 

Spell Check Window 

 

Enabling spell checker 
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Spell Checker Options 

You can get into the Spell Checker Options window by either following the method mentioned on the last page or by 
going to the View menu, clicking the Program Settings button and then clicking the blue link Spell Checker Settings.  

Spelling Options Window 

 

The window is split into 3 options: 

General Options 

Ignore words in UPPERCASE When ticked any words that are in full uppercase will be ignored when COv5 is 

running a spell-check.  

Ignore words in MiXeDcASe When ticked any words that are in mixed case will be ignored from the spell-check. 

Ignore words with numbers When ticked any words that include numerical values will be ignored form the spell-

check. 

Ignore repeated words Usually if a word is used twice the second word will be highlighted as being incorrect. 

When this is ticked it will ignore words that are used more than once. 

Ignore e-mails When ticked any email address will be ignored from the spell-checker. 

Ignore web sites When ticked any web site addresses will be ignored from the spell-checker. 

 

Edit Custom Dictionary 

If you click the Edit… button the Custom Dictionary window will open. You will see that any custom words that you have 
added to the dictionary will appear on this screen. You can add additional words from here and remove previously added 
ones.  
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International Dictionaries 

This is where you can select different languages for the spell checker. By default ClinicOffice includes English (United 
Kingdom), English (Ireland) and Dutch (Netherlands).  

 

Adding New Dictionary Languages 

You can also add additional dictionaries to ClinicOffice, by going to the Program Settings and located under Local 
Computer Settings is a link Manage Installed Dictionaries. You will note that when in this window you have the option 
to tick additional languages. So for example, if you needed the Spanish (Spain) dictionary installed, you would tick 
es_ES. When you click OK this dictionary will be downloaded. When you go back into the Spell Checker Settings you 
will be able to select “Spanish (Spain)” in the Language field. 

 

 
 
Diary Synchronisation 

With the Diary Synchronisation module you can synchronise your appointments between ClinicOffice and Microsoft 
Outlook or Google Calendar. This is very handy because you can take your diary from ClinicOffice and transfer it to any 
device which can handle Outlook or synchronize with Outlook. Alternatively has internet access in order to synchronise 
with Google Calendar. 

 

Outlook Synchronisation 

To synchronize with Microsoft Outlook, follow the steps below: 
 

• Right-click anywhere in the main ClinicOffice Diary 

• Select Sync Calendar then select Sync with MS Outlook  

• The following window will appear: 
 

Outlook Synchronization window 

 

• Under Outlook Data Folder field you can choose the calendar you wish to Synchronize with 

• Now select one of the Synchronization Types  
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Export to Outlook  

 

This option exports all appointments from ClinicOffice into Outlook. The Synchronization Options for this are as follows: 

 

Data range to Synchronize 

You can choose to synchronize for: Current and future appointments, from the start of this month, from the start of this 
year and from 12 months ago onwards. Please remember the larger the data range the longer it will take to synchronize. 

Only sync appointments belonging to 

By selecting this you can specify which practitioner’s appointments you wish to export. If you do not then all practitioners’ 
appointments will be exported. 

Include cancelled appointments 

By default ClinicOffice will not export cancelled appointments. If this is ticked then appointments that have been 
cancelled will be exported as well.  

Perform full export  

You may have the same appointments in ClinicOffice and Outlook but in different locations. When you have this option 
ticked it will forcibly move those appointments in Outlook to match ClinicOffice. Also any differences in the Subject or 
Location will also be changed according to the ClinicOffice appointments. When not selected only new appointments 
will be exported over and no other changes will be made. 

Delete Outlook appointments if not present in ClinicOffice 

If this option is ticked, then when you go to export to Outlook it will delete any appointments that are not present in 
ClinicOffice. This is only suggested if you are sure you do not need any of the appointments present in Outlook that are 
not present in ClinicOffice v5.  

 

Import from Outlook  

 

This option imports all appointments from ClinicOffice into Outlook. The Synchronization Options are very similar to that 
of the Export to Outlook. The differences are listed below: 

 

Only sync appointments belonging to 

By selecting this you can specify which practitioner’s diary you wish to import the appointments for. If you do not have 
this option ticked, then you will notice that the field below comes into play.  This option is If staff member is not 
specified, presume, so ClinicOffice will assign the new imported appointments to a practitioner. You can select the 
default practitioner if you wish.  

Include cancelled appointments 

By default, ClinicOffice will not import cancelled appointments. If this is ticked, then appointments that have the cancelled 
status will be imported as well.   

Perform full import  

You may have the same appointments in ClinicOffice and Outlook but in different locations. When you have this option 
ticked it will forcibly move those appointments in ClinicOffice to match Outlook. Also, any differences in the Subject or 
Location will be changed according to the Outlook appointments. 
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2-Way Synchronization 

  

This option is an export and an import combined. This means appointments in Outlook and ClinicOffice will be transferred 
to each other. So, any differences will be noted in both programs and added accordingly to both diaries. 

As a rule of thumb, we would recommend that you use this option instead of doing the other two separately. The reason 
is that it saves you time and you know that both diaries match each other, giving you peace of mind. The only unique 
option for the 2-way synchronization is: 

 

For 2-way synchronization, give priority to 

You may find that the ClinicOffice appointments might be in different locations to that of Outlook. A 2-Way 
Synchronization will organize both diaries to match one another. The question is through which program has the 
overriding decision. Under this option you can select which program you wish to model the appointments on. If you 
select ClinicOffice then any appointments that are the same but have a different time, location or subject will be altered 
in Outlook to match ClinicOffice. If you select Outlook, the opposite happens. Please note that new appointments will 
not be affected by this option and will be synchronized in the usual manner. 

• Once you have selected the Synchronization type and you are happy with its options, press the Synchronize 

button to start the synchronization process  
 

Additional Information 

Both Outlook and ClinicOffice have a similar structure to their appointments, but ClinicOffice has a few additional fields 
that are not present in Outlook. This is not a problem though as the ClinicOffice Synchronization has been designed to 
compensate for this. This does though require data to be entered into Outlook in a particular way for the desired 
information to be transferred across, although it is not essential.  

 

Subject in Outlook – Description and Patient in ClinicOffice 

In Outlook when you create a new appointment you will fill in the Subject field. The Subject field is the same as the 
Description field in ClinicOffice, but it also can cover the Patient field. When you export an appointment, with a patient 
assigned to it, you will notice that the Subject will be in this format ‘Lastname, Firstname Title’. So when creating a new 
appointment in Outlook, if you for example enter under the subject ‘Davis, Mark Mr’ and then import it into ClinicOffice, 
it will assign that appointment to Mr Mark Davis (this is so long as Mr Mark Davis is an actual record in ClinicOffice). 
Please note that text can be entered in any way you like, and it will be copied into the Description field either way.  

Location in Outlook – Room and Clinic in ClinicOffice 

The Location field in Outlook is the same as the Room and Clinic fields in ClinicOffice. When you export appointments 
from ClinicOffice into Outlook you will notice that the Location field for these appointments is entered in this format 
‘Room x | Clinic x’ (x=unique value).  So, if an appointment was in Room 1 for Willoughby Road Clinic it will look like 
this: ‘Room 1 | Willoughby Road Clinic’. If you want the location to be recognised when importing a new appointment 
into ClinicOffice from Outlook, you must make sure that the room name and clinic name match what is in ClinicOffice. 

Category in Outlook – Appointment Type in ClinicOffice   

In Outlook you can assign a Category to the appointments. The Category in Outlook is equivalent to the 

Appointment Types in ClinicOffice. You need to make sure that the name of the Category matches the name of 
ClinicOffices’s Appointment Type for this to work properly. You can also assign a colour to the Category that 

matches the Appointment Type colour in ClinicOffice. Please note that Outlook can have two categories, ClinicOffice can 
only have one. If an appointment in Outlook has two categories, then both will be ignored when it is being imported 

into ClinicOffice and the Appointment Types field will be left blank.    
 

 With a bit of practice the ClinicOffice Synchronization is incredibly easy to use. Note that the Synchronization is not 
automatic.  
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Google Calendar Synchronisation 

To synchronize with Google Calendar, follow the steps below: 
 

• Right-click anywhere in the main ClinicOffice Diary 

• Select Sync Calendar then select Sync with Google Calendar 

• The window to the right will appear: 
 

 
 

• Under step [1] click the Connect button; this 

will open a separate browser window and 
request for you to login to your Google account. 

• Once logged in to your Google Account you need 

to click Accept to the next message that 
appears. 

• Under step [2] if you have more than one 

calendar on your Google account, you can select 

which calendar you wish to synchronise with. 

• Under step [3] select the Synchronisation 
Direction. You can choose either “Two-way 

synchronisation”, “Export from ClinicOffice -> 
Google” or “Import from Google -> ClinicOffice”. 

For more information on what each of these 
options do, please see the section “Outlook 

Synchronisation”. 

• Next in the field Synchronise date range you 

can select to synchronise only current and future 
appointments, appointments from the start of 

this month or year and onwards and 
appointments up to 12 months and onwards 

• The next field Sync appts belonging to, you 

need to specify which staff member’s 

appointments you wish to synchronise. 
Generally, it is recommended that you 

synchronise a single practitioner with one 
calendar or account. 

• Below this is the section Cancelled 

appointments which allows you to specify what 
to do with appointments with the cancelled 

status. If you select Synchronize cancelled 

appts to Google Calendar, then all 
appointments that have been cancelled will be 

included in the synchronisation. These will have the term [CANCELLED] put in front of them. If you select 
Remove cancelled appts from Google Calendar instead, then any appointments marked as cancelled in 

ClinicOffice will just be removed or not even appear in the Google Calendar. 

• When you have finished going through the options click the Synchronize Now button. 
 

When the synchronisation has been completed you are offered the option to view the synchronisation log. If you wish 
to read it, click the Yes button. To exit the synchronisation screen, click the Close button. 

 

Note 1: In Step 1 if the authentication process takes longer than 20 seconds ClinicOffice will present a message 
saying that it is “Unable to Connect”. This is not a problem, just click OK, complete the authentication process in 
Google and click Connect. You will still be connected up. 
 

Note 2: Due to Google’s Security settings you will be required to repeat the authentication process in Step 1, when 
clicking the Connect button, every hour or whenever you log off from ClinicOffice and back. 
 

Note 3: When you delete an appointment in Google Calendar it will not delete the appointment in the ClinicOffice 
diary. All that happens is that the corresponding appointment in ClinicOffice will have the additional text “-DELETED-” 
added to the appointment’s description. 

Google Calendar Synchronization window 
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Backing up and Restoring your Database 

 

Backing Up a Database 

Click the Tools menu at the top of the main ClinicOffice screen and click . 

For a quicker more efficient backup it is advisable to do the backup on the computer that is hosting the database.  

Please note that it is important to make sure that any other users are logged off before you perform a backup. If you 

were logged on, ClinicOffice will ask for permission to log you off before it can perform the backup. 

 

 

The backup window will then appear on the screen. 

 
Backup Window 

 

ClinicOffice v5 will generate a filename based on your database name and the current date and time, but you can 

change the filename if you wish. You can also choose to save the backup to whatever location you want. If you are 

backing up the Startup/Professional Editions the resulting file is given a “.EDBBkp” extension. If you are backing up the 
Server Edition the resulting file is given a “.COv5_Backup” extension. Both of these extensions are ClinicOffice’s own 

Zip format and would only be recognised by ClinicOffice.  

  

However, please note that saving the file directly onto a writable CD/DVD is not likely to work. Even if the save appears 
to have succeeded, you will most likely still need to perform another operation to actually burn the CD/DVD using your 

CD burning software. 

When you click the Save button you will be presented with a Backup Compression window. 

 

Select the level of compression you would like to use and click OK. ClinicOffice Zip files contain a complete copy of your 

entire database. 
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This is not an incremental backup. For that kind of functionality, we recommend using a 3rd party backup solution rather 

than this feature in ClinicOffice. 

 

When you log out from your database, ClinicOffice will automatically remind you to take a backup. You can alter how 

often ClinicOffice reminds you by going to the Database Settings. To get to this go to your View menu and click on the 

Program Settings button. When the Setting window opens you will notice the Database Settings tab. You will note 

that you can choose to stop the backup reminders simply by un-ticking the box Remind me to Backup.  

 

Remember the more frequent your backups are the less information that will be lost if something does go wrong.  

 

 

Restoring a Database 

Click the Tools menu at the top of the main ClinicOffice screen and click . 

Please note that it is important to make sure that any other users are logged off before you perform a restore. If you 

were logged on, ClinicOffice will ask for permission to log you off before it can perform the restore operation. 

The restore window will then appear on the screen; like the backup window you are able to locate your backup file. 
So locate your database and then click Open. ClinicOffice will ask you if you want to create a new database or 
overwrite the current one you are looking at. If you choose to create a new database then you need to assign it a 
name. If you on the other hand choose to overwrite the selected database a message will come up asking you to 
confirm this, click YES, then type YES and click OK, and then close the COv5 databases window. You can now select 
the new database from the logon screen and log onto it.   

 

*** IMPORTANT NOTE *** 

If you choose to overwrite your existing database, this will destroy your current database and replace it with the one in 

the backup file. Please only perform this operation if you are absolutely certain that this is what you want to do. 

If you are restoring a backup of a database that wasn’t on your computer previously, then it would be wise to restore 

it as a new database.  

Note: We strongly recommend that you copy your backup files on to some external media (e.g. backup tape, 
CD/DVD, external disk drive, flash drive/memory card, online etc.) which you should remove from your premises. We 
also recommend that you keep numerous copies of your backup files on different media rather than just relying on one 
memory stick or external disk. Please see the ClinicOffice Forum FAQ’s for more information on Backup strategies. 

Pioneer Software cannot be held in any way responsible for any loss of data and subsequent inability to restore from a 
backup, resulting from an inadequate backup strategy. 
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Importing Data 

ClinicOffice has the ability to import data that is saved as a CSV file (Comma Separated Variable format). The CSV file 
can be created in Microsoft Excel; the option is given to you when you save the spreadsheet.  

To import the data follow the steps below: 

• Go to the Tools menu and click the Import Data button 

 

• You need to first locate your CSV file 
 

• Once you have located the directory of the file select the type of data that you are importing (i.e. Patient or 

Contact Records) 
Import Data Window 

 
• Now you need to click the Preview File button (this may take some time depending on the amount of data). 

This now previews the data with its records. 
 

• Click the Verify Data button to see how compatible your data is with ClinicOffice 

 

• A message will appear signalling if the data is valid. Click Yes, to see the validation messages. This now opens 
Notepad and displays what will occur when you actually import the data such as what will be included in the 

import and what will be ignored. This in turn will give you an idea if you need to rename some of the column 
headers within your CSV file. If you do make any adjustments to the CSV file, please repeat the steps above. 

 

• Finally click Begin Import button. A message will appear displaying how many records where imported 

successfully. Press OK. 
 

Once you have finished press the Close button. Everything that has been successfully imported will now be present on 
your database.      

 

Note: For more information please see the COv5 Frequently Asked Questions on the ClinicOffice Support Forum 
(www.clinicofficeforum.co.uk) on the subject,” Can I import data into my database?” This also contains sample 
spreadsheets that can be used to practice importing data. 

Additional Information: Patient records can now be updated via a CSV file by adding an 'UPDATE' column to it. 
Set the row values to "TRUE" for this new column. You will also need to include either an "id" column or "code" column 
to match the existing patient "id" or "code" stored within the database. 
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Designing and Customising ClinicOffice 

ClinicOffice has been designed to be intuitive to the user and visually appealing. The layout of the program enables a 

person to carry out a task in seconds, which by hand would have taken them minutes. Every editor (i.e. Patient or 
Appointment Editor) has a particular default layout which for most is quite adequate but it might not suite everybody. 

This is why ClinicOffice has a feature which will enable the users to change the layout of an editor completely.  

 

To edit the layout of an editor follow the example below:- 

• Go to the Patient Grid. 

 

• Open up a patient’s record. 
 

• At the top of the Patient Editor’s ribbon bar is the Design Tab, click on this. 
 

Design Tab on Patient Editor Ribbon Bar 

 

• To enter the design mode click on the ENTER DESIGN MODE button. You will notice a Customization menu 
appear. 

 
 

• Now click on the Custom Fields tab in the Patient Editor. 

• If there are fields already there you can remove them by right-clicking on one of the fields and selecting 
Delete Field. 

• If you do not wish to delete the field, right-click on the field and select Hide Field. The field will then add itself 

to the Hidden Items on the Customization window. 

• Continue to delete or hide the fields under Custom Fields until you feel satisfied. 
 

Now that we have some free space we can start adding fields. To do this, follow the instructions below:-  

Customization Window 
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• Click on the Customization menu and then click on the ADD FIELD button which is located on the ribbon bar.  

• Choose from the pull down menu Text Field. Enter a name for it and then press OK. 

• Left-click on the new field, drag it from the Customization menu and drop it into the place of your choosing 

within the Custom Fields under the Patient Editor.   
 

You have now created your first field. You might have found it pointless clicking on the Customization menu, but by 
doing this the new field you have created will be added to the menu; otherwise ClinicOffice will place it below an 

existing field within the Patient Editor.  
 

You can hide the field name completely by right-clicking on the field and selecting Label Position and then click Top. 

This positions the label so that it is above main the field. If you right-click again on the field and then click Hide 
Label, the label will be hidden from view. The reason why you would use this method is that if you were to hide the 

field label straight away then you will be left with a blank space.  
 

A Checkbox field will automatically have a space on the left hand side of it, this is a hidden label. To remove it first 

right-click on the field then click Show Label, use the same method as mentioned before to the remove this label. 
This leaves you with a well-structured editor.   

 
As you probably have noticed there a several custom fields to choose from. Each editor will vary on the types of 

custom fields. All fields are created in the same manner except for one which is the List Field. The reason for this is 

that there are more variables involved with this field. Please follow the instructions below to create one. 
 

• Like before click on the Customization menu, then click the ADD FIELD button and select List Field. 

• Enter a name and choose one of the predefined lists. It will look like something like the example below.  
 

Custom Field List 

 

• Click OK. The field will be added in the same manner as the other fields.  

 
You will notice that this field has a pull down menu and you can choose from the selection. You may edit the list and 
even create your own one. To do this click on the EDIT CUSTOM FIELD LISTS button located on the ribbon bar. The 
following window will appear:- 
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Custom Field List Editor Window 

On the left hand side are the Custom Lists, which is the field category. On the right hand side you have the values. 

This makes up the content of the custom list. By clicking on the  or  buttons on either side you can add or 

remove a field.  

 

Grouping Fields 

When you are in the design mode you can group fields together so that they will all come underneath one main 
heading. To group a field just right-click on it, then press Group. ClinicOffice will assign it a default name of ‘item1’. 

You can rename this by right-clicking on the group name and then click Rename Label, type in the name you wish 

and press OK. 

You can add another field to this group by left-clicking, then dragging and dropping it into the group box.   

After you have created a group you can make this into a tab. To do this right-click on the group name and select 
Create Tabbed Group. You can add another tab by just right-clicking in the empty row next to the group name and 

select Add Tab.  

Right-Clicking and Add Tab 
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This tab will be given a default name such as ‘item2’. You can change this in the same way you would rename a 

group name. By adding a new tab it is like adding another page to the editor.  

The best way to get to grips with the Design Mode is to play around with it. Remember if you alter the layout of an 
editor you do not have to save it. The editor will then revert back to how it was before you entered into the Design 

Mode. 

You can create a Custom Form with the Clinical Notes using the same method, see the “Designing Forms” section of 

this User Guide.   

 
 

 

Appendix – Help Resources 

For additional help on ClinicOffice v5 please see the Help menu. 

Help Menu 

Not only does it provide the User Guide and Tutorial, but you can access our support forum from here as well. Displayed 

here is an additional search box which will enable you to search the support forum based on key words or phrases. For 
example you can enter “Undelete” and it will search for all words in the forum related Undelete. There is the option to 

Post a Question to the forum if you cannot find what you are looking for. You may also use our Online Help Desk and 

the Email Support also for questions.  

 

If you require further assistance our pre-sales and support helpdesk is 01205 205500 if you are ‘test-driving’ 

ClinicOffice or you need assistance with ClinicOffice and you are on the Support Plan. 
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Section 3 - ClinicOffice v5 Tutorial 

 

Preparing for the Tutorial 

This tutorial is designed to take you step by step through some of the basic features of ClinicOffice v5 using the sample 

database. 

By the time you have followed the tutorial through, you will be able to:- 

• Create a new staff member & assign working hours 

• Enter new patients 

• Book, Edit & Move appointments 

• Send / Receive Messages 

• Create Session Notes with additional attachments 

• Create invoices and take payments 

 

If you have not yet done so, you will need to install ClinicOffice on your computer. Please refer to the Getting Started 

section of your user guide for installation instructions. 

 

Logging On to the Sample Database 

 

For the purposes of this tutorial, we will be working with a fictitious sample database which contains the data for a clinic 

called “Willoughby Road Clinic”. This is available in the Trial, Startup and Professional editions of ClinicOffice.  

 

Every time you start ClinicOffice v5, the first thing you will have to do is log onto your database. This is for security 

reasons as patient information is obviously highly confidential. 

 

Logging on to your clinic 

 

 

To log on to the sample database:- 

• Select the Sample Database (if it is not already selected) 

• Type jsmith in the username box (as shown) 

• Leave the password box empty 

• Left-click on the LOGON button 
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If you entered the username or password incorrectly, ClinicOffice will notify you. In this case, please check that you 

have not entered any spaces before or after the “jsmith” and please make sure that the password is completely blank. 

If this is the first time you have logged on then you will be taken straight to the ClinicOffice Home Page, otherwise you 

will be prompted to reset the Sample Database. 

 

Resetting the Sample Database 
 

You will notice that once you have clicked Logon, you are prompted with the reset the sample database window.  
 

Reset Sample Database 

 
 

When prompted please click yes to resetting the database as this will make the tutorial relevant. This brings all the 

appointments / Invoices / Payments etc to the week that we are currently in. This therefore allows you to work on the 
database with relevant data.  

  

Once you have done this you will be directed to the Home page. 
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Your ClinicOffice v5 Home Page 

 

Take a little time to look around this screen and familiarise yourself with it. From here you can access all areas of 

ClinicOffice v5 by simply clicking on the appropriate picture, button or text link. 

You will be returning to this screen frequently, so you’ll get to know it quite well. 

 
The ClinicOffice v5 Home Page 

 

You can return to this home page at any time by clicking the  button which is always available at the top of the 

screen when you are logged on to a database. 

 
 
Creating a New Staff Member 

Willoughby Road Clinic is expanding. Currently Mr John Smith is the owner of the practice and has 2 associates plus a 

receptionist (Miss Rebecca White) who he employs full-time. 

Due to an increased workload though, he’s now taking on Miss Rachel Brown – a promising young practitioner who 

will help on a part-time basis. 

So, our first job is to add Rachel to the staff list:- 

• From the Home Page, click on Staff Members, the middle button on the home page. This takes you to the Staff 
Members screen which shows your current staff members. 

• To create a new record, right-click on the grid and choose New Staff Member. 
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The Staff Editor will appear on the screen (as shown below) ready for you to enter the new details. 

The Staff Editor 

 

Entering Basic Contact Details 

We now need to enter some details about the new staff member. If you look closely the cursor should be flashing in 

the Title box (if not, then left-click in that box). 

• Type in “Miss” (without the quotes). 

• Now press the <TAB> key. You should notice that the cursor has moved on to the next box. 

• Type in “Rachel” (again, without the quotes). Press <TAB>. 

• Type in “Brown”. 

 

Tip: In ClinicOffice v5, you use the TAB key to move on to the next field. If you hold down the SHIFT key at the 
same time (i.e. SHIFT+TAB) then the cursor will go back to the previous field. 

 

Practice entering data by typing in Miss Rachel Brown’s address and telephone number. Here are the values to enter:- 

• Known As Rachel Brown 

• Job Title Associate Practitioner 

• Username rbrown 

• Address 1 71 Willoughby Road  

• Town/City Boston 

• County Lincolnshire 

• Postcode PE21 9HN (try using the Loqate Address Finder) 

• Country UK 

• Telephone 01205 123456 
 

If you want some more practice, you can enter other information for her too, such as mobile telephone, email address 
etc. You can even choose a photo for her by right-clicking on the “No image selected,” clicking the ‘open image’ and 
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locating it on your hard disc. It’s important to get comfortable with entering data, because entering data on screens like 
this is used frequently throughout ClinicOffice. If you are happy then we can continue. 

 

Staff Details 

There are some important staff fields on this screen:- 

Known As 
This is the name which will be used throughout ClinicOffice when referring to this staff member. For now, we’ll 
leave it as “Brown, Rachel Miss”. 

Username 
This is the name which this staff member will use when logging on to the database. The default is “rbrown” 
which will be fine for now (press icon to generate username). 

Job Title 
Rachel’s job title is “Associate Practitioner” – please key it in. 

Staff Category 
This field allows you to categorise staff members. In this case, Rachel is working part-time at the clinic, so select 
“Part Time” from the list.  

Staff Member is a Practitioner 

This is an important field, which tells ClinicOffice whether this person is a practitioner or a member of the support 
staff. “Rachel Brown” is a practitioner, so we need to tick this box under the Diary Options. 

 
 

Completed Staff Editor 

 

Setting Staff Working Hours 

First, we need to tell ClinicOffice that Rachel will be working at this clinic and then set her working hours. This is 
important because it will display her working hours on the diary, displaying when she is available. Also, ClinicOffice will 

inform you when you try to book an appointment outside of her working hours.   
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Click the Working Hours tab on the staff editor 

Staff Editor – Working Hours 

 

Tick the box which says Brown, Rachel Miss works at Willoughby Road Clinic. For each day you can now select 

up to 3 sections of working hours. Plus, you can set different working hours for specific weeks by selecting Define 

their hours for a specific week; we will not worry about this now.  

For new staff members, ClinicOffice defaults to the clinic’s opening hours, which (as you can see) are 09:00 to 17:00 

Monday to Friday. 

You may recall however that Rachel Brown will be working part time, so we need to change this pattern of working 

hours. In fact, her working hours are as follows:- 

Monday   (09:00 – 18:00) 

Wednesday (09:00 – 18:00) 

Thursday (09:00 – 12:30) 

Here’s what we need to do:- 

• Set Monday’s 17:00 to 18:00. Do this by clicking on the upwards arrow. 

• She doesn’t work on Tuesdays, so un-tick the tick box next to the day’s title  

• Set Wednesday’s 17:00 to 18:00 

• Friday also needs to be un-ticked 

• Thursday needs to be adjusted. Left-click inside the box that says 17:00 and type in 1230. When entering the value 
in make sure it is done quickly, otherwise the number will not be entered in sequentially. 

 

Q. What if I get it wrong and mess this up? 

Don’t panic! Simply use the Undo button (next to the Save button) to undo the changes made to the working hours. 

 CAUTION! There are two undo buttons on this screen. The other one is at the top of the editor (on the ribbon bar) 

which will undo all changes made to this staff member since the last save. We should be using the undo button in the 
Working Hours section. 
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All being well, we should now see that Rachel Brown’s working hours are correctly set for Monday, Wednesday and a 

½ day on Thursday, as shown below:- 

 
Rachel Brown’s working Hours 

 

 

Saving the Record 

Now that we have entered Rachel’s personal details and her working hours, all that’s left is to save our new staff 

member. 

Simply click the  button located on the ribbon bar at the top left of the Staff Editor. 

ClinicOffice will beep at you (if you have sounds enabled on your computer) to let you know it has saved the record, 

and the Staff Editor will close. 

Congratulations! We have now completed adding a staff member to the database. You’ll notice that you are able to 

select Miss Rachel Brown in the Diary’s list of staff members. 

Next, we’ll look at the appointments diary. 
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Introducing the Appointment Diary 

Now click on the  Appointment Diary button to take us into the diary.  

Let’s take a moment or two to get to grips with this screen:- 

 
The Appointment Diary 

 

The main diary area is where the appointments are shown. The calendar (top right inside Diary Navigator) allows you 

to select which date(s) you want to look at in the diary. 

Underneath the calendar you will see 2 Diary View options that allow you to change the display style of the diary (i.e. 

View appointments by staff or by Room). 

Finally, we have the staff list (or room list, dependant on which view you have selected) which tells us which staff 

members (or rooms) we are currently looking at. 

 

Setting up the Diary 

Before we can add an appointment, we just need to make sure that the diary is set up correctly. 

We want to make sure that the diary intervals are set to 30 minutes (if they are not already set to that). Of course, for 

your own clinic, you may want to use a different interval setting, but for this tutorial we’ll use 30 minute blocks. 

• Right-click on the time ruler on the left side of the diary. 

• Select the 30 minute option. 

 

The most common way of viewing the diary is by staff. Make sure the staff view is selected:- 
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• Underneath the calendar, make sure that View appointments by Staff is selected 

• Tick both John Smith and Rachel Brown (our new staff member) in the staff list and un-tick the other 2 staff 

members. 

 
We should now have only two columns in the diary – one for John and the other for Rachel. When you start using your 

own data later, your diary will look similar to this although it may have more or less columns, depending on how many 

practitioners you have.  

You will notice that the appointments that have been auto-created are invoiced up to Tuesday so imagine that today is 

Wednesday. 

 

 

Creating an Appointment 

Let’s imagine that the telephone rings and Mrs Andrea Brookes is calling to book a treatment for Thursday. Mrs 
Brookes has been many times before, so we know she’s already on the system and we also know that she is usually 

treated by John Smith. 

 

• Select Thursday on the calendar by clicking on it. Scanning through the day, it appears that John Smith is only free 

just before Lunch so we offer her a choice of any time around 12pm. She asks for 11.30am. 

• Double-click on the slot between 11:30–12:00 in John Smith’s column. This brings up the Appointment Editor. 

• Notice that ClinicOffice has already filled in the date, time and staff member for you. So all we need to do is tell the 
system who the patient is and what type of appointment it is. 

• Click the search button      at the end of the Patient field. Clicking this button brings up the Patient/Contact 

Selector window. 

• Make sure the cursor is in the search edit box, and type in “br” and then press Enter. This will locate anyone whose 

name starts “Br…”. Click on Mrs Andrea Brookes and then click OK (or you can double-click on her name). 

• Notice that she now appears in the patient box of the Appointment Editor. Next we want to set the appointment 
type which is a Treatment. 

• Finally we click SAVE AND CLOSE to save the appointment. 

 
Congratulations on your first appointment! Let’s try another one. 

 

Mr Brian Jackson telephones in and would also like to book a ½ hour treatment for Thursday with John Smith. He 

says that 12:00 would be ideal for him. 

Following the steps just outlined, have a go at booking his appointment. You will note that when you click Save and 
Close a message will appear saying “Jackson, Brian [27] has a different Default Practitioner”. In this situation click 

“Keep practitioner as: John Smith”. 
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After saving this second appointment, our diary for Thursday should look something like this:- 

 

Appointment Diary after Second Appointment 

 

 

Barely a few minutes later “Mrs Joan Campbell” telephones. She identifies herself as a new patient who hasn’t been 

to your clinic before. As a new patient she would like an hour-long consultation also on Thursday between 11:00–

12:00. 

This appointment is different from the last two because (1) she’s a new patient; not yet on the system and (2) because 

consultations are an hour long rather than ½ hour for just a treatment. 

 

Here’s what to do:- 

• Select BOTH slots from 11:00–12:00 in Rachel Browns diary column, by dragging down with the left mouse button. 
This will highlight both slots in blue. 

• Right-click the mouse over the selected slots, and click on New Appointment in the menu. As before this brings 

up the Appointment Editor. Notice that this time, the duration of the appointment is an hour long. 

• Mrs Joan Campbell is a new patient, so there’s no point searching for her. Instead, click the new button ( ) at 
the end of the patient field.  
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Create a New Record Message 

 
• The system will ask if she’s a new patient or contact. Click New PATIENT Record. This opens the Patient Editor. 

• As mentioned earlier, Mrs Campbell is on the telephone, so it’s most likely that you wouldn’t take all her details until 

she comes in for her appointment, so we’ll just enter her name and telephone number. 

• Her Title is “Mrs” 

• Her Firstname is “Joan” 

• Her Surname is “Campbell” 

• Her Telephone number is “01205 368685” 

• Click SAVE AND CLOSE to save her as a new patient (notice that her name now appears in the patient field). 

• If you are prompted to assign a patient code, click yes. 

• Set the appointment type to Initial Consultation. 

• Click SAVE AND CLOSE. 

 

You should now see the hour-long consultation in your diary:- 

 

Appointment Diary after Initial Consultation 

 

Finally, Mrs Stephanie Allshaw (another existing patient) calls up for a ½ hour treatment this Thursday, but due 

to her busy schedule she can only do 09:00–09:30. As John Smith is busy, she’s agrees to see Rachel Brown instead. 

• Don’t forget to create this appointment in Rachel Brown’s diary column instead of John Smith’s. 

• When you go to create the appointment you will be asked if you wish to use the active patient ‘Campbell, Joan 
Mrs [35]’. Click No, clear the active patient and then search for Stephanie Allshaw instead. 

• ClinicOffice may warn you that the Rachel is not the usual practitioner for this patient. Click Keep practitioner as: 

Rachel Brown to acknowledge this. 
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Our diary should now look something like this:- 

Appointment Diary after Fourth Appointment 

 

 

Moving an Appointment 

A little later on, Mrs Andrea Brookes calls back (she was the first appointment we booked). She’s just remembered that 

she can’t actually make it in the afternoon, because she’s having her hair done. 

She apologises and asks if she can move the appointment to the morning instead – ideally at 10:30 (i.e. from 10:30 to 

11:00). We inform her that John Smith is busy and she is happy to be treated by Rachel. 

 

Here’s what to do:- 

• Click and HOLD the left mouse button over her morning appointment. 

• While still holding the button, move the mouse over to Rachel’s diary and move it to the 10:30 slot. This will move 

the appointment. 

• Release the mouse button when the appointment is in the 10:30–11:00. 

• You will now see a message asking you to confirm the change of appointment. Click YES to confirm the move 

operation. 

 

It may be a good idea to spend a little time experimenting with this. Try dragging appointments around to different 

time slots. 

After you’ve finished experimenting, remember to move the appointments back to their original positions. 

Here’s a screenshot of what our diary should look like:- 

Appointment Diary after Appointment Move 
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FAQ (Frequently Asked Questions) about the Diary 

 

Q. How can I look ahead a whole week for a staff member? 

A. In the staff list select only the practitioner you wish to see e.g. “John Smith”; remove the ticks next to the other 

practitioners. Under the calendar, click the link Go To… then select 1 week from now. 

Q. Why are some time slots a darker shade? 

A. The darker shaded regions on your diary represent the hours in which a staff member is not working. 

Q. What about viewing appointments according to their room? 

A. To view the appointments by room click on View appointments by Room; this is under the calendar. You will 

notice that the list of staff members changes to a list of room names. 

Q. Can I change the text which is displayed in the appointments? 

A. Click DIARY OPTIONS which is in the top right. Go to the Visual Notes tab you will notice under Formats you 
can choose from a selection of predefined options. Each option will affect the way the text appears in different ways 

and areas. For example when you alter the Caption format for room view, this will only affect the appointments in 

the room view. On the other hand if you change the name format then this will affect all appointments under both staff 

and room views.     

 
 

 

Using the Appointment Status 

Before starting this section, please make sure that:- 

• The Diary View is set to View appointments by Staff  
• Both “John Smith” and “Rachel” are ticked  

• We are looking at Thursday in the diary 

 

Let’s imagine that Thursday is upon us, and Mrs Stephanie Allshaw has arrived at the clinic for her 09:00 appointment 

with Rachel Brown. 

You’re at the reception desk and you know that Rachel is just in the middle of an important telephone call.  

What to do? 

• Right-click on Mrs Allshaw’s appointment in the diary. 

• Click Appointment Status and then click Arrived. This updates the status of the appointment. 

• You are asked whether to send a notification to Rachel about this. Click YES. 

• A message has just been sent to Rachel’s screen to let her know that Mrs Allshaw is in the waiting room. Obviously 

we’re still logged on as “JSMITH” (check the title bar at the top of your screen) so the message won’t come to us. 

• Notice that the side bar of the appointment has turned yellow, indicating that the status has changed to Arrived. 

 

Now we’re going to pretend to be Rachel Brown:- 

• Click the LOG OFF button (top right of the main screen) 

 

This takes us back to the logon screen. 
  

• Log on with the username “rbrown” and no password. 

(If you need some help with logging on again, please refer back to the 

start of this tutorial.) 

 

Now that we have logged on as Rachel Brown, you should receive the 

mail message which we just sent to her:- 

Click the Dismiss  button to remove the message from the screen 

or the Delete  to permanently delete it. 

 

Mail Message 
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You should currently be on the Home Page, so click Appointment Diary and then select this Thursday from the 

calendar to take us back to familiar territory. 

So we know Stephanie Allshaw is waiting to see us, but what do we know about her as a patient? 

 

• Right-click on her Thursday morning appointment and then click Open Patient Record. 

• This will display the Patient Editor with all her details – please see “The Patient Editor” section in the user 

guide for more detailed information on this. Suffice to say at this stage that you can peruse her patient details 

from here. 

• You can also click the Clinical Summary button located on the ribbon bar of the Patient Editor. This will 

bring up a complete history for this patient (see “Clinical Summary” in the user guide). 

• Once you’ve looked through, click the “Close” button on the Clinical History, and click the Cancel button on 

the Patient Editor to return to the diary. 

 

OK – so Mrs Allshaw has now been treated and feels a whole lot better. What we should do now is write up some notes 

about the session. 

  

• Once again, right-click on the appointment in the diary, then click on Enter Session Notes. 

• ClinicOffice then asks you to select a case:- 

 
Select a Case 

 

For an explanation of cases and session please see the section “Clinical Terminology” which is located in the “Clinical 

Notes” section of this diary. 
 
 

• Select Create a NEW CASE for this session then click OK to attach our new session notes to Case #2 
which has just been automatically created. 

• Note that most of the information (date, time, practitioner and type) is filled out automatically from the 
appointment record. 

• Because we did so well with the treatment, set the outcome of the session to “5) Great Improvement” 

• By default, the session editor uses SOAP notes (Subjective, Objective, Assessment and Plan) – although 
these tabs can be changed by simply going into the design mode. For the purpose of this tutorial just type 
anything you like under these notes. 

• Press the SAVE button located on the ribbon bar. 

Before closing the session record, we’re going to take a look at another impressive feature of ClinicOffice v5:- 
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Visual Notes 

• Click the ATTACH button which is located on the ribbon bar of the Clinical Notes Window. Now select Visual 

Note, this brings up the Visual Note Templates. 

• Browse through the different visual note templates in the library, and when you find one you like, click OK. 

• The Visual Note will now attach itself to the session you have just created. You can now edit this Visual Note 
with several tools you are provided with; feel free to experiment. Try the different “Tool Styles” to see what 

will be useful for you. 

Example Visual Note Being Edited 
 

 

• You can add extensive notes to the Visual Note by clicking the NOTES button. This brings up a small 

separate window which will allow you to enter text in a basic format. If you close the window the text will be 

automatically saved, and you can view them later.  

• When you have finished editing the visual note, click SAVE again. 

• Notice that the picture now appears as an attachment to this session record. It will also appear as part of the 

patient’s Clinical History. 

• Finally, click Save and Close on the Clinical Notes to save all the records attached to Stephanie Allshaw. This 

will take you back to the Appointment Diary. 

 

So what’s next? Well, Mrs Allshaw has now been treated and is feeling much better, the session notes have been written 

up, so now she has come back through to reception to pay. 
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Creating a Quick Transaction 

You may have noticed that so far, we have been able to do everything from the Appointment Diary screen and invoicing 

is no exception. 

 

1. Right-click on Mrs Allshaw’s Thursday 

morning appointment and then click 

Quick Transaction. 

2. If you are prompted to back date the 

invoice, please click yes. 

3. This will display the Quick Transaction 

editor. Notice all the fields that have 
been filled in for you. The details are all 

taken from the appointment and the 
cost is taken from the Appointment 

Type (see the “Appointment Type 

Editor” section in the User Guide). 

4. This screen does more than just create 

an invoice for us. It will also allow us to 
enter a payment at the same time. Mrs 

Allshaw is paying with cash, so select 

Cash as the payment method. 

5. If you wanted to print an invoice, then 

you will tick the “Print this invoice after 
saving” box and select an invoice 

report. You would do the same if you 
wanted to print a payment receipt, by 

selecting “Print a receipt after saving” 

box and selecting a Payment Receipt. 
For the sake of this tutorial make sure 

both are un-ticked. 

6. The appointment with Miss Allshaw is 
now done and dusted; it would be a 
good idea to update the status of the 
appointment to Completed. Tick the box 
which says Change the associated appointment’s status to and select Completed.  

7.  If you use the Quick Transaction a lot and each time you needed to print off an invoice or receipt, then you 

can tick the Quick Print (do not show preview window). This means that anything that needs to be printed 

will go straight to your printer without the need for you to look at it. This is only recommended if you are sure 

of what you are doing. For now leave this un-ticked.  

8. Finally, clicking OK will bring up a summary form and clicking YES will return you to the diary. You will notice 

that there is now a small invoice icon on the appointment. 

 

Appointment showing invoice icon 

 

 

The green invoice icon indicates that the invoice has been paid. Red indicates unpaid, and orange indicates part paid. 

And that’s all there is to it. That one screen created the invoice and posted a payment for the invoice. It may all seem 

a little daunting at first, but given a little practice, you’ll soon find that creating and paying invoices can literally be done 

in a matter of seconds. 

OK – let’s try entering another invoice – this time for Mrs Brooke’s appointment at 10:00am with Rachel. 

 

• Right-click on the 10:00am appointment and then click Quick Transaction. 

 

• Once again, note how the invoice details have been filled out for us based on the appointment details. 
 

The Quick Transaction Screen 
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• This time, rather than entering a quick payment; select the option to Open the Payment Editor Screen. 

 

• Click OK and then YES to confirm the details. At this point the invoice will be saved, and the Payment Editor opens. 
Now we’ll see how to use the Payment Editor to receive payments. 

 

 

Receiving a Payment 

We’ve created the invoice for Mrs Brookes (for £20) and she is now busy writing out a cheque to pay us. 

Look at the Payment Editor window. As before, most of the fields have been automatically completed. We just need to 

do the following:- 

• Set the Pay Method to Cheque. 
 

• You could enter her cheque number as a payment reference, though there is no requirement to do so. 

 

• Enter the amount being paid £20. 

 

• We need to tell ClinicOffice how to allocate this payment (i.e. which invoices are being paid). There is only one 
invoice outstanding for Mrs Brookes, so ClinicOffice will automatically allocate the payment to that invoice. 

 
The Payment Editor 

 

We can now click  to save this payment. 

Congratulations are once again in order! 

 

You have now completed the basic elements of the tutorial. Over the last few sections you have learnt how to:- 

• Enter new staff members 

• Enter new patients 
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• Book appointments 

• Create a Session Note with a Visual Note 

• Create invoices and take Payments 

 

Please don’t worry, if it all seems a bit scary at first – like most things in life – the more you do it, the easier it becomes.  

The remainder of the tutorial is now aimed at consolidating what you have done and setting some exercises to work 

on. 

 

 

Extended Tutorial 

 

Using Documents 

So, we have the invoice to send to Mrs Campbell – now we need a covering letter to go with it. This is where the 

Documents feature comes in hand:- 

1. From the diary, right-click on the appointment in question and select Open Patient Record. 

2. In the Patient Editor, go to the Documents page by clicking the DOCUMENTS tab. 

The Documents tab 

 

You can see that there are currently no documents. 

3. Click on the PRINT button, select Letters and choose Letter to Patient to add to her record. 

4. Now press the SAVE button and select Save to Database. The letter will now appear in the Documents 

section of the patient’s record. 

You can create mail merge documents and then store them under the Documents section of the Patient Editor. 
It is also worth noting that you can now scan pictures/documents directly into ClinicOffice. 

 

Searching for a Patient 

Imagine you get a phone call from a “Mr Antonio Barratt”. He is aware that he still owes money for a treatment session, 

and he wants to send through a cheque. 

But he has forgotten exactly how much he owes:- 

1. In the top right-hand corner of the ClinicOffice screen is a Search field. 

Click on the button to the left of the field and then click on Patients. 

2. Type in “Barratt” (the case does not matter) and press Enter. 

3. This will take you to the Patients Search screen. If you typed it in 

correctly, then one record should appear which will be “Mr Antonio 

Barratt”. (If he doesn’t appear then go back to step 2). Double-click on 

him to bring up the Patient Editor. 

4. Now go to the FINANCES tab on the Patient Editor. You should see 
that he has an unpaid invoice and the screen also tells you his overall 

account balance (-£20). 

5. You tell Mr Barratt that he owes you £20 and he wants to pay the full 

amount by credit card over the phone. Notice the handy FINANCIAL 

ACTIONS link on the ribbon bar. Click that link and select Enter 

Payment.  

6. The Payment Editor will open. You can now enter £20 as the amount 

and select Cash as Pay Method.  

Searching for a Patient 
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7. Press the Save and Close button.  

 

This demonstrates how to do a simple patient search, look up their account balance and take a payment from them. 
There is lots of other important information on the Patient Editor; take time to look around and experiment. Remember 

it does not matter if you mess up the sample database. 

 

 

Tutorial Summary 

As stated at the outset earlier, the purpose of the tutorial is to work through some of the basic features of ClinicOffice 

v5. There is obviously far more functionality than we could possibly cover in a short tutorial. 

We strongly recommend that you take the time to read the User Guide to become more familiar with the software. But 

the biggest key to success is simply to spend time using the ClinicOffice program. 

Experiment with the sample database to see how the program best fits your needs. Simply spending time with the 

program is what pays the greatest dividends. 

 

Other Helpful Resources 

Full ClinicOffice User Guide: https://pioneersoftware.co.uk/files/COv5_Userguide.pdf 

Support Forum: https://pioneersoftware.co.uk/forums 

For telephone and online support call us on 01205 205500 and dial 2 (requires our Support Plan). 

For any sales enquiries, please call us 01205 205500 and dial 1. 

 

Thanks for using ClinicOffice v5! 

Kind Regards, 

 

ClinicOffice Team 
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